Oracle CX Sales

Using Sales

20A
## Contents

### Preface
- About This Guide: 1
- Audience and Scope: 1
- Related Guides: 1

### 1 About This Guide
- Audience and Scope: 1
- Related Guides: 1

### 2 Get Started
- Overview of the Sales Application: 3
- Overview of Work Areas: 5
- Get Help in the Application: 8
- Find Your Way Around the Oracle Help Center: 9

### 3 Resources
- Overview of Managing Resources: 11
- Resource Directory: 11
- View Resource Information: 12
- Designate Proxies: 13
- Work as a Proxy: 13
- FAQs for Resources: 13

### 4 Search
- Two Ways to Search Your Sales Application: 17
- How to Use Search: 21
- Personal Lists: 30

### 5 Infolets
- Quick Way to Get Key Sales Information and Take Action: 33
- Personalize Your Key Infolets: 36
- What happens if I delete an actionable infolet?: 40
<table>
<thead>
<tr>
<th>Chapter</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>6</td>
<td>Activities and Calendars</td>
<td>41</td>
</tr>
<tr>
<td></td>
<td>Overview of Activities</td>
<td>41</td>
</tr>
<tr>
<td></td>
<td>Get Started with Activities and Calendars</td>
<td>41</td>
</tr>
<tr>
<td></td>
<td>Overview of Creating Lists</td>
<td>46</td>
</tr>
<tr>
<td></td>
<td>Create Tasks from a Task Template</td>
<td>46</td>
</tr>
<tr>
<td></td>
<td>Select Addresses for Activities</td>
<td>47</td>
</tr>
<tr>
<td></td>
<td>Activity Notification</td>
<td>47</td>
</tr>
<tr>
<td></td>
<td>Notifications to Drill Down to Transactions</td>
<td>48</td>
</tr>
<tr>
<td></td>
<td>Apply Mass Update to Activities</td>
<td>49</td>
</tr>
<tr>
<td></td>
<td>Calendars</td>
<td>50</td>
</tr>
<tr>
<td></td>
<td>FAQs for Activities and Calendars</td>
<td>54</td>
</tr>
<tr>
<td>7</td>
<td>Accounts, Contacts, and Households</td>
<td>57</td>
</tr>
<tr>
<td></td>
<td>Overview of Accounts, Contacts, and Households</td>
<td>57</td>
</tr>
<tr>
<td></td>
<td>Account Management</td>
<td>57</td>
</tr>
<tr>
<td></td>
<td>Contact Management</td>
<td>64</td>
</tr>
<tr>
<td></td>
<td>Household Management</td>
<td>67</td>
</tr>
<tr>
<td></td>
<td>Searches</td>
<td>69</td>
</tr>
<tr>
<td></td>
<td>Record Integrity</td>
<td>75</td>
</tr>
<tr>
<td></td>
<td>Data Enrichment</td>
<td>76</td>
</tr>
<tr>
<td></td>
<td>Business Plans</td>
<td>84</td>
</tr>
<tr>
<td></td>
<td>Assets</td>
<td>87</td>
</tr>
<tr>
<td></td>
<td>Mass Update</td>
<td>91</td>
</tr>
<tr>
<td></td>
<td>Record Management</td>
<td>93</td>
</tr>
<tr>
<td>8</td>
<td>Campaigns</td>
<td>95</td>
</tr>
<tr>
<td></td>
<td>Overview of Sales Campaigns</td>
<td>95</td>
</tr>
<tr>
<td></td>
<td>Create a Sales Campaign</td>
<td>95</td>
</tr>
<tr>
<td></td>
<td>Sales Campaign Management</td>
<td>96</td>
</tr>
<tr>
<td></td>
<td>FAQs for Sales Campaigns</td>
<td>102</td>
</tr>
<tr>
<td></td>
<td>Marketing Content</td>
<td>104</td>
</tr>
<tr>
<td></td>
<td>FAQs for Marketing Content</td>
<td>107</td>
</tr>
<tr>
<td></td>
<td>Marketing Campaigns</td>
<td>108</td>
</tr>
<tr>
<td></td>
<td>FAQs for Marketing Campaigns</td>
<td>111</td>
</tr>
</tbody>
</table>
### Leads

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview of Lead Management</td>
<td>113</td>
</tr>
<tr>
<td>Lead Processing</td>
<td>113</td>
</tr>
<tr>
<td>Lead Follow Up</td>
<td>118</td>
</tr>
<tr>
<td>Qualification</td>
<td>130</td>
</tr>
<tr>
<td>FAQs for Leads</td>
<td>134</td>
</tr>
</tbody>
</table>

### Responses

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview of Response Management</td>
<td>141</td>
</tr>
<tr>
<td>Differences Between Response, Lead, and Opportunity</td>
<td>141</td>
</tr>
<tr>
<td>What's the difference between a response and an interaction?</td>
<td>142</td>
</tr>
<tr>
<td>What happens when I convert a response to a lead?</td>
<td>143</td>
</tr>
</tbody>
</table>

### Opportunities

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview of Opportunities</td>
<td>145</td>
</tr>
<tr>
<td>Opportunity Management</td>
<td>147</td>
</tr>
<tr>
<td>Recommended Actions</td>
<td>151</td>
</tr>
<tr>
<td>Opportunity Team Members</td>
<td>154</td>
</tr>
<tr>
<td>Sales Coach</td>
<td>155</td>
</tr>
<tr>
<td>Opportunity Access</td>
<td>155</td>
</tr>
<tr>
<td>Sales Competitors</td>
<td>158</td>
</tr>
<tr>
<td>FAQs for Sales Competitors</td>
<td>162</td>
</tr>
<tr>
<td>Opportunity Assignment</td>
<td>163</td>
</tr>
<tr>
<td>Opportunity Closure</td>
<td>164</td>
</tr>
<tr>
<td>Opportunity Assessments</td>
<td>167</td>
</tr>
</tbody>
</table>

### Opportunity Products and Revenue

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview of Opportunity Products and Revenue</td>
<td>171</td>
</tr>
<tr>
<td>Opportunity Products and Revenue Management</td>
<td>171</td>
</tr>
<tr>
<td>Recurring Opportunity Products</td>
<td>174</td>
</tr>
<tr>
<td>Sales Credits</td>
<td>177</td>
</tr>
<tr>
<td>Product Attribute Synchronization</td>
<td>180</td>
</tr>
</tbody>
</table>
### Forecasts

Overview of Forecasts | 185
---|---
How can I add forecast items to a forecast? | 186
About Forecasting by Territory, Product, or Unit | 186
Manage Your Forecast | 187
Sales Forecast Adjustments | 189
Copy the Prior Forecast | 190
Forecast Actions and Results | 190
Available Forecast Metrics | 191
FAQs for Forecasts | 192

### Territories

Overview of Territories | 195
---|---
Modify Your Territories | 195
Territory Proposals, Coverage and Dimensions | 197

### Quotes

Overview of Using Quotes | 201
---|---
Overview of Quotes and Orders | 202
Create and Update a Quote for an Opportunity | 202
Create and Update a Quote for an Account | 204

### Quotas

Overview of Sales Quotas | 205
---|---
How You Allocate, Publish, and Revise Quotas | 205
FAQs for Quotas | 206

### Analytics

Overview of Sales Analytics Pages | 209
---|---
Sales Analytics Interfaces | 209
18 **Office 365**

- Overview of Office 365 for Sales
- Side Panel Components
- Search Using the Side Panel
- Create Contacts from the Side Panel
- Set Communication Preference of a Contact
- Share Contacts
- Example of Familiarizing with Contacts Using Top Connections
- Add Objectives to Your Appointment, Call Report, or Tasks
- Example of Sharing Emails and Appointments with the Sales Application
- Share the Appointment Received from an Email ID Held by Multiple Contacts
- Example of Creating Activities in the Side Panel
- View Service Requests
- Sync Records with the Sales Application
- Sync Emails with the Sales Application
- See Opportunity Quotes and Download the Proposal
- FAQs for Office 365

19 **IBM Notes**

- Overview of Oracle Sales Cloud for IBM Notes
- Considerations for IBM Database Configurations

20 **Gmail**

- Overview of Oracle Sales for Gmail
- Install and Configure Gmail for Sales
- Create Contacts from the Oracle Sales for Gmail Side Panel
- Examples of Creating Contacts
- Example of Sharing Your Email with Sales Application Users
- Sync Settings
- About Sales and Gmail Sync

21 **Mobile Applications**

- Using Mobile Applications
- Oracle CX Cloud Mobile
- Sales Cloud Mobile
<table>
<thead>
<tr>
<th>22 Sales Assistant</th>
<th>249</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview of Sales Assistant</td>
<td>249</td>
</tr>
<tr>
<td>Get Started with the Sales Assistant</td>
<td>250</td>
</tr>
<tr>
<td>Use Sales Briefing</td>
<td>251</td>
</tr>
<tr>
<td>Use Create Tasks</td>
<td>252</td>
</tr>
<tr>
<td>Use Get Tasks</td>
<td>253</td>
</tr>
<tr>
<td>Use Get Open Pipeline</td>
<td>254</td>
</tr>
<tr>
<td>Use Get Opportunity Details and Actions</td>
<td>257</td>
</tr>
<tr>
<td>Use Get Account Details and Actions</td>
<td>261</td>
</tr>
<tr>
<td>Use Get Contact Details and Actions</td>
<td>264</td>
</tr>
<tr>
<td>Use Get Current, Next Appointment, and Reschedule Appointment</td>
<td>266</td>
</tr>
<tr>
<td>Use Follow Up on Appointment</td>
<td>269</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>23 Social Networking</th>
<th>273</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview of Social Networking</td>
<td>273</td>
</tr>
<tr>
<td>Overview of Adding Oracle Social Network</td>
<td>273</td>
</tr>
<tr>
<td>Share Information Using Oracle Social Network</td>
<td>273</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>24 LinkedIn Sales Navigator</th>
<th>277</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview of LinkedIn Sales Navigator</td>
<td>277</td>
</tr>
<tr>
<td>Use the LinkedIn Sales Navigator</td>
<td>277</td>
</tr>
<tr>
<td>Associate a LinkedIn Record with Contacts or Leads</td>
<td>278</td>
</tr>
<tr>
<td>How can I add LinkedIn to my list of trusted sites in Internet Explorer?</td>
<td>278</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>25 Service Requests</th>
<th>281</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview of Service Request Management</td>
<td>281</td>
</tr>
<tr>
<td>Overview of Service Request User Tasks</td>
<td>281</td>
</tr>
</tbody>
</table>
## 26 Sales Lightbox

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview of Sales Lightbox</td>
<td>283</td>
</tr>
<tr>
<td>Available Actions for Different Content Types</td>
<td>283</td>
</tr>
<tr>
<td>Content Creation</td>
<td>285</td>
</tr>
<tr>
<td>Content Upload</td>
<td>289</td>
</tr>
<tr>
<td>Content Update</td>
<td>290</td>
</tr>
<tr>
<td>Content Search</td>
<td>292</td>
</tr>
<tr>
<td>Content Download and Open</td>
<td>293</td>
</tr>
<tr>
<td>Content Share</td>
<td>297</td>
</tr>
<tr>
<td>Content with Thumbnail Images</td>
<td>300</td>
</tr>
<tr>
<td>Content Deletion</td>
<td>301</td>
</tr>
</tbody>
</table>

## 27 In-Context Audit

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview of In-Context Audit</td>
<td>303</td>
</tr>
<tr>
<td>Use the Change History Subtab</td>
<td>303</td>
</tr>
</tbody>
</table>
Preface

This preface introduces information sources that can help you use the application.

Using Oracle Applications

Help

Use help icons ? to access help in the application. If you don't see any help icons on your page, click your user image or name in the global header and select Show Help Icons. Not all pages have help icons. You can also access the Oracle Help Center to find guides and videos.

Watch: This video tutorial shows you how to find and use help.

You can also read about it instead.

Additional Resources

- **Community**: Use [Oracle Cloud Customer Connect](https://oracle.com) to get information from experts at Oracle, the partner community, and other users.

- **Training**: Take courses on Oracle Cloud from [Oracle University](https://oracle.com).?

Conventions

The following table explains the text conventions used in this guide.

<table>
<thead>
<tr>
<th>Convention</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>boldface</strong></td>
<td>Boldface type indicates user interface elements, navigation paths, or values you enter or select.</td>
</tr>
<tr>
<td><strong>monospace</strong></td>
<td>Monospace type indicates file, folder, and directory names, code examples, commands, and URLs.</td>
</tr>
<tr>
<td>&gt;</td>
<td>Greater than symbol separates elements in a navigation path.</td>
</tr>
</tbody>
</table>
Documentation Accessibility

For information about Oracle's commitment to accessibility, visit the Oracle Accessibility Program website. Videos included in this guide are provided as a media alternative for text-based help topics also available in this guide.

Contacting Oracle

Access to Oracle Support

Oracle customers that have purchased support have access to electronic support through My Oracle Support. For information, visit My Oracle Support or visit Accessible Oracle Support if you are hearing impaired.

Comments and Suggestions

Please give us feedback about Oracle Applications Help and guides! You can send an e-mail to: oracle_fusion_applications_help_ww.grp@oracle.com.
1 About This Guide

Audience and Scope

If you’re looking for information about performing day-to-day tasks in your sales applications, then this guide is for you. The information is primarily aimed at salespeople, sales managers, and other sales users who form part of your sales organization.

This guide describes how to:

- Manage customers and contacts.
- Log sales calls.
- Manage calendars and activities.
- Create and update sales campaigns and sales leads.
- Create, monitor, and update opportunities.
- View and perform actions from within actionable infolets.
- Create and update territories and quotas.
- Participate in social conversations.
- Use mobile applications with your sales application and use sales assistant.
- View key metrics, such as pipeline revenue, quota performance, and in-context audit to view transaction change history at a glance.

Note: With release 20A (11.13.20.01.0), "Oracle Engagement Cloud" is now known as Oracle CX Sales and Oracle B2B Service. Existing Oracle Engagement Cloud users will retain access to Oracle CX Sales and B2B Service features under their preexisting licensing agreements. Any new users created within your current Oracle Engagement Cloud license count will also retain the same access to Oracle CX Sales and Oracle B2B Service. To obtain additional features or manage your subscription, refer to your Oracle Cloud Applications Console. This document describes features available to users under Oracle CX Sales, Oracle B2B Service, and Oracle Engagement Cloud licensing agreements.

Related Guides

You can refer to the following related guides to understand more about the user tasks covered in this guide.

<table>
<thead>
<tr>
<th>Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Oracle Applications Cloud Using Common Features</td>
<td>Describes user tasks and features that are common across Oracle Applications Cloud.</td>
</tr>
<tr>
<td>Oracle CX Sales Using Incentive Compensation</td>
<td>Describes the user tasks for the incentive compensation business process, from creating and managing compensation plans to reviewing and monitoring incentive plans and performance data.</td>
</tr>
</tbody>
</table>
### Title

<table>
<thead>
<tr>
<th>Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Oracle CX Sales Using Customer Contracts</td>
<td>Describes user tasks for customer contracts including creating customer contracts, authoring of contract terms, and maintenance and configuration of contracts.</td>
</tr>
<tr>
<td>Oracle CX Sales Creating and Administering Analytics</td>
<td>Provides advanced instruction on creating and modifying analytics and reports.</td>
</tr>
<tr>
<td>Oracle CX Sales Using Partner Relationship Management for Channel Managers</td>
<td>Describes user tasks to help channel sales managers, channel account managers, and channel operations managers perform day-to-day business tasks.</td>
</tr>
<tr>
<td>Oracle CX Sales Using Partner Relationship Management for Partners</td>
<td>Describes user tasks to help partner sales managers, partner salespeople, and partner administrators perform day-to-day business tasks.</td>
</tr>
<tr>
<td>Oracle CX Service Using B2B Service</td>
<td>Contains information to help service managers, service personnel, and other service end users to perform day-to-day business tasks using Oracle CX Service.</td>
</tr>
<tr>
<td>Oracle CX Service Using Knowledge</td>
<td>Describes how administrators, agents, authors, and other knowledge base contributors can implement and use Knowledge in CX Service.</td>
</tr>
<tr>
<td>Oracle CX Sales Deploying Sales for Outlook</td>
<td>Describes how users can install, uninstall, configure, administer, and upgrade Oracle CX Sales for Outlook.</td>
</tr>
<tr>
<td>Oracle CX Sales Using Sales for Outlook</td>
<td>Describes user tasks that are related to managing and using Oracle CX Sales data within Microsoft Outlook.</td>
</tr>
</tbody>
</table>

**Related Topics**

- Oracle Help Center
Get Started

Overview of the Sales Application

Your sales application from Oracle gives you a single interface to perform a variety of key sales tasks. The easy-to-use design means less time training, so you get up-to-speed quickly. In addition to presenting core tasks in a simple UI, the application features analytics that provide information when and where you need it. Here’s a summary of the key tasks you can accomplish with the applications:

- Manage accounts, households, and contacts.
- Create business plans and manage customer assets.
- Log sales calls and follow up on tasks.
- Manage calendars and appointments.
- Send out sales campaigns.
- Create and update leads and convert them to opportunities.
- Create, monitor, and update opportunities.
- View competitor information.
- Create and manage service requests.
- Create and update territories and quotas.
- Manage sales forecasts.
- Participate in social conversations.
- Use and share documents in the Lightbox content library.
- Manage partner information.
- Use the mobile application to manage customer information, leads, and opportunities.
- View sales metrics, such as pipeline revenue and quota performance, at a glance.

Getting to Know the UI and Features

Understanding the main areas of the UI and core features helps you as you work within the sales applications. UI and features include:

- Home page:
  - The home page offers a central location from which you can navigate to complete important tasks, like updating contact, account, lead, or opportunity information.
  - The home page contains a springboard and a panel that, based on setup, shows either company announcements or social networking conversations.

- Springboard:
  - The springboard is the area that contains a set of functional area icons.
  - The springboard provides icons that you can use to open pages and applications.
• Accounts and contacts:
  ◦ Create and manage accounts, contacts, and households for B2B selling.
  ◦ View and manage associated items, such as interactions, leads, opportunities, and appointments.

• Scheduling and calendars:
  ◦ Calendars and tasks are available within the Activities area.
  ◦ Create and manage appointments and tasks, and associate them with the contacts, leads, and opportunities you’re working on.
  ◦ Manage team calendars and respond to autogenerated tasks.

• Leads:
  ◦ View and edit lead information, including products, budget, and deal size.
  ◦ Create, qualify, and convert leads.

• Sales campaigns:
  ◦ Create sales campaigns to target contacts from multiple sources including the contact repository and previous campaigns.
  ◦ Manage all the information related to your sales campaign such as monitoring responses.

• Opportunities:
  ◦ Create and manage opportunity information, such as owner, product revenue, win probability, sales stage, and more.
  ◦ Manage all the information related to your opportunities like relationships, contacts, appointments, and sales team members from one, convenient portal.

• Sales forecasting:
  ◦ View forecast, pipeline, and won amounts for current, past, and upcoming quarters.
  ◦ See forecast trends over time.

• Partner management:
  ◦ Manage partners, including their leads and opportunities.
  ◦ Review notification requests and manage activities and notes related to partners.
  ◦ Manage partner enrollments.

• Social:
  ◦ Participate in conversations with other sales team members.
  ◦ Associate conversations with sales business objects, such as accounts, contacts, leads, and opportunities.

• Sales analytics:
  ◦ Predefined infolets contain key metrics, such as Top Open Deals or Stalled Deals. You navigate to the infolets using the pagination controls (clickable dots).
  ◦ Gain insight into your performance against your quota.
  ◦ View your pipeline, including total opportunity revenue, revenue per sales stage, and opportunity count in the pipeline.
• Additional configuration (administrators only):
  ◦ Set any one of several different themes to change look and feel.
  ◦ Change icon style, button shape, and logo to personalize the user experience.
  ◦ Configure news and announcements on the home page.

For more information see the related topics and the online help.

Configuring the UI
Several configuration options are available for administrators to tailor the UI to company business needs, such as:

• Modify tables and forms
• Add, remove, and reorder subtabs
• Show or hide predefined fields
• Add and remove company-defined fields
• Change field names and make fields read-only
• Create dynamic lists
• Specify whether changes are available for users with a particular role or to all users
• Add and remove infolets that present analytics

Administrators use Application Composer and Page Composer to modify UI elements. For more information about modifying the UI, see the Extending Sales and Service guide. Also read the topic, Understanding Default Navigation Components, in the Implementing Sales guide.

Related Topics
• Sign In and Get Started
• Help Center

Overview of Work Areas

A work area is a set of pages that provides everything you need to accomplish a business goal. Let’s explore a couple of work areas to see their common features.

You can use the Navigator to open work areas. The first thing you see when you open any work area is the landing page. Landing pages typically summarize data and let you drill down to more details. Often you can change the records in the summary list by running a different search or clicking an infotile. In some work areas, you can display the list as a grid instead. Let’s look at some examples.
Landing Pages with Infotiles

First, let’s walk through the Travel and Expenses work area. To open this work area, you click Expenses on the Navigator, and you will see the Travel and Expenses work area.

![Image of the Travel and Expenses work area]

This table shows the available UI elements on the landing page and explains what you use them for.

<table>
<thead>
<tr>
<th>Callout Number</th>
<th>UI Element</th>
<th>What You Use It For</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Row of infotiles</td>
<td>Display key information about a set of records, such as expense items and expense reports.</td>
</tr>
<tr>
<td>2</td>
<td>Summary table</td>
<td>View records for the infotile you select.</td>
</tr>
<tr>
<td>3</td>
<td>Panel tab</td>
<td>Do additional tasks, such as use the links to go to related tasks.</td>
</tr>
</tbody>
</table>

In this work area, you land on a page with a row of infotiles. Each infotile gives you key information about a specific business object. You select an infotile to see the related set of records, and you can click links in the infotile to filter the records. Suppose you want to see the expense reports that you need to act on. First, you click the Expense Reports infotile, and then click the Requires Action link. The summary table lists the matching records. You click a record to see more details or to take some quick actions, such as attach receipts to a hotel expense record.

Some pages have tabs to take you to another page in the work area or to other parts of the same page.
Landing Pages with Grid and List Views

Let's look at the My Team work area as an example. To open this work area, you click My Team on the Navigator. This landing page displays records in the form of a grid or list. You can switch between these two views of the same records.

Here's an example of the grid view showing each record as a card (1), laid out in a grid. Cards provide a summary view of a record, in this case people, using text, links, or images. You can flip the card to see additional information on the other side. You use the Grid icon (2) and the List icon (3) to switch between the grid and list views.

And here's the same information in a list view, which displays the record in a table (1). With either view, you can open and edit any of the records, or select the action you want to take from the Actions menu (2).

In either view, you can usually select actions to take on specific records, or open up the record to see or edit details on another page.
Landing Pages with Infolets

Some landing pages consist of only infolets. Each infolet is a small, interactive widget that gives you key information and actions for a specific subject related to the work area. Infolets have a front view and possibly also a back and expanded view.

This is what a landing page with infolets looks like.

From an infolet, you can usually open other pages in the same work area or another work area. You can also personalize the infolet page by moving or hiding infolets.

Related Topics

- Sign In and Get Started
- How You Use Tables

Get Help in the Application

Watch video

We all can use a helping hand sometimes. To get help for what you’re working on, use the help icons that are on many of the pages you use. The icons open help windows that can have informational text, links to help content, or both, and maybe even help that your company added.

Use Help Windows

Here's what you do:

1. If you don't see any help icons, click your user image or name in the global header and select Show Help Icons. You reveal any icons on your current page, but not all pages have help icons.

2. Click a help icon. If the icon isn't next to the page title, then the help window gives you information specific to the part of the page that the icon is on.
3. On the help window, click any of the links available.
   - You see help links in your preferred language only if there's content in that language. If not, you see links in English.
   - Help content opens in a new browser tab so you can keep that open while you work.
   - You can do more with the help than just read it. Options can include printing, downloading, bookmarking, or emailing the help.

Browse and Search for Help

Most of the links open guides in the Oracle Help Center. You can use the Table of Contents tab to move around in the guide for other information.

To search within a guide:

1. Open the Search tab.
2. With the **Search this book** option selected, enter your keywords and run the search.
3. In the new browser tab showing the search results, find the entry you want and click one of the two links for that entry.
   - The first link takes you to the beginning of the relevant chapter.
   - The second link takes you directly to the part of the chapter that contains the summary text that you see in the search result.

**Tip:** To open the Oracle Help Center at any time, click your user image or name in the global header and select **Applications Help**.

Related Topics
- Oracle Help Center

Find Your Way Around the Oracle Help Center

**Watch video**

The Oracle Help Center (https://docs.oracle.com) has guides, videos, information about releases and updates, and other resources for Oracle Applications Cloud. In the application, when you click links in help windows, most of the time you open a specific guide in the Help Center. From there, you can search or browse to find other content. Let's take a look at how you can move around and find what you're looking for in the Help Center.

Browse for Content

To find guides and other materials for a specific cloud service:

1. In the Oracle Help Center, open the main menu and click **Cloud Applications**.
2. Click the name of your cloud service. This is also your starting point if you got to the Help Center by clicking your image or user name in the **global header** and selecting **Applications Help**.
3. Select a release update for the cloud service, if you need to.
4. Get to a specific guide, video, or other resource.
   - Here are some examples of where you might go on the cloud service page to browse for information:
     - Learn What’s New panel: Get information about new features and other changes for the release update.
     - Tasks section in the navigation pane: Click a task category and then a specific task, to open the guide that covers the task.
     - REST API section in the navigation pane: Get reference information about REST APIs.
     - Click the Videos or Books link in the navigation pane to get all the videos or guides for the cloud service.
       - On the Videos or Books page, you can use the View list to filter by category.
       - Most guides are available in multiple formats, for example HTML and PDF.

   Tip: Use the breadcrumbs to get to other parts of the Help Center.

Search for What You Want
The scope of the search depends on the page you're on in the Oracle Help Center. For example, on the Cloud Documentation page, you search across all cloud services in Oracle. On the pages for a specific cloud service, you search only within that service.

Related Topics
- Oracle Help Center
3 Resources

Overview of Managing Resources

Managing resources involves viewing and modifying a resource's profile, organization membership, role assignment, skills, additional contact information, and salesperson information.

All the resources within the deploying company can view any resource's profile. However, only the administrator can modify a resource's profile, organization and team membership, and role assignment. Managers can modify the skill information of their direct and indirect reports. However, resources can only modify their own profiles, skills, and additional contact information.

Manage Resource Profiles

Resource profile management involves managing a user's profile, including the resource's core skills, photo, time zone, additional contact information, and so on. As part of managing a resource's profile, the administrator specifies the dates between which the resource is available to the organization. The administrator also ensures that role assigned to the resource is within the period mentioned in the profile.

Manage Organization Membership

At any point in time, a resource belongs to an organization, and the administrator can assign this resource to any other organization within the deploying company.

Manage Resource Role Assignment

An administrator or an organization manager can assign or modify resource roles within an organization, with one role assigned to a resource at a time. However, administrators can also assign multiple roles to resources outside an organization.

Note:

- The dates of the resource role assignment must be within the date range during which the resource is active in the deploying organization.
- An organization can have only one manager.

Configure Extensible Resource Pickers

Administrators can configure extensible resource pickers that let sales users search and associate users with business objects relevant to their business flows. For more information about configuring the resource search, see the related topics.

Related Topics

- Overview of Configuring Resource Search
- Configure Resource Search
Resource Directory

You can use the Resource Directory to view all the resources within your organization. You can also use the Resource Directory to find and communicate with other resources, and to network and collaborate with them.

You can access the Resource Directory using the following path: Navigator > Resource Directory. You can also perform some of the functions of the resource directory using the Manage Resources setup task.

You use the Resource Directory to perform the following tasks:

- View and modify your profile
- View your organization information
- View information related to other organizations
- View the profiles of other resources
- Communicate with other resources

Note: You can set the profile option HZ_RESOURCE.Allow_CUSTOMIZATION to Yes to enable desktop pages for Resource Directory in Application Composer. The default value of this profile option is No.

View Resource Information

You can use the Resource Directory to view the detailed information about the resources in an organization. Sales representatives and sales managers are examples of resources. As a sales representative, you can view the profile details of the resources within your organization. You can also modify part of your own profile, skills, and additional contact information. As a sales manager, you can modify the skill information of your direct and indirect reports.

Here's how you view the details of a resource:


   The page displays the organizational structure between you and your manager.

2. View your details or another resource's details using the following steps:

   o Click Tasks > View Resource Details to view your details.

   The Resource page with your details appears.

   o Click Tasks > View Resources to view the profile information of another resource.

   The View Resources page appears. You can search for the required resource and click on the resource name in the search results to view the details of the resource.

   The Resource page displays the details about the resource, such as usages, registry ID, manager, job title, department, roles, mail stop, phone, email, address, and time zone.

3. In the Resource page, you can see the details about a resource, such as usages, registry ID, manager, job title, department, roles, mail stop, phone, email, address, and time zone.

   o Organizations: Displays the organization membership details of the resource such as role, organization, usage, and manager.
Teams: Displays the team information of the resource, such as role, team, team usage, and team manager.

Roles: Displays the role information of the resource, such as role name, member, manager, administrator, and lead.

Skills: Displays the skills of the resource, such as accomplishments, skills, competencies, degrees, honors and awards, languages, licenses and certifications, problem codes, and work requirements.

Additional Contact Information: Displays additional contact point information such as phone, email, social network, web, and contact preferences.

4. Click **Save** if you made any updates, or else click **Cancel**.

### Designate Proxies

Here’s how you can designate a proxy to work on your behalf.

1. Click your user image or name in the global header, and on the **Settings and Actions** menu, select **Set Preferences**.
2. Click **Proxies**.
3. Click **Actions > Create**.
4. Search for the person you want to designate as your proxy.

**Note:** If you can’t find the person you want to designate as a proxy, ask your administrator to check if the person has the Impersonate User (FND_IMPERSONATE_USER_PRIV) privilege.

5. Verify the user details and click **Apply**.
6. Click **OK**.
7. Select the start and end dates.
8. Click **Save and Close**.

### Work as a Proxy

You must have the Impersonate User (FND_IMPERSONATE_USER_PRIV) privilege to work as a proxy, which means on behalf of another user.

1. Click your user image or name in the **global header**.
2. Click **Switch To** and select the user you want to work on behalf of.
3. Enter your password.
4. Click **Confirm**. You’re ready to work as a proxy.

As a proxy, you can access all the data and tasks of the actual user. All the tasks you do are logged as though the actual user worked on them. After you’re done working as that user, switch to another assigned account, or sign out and sign back in to your own account.

### FAQs for Resources
How can I search and view resource information from other sources?

You can search for resources and view their public profiles using the Resource Directory. You can search for resources either by name or organization, or by the names of the teams to which they belong.

You can use the Resource Directory to view the following details of a resource's profile:

- Key profile information, including the resource's name, manager's name, job title, contact information, and so on.
- Organization membership information
- Roles of the resource
- Key skills of the resource
- Additional contact information
- Salesperson details, if applicable.

You can search for organizations or teams, instead of searching for users. Then, you can view the list of resources that belong to an organization or team, and view the profiles of any resource listed.

Can I add resources outside my reporting hierarchy to my social network?

Yes. You can use the Resource Directory to view the public profile of all active resources within the your company and to add them to your social network.

You can add a resource to your social network using the Contextual Action interface. Search for the resource with whom you want to make a connection, view the resource’s detailed profile, and then add the resource as a connection. Once the resource accepts your connection request, the resource becomes a part of your social network.

Why am I unable to view the resource hierarchy for my organization?

You must enable the reporting structure of your organization for a resource or reporting hierarchy to be visible. If there is no manager defined for an organization, the reporting hierarchy of the organization can’t be constructed. Verify if your organization is assigned a manager in Resource Management.

Can I view a resource organization hierarchy version as of a particular date?

Yes. Unless otherwise specified, organization hierarchies are active since the date of their creation. Navigate to the View Organization Hierarchies page from the Resource Directory to view the hierarchy of a resource organization at a specific date. You can search and select the organization hierarchy to view its details. This displays the concerned organization’s active hierarchy. A drop-down list displays the date from which the current organization hierarchy has
been active. You can select the required date from the drop-down list to view the organization hierarchy for a particular date.
Two Ways to Search Your Sales Application

There are two different ways of searching your sales application:

- You can use the global search located at the top of the application page to search across objects in the application.

  ![Global Search](image)

- You can open the work area of the object you're looking for and search for it there by name or using multiple search criteria.

  Here's a screenshot of the search available in the Opportunities work area landing page.

  ![Opportunities Search](image)

Global Search

Enter your search term in the global search box located at the top of each page to find all the records related to that search term. For example, entering the name of a contact as a search term retrieves not only the information about the contact herself, but also all of the opportunities, leads, and activities that mention that contact.

Global search makes it possible to search all the key fields in the following objects. Your application administrator determines which of these objects are available for search in your implementation.

- Accounts
- Activities
- Campaigns
- Contacts
- Forecasts
- Households
- Leads
- Opportunities
• Partners
• Service Requests

Not all objects or fields are searchable. Global search doesn't permit searches of child objects, or through notes or presentations you have uploaded, for example. Attachment searches are restricted to the attachment file names. Nor can you use global searches to find calculated values, such as the currency value of an opportunity or the due date of an activity. While the application administrator can make your modified objects searchable, you can't search modified child objects. Modified objects have their own work areas. Modified child objects appear as tabs of other objects.

Global search depends on an indexing process to make new records available for search. Your application administrator schedules a separate process to periodically index each application object. The indexing processes are usually scheduled to run once a day in off-peak hours to minimize performance impact. Any new record you create is not available to search by you or by others until the indexing process has run.

**Work Area Search**

Use the search in the different work areas to quickly find a particular object you're looking for in one of three ways:

• By typing the object name in the **Find** field.
  
  As you type, the application matches the search term to the records you opened, created, or updated recently and displays them in the Recent Items window.

• By selecting a list. A list displays records using search criteria you or an administrator saved previously.

• By clicking **Show Advanced Search** (the filter icon) and entering your search criteria in the Advanced Search panel.

Here's a screenshot of the Opportunity work area search.

<table>
<thead>
<tr>
<th>Callout</th>
<th>Search Element</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Find</td>
</tr>
<tr>
<td>2</td>
<td>List selection</td>
</tr>
<tr>
<td>3</td>
<td>Advanced search icon</td>
</tr>
</tbody>
</table>

![Opportunities](image)
Advanced Search in Work Areas

When you click the **Show Advanced Search** icon (filter icon) in the work area landing pad, the application displays the Advanced Search panel showing the search criteria for the list displayed on the page. You can modify the existing search criteria for the list, add additional search terms, or select a different list (saved search) as the basis of your search.

*Note:* The Advanced Search panel uses the term **Saved Search** instead of **List**.
Here’s a screenshot of the Advanced Search panel in the Opportunities work area landing pad. It shows the search criteria for the My Open Opportunities list. The search criteria are: the Record Set equals Records I own; Status equals Won; Close Period equals Current Fiscal Quarter; and the Close date falls between 7/1/15 and 9/30/15.

**Opportunities**

Clicking **Search** initiates the search. Clicking **Save** saves your changes to the saved search or creates new list, as described in related topics.

How to Find the Most Recent Records Created in the Application

Searches depend on two indexing processes that are set up by the application administrator to run periodically, one for the work area searches and another for the global search. Work area searches are indexed every five minutes, so use this type of search for finding the most up-to-date information. Use the work area search to find the latest information
about a customer appointment, for example. Oracle recommends global searches be indexed once every day, so use global searches for finding information across different objects.

Even though new records you create are unavailable for search until they indexed by each search, they are always available for you from the Recent Items list. As you enter a search term in either the global and work area searches, the application automatically displays a list of records you personally created, edited, or opened in the last 30 days (or another interval configured by the administrator). Each search maintains its own list of Recent Items. When you use the global search, you do not see the recent items from the work areas.

How to Use Search

Use Global Search for Broad Searches Across Sales Objects

Here are some tips on using global search.

Select from the List of Recent Items

Start typing any one of the words in the search term. Capitalization doesn't matter. As you type, the application matches your entry to your recent searches and any records you accessed and displays them in a list under the Recent Items heading. If you see what you're looking for, just select it from the list.

The following figure shows a screen capture of the global search box as you type the letters gr in a demonstration environment. The matching object, the opportunity Eagle Green Server for the Eagle Green Server account, based in Board Camp, US. is listed under the Recent Items heading. The Recent Searches heading lists recent searches and filters.

Search Complete Words

If you don't find what you're looking for among the Recent Items, you can do the following:

1. Finish typing the complete search term.
2. To speed up your search, you can narrow the list of objects searched, by clicking **Personalize** (the gears icon) and selecting the objects you want to search.

The following figure shows a screen capture of the global search highlighting the location of the Personalize icon.

3. Click **Search** (the magnifying glass icon).

The application displays a list of records that contain your search term. If there’s a search term with similar spelling, then the application displays the term above your results.

Refine Your Search Using Filters

Click **Show Filters** to display the filters available for refining your search. You can filter by object or date by clicking the **All** link.

Here’s a screenshot of the Global Search page with the Filters panel open. Clicking the **All** link for the **Last Updated Date**, for example, enables you to select the range of dates for your search. Callout 1 highlights the location of the **All**
link. Callout 2 shows the location of the Hide Filters button. When the Filters page is open, the Show Filters button becomes the Hide Filters button.

Search Partial Words and Exact Phrases

You can use quotation marks around your search terms to search for exact phrases. You can also search for partial words.

- Put an asterisk (*) after two or more letters, and you get all the names with words that start with those letters.

  For example, searching on `pi*n*`, returns Pinnacle Technologies and All Pines Furniture.
• Put the asterisk in the middle of the word to indicate any number of letters. For example pi*acle, returns both Pinnacle and Pinacle.

Note:
• You can't use the asterisk at the beginning of a search term in global searches.
• Using the asterisk can slow your searches, so enter a whole word if you know it.

Search Within Work Areas for Fastest Results
Use the different work areas to quickly search for accounts, opportunities, leads, and other objects:
• Start typing the record name and select the item from the list of recent items.
• Search for names using complete words or phrases.
• Search for partial words using the percentage sign (%) to stand for missing characters or words.
• Select a list, click the Show Advanced Search (the filter icon), and modify the search criteria.
• Search for the account itself first to find activities, leads and other objects related to an account.

Start Typing the Name and Review the List of Most Recent Items
You can get to your most recent items, even before you finish typing their name:
1. Open the work area.
2. Click in the Find field.
3. Start typing any one of the words in the name.

Capitalization doesn't matter.
As you type, the application matches your entry to the records you opened, created, or updated recently and displays them in the Recent Items window. If you see what you're looking for, just select it.

Here's a screenshot of the Recent Items window in the Opportunities work area. In this example, entering server in the Find search box, displays two recent opportunities: Green Server (Blade) 6000 and Opportunities: Server Upgrade Opportunity.
Search by Name Using Complete Words or Exact Phrases

If you don't find what you're looking for among the Recent Items, finish typing the word and click **Search** (the magnifying glass icon). The application displays a list of records with names that contain your search term, followed by records with related words, just in case you didn't type the word correctly. Say you're searching for accounts using the word *software*. The application first displays the account names that contain that word, such as Compucon Software and Forte Software Inc. That's followed by names with similar spellings, such as Softgear Inc.

**Note:** The application administrator can turn off the display of search results with similar spellings by setting the Include Similar Results in Searches profile option.

Here's a screenshot of the Accounts work area landing page showing a sample search for the word *software*. Callout 1 highlights the location of the two account names that include the exact spelling of the word in the name. Callout 2 shows the location of the account name with a similar spelling.

If you want to find the exact name you're searching for, then put quotation marks around your search terms. For example, **"Forte Software Inc"**, returns just that one record.

**Search for Partial Words in a Name**

You can also search for partial words:

- Put a percent (%) sign after two or more letters, and you get all the names with words that start with those letters.

  For example, searching on **p%**, returns Pinnacle Technologies and All Pines Furniture.
• Put the percent sign at the front of the term, and you get records that end with your term. For example, searching for %ard, returns The Board of Education and Edward Ward and Co.

• Put the percent sign at both ends, and you get all the customer names with words that include those letters.

**Note:** You can use the percent (%) sign at the beginning of your search term only in the **Find** field on the main page of each object.

Using the percent (%) sign can slow your searches, so enter a whole word if you know it.

**Search by Other Criteria Besides the Name**

Use advanced search to search by criteria other than the name:

1. Whatever search criteria you enter are limited by the list you start off with, so start by selecting a list that's a superset of what you are looking for.

   For example, selecting All Opportunities lets you search within all the opportunities you can access. Selecting My Open Opportunities narrows down the scope of your search to just the open opportunities you own.

2. Click **Show Advanced Search** (the filter icon) to display the Advanced Search panel.
The panel displays the search criteria for the list you selected. Here's a screenshot highlighting the Advanced Search panel.

3. Here's how you can modify your search:
   
   - Select a different record set to change the scope of your search. For example, selecting **My territory hierarchy** searches all the records in your territories and their subordinate territories. The available record sets vary from object to object.

   To improve saved search performance, restrict your saved searches to smaller record sets. For example, rather than searching all the records you can see, search all the records in your territory hierarchy. Or
restrict your searches to a smaller geographical area. For example, search all the accounts in one state instead of the whole country.

- Add additional fields to the search by clicking **Add**.
- Select different operators for the fields in your search. Most of the operators, which differ field by field, are self-explanatory. But here are some notes on the more complex:

  - **Between**
    
    Selecting the Between operator for a date field, prompts you to enter a specific date range for the search.

  - **Rolling-time operators**, including **Yesterday**, **Today**, **Tomorrow**, **Last Week**, **This Week**, **Next Week**, **Last Month**, **This Month**, and **Next Month**
    
    Searching for opportunities created this month, for example, returns opportunities created in the current calendar month. The rolling-time filters use the time zone of the signed-in user for the calculation.

  - **Current User**
    
    Including the Current User operator in the Last Updated By and Created By fields displays only the records relevant to you, the signed-in user. For example, when you search for opportunities last updated by the current user, you get a list of opportunities last updated by you.

  - **Is Blank, Is Not Blank, and Does Not Equal**
    
    Selecting the Is Blank operator, makes it possible to search for records missing values in a text field or a field validated by a list of values, for example. Administrators must make these operators available by setting two system profile options. The Enable Additional Search Operators for Text Fields (ZCA_ENABLE_ADDITIONAL_TEXT_OPERATORS) profile option enables the Is Blank and Is Not Blank operators in text field searches. The Enable Additional Search Operators for List of Values (ZCA_ENABLE_ADDITIONAL_LOV_OPERATORS) enables the Is Blank, Is Not Blank, and Does Not Equal operators on fields validated by list of values (both fixed choice and dynamic choice list fields).

- Specify which attributes you want to display in the search results table by selecting **Columns** from the **View** menu.

  You can select specific columns or display all columns.

- Reorder the filter conditions by clicking **Reorder**.

- Delete any fields you added to the search.

  You can't delete the fields provided by Oracle. You can only delete fields you added.

4. **Click Search** to display the results.
5. You can save your modified search as a new saved search (list):

   a. Click **Save**.

   
   ![Create Saved Search window](image)

   b. In the Create Saved Search window, enter a new name for the saved search.
   c. Optionally, you can set this search to be the list that appears whenever you navigate to the work area by selecting the **Set as Default** option.
   d. Click **OK**.

Search for the Account to View Its Opportunities, Contacts, and Other Related Information

Instead of searching for an opportunity or contact in their work areas, you can search for the account instead and then drill down to the opportunity or contact from there. Whatever search method you use, always remember that you may not have permission to access all information in the application. For example, to see an opportunity, you may have to own the sales territory, be on the sales team, or manage someone who is.

There may be a delay of a few minutes between the time you create or update a record and when you and others can search for it. That's because the application must update an index to enable searches. You can access newly-created items from the Recent Items list in the meantime.

What's the difference between the global search and the work area searches in my sales application?

Global search, located at the top of the page, makes it possible for you to search across multiple sales objects. The searches available on the different work area landing pads search for a single object. The following table details the key differences between the two search methods.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Global Search</th>
<th>Work Area Searches</th>
</tr>
</thead>
<tbody>
<tr>
<td>Search Scope</td>
<td>Searches key fields in multiple sales objects.</td>
<td>Makes it possible for you to search for an object by name or by using multiple search criteria.</td>
</tr>
</tbody>
</table>
Oracle CX Sales
Using Sales

Chapter 4
Search

<table>
<thead>
<tr>
<th>Feature</th>
<th>Global Search</th>
<th>Work Area Searches</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Searching on a contact name retrieves not just the contact record, but also related opportunities, leads, activities, and other objects.</td>
<td></td>
</tr>
<tr>
<td>Indexing Frequency</td>
<td>Until a new record is indexed, it is not available for search.</td>
<td>Usually every five minutes.</td>
</tr>
<tr>
<td></td>
<td>Usually once a day.</td>
<td></td>
</tr>
<tr>
<td>List of Recent Items</td>
<td>Displays recent items for all of the objects you enabled in the search.</td>
<td>Displays the recent items relevant the work area.</td>
</tr>
<tr>
<td></td>
<td>Lists records you recently created, edited, or accessed. This includes records that haven't been indexed yet.</td>
<td></td>
</tr>
<tr>
<td>Wild Cards</td>
<td>Use an asterisk (*) at the end or middle of a word to indicate missing letters.</td>
<td>Use a percent sign (%) at the beginning, end or middle of a word to indicate missing letters.</td>
</tr>
<tr>
<td>Saved Searches (Lists)</td>
<td>Saved searches are not available unless specially configured by your application administrator.</td>
<td>You can search using one or more fields by creating saved searches (lists). For example, you can create a saved search to display a list of all active accounts in New York. Application administrators can create saved searches for others in the organization.</td>
</tr>
</tbody>
</table>

Personal Lists

Create Your Personal List in a Work Area

Create your own personal list in any of the work areas where you see lists. That includes opportunities, leads, and accounts. To create your own a list, also known as saved search, just modify one of the existing lists. The detailed steps are a bit different for each business object, but the principles are the same. Here's an example of how to create a list of all accounts in the state of New York. Once you get the idea, you can create a new list in any work area. If you're adding a custom field as part of the search criteria, be sure that the field is indexed for search to improve performance.

The lists you create are available to you only. However, sales administrators can create lists for different sets of users by using the same sets of steps. They just have to use Page Composer in a sandbox and publish the sandbox to make the list available to others.
Tip: To improve saved search performance, restrict your lists to smaller record sets. For example, rather than searching all the records you can see, search all the records in your territory hierarchy. Or restrict your searches to a smaller geographical area. For example, search all the accounts in one state instead of the whole country.

Create the List

1. In the work area landing page, click Show Advanced Search (the filter icon) to the right of the List field.
2. In the Advanced Search panel, from the Saved Search list, select the saved search you want to use as the basis of your new saved search. In this example, you're creating a list of all accounts in New York, so you can use the default My Accounts saved search.
   Tip: To create a saved search entirely from custom fields, select Account Name.
3. In this example, you want to display all of the New York accounts you can access, so select All records I can see from the Record Set list.

The record set specifies the set of records to be searched. To improve search performance, you want to restrict your searches to a smaller record set. In this example, however, you can select All records I can see because you're restricting the number of records searched by adding the state field.
4. Click Add.
5. Select State from the list.
6. Enter NY in the State field.
7. Click Save.
8. In the Create Saved Search window, enter a new name.
9. If you don't want the new search to become the default, deselect the Set as Default option.
10. Make sure the Run Automatically option remains selected. This selection runs the query each time you select the list in the UI.
11. Enter a new name, for example, NY Accounts.
12. Click OK.

The work area landing pad and the Advanced Search Panel display the new search and the search results.

Delete or Hide a Personal List

You can delete any of the work area lists you created. While you can't delete any of the lists provided by Oracle or by your application administrator, you can hide them from view. If you hide a list, you're affecting your own UI only.

Delete a List You Created

1. In the work area landing page, click Show Advanced Search (the filter icon).

   The application displays the Advanced Search panel on the left side of the page.
2. Select Personalize from the Saved Search list.
3. In the Personalize Saved Searches window, click Delete.
4. Confirm your deletion by clicking Yes on the warning.

Hide a List from View

1. In the work area landing page, click Show Advanced Search (the filter icon).

   The application displays the Advanced Search panel on the left side of the page.
2. Select Personalize from the Saved Search list.
3. In the Personalize Saved Searches window, select the saved search you want to hide and deselect the Show in Search List option.
4. Click OK.

The list is now hidden. You can restore the list in the future by selecting the Show in Search List option.

How can I create saved searches with just one custom field?

You can create a saved search using a single custom field by editing one of the two single-field saved searches provided by Oracle: Name and Close Date. For opportunities and leads, use the Close Date list. For all other objects, including accounts, use the Name list, for example, the Account Name list or the Contact Name list. You can only create a new search by editing an existing saved search and you can't delete any of the existing fields. However, you can leave the value of some fields blank, effectively enabling you to search using one custom field. For best search performance, you must index the custom fields used in the search.

Here's an example of how to create a saved search for a particular value of an account custom field:

1. On the Accounts work area landing page, click Show Advanced Search (the filter icon).
2. In the Advanced Search panel on the left side of the page, select Account Name from the Saved Search list.
3. Click Add and select the custom field.
4. Enter a value in the custom field.
5. Click Save.
6. In the Create Saved Search window, enter a new name for your search.
7. If you want the new search to become the default, select the Set as Default option.
8. Make sure the Run Automatically option remains selected. Selecting this option runs the query each time you select the list in the UI.
9. Click OK.
5 Infolets

Quick Way to Get Key Sales Information and Take Action

Watch video

The Sales Infolet page displays key sales information in containers called infolets. Some infolets provide you with an overview, but others make it possible for you to take direct action. These actionable infolets summarize key sales data and let you take immediate action on the tasks presented. The actionable infolets contain key metrics modified for sales roles in your organization. To get to the Sales Infolets page, you click the page controls (dots at the center of the welcome page). You can take action in the infolet by making a selection from a menu without having to drill down into a record.

Take advantage of the following sales-oriented infolets:

- **My Tasks**
  
  Quickly view and work on your most urgent tasks with minimum additional navigation.

- **My Appointments**
  
  Directly review, add, update, and add notes to your appointments. You can also access your calendar to create appointments.

- **My Accounts**
  
  View and manage account information from a single place. You can drill down to edit an account record as well as create accounts, filter your accounts and perform other quick actions.

- **My Opportunities**
  
  View, update, and add a note for your individual opportunities. You can drill down to edit an opportunity record as well as create opportunities, tasks, and appointments.

- **My Leads**
  
  View newly assigned leads, accept or reject individual lead records without having to drill down to the leads landing page. You can also create a lead and drill down to edit individual leads.
This image highlights the main areas of the key sales infolets.

<table>
<thead>
<tr>
<th>Callout Number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Navigate to sales infolets by clicking the page controls on the home page.</td>
</tr>
<tr>
<td>2</td>
<td>Filter the information you see. You can select one of these available filters to narrow the search for the records that meet your filter criteria.</td>
</tr>
<tr>
<td>3</td>
<td>Click the Actions drop-down list to personalize your infolets, refresh the data, and create new records.</td>
</tr>
<tr>
<td>4</td>
<td>Click this Quick Actions icon to take actions on each record or drill down.</td>
</tr>
<tr>
<td>5</td>
<td>Click this icon at the bottom right of the summary chart of the infolet to expand or collapse the infolet.</td>
</tr>
<tr>
<td>6</td>
<td>Click the infolet repository (gears) icon. Then select the check box next to the actionable infolets you want to display.</td>
</tr>
</tbody>
</table>

Use filters to find the records that need your attention. For example, you can filter your leads to see unaccepted leads only. Then use quick actions to accept a lead without leaving the infolet.

You can personalize your actionable infolets, refresh data, create and edit data as required. If you have the required privileges, built in configuration features help you effectively plan your day thus saving valuable time. For example, you can choose to select or hide predefined filters that you want to make available on the actionable infolets.
Infolet Filters and Actions

With a few clicks, navigate to the relevant areas in your sales process where you can use filters to view the records that you want and take immediate actions. For example, with just a single click of a button, you can complete or defer tasks without having to drill down to view the record, or you can accept or reject new leads without having to navigate to the Leads UI.

Use the Configure menu item to add or modify filters and actions. You can also refresh your record data, edit the title of your infolet, move, hide, or show specific infolets on your infolet page.

Here are the predefined filters and actions available to you from your actionable infolets:

<table>
<thead>
<tr>
<th>Actionable Infolet</th>
<th>Select one of these filters...</th>
<th>Select one of these record quick actions...</th>
<th>Select one of these infolet actions...</th>
</tr>
</thead>
<tbody>
<tr>
<td>My Tasks</td>
<td>• Today's Task (default)</td>
<td>• Mark as Complete</td>
<td>• Refresh</td>
</tr>
<tr>
<td></td>
<td>• Overdue Tasks</td>
<td>• Defer by 1 Day</td>
<td>• Create Task</td>
</tr>
<tr>
<td></td>
<td>• Tomorrow's Task</td>
<td>• Defer by 2 Days</td>
<td>• Configure</td>
</tr>
<tr>
<td></td>
<td>• Beyond Tomorrow's Tasks</td>
<td>• Defer by 1 Week</td>
<td>• Edit Title and Views</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Create Note</td>
<td>• Hide</td>
</tr>
<tr>
<td>My Appointments</td>
<td>• Today's Appointments</td>
<td>• Create Note</td>
<td>• Refresh</td>
</tr>
<tr>
<td></td>
<td>(default)</td>
<td>• Create Call Report</td>
<td>• My Calendar</td>
</tr>
<tr>
<td></td>
<td>• Tomorrow's Appointment</td>
<td></td>
<td>• Configure</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Edit Title and Views</td>
</tr>
<tr>
<td>My Accounts</td>
<td>• My Accounts (default)</td>
<td>• Create Lead</td>
<td>• Refresh</td>
</tr>
<tr>
<td></td>
<td>• My Favorite Accounts</td>
<td>• Create Opportunity</td>
<td>• Create Account</td>
</tr>
<tr>
<td></td>
<td>• My Team Accounts</td>
<td>• Create Appointment</td>
<td>• Configure</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Create Task</td>
<td>• Edit Title and Views</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Create Note</td>
<td>• Hide</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Create Call Report</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Log a Call</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Create Service Request</td>
<td></td>
</tr>
<tr>
<td>My Opportunities</td>
<td>• Closing in Next 7 Days</td>
<td>• Create Appointment</td>
<td>• Refresh</td>
</tr>
<tr>
<td></td>
<td>(default)</td>
<td>• Create Task</td>
<td>• Create Opportunity</td>
</tr>
<tr>
<td></td>
<td>• Closing This Month</td>
<td>• Create Note</td>
<td>• Configure</td>
</tr>
<tr>
<td></td>
<td>• Closing This Quarter</td>
<td></td>
<td>• Edit Title and Views</td>
</tr>
<tr>
<td></td>
<td>• Closing Next Quarter</td>
<td></td>
<td>• Hide</td>
</tr>
<tr>
<td></td>
<td>• Open opportunities</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>where I am on the team</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• My Open Opportunities</td>
<td></td>
<td></td>
</tr>
<tr>
<td>My Leads</td>
<td>• Unaccepted Leads</td>
<td>• Accept</td>
<td>• Refresh</td>
</tr>
<tr>
<td></td>
<td>(default)</td>
<td>• Reject</td>
<td>• Create Lead</td>
</tr>
<tr>
<td></td>
<td>• My Open Leads</td>
<td></td>
<td>• Configure</td>
</tr>
<tr>
<td></td>
<td>• Recent Open Leads</td>
<td></td>
<td>• Edit Title and Views</td>
</tr>
<tr>
<td></td>
<td>• Open Leads where I am</td>
<td></td>
<td>• Hide</td>
</tr>
<tr>
<td></td>
<td>on the team</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Personalize Your Key Infolets

You can personalize actionable infolets from the Actions menu. For example, you can edit infolet titles and views, move, hide, or show specific infolets and refresh the data displayed. If enabled by the administrator, you can personalize the layout, record count, filters, and actions at the record level for each of your infolets.

Configure Layout of Actionable Infolets

Once enabled, the Configure menu item from the Actions menu becomes available so that you can personalize the actionable infolets to suit your requirements. For example, you might want to change the layout and size of columns, as well as the locations of the fields being displayed. You might want to use your own saved searches as view filters or hide some of the quick actions that might not be relevant to you.

Here's how to modify the layout of the My Opportunities actionable infolet:

1. Navigate to the actionable infolet that you want to modify.
2. Go to My Opportunities, and select Configure from the Actions menu.
   The My Opportunities actionable infolet screen is displayed with the predefined fields selected.
3. From the Layout tab, select the attributes that you want to edit from the respective drop-down lists.
4. Set and adjust the two column table widths in percentage terms by sliding your mouse along the Column Width ruler.
5. Make the changes that you want to the attribute and select another attribute to edit, if required.
6. In the Drill Down Field, select the item that you want to use for drilling down to the detail page of an opportunity.

<table>
<thead>
<tr>
<th>Actionable Infolet</th>
<th>Drill Down Field</th>
<th>Attribute</th>
</tr>
</thead>
<tbody>
<tr>
<td>My Opportunities</td>
<td>Name</td>
<td>Amount</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Close Date</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Stage</td>
</tr>
<tr>
<td>My Leads</td>
<td>Lead Name</td>
<td>Rank</td>
</tr>
<tr>
<td>My Accounts</td>
<td>Name</td>
<td>Primary Contact</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Primary Address</td>
</tr>
</tbody>
</table>
7. Click **Save and Close** when you have finished making the changes.

### Change the Record Count Display for Actionable Infolets

You can also change the predefined number of records to display on the infolet. By default, 10 records display. You can change the default to 10, 20, 25, or 30, as required.

Here’s how to modify record counts for an actionable infolet:

1. From the actionable infolet that you want to modify, for example, My Opportunities, select **Configure** from the **Actions** menu.

   The My Opportunities actionable infolet screen is displayed.

2. From the **Record Count** tab, select the number of records that you want to display on the infolet from the drop-down list.

3. Click **Save and Close**.

### Modify Filters

Filtering reduces the number of searches required to view any outstanding items that might require attention. For example, you can choose to select or hide predefined filters that you want to make available on the actionable infolets.

Predefined saved searches are available for selection. However, any custom saved searches that you create must include Record Set values selected for either any records that you own or for records where you’re on the team. In addition, when saving your saved search, you must select the Run Automatically check box to run the search automatically when your saved search is loaded. Otherwise, the custom saved search won’t display in the available filters list in the Configure UI for your actionable infolet.

You can show or hide filters, rearrange filters, and add custom filters. You can multiselect and double-click filters in the Available list to move them to the Selected list. However, you must select at least one filter for the actionable infolet filter list.

This table lists filters that you can modify.

<table>
<thead>
<tr>
<th>Actionable Infolet</th>
<th>Filter</th>
</tr>
</thead>
<tbody>
<tr>
<td>My Tasks</td>
<td>• Today's Tasks</td>
</tr>
<tr>
<td></td>
<td>• Tomorrow's Tasks</td>
</tr>
<tr>
<td></td>
<td>• Overdue Tasks</td>
</tr>
<tr>
<td></td>
<td>• Beyond Tomorrow's Tasks</td>
</tr>
<tr>
<td></td>
<td>• All Tasks</td>
</tr>
</tbody>
</table>
Here's how to modify the filters of an actionable infolet:

1. Navigate to the actionable infolet that you want to modify.
2. From the actionable infolet that you want to modify, for example, My Opportunities, select **Configure** from the **Actions** menu.

   The My Opportunities actionable infolet screen is displayed with the predefined fields selected.

3. From the **Filters** tab, select the filters that you want to modify
4. Click **Save and Close** when you have finished making the changes.

### Modify Quick Actions

You can navigate to the relevant areas in your sales process where you can perform quick actions at the record level. For example, you can easily complete or defer tasks without having to drill down to view the record, or you can accept or reject new leads at the click of a button.

You can show or hide actions, rearrange actions, and add custom quick actions. For example, you can multiselect and double-click actions in the Selected list to move them to the Available list if you want to hide a quick action. However, you must select at least one action for the actionable infolet quick actions list.

Here are the selected quick actions that you can modify in the order as they appear on the UI.

<table>
<thead>
<tr>
<th>Actionable Infolet</th>
<th>Quick Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>My Tasks</td>
<td>• Mark as Complete</td>
</tr>
<tr>
<td></td>
<td>• Defer by 1 Day</td>
</tr>
<tr>
<td></td>
<td>• Defer by 2 Days</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Actionable Infolet</th>
<th>Filter</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Open Tasks</td>
</tr>
<tr>
<td></td>
<td>• High Priority Open Tasks</td>
</tr>
<tr>
<td>My Appointments</td>
<td>• Today's Appointments</td>
</tr>
<tr>
<td></td>
<td>• Tomorrow's Appointments</td>
</tr>
<tr>
<td>My Accounts</td>
<td>• My Accounts</td>
</tr>
<tr>
<td></td>
<td>• My Favorite Accounts</td>
</tr>
<tr>
<td></td>
<td>• My Team Accounts</td>
</tr>
<tr>
<td>My Opportunities</td>
<td>• Closing in Next 7 Days</td>
</tr>
<tr>
<td></td>
<td>• Closing This Month</td>
</tr>
<tr>
<td></td>
<td>• Closing This Quarter</td>
</tr>
<tr>
<td></td>
<td>• Closing Next Quarter</td>
</tr>
<tr>
<td></td>
<td>• Open opportunities where I am on the team</td>
</tr>
<tr>
<td></td>
<td>• My Open Opportunities</td>
</tr>
<tr>
<td>My Leads</td>
<td>• Unaccepted Leads</td>
</tr>
<tr>
<td></td>
<td>• My Open Leads</td>
</tr>
<tr>
<td></td>
<td>• Recent Open Leads</td>
</tr>
<tr>
<td></td>
<td>• Open Leads where I am on the team</td>
</tr>
</tbody>
</table>
Here’s how to modify the quick actions of an actionable infolet:

1. Navigate to the actionable infolet that you want to modify and make sure that the infolet displays in expanded view.
2. From the actionable infolet that you want to modify, for example, My Opportunities, select **Configure** from the **Actions** menu.

   The My Opportunities actionable infolet screen is displayed with the predefined fields selected.
3. From the **Quick Actions** tab, select the actions that you want to modify.
4. Click **Save and Close** when you have finished making the changes.

### Edit Actionable Infolet Titles and Views

Here’s how to edit titles and views for actionable infolets:

1. Click the **Actions** icon on the top right corner of the actionable infolet, and select **Edit Title and Views**.
2. Edit the infolet title, and enable or disable the infolet views.

   The **Enable** option is automatically set to Yes. You can’t disable a view of an infolet.
3. Click **Save and Close**.

### Move Actionable Infolets

To change the position of an actionable infolet within an Infolet page, click and drag the infolet, and drop it at the required position.
Hide or Show Actionable Infolets

To hide an actionable infolet from an infolet page, click the infolet repository icon, and deselect the actionable infolet from the list of infolets. Alternatively, click the Actions icon on the top right corner of the actionable infolet, and select Hide. To show a hidden infolet on an infolet page, click the infolet repository icon, and select the infolet from the list of infolets.

Related Topics

• Modify Actionable Infolets

What happens if I delete an actionable infolet?

If you delete an actionable infolet by accident, then it’s no longer available to you. You must contact your help desk to retrieve the data and recover the actionable infolet.
6 Activities and Calendars

Overview of Activities

As a sales representative, you typically check your calendar for appointments that you have on any particular day before you begin your retail visit. You can plan your day based on the appointments and the notes if any that you have or want to include in your appointment.

Here’s what you can do when you work with appointments:

• Add resources to an appointment.
• Use appointments to check your schedule and the visits that you need to make.
• Review the details of the visits for an account and plan your tasks for the day.
• Add an account to an appointment and the appointment is assigned to a field sales representative who is the owner of that account and appears on the assignee’s calendar.
• Create notes for any additional information that you may need to record regarding your retail visit.

The activities pages include the My Calendar, My Tasks, and Activities pages. You use these pages to manage tasks, appointments, and call reports outside the context of a particular record. Within an activity, you can associate the activity itself with a record, such as a lead or opportunity. Additionally, in some of the sales applications, you can manage activities within the records themselves.

In the Activities pages, you can:

• Create new tasks and appointments.
• Search for and view tasks and appointments.
• Edit existing tasks and appointments.
• View reports and analytics information.
• Manage your calendar.
• View other sales users’ calendars, as well as team calendars, with permission.
• View at-a-glance which tasks are overdue.

Get Started with Activities and Calendars

Activities

Watch video

Activities help you keep track of things you plan to do, like tasks and appointments, or things that you need to track, like customer calls.
Types of Activities

There are three types of activities:

- Tasks are to-do items assigned to people or groups. Tasks are also used to record completed customer interactions that aren’t scheduled in your calendar as appointments.
- Appointments are calendar events, for example, a meeting with another person or a scheduled phone call.
- Call reports are created to record a brief summary of a call. They can be created from an appointment, a task, or standalone from the Activities list page. When created from a task or appointment, the application automatically populates all pertinent data into the call report.

Collectively called “activities”, tasks and appointments can be meetings, calls, demonstrations, events, and so on. The difference between a task and an appointment is that a task appears in a task list and has a due date and status, while an appointment is scheduled on your calendar with a specific date and time. For all activities, the Type field lets you categorize the item. For example, when you create a task you can set the type as a Call or a Meeting.

Access List of Activities

Use the Activities landing page to access your activities. Use the search utility to find both tasks and appointments in the same search.

In the Activities landing page, information appears in columns only when applicable. For example, some fields apply only to tasks and some only to appointments; thus, blank fields appear when there is nothing relevant to display. Appointment and task icons make it easy to differentiate between the different types of activities.

To access the Activities landing page:

1. Sign in to a sales application as a salesperson.
2. On the home page, click Sales > Activities.
   The My Calendar page appears.
3. Click the Activities tab.
   The Activities landing page appears.

Create New Tasks and Appointments

You can create new tasks and appointments in several ways:

- In the My Calendar page, click Create Appointment to create a new appointment.
- In the My Tasks page, click Create Task to create a new task.
- In the Activities page, click Create Task or Create Appointment.
- Create follow-up tasks or appointments from existing ones: In the Actions menu for the existing task or appointment, select Create Follow-Up Task or Create Follow-Up Appointment.
- Create tasks or appointments related to opportunities or leads: Navigate to a lead or opportunity and click the Activities tab. Tasks or appointments you create automatically are associated with the related record.

Manage Your Calendar

Use the Calendar pages to keep track of all your appointments. You can:

- View your appointments in a daily, weekly, or monthly format, and either in a calendar view or as a list.
- Move appointments from one time and day to another day or time.
• Create new appointments, including recurring appointments.
• View and edit existing appointments.
• View your colleagues’ appointments, if you have permission.
• Access additional calendars. Additional calendars, if enabled, are available after you click the Manage My Calendar icon.

Manage Your Tasks
The Tasks landing page displays your tasks that include a due date, allowing you to see at-a-glance which ones are due on which dates. Icons help you spot overdue tasks quickly. You can use the My Tasks list to sort tasks by due date, subject, or priority.

Create Your Own Lists for Activities

You can create your own list of activities. For creating your own lists you must set your search criteria and save the list. You can view your list in the List field.

Here’s how you can create your own lists:

1. Sign in as a sales representative.
2. On the home page, click Sales > Activities.
   The My Calendar page appears.
3. Click the Activities subtab.
   The Activities landing page appears.
4. Click the Show Advanced Search icon.
   The Advanced Search pane appears.
5. In the Advanced Search pane, select I Own in the Record Set field.
6. Click Save.
   The Create Saved Search dialog box appears.
7. Name the list.
8. Click the Run Automatically check box, and click OK.
9. View the list in the Saved Search field.

Use the Show Filter in Activities
Use the Show filter in activities when you want to:
• Create saved searches for activities.
• Search for activities in associated objects, such as opportunities or accounts.

When the Show filter is set to All or Completed, the sort order displays your future activities first, followed by the historic activities. To view future activities:

1. Sign in to the application as a sales representative.
2. Navigate to Sales > Activities.
   The My Calendar page appears.
3. Click the Activities subtab.
   The Activities landing page appears.
4. Click the Show Advanced Search icon.
   The Advanced Search pane appears.
5. In the Advanced Search pane, select My Open Activities from the Saved Search drop-down list.
6. Select Complete or All from the Show field.
   A list of all the future appointments and open tasks appears.

Call Reports

A call report is a central place for salespeople to capture what happened in a sales activity, make related changes, and track key updates. Call reports can boost salespeople's productivity by saving time, increasing visibility into their business, and selling more in less time.

A call report is a type of activity like tasks and appointments. You can create call reports for scheduled appointments or ad hoc call reports from the Activities tab. Each scheduled appointment can have multiple call reports, created by different salespeople. The call reports for an appointment are listed in and viewed from that appointment. Salespeople can also create ad hoc call reports to report sales activities that aren't scheduled on their calendar.

Note: The administrator must use Application Composer to enable the Create Call Reports button on the Activities tab, the Activities list, and the Tasks tab.

Call reports record a snapshot of the outcome of the sales activity and key changes, including:

- Outcome summary, meeting minutes, complete objectives, attendees, attachments, notes, and so forth.
- Related objects, such as appointments, accounts, opportunities, and leads

Appointment resources and others who have access to an appointment can create a call report from it. Multiple call reports can be created from one appointment.

Add and Remove Objectives

Appointment objectives are copied over to the call report by default. You can add additional objectives, or remove existing ones.

To add objectives, you can either select them from a predefined list or type free text to add new ones. Predefined objectives include:

- Demo product
- Determine next steps
- Discuss proposal
- Identify stakeholders
- Review RFP or RFI (Review Request for Proposal or Request for Information)

You can check an objective in a call report to mark it as complete, or deselect it to mark it incomplete. Objectives copied over from the appointment or added by user are deselected by default.
Appointment Contacts and Resources
Appointment contacts and resources are copied to the call report. You can add or remove contacts and resources. You can also check or deselect a contact or resource’s attendance status to indicate whether he or she attended the meeting.

- Contacts that are defaulted from the appointment are marked as attendees by default.
- Resources that are defaulted from the appointment are marked as attendees by default if the resource’s response in the appointment isn't Declined.
- Resources and contacts that aren't defaulted from the appointment and added by the user are marked as attendees by default.

Appointment Outcome
You can select an appointment outcome from a list of predefined values. Your sales administrator can add or remove values from this list as needed. Default values are:

- Call answered
- Call transferred
- Captured issue
- Failed
- Left message
- Not available
- Provided information
- Successful
- Incomplete
- At risk
- Customer undecided

Attachments and Notes
You can add attachments to a call report in the same way that you add them to other objects.

Anyone who has access to the call report can create notes on it. Call reports support both internal and external notes. You can use external notes to share with external contacts.

Any user who can view the call report can see non-private notes, but only the note creator can see private notes.

Call Report Security
Call reports include a Private setting, which determines who can view it:

- If the call report is set to Private, then only the call report resources can view it.
- If the call report isn't set to private, then anyone who can view the related appointment can view the call report.

Call Reports and Oracle Social Network
You can share a call report on the call report Oracle Social Network wall. In Manage Oracle Social Network Objects setup, you can enable Activity on Oracle Social Network and configure the attributes that can be shared on Oracle Social Network.
Overview of Creating Lists

You can refine your list of activities by creating lists from Activities using Saved Search in the Advanced Search pane. For example, you can create a list of all completed tasks you own. A date range is required when using the Saved Search (list) pane. The available Show filters are Open, All, Completed.

<table>
<thead>
<tr>
<th>Show Filter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open</td>
<td>Displays all appointments that have a start date of today or in the future within defined date range, all open tasks with a due date in the defined date range, and open tasks with no due date.</td>
</tr>
<tr>
<td>All</td>
<td>Displays all appointments within the defined date range, open tasks with no due date or with a due date within the defined date range, and closed tasks with an end date in the defined date range.</td>
</tr>
<tr>
<td>Completed</td>
<td>Displays appointments in the past with a start date that falls within the defined date range, and tasks having been completed within the defined date range.</td>
</tr>
</tbody>
</table>

Create Tasks from a Task Template

You can create tasks for a business object from a task template. First select a set of tasks for a template task and then create tasks. In this topic, the opportunity business object is used as an example. However, the procedure to create task templates is the same for all objects.

Note: Tasks can be autogenerated from a task template and displayed in the Activities subtab. For example, a task template is associated with a sales stage. On updating the sales stage, the autogenerated tasks appear in the opportunity Activities tab.

Here's how you create tasks from a task template:

1. From the Navigator, click Opportunities.
2. Select the opportunity for which you want to create a task.
   The Edit Opportunity page opens.
3. Click the Activities subtab.
4. Click Create Tasks from a Template.

   Note: If the administrator hasn't set up task templates, a warning appears.

5. Select the template name from the available task templates.
6. (Optional) Enter the name of the owner of the task. If the field is blank, the signed-in user is set as default as the owner of the task.
7. Click Save and Close, on the Create Tasks from a Template page.
The tasks are created from the template.

Select Addresses for Activities

If the administrator has exposed the address selector on the Activity UI, you can associate an address with an activity's account or contact. The association enables sales managers to audit and relate call report contact or account location with sales. Managers can also audit trail the customer visits of a sales person. On a call report the address selector helps to automatically populate the address of the account or contact.

Remember the following rules:

- You can change the selected address as needed, except after a call report is submitted.
- The addresses are available for accounts, if both accounts and contacts are defined for the activity.
- If only contacts are defined for an activity, but not an account, then the address shown is related to the primary contact.

An address selector can be enabled for call reports, appointments, and tasks. Using the address selector on a call report is used as an example in the following procedure. To select an address:

1. Open an appointment or a task to access a call report.
2. Click Create Call Report or open an existing Call Report.
3. Select an account.
4. Select an address related to the account from the Addresses section.
5. Click Save and Close.

For more information, see Exposing the Address Selector on Activity Pages, in the Implementing Sales guide.

Activity Notification

Activities generate notifications when you perform various tasks or make certain updates. Let's take a look at how the notification process works.

Notification Events

Notifications are sent by email or on a global notification list (also called a bell notification list). You can choose whether to receive email, a notification in the notification list, or both. Notifications are triggered when a change is saved. Notifications can be sent when an appointment or task is created, updated, or deleted. You can also send notifications as a reminder for appointments.

Note: For updates, notifications are triggered on any update except the settings and values specific to each individual user:

- Show Time As
- Reminder
- Response

Notification messages are displayed only on the bell notification list. The messages aren't displayed in the Worklist for notifications and approvals.
Notifications to Drill Down to Transactions

You can opt in to use the capability to drill down and act from activity notifications and receive notifications through notification lists and email. If you opt in to receive notifications, then list and email notifications are generated when you create or update appointments and tasks. Each notification includes a link that you can drill down on to view the record details before you approve or reject the request. You can accept or decline appointments and complete tasks from notifications. You can decide whether to use the enhanced notifications with drill-down capability or continue to use the earlier option with no drill-down capabilities.

To receive notifications, you must set a preference in your Preferences page. See the section in this topic, Setting the Preference to Receive Notifications, for more information. After you opt in, you receive two types of notifications: Action Required and FYI. In the Pending Notifications window, you can act on each notification by clicking Accept or Decline.

Appointments and tasks have the following set of fields that appear by default in the email notifications:

- Task
- Due Date
- Owner
- Status
- Assigned to

Each appointment notification has the following default fields:

- Subject
- Date
- Location
- Invitees

In addition, all email notifications include the following fields, if they're defined on an activity.

- Account
- Opportunity
- Lead
- Asset
- Description

To drill down into an activity, click the subject or task link in the appointment notification. You can also accept or decline an appointment or complete a task from the email notification.

Set the Preference to Receive Notifications

Here’s how you can receive notifications by email and lists.

1. Sign in as a sales representative.
2. Click Setting and Actions > Set Preferences in the global header.
3. Click Calendar and Appointment Preferences.
   
   The Calendar and Activity page appears.
4. In the Appointments and Task sections, select the **Notify me by** check box.

```
4. In the Appointments and Task sections, select the Notify me by check box.
```

5. Click **Save**.

**Apply Mass Update to Activities**

You can select multiple activity records and update all of them to the same value for a field using the mass update feature. An administrator must enable the update action using Application Composer.

**Update Activities in Bulk**

Here’s how you can apply mass updates to activities:

1. Navigate to the **Activities** landing page.
2. Enter the search criteria for the activities that you want to update, and click **Search**.

   The application returns a list of results based on your search criteria.
3. Select the activities that you want to update at the same time.
4. Click **Update** from the **Actions** menu.

   To select or deselect activities, click a record in the list. Use the select all and deselect all links to select or deselect all activities.

   **Note:** By default, all the attribute fields on the Mass Update dialog box are read-only until you select to update them.

5. Select the attributes that you want to update and assign a value for each of the selected attributes.

   The default values are displayed. The text fields are blank by default.
Note: Some fields that you can update might contain a list of values (also known as a fixed choice list field). In some cases, a list of values field can have a parent. This means that the parent field's selected value controls which values display in the child field at runtime. If this type of parent/child relationship exists and you're updating the value of a child field, note that the value of its parent field must be the same across all records selected for mass update.

6. Click Save and Close.

Calendars

My Calendar

Use the My Calendar page within Activities to manage calendar views.

View Calendars

You can view calendars by day, week, month, or agenda. You can view the status of other deals by selecting a different calendar listed in the side panel. The steps to view a calendar using the side panel are the same for opportunity and account. In the following procedure, account is used as an example.

Weekly View

The default calendar view is the Weekly View. From here, you can see all of the items on your calendar for the week. On the left, each user added to the team calendar is displayed (by default only the signed-in user is displayed, as in single calendar mode). Each day shows:

- Start time of appointment, with recurrence icon (if applicable)
- Whether the appointment is multi-day (indicated by an arrow)
- Appointment subject

You can view and edit the recurrence information in the Add: Recurrence dialog box that appears when you click the Recurrence button. Nonrecurring appointments display the edit page for the appointment.

Note: The appointment time isn't reset when the All Day check box is cleared.

You can only edit your own appointments. Even if your peers have given you permission to view theirs, you can't edit them. Appointments marked by others as Private display as Busy on their calendar entry, and don’t include details.

Day View

On the Day View, you can see all of the items on your calendar for the current day. On the left, each user added to the team calendar is displayed (the default only shows the signed-in user).

Along the top are the hours of each day, where the calendar entries are displayed. Each day shows:

- Start time of appointment, with recurrence icon (if applicable)
- Whether the appointment is multi-day (indicated by an arrow)
• Appointment subject

You can view and edit the recurrence information in the Recurring Appointments dialog box. Nonrecurring appointments display the edit page for the appointment.

You can only edit your own appointments. Even if your peers have given you permission to view theirs, you can't edit them. Others who can edit other users’ appointments include:

• The administrator.
• The user’s manager, if the person is in their resource hierarchy and the manager has the Sales Manager duty role.

Appointments marked by others as Private display as busy on their calendar entry, and don’t include details.

Appointment Colors

The legend at the bottom of the calendar displays the colors associated with different appointment types. If an appointment is of one of these types, the appointment box in the calendar is displayed in that color. You can change these colors using Setup Manager.

Appointments that show a user as busy don’t display any details because you don’t have access to their record.

Add Appointments

To add new appointments to the calendar click Create Appointment. Selecting the check boxes next to the user names in your team calendar automatically adds those users as resources to the new appointment.

Set Up Appointment Visibility

You can let other users access your calendar appointment details by giving them permission to view them.

Permit Appointment Visibility

Use the following procedure to give others permission to view your appointments.

1. In the global header, within the Settings and Actions menu, click your user name and select Set Preferences under Personalization.
2. Select Calendar and Appointment Preferences. The Calendar and Activity page appears.
3. In the Additional Calendar Sharing Levels with Specific Resources section, add a row to the table. Select the individuals that you want to share your appointment details with.
4. Set the Access Level value to Show appointment details.
5. Save your changes.

The users you select can access your calendar appointment details from the Calendar page by selecting your name in the Resource list.

Use Activity Subtype

Managers track your performance through your activities and classify them using the Subtype field. For example, your activity of email has subtypes of outbound, inbound, and so on.
For you to view and select values from the Sub Type field, make sure that your administrator has mapped an activity type to a subtype, and enabled the Sub Type field on the list UIs. As salespeople, you can use the Sub Type field to:

- Select values from the Sub Type field drop-down list, on the Create and Edit pages of an Activity.
- View the selected values in the Sub Type field in all list pages including Activity Embedded pages.
- Search for activities based on Sub Type field in the Advanced Search page and Activity sub tabs using the Sub-Tab Search functionality.
- Update the values using the click to edit functionality on the Activities List page.

Note: Whether you’re an existing customer or a new user, you must create the sub types and map the type to the subtype manually.

Overview of Integrating Assets with Activities

After the administrator enables the functionality, salespeople can associate assets with activities, including appointments, call reports, and tasks.

Associating an asset with an activity and then viewing the asset calendar helps salespeople manage their appointments. Salespeople can view all the related appointments in a single place. After someone in the organization associates an asset with an appointment, then the asset calendar is enabled.

Overview of Asset Calendars

Use your calendar to manage assets. An asset calendar displays the appointments relevant to your assets. Team members view all upcoming appointments related to an asset in the calendar and coordinate their activities for the asset.

You can create an asset calendar for:

- Assets that you can access
- One asset at a time

The asset calendar displays all appointments for the asset and private appointments. The asset calendar identifies the owners of the appointment with a picture or icon with the user initials or name. With the asset calendar you can:

- View all appointments related to an asset in a single calendar view.
- View all the owners of appointments related to an asset.
- Hide or show appointments of individual or multiple appointment owners.
- Save asset calendars to a list and access the calendar that you want.
- Determine the owner of each appointment on the calendar.
- Switch between all calendar views: day, week, month, and agenda.

Add Assets to Activities

If the functionality is enabled by the administrator, you can add assets to all types of activities, including appointments, call reports, and tasks. You can add assets to new and existing activities, using the activity create and edit pages. After you add an asset to an activity, then you can view the asset on that activity’s page.
After an asset is associated with an appointment, you can view the asset calendar from the Manage My Calendar window available on the My Calendar page. For more information, see the related topics.

To add an asset to an appointment:

1. Access the activity page where the Assets list if enabled. For example, click **Create Appointment** in the My Calendar page.
2. Click **Search** in the Asset drop-down list.
   
   The Select: Asset page appears.
3. Click **Search**.
   
   The search results appear.
4. In the search results, select an asset and click **OK**.
   
   The Create Appointment page appears.
5. The asset number and asset serial number of the selected asset, if available, are automatically populated.
6. Click **Save and Continue** in the Create Appointment page.
   
   The asset appears as a link.
7. Click **Save and Close**.

**Create an Asset Calendar View**

An asset calendar displays the appointments relevant to your assets. After an appointment is associated with an asset, you can create an asset calendar view from the My Calendar page. The asset calendar is available to the whole organization as soon as one person across an organization associates an appointment with an asset.

The asset calendar displays:

- All appointments that are associated with an asset.
- All owners of appointments associated with an asset. The appointments can be owned by different people.

Here’s how you can create an asset calendar view:

1. Click the **Manage My Calendar** icon on the My Calendar page.
2. Click **Other Calendars**.
3. Click **Create Asset Calendar View**.
   
   The Create Asset Calendar page appears.

   **Tip:** Remember, an asset calendar can only be enabled after an appointment is associated with an asset.
4. Click **Search** in the Asset field.
   
   The Select: Asset page appears.
5. Search for and select an asset. Alternatively, you can create an asset to use.
6. Click **OK**.
   
   The name of the asset is automatically populated as the calendar name, but you can change it if needed.
7. Save your changes.
You can access the asset calendar from the My Calendar page by clicking Manage My Calendar > Other Calendars. You can filter the calendar to view appointments associated with a particular owner.

**Related Topics**
- Overview of Sales Assets

## FAQs for Activities and Calendars

### What activities does selecting My Open Activities display?

When you select the **My Open Activities** list in the Activities work area, the application displays a list of all of the future appointments and open tasks where you are listed as a resource. You are automatically a resource if you created the activity or you can be assigned as a resource by another resource or an automated process.

### What activity records do the different record sets permit you to search?

The different record sets in the Saved Searches window restrict your saved searches to different sets of activities. To improve saved search performance, restrict your saved searches to smaller record sets. For example, rather than searching all the records you can see, search all the records you and your subordinates own. Or restrict your searches to a smaller geographical area. For example, search all the activities in one state instead of the whole country.

Here’s a list of the record sets for activities. Not all record sets are available to all users. For example, the record set involving subordinates is available only to managers.

<table>
<thead>
<tr>
<th>Record Set Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>I own</td>
<td>Activities you either created or ownership was assigned to you.</td>
</tr>
<tr>
<td>I am a resource</td>
<td>Activities where you’re a resource.</td>
</tr>
<tr>
<td>My subordinates own</td>
<td>Activities owned by you and your subordinates.</td>
</tr>
<tr>
<td>All records I can see</td>
<td>Activities that you can view based on your resource team membership, sales territory assignments, your position in the organization, and security permissions. This record set is available only if the administrator enables it using a profile option.</td>
</tr>
</tbody>
</table>
How does the Show filter refine my activity list?

The Show filter displays activities based on certain criteria. Here’s a list of the show filter criteria for activities:

<table>
<thead>
<tr>
<th>Show Filter</th>
<th>Tasks</th>
<th>Appointments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open</td>
<td>All open tasks with a due date in the defined date range, and open tasks with no due date</td>
<td>All appointments that have a start date of today or in the future within a defined date range</td>
</tr>
<tr>
<td>All</td>
<td>Open tasks with no due date or with a due date within the defined date range. Closed tasks with an end date in the defined date range</td>
<td>Open tasks with no due date or with a due date within the defined date range. Closed tasks with an end date in the defined date range</td>
</tr>
<tr>
<td>Completed</td>
<td>Tasks that are completed within the defined date range</td>
<td>Appointments in the past with a start date that falls within the defined date range</td>
</tr>
</tbody>
</table>

How can I view activities that are set as private?

You can only view activities that are set as private if you’re the owner of the activity, are delegated by other users to view it, or are a resource or contact of the activity.

**Tip:** The Private check box is hidden by default in the tasks pages. Administrators can use Application Composer to display the check box on the Create Appointment page and enable you to set a task as private.

How can I track customer-facing activities?

You can define your own criteria for an interaction using the Activities feature. Customer interactions are logged either as completed tasks or as appointments using the activity types you want to report on. To track your customer-facing interactions, generate a report to retrieve activities of a specific type with accounts or contacts associated. For example, you can list all calls with an associated contact. To track a completed task, go to the Activities page from the Customer, Opportunity, or Lead page, and click Log a Call.

How can I view my appointment in a different time zone?

You can use the time zone drop-down list to view the appointment time in a different time zone. The time zone for users is defined in the Regional area within Set Preferences. If no time zone is defined, the appointment time zone displays as null, and appointments are created based on Universal Time Coordinated (UTC) time. You can’t change the default time zone.

When appointments include attendees from a different region, the appointment time zone drop-down list can be used to define an attendee-friendly time. For example, a user in Chicago selects 9 A.M., and sets the time zone to Cairo, Egypt.
time zone. Upon saving, the appointment displays to the Chicago user as 2 A.M., and the time zone drop-down list has the Chicago value.

What's the difference between a task, an interaction, and an appointment?

A task is a unit of work to be completed by one or more people. Tasks are related to business objects such as opportunities or contacts, and can include attachments.

An appointment is a calendar entry related to a business object such as an opportunity or a customer. Appointments can include attachments.

An interaction provides a historical view of all communications initiated by you to a customer, or by a customer to you. Interactions don't document internal communications.
7 Accounts, Contacts, and Households

Overview of Accounts, Contacts, and Households

You can use the Accounts pages to manage the information related to your sales accounts, including customers, prospective customers, individual contacts, and households.

Use the account data management capabilities to:

- Create and update accounts, prospective accounts, contacts, and households
- Maintain account data and view data in hierarchical fashion
- View household relationships
- Enrich customer data

As your work with the account management application, keep in mind the following terminology:

- **Account**: An account is an organization that a salesperson sells to. Accounts can be prospects or customers.
- **Contact**: A contact is a single person. A contact need not be related to a customer. A person may also be both a customer as well as a contact of another customer.
- **Customer**: A customer is someone with whom you have a selling relationship. The selling relationship can result from the purchase of products and services, or from the negotiation of terms and conditions that provide the basis for future purchases.
- **Household**: A household is a group of contacts with whom you have a selling relationship. Households provide valuable segmentation information about the household as a whole, as well as summary of information about the household member contacts. Usually all the contacts reside at the same address and have a similar set of attributes that accounts do, such as team members, territories, and contacts.
- **B2B and B2C**: Business-to-business and business-to-consumer, or B2B and B2C, are terms that indicate the type of customer relationship:
  - B2B: The customer is a business rather than an individual consumer.
  - B2C: The customer is an individual consumer rather than a business.

Account Management

Overview of Accounts

An account refers to an organization that a salesperson sells to and that can be maintained as a prospect or customer.

Create Accounts

You can create accounts in the following ways:

- Create them in the Accounts page
- Import them using file-based data import
• Use web services to create an account

## Overview of Account Management

Use account management capabilities to search for, create, update, delete, merge, and enrich accounts. Here's a description of the account areas that you use to manage accounts.

<table>
<thead>
<tr>
<th>Account Tabs</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview</td>
<td>Provides a general overview of customer or prospect, opportunities, leads, active contracts, assets and recommendations, and activities.</td>
</tr>
<tr>
<td>Profile</td>
<td>Provides details of the account such as address and contacts. Here you can also:</td>
</tr>
<tr>
<td></td>
<td>• Create and manage account hierarchy</td>
</tr>
<tr>
<td></td>
<td>• Update and verify account address</td>
</tr>
<tr>
<td></td>
<td>• Add <em>industry codes</em> and <em>organization types</em>.</td>
</tr>
<tr>
<td></td>
<td>Use this tab to add the primary contact to the account.</td>
</tr>
<tr>
<td>Team</td>
<td>Shows team members and territories that are part of your account. Here you can also:</td>
</tr>
<tr>
<td></td>
<td>• Add team members</td>
</tr>
<tr>
<td></td>
<td>• Add territories</td>
</tr>
<tr>
<td></td>
<td>You can manually run territory assignment for the account through the Run Assignment process. For example, a sales administrator can manually assign a specific account to verify that expected territories are assigned after territory realignment.</td>
</tr>
<tr>
<td></td>
<td>The assignment action is enabled for the type of account enabled for assignment. If you have enabled assignment for account of type customer, then the assignment object is shown as:</td>
</tr>
<tr>
<td></td>
<td>• Enabled for customer account</td>
</tr>
<tr>
<td></td>
<td>• Disabled for prospect account</td>
</tr>
<tr>
<td>Contacts</td>
<td>Enables you to add and view contacts for the account. Review contacts in the following views:</td>
</tr>
<tr>
<td></td>
<td>• Table view</td>
</tr>
<tr>
<td></td>
<td>• Hierarchy view</td>
</tr>
<tr>
<td></td>
<td>The hierarchy view shows how the contacts are related to each other. Here you can manage reporting relationships and drill into contact details.</td>
</tr>
<tr>
<td></td>
<td>Use this tab to add additional contacts to the account. You must have edit access on the Account to add contacts. To add a contact, you can search by an account. The search results show the contacts and their primary customers and account.</td>
</tr>
<tr>
<td>Opportunities</td>
<td>Enables you to add and view opportunities for the account.</td>
</tr>
<tr>
<td>Quotes and Orders</td>
<td>Enables you to add and view quotes and orders for the account.</td>
</tr>
</tbody>
</table>
### Account Tabs

<table>
<thead>
<tr>
<th>Account Tabs</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Leads</td>
<td>Enables you to add and view leads for the account.</td>
</tr>
<tr>
<td>Recommendations</td>
<td>Provides a list of products recommended for this account.</td>
</tr>
<tr>
<td>Contracts</td>
<td>If your administrator has enabled this view, then you can view contracts associated with the account. Depending on your access, you can also preview the contract in a PDF format.</td>
</tr>
<tr>
<td>Notes</td>
<td>Enables you to add and view notes for the account.</td>
</tr>
<tr>
<td>Assessments</td>
<td>Enables you to add and view assessments for the account.</td>
</tr>
<tr>
<td>Activities</td>
<td>Enables you to add and view appointments, tasks, and call logs.</td>
</tr>
<tr>
<td>Assets</td>
<td>Shows a list of assets for this account.</td>
</tr>
</tbody>
</table>
| Relationships| Enables you to add account relationships to other account or contacts that aren’t directly related to the account but are influential. You can add the same contact to multiple accounts using different relationships. You must add your first contact from the Contact subtab and add your subsequent contacts here. Review the relationships in the following views:  
  - List view  
  - Diagrammer view |

**Note:** You can’t edit a role after you have added a relationship. To update the role, delete the existing relationship and create another relationship with the role that you want.

---

### Manage Multiple Classification Codes

If your administrator has enabled the Multiple Classification Codes option and you have edit access to your account, then you can add or remove multiple industries and organizations for your account. This gives you the flexibility to assign the most accurate industry and organization type to your account that provides greater accuracy for account qualification and territory assignment.

You can assign primary as well as secondary industry and organization type values to your account. You can also load your own industry and organization classifications and use them to qualify your accounts. When an account is assigned
multiple classification values, you have the option to use all the values to determine territory and rule-based assignment for accounts, or you can use only the primary account classification.

When you remove the primary organization type, then the application sets the next available organization type in the hierarchy as the default organization type. If there isn't any organization available, then there is no default organization attached to your account. Similarly, when you remove the primary industry code, then the application sets the next available industry code in the hierarchy as the default industry. If there isn't any industry code available, then there is no default industry attached to your account.

**What happens when I remove the primary industry code?**

The application sets the next available industry code in the hierarchy as the default industry. If there isn't any industry available, then there is no default industry attached to the account.

**What happens when I remove the primary organization type?**

The application sets the next available organization type in the hierarchy as the default organization. If there isn't any organization available, then there is no default organization attached to the account.

**View and Manage Account Hierarchies**

You can use sales applications to view and manage your accounts hierarchically. On the Profile page for a selected account, you can indicate a parent account, and you can create an account hierarchy if one doesn't already exist or manage the existing account hierarchy.

To access the Profile page, click Accounts, select an account to edit, and click Profile.

In the sales application, you can view both a graphical chart view and a table view for account hierarchies. You can click the view icons on the Create Hierarchy page to alternate between views. Here’s what you can do with the chart view and table view.

<table>
<thead>
<tr>
<th>Chart View</th>
<th>Table View</th>
</tr>
</thead>
<tbody>
<tr>
<td>See the hierarchy and the current active hierarchy version.</td>
<td>See the hierarchy and the current active hierarchy version.</td>
</tr>
<tr>
<td>Use the Control Panel tools to change the hierarchy layout, move the hierarchy around, center the hierarchy in the view, and increase or decrease the amount of zoom.</td>
<td>See the transactions associated with each node in the hierarchy. The transaction details region shows a list of associated contacts, open opportunities, open leads, team members, and assets.</td>
</tr>
<tr>
<td>Use the scroll arrows to see the following customer information:</td>
<td>Add or remove a node from the hierarchy (with the exception of the currently selected account).</td>
</tr>
<tr>
<td>• Number of open opportunities</td>
<td></td>
</tr>
<tr>
<td>• Number of won opportunities</td>
<td></td>
</tr>
</tbody>
</table>
### Chart View
- Number of leads
- Number of contacts
- Number of team members
- Number of assets (value)
- Customer type
- Industry for the account
- Primary contact information

### Table View

- Use the scroll arrows to see the following information for prospects:
  - Customer type
  - Industry for the account
  - Primary contact information

- Add an account to the hierarchy. You can add only one account to a given account hierarchy.

- See the parent and children for the selected account. You can see up to five nodes for each level, and you can navigate through and expand each level in the hierarchy

- Add an account to the hierarchy. Print the hierarchy and export it to Microsoft Excel.

### Add a Parent Account
When you add a parent account it creates a parent-to-child hierarchy between the two accounts. Here's how you can add a parent account to a selected account.

1. Click **Accounts**, and select an account to edit from the list.
2. On the Edit Account page, click the **Profile** tab.
3. Click the **Search** icon next to the Parent Account field.
4. On the Select Parent Account page, search for and select the account that you want to add as a parent.
5. Click OK.

   **Tip:** The account appears as a link in the Parent Account field.

   You return to the Profile page and the selected account appears in the Parent Account field.

### Create an Account Hierarchy
You can create a hierarchy for your selected account, with these steps:

1. Click **Accounts**, and select an account to edit from the list.
2. On the Edit Account page, click the **Profile** tab.
3. Under the Parent Account field, click the **Manage Account Hierarchy** link.
   The Create Hierarchy page appears, displaying the selected account in chart view. You can use the view icons to switch between Chart and Table views.
4. From the Action menu, select **Add Child**.
5. Search for and select the child account you want to add.
6. Continue adding accounts to your hierarchy.
7. Click **OK**, then click **Save and Close** to save your changes and return to the Profile page for the selected account.

Can I delete accounts that belong to a hierarchy?

You can’t delete an account if the account is the ultimate parent (the root node) in an account hierarchy. However, you can remove the account as the ultimate parent in the hierarchy and then delete the account. To do so, you must first delete the sub accounts before deleting the ultimate parent account.

You can delete an account that’s in the middle or at the lowest subsidiary (the leaf node) of an account hierarchy. The deleted account is no longer shown in the account hierarchy. The deleted account’s sub accounts, if any, become separate hierarchies.

Manage Account Contacts

When you create an account, you can select a contact as the primary contact. This contact is shown in the **Contacts** tab.

You can add or view the contacts in the following ways:

<table>
<thead>
<tr>
<th>View</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>List View</td>
<td>Shows the available contacts in a tabular format. Each line represents an account and the table structure represents the hierarchy. By default, the hierarchy shows all the parent levels and the immediate children of the account.</td>
</tr>
<tr>
<td>Diagrammer View</td>
<td>Shows the available contacts in a graphical view in a hierarchical format. You get a quick snapshot of how these contacts are related to each other in the organization. The node that represents the current account is emphasized. By default, the hierarchy shows the immediate parent and children of the account.</td>
</tr>
</tbody>
</table>

Manage Hierarchy

You can see the complete details of a selected account and its connection with other accounts, when you view the account hierarchy.

Use the account hierarchy to:

- Add a child account and subsequent child accounts and create a hierarchy
- Remove a child account
- Remove a parent account
Account Team Territories

Account Territory Member Access
Access for the territory owners and members are the same as that of the team members. These access levels control the internal and partner territory privileges for the account:

- Internal territory owner: Full access
- Internal territory members (nonowner): Edit access
- Partner territory owner and members: View-only access

**Note:** You must implement Territory Management before you can access territory owners.

Account Team Member Access Levels
Access levels control the team member's privileges for the account. There are three types of account team membership access levels:

- **View Only**
- **Edit**
- **Full**

When you add a resource to the account team, a profile option setting determines the member's default access level. If the member is removed from the account team, then that member no longer has access to the account. Only a member of a territory who's assigned to an account retains access. Resources in the management hierarchy of a newly added team member inherit the same access level of the subordinates. Resources in the management hierarchy of a newly added team member inherit the same access level of the subordinates.

View Only
View Only is the minimum level you can assign to team members. Team members with View Only access can view details of the account, such as: account team, snapshot, assessments, discussion forums, notes, and activities. The team member's resource role doesn't provide functional access to view a particular child attribute of an account. Without functional access a member can't view the attribute, regardless of their account team access level. The data security inherent on objects, such as leads and opportunities, determines whether team members can view details of that business object.

Edit
Team members with the Edit access can view and edit all customer-related objects. The data security inherent on objects, such as leads and opportunities, determines whether team members can view details of that business object. They can also run the territory reassignment process, but they can't change the composition of the account team.

Full
With Full access, team members can perform edit access functions and also change the composition of the account team. Initially, only the account owner and sales administrators have Full access, but they can grant Full access to other team members. Team members with Full access can do the following for other members:

- Manually add and remove other team members
• Change a member's access level
• Mark the lock assignment setting

Note: Team members must have Full Access to edit Account Profile and Household Profile pages.

What are favorite accounts?
Favorite accounts are those that you want to focus on because of business or other reasons. Tag accounts as favorites when creating or updating accounts, or when viewing the account list. Optionally, create a saved search based on your favorite accounts.

Contact Management

Overview of Contacts
Any person can be a contact and that person doesn't have to be related to an account.

Create Contacts
You can create contacts in these ways:
• Create directly in sales applications
• Import contacts using file-based import
• Use web service to create a contact

Note: If your sales application is integrated with Microsoft Outlook and IBM Notes, then you can also create contacts using these applications.

When you create a contact, existing contacts are checked for duplicate entries. If there is a match, you can select from the duplicate or continue creating the new contact. You can also search for relationships and edit them.

When you create or update a contact, the address field isn't mandatory by default. Depending on the country that you choose, some fields are made mandatory. For example, if you select United States, then you must enter Address Line.

Manage Contacts
Use contact management capabilities to search for, create, update, delete, merge, and enrich contacts.

Here's a description of what the tabs do on the Contacts Overview page.

<table>
<thead>
<tr>
<th>Contact Tabs</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview</td>
<td>Provides a general overview of the contact, open opportunities, quotes, open leads, active contracts, assets and recommendations, and activities.</td>
</tr>
<tr>
<td>Contact Tabs</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| Profile      | Gives a complete picture of the contact including all the customer relationships and associated with the contact. When a customer has multiple contacts, you can designate which contact is the primary contact from the customer's profile page. This designation means that the selected contact is the primary means of communication to the customer. You can also include a picture of the contact in the Additional Details region. Here you can also:  
  - Add account  
  - Update and verify address  
  - Mark as favorite contact |
| Team         | Enables you to view and add team members. For a B2C account, you can also see and add territories. You can manually run territory assignment for the contact through the Run Assignment process. The assignment action is enabled for the type of contact enabled for assignment. |
| Assets       | Shows a list of assets for the contact. |
| Contracts    | If your administrator has enabled this view, then you can view contracts associated with the contact. Depending on your access, you can also preview the contact in a PDF format. |
| Opportunities| Enables you to add and view opportunities for the contact. |
| Leads        | Enables you to add and view leads for the contact. |
| Relationships| Enables you to add account relationships to other account or contacts that aren't directly related to the account but are influential. You can add the same contact to multiple accounts using different relationships. Review the relationships in the following views:  
  - List view  
  - Diagrammer view You can't edit a role after you have added a relationship. To update the role, delete the existing relationship and create another relationship with the wanted role. |
| Notes        | Enables you to add and view notes for the contact. |
| Assessments  | Enables you to add and view assessments for the contact. |
| Activities   | Enables you to add and view appointments, tasks, and call logs. |
Chapter 7
Accounts, Contacts, and Households

Related Topics
- Understanding File-Based Data Import and Export

How can I attach a contact's photo to a contact?

After your administrator enables the photo field on the profile page, you can attach a photo to a contact's profile.

Here’s how to add a photo on the Contacts landing page.
1. On the home page, navigate to Sales > Contacts.
2. Click a contact name.
3. On the Edit Contact page, click the plus icon and select a photo from your computer.
   The file name appears on the page.
4. Click Save and Close.
   You can see the photo of the contact on the Contacts list page with the card view enabled.

How can I designate a contact as primary?

You designate a contact as primary from the customer account. On the customer's Contacts page, you can click the check icon in the Primary column for the contact you want to be the primary contact. You can’t edit the primary contact designation from the contact's Profile page. You must make changes in the customer’s Contacts page.

For example, you can have more than one contact point, such as phone number and e-mail address, for the same customer. In this example, a contact is related to customers Acme 1 and Acme 2. This contact has work phone 1 and mobile phone 1 for customer Acme 1, and work phone 2 and mobile phone 2 for customer Acme 2. You can designate work phone 1 as the primary contact point for customer Acme 1, and mobile 2 as the primary contact point for customer Acme 2.

How can I specify the customer relationships for my contacts?

You add relationships for a contact in the contact's Relationships tab. If the contact is associated to a customer, you can also add relationships for the contact from the customer's Contacts page by clicking the contact name and accessing the contact’s Relationships tab.

What's the difference between a primary contact, an overall primary contact point, and a relationship associated primary contact?

The primary contact point is the specific phone, e-mail or other means of communication with a customer that a contact prefers. If there is only one contact point entry, it's the primary contact point. Contact points can have multiple entries. On the Edit Contact: Profile page, you can designate a primary contact for each type of contact point.

An overall primary contact point is the first entry for each type of contact point for a contact. If no customer is associated with the contact, the primary contact point is the overall primary contact point.
If a customer is associated with the contact, the primary contact point becomes the relationship-associated primary contact point. A relationship-associated primary contact point is the first of multiple records for a contact's customer relationship. You can change the primary on the Edit Customer: Contact page. Since the contact is related to a customer in this case, the relationship-associated primary contact is also the overall primary contact.

### About Personally Identifiable Information

The data or information that's used to uniquely identify a contact or locate a person is called personally identifiable information (PII). The information includes social security numbers, addresses, bank account numbers, phone numbers, and so on.

PII is considered confidential and sensitive and is protected to prevent unauthorized use of personal information. Sensitive PII is information which, when disclosed, could result in harm to the individual whose privacy has been breached. Aspects of protecting PII include legal regulation, financial liability, and personal reputation. In the sales application, the PII data is secured and only authorized users can access sensitive information. For example, only authorized users are granted access to the social security numbers of people stored in the database. Administrators can find setup information about PII in the Implementing Sales guide.

**Related Topics**

- Manage Personally Identifiable Information

### Household Management

#### Overview of Households

A household is a group of contacts generally sharing a common link or association.

Households provide valuable segmentation information about the household as a whole, as well as summary of information about the household member contacts. Usually all the contacts reside at the same address and have a similar set of entities that accounts do, such as team members, territories, and contacts.

#### Create Households

Here's how you can create households:

- Create directly in sales applications
- Import households using file-based data import
- Create households using Web Services

#### Manage Households

Use household management capabilities to search for, create, update, and delete households.

Here's a description of the household tabs.
<table>
<thead>
<tr>
<th>Household Tabs</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview</td>
<td>Provides a general overview of the household, opportunities, active contracts, open leads, products, and activities.</td>
</tr>
</tbody>
</table>
| Profile        | Provides household-related details such as address and contacts. Here you can also:  
  • Assign head of the household  
  • Update and verify household address |
| Team           | Shows team members and territories that are part of the household. Here you can also:  
  • Add team members  
  • Add partner territories  
  **Note:** You can manually run territory assignment for the household through the Run Assignment process. The assignment action is enabled for the type of household enabled for assignment. |
| Assets         | Enables you to add and view assets for the household. |
| Opportunities  | Enables you to add and view opportunities for the household. |
| Leads          | Enables you to add and view leads for the household. |
| Relationships  | Enables you to add relationships to other households or contacts that aren't directly related to the household but are influential. Review the relationships in the following views:  
  • List view  
  • Diagrammer view |
| Notes          | Enables you to add and view notes for the household. |
| Assessments    | Enables you to add and view assessments for the household. |
| Activities     | Enables to add and view appointments, tasks, and call logs. |
| Contracts      | If your administrator has enabled this view, then you can view contracts associated with the household.  
  If you have the appropriate access, then you can also preview the contract in a PDF format. |
What happens when I create an account or household that has the same name and address as the existing account or household?

The new account or household is suffixed by null and a random number to make the whole name unique. The suffix of an account or household’s unique name is generated from its primary address, which is based on the Party Suffix style. When the Party Suffix style formats are set to empty in the Manage Address Formats task, then null and a random value is suffixed.

Household Relationships

Relationships can be household contacts, such as parent, spouse, or child. Relationships can also be of other types, for example a bank that has a financial dealing with the contact and so on. The other relationships can be of type person, group, or organization.

The Relationships tab includes:

- Contacts: household members as the immediate beneficiaries.

  Note: If you have selected a primary contact, then it’s included as a household contact, by default.

- Other relationships: other relationships of type person, group, or organization.

Review relationships in the following views:

- List view: This view shows the available relationships is a tabular format.
- Diagrammer view: This view shows network visualization of the relationships. The visualization can show up to four levels of connections. By default, the connections are shown up to the second level.

  Your administrator must enable this view.

List View

The list view is the default view. It contains two tables; Household Contacts and Other Relationships.

The list view table displays household members who are your immediate beneficiaries. The other relationships table shows other relationship that may not be your direct beneficiary. By default, both the tables are sorted by name.

Diagrammer View

Diagrammer shows a graphical representation of the contacts and other relationships that the household has.

The visualization can display up to four levels of connections. By default, the connections are shown up to the second level. Each node in the graph represents an account or a household and each link between nodes represents a connection between them.
Searches

Manage Contact Saved Search Lists

Here’s how to manage your contact saved search lists in the Contacts page.

You can’t edit or delete the preconfigured saved lists or any user-defined lists added by your administrator. You can modify these saved searches to match your requirements, and then create a new saved search.

The Contacts page includes four predefined saved searches that let you filter the contacts you view in the page:

- **My Contacts**: Displays all contacts, of the type sales account, that you’re an owner of.
- **My Favorite Contacts**: Displays all your favorite contacts.
- **My Team and Territory Contacts**: Displays all contacts, of the type sales account, where you’re on the account team member or you’re on the account territory resources.
- **My Business Contacts**: Displays all contacts belonging to all the accounts you own.

Create a Saved Search

Here’s how to create a saved search:

1. From the List menu, select **Create or Edit Lists**.
2. In the Saved Searches window, use the filters to modify your search, and click **Search**.
3. Click **Save**.
4. In the Create Saved Search window, enter a name for the saved search.
5. Click **OK**.

Use Search Mode on Account or Contact Creation Page

You can verify an address in the search mode while creating a new account. Search and select from multiple similar addresses when verifying account or contact addresses from the Oracle Address Verification Cloud Service. Select the most appropriate address from a list of similar verified addresses.

To verify an address:

1. On the Contacts landing page, click **Create Contact**.
2. Enter the name, address lines, state and postal code.
3. Click **Verify Address**.

   A list of similar verified addresses appears.
This image shows an example of how a list of similar verified addresses appears in the page. The image shows a list of addresses you can select from.

Related Topics

- How You Enable Search Mode for Address Verification Cloud Service

Use Standard Fields to Search Records

You can search and associate records for account, contact, household, and asset with a list of values and use data that’s relevant to their business. You can use standard fields to search and view them in the search results, where you can find and select the relevant record.
View Only Primary Names for Address Geography Selection

Your administrator sets up primary names for geographies. When you enter the postal code on the Create Account page, the list of values for address selection displays only primary names for address geographies.

For more information, see Configuring Address Verification, in the Getting Started with Your Customer Data Management Implementation guide.

Related Topics
- Getting Started with Your Customer Data Management Implementation

What account records do the different record sets permit you to search?

The record sets in the Saved Searches window restrict your saved searches to different sets of accounts. For example, the default **My Accounts** saved search, searches the **Records I own** record set, listing all of the accounts you created or are assigned to as an owner.

Here's a list of the record sets for accounts. Not all record sets are available to all users. For example, the record sets involving subordinates are available only to managers.

<table>
<thead>
<tr>
<th>Record Set Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Records I own</td>
<td>Accounts you own. You're the account owner if you created the account or if ownership was assigned to you.</td>
</tr>
<tr>
<td>I am on the team</td>
<td>Accounts where you're on the account team. You're on the account team if you're the account owner or were added as a member by another team member.</td>
</tr>
<tr>
<td>My territory</td>
<td>Accounts in your sales territories.</td>
</tr>
<tr>
<td>My subordinates own</td>
<td>Accounts owned by you and your subordinates.</td>
</tr>
</tbody>
</table>
Oracle CX Sales
Using Sales

Chapter 7
Accounts, Contacts, and Households

Record Set Name | Description
--- | ---
My subordinates are on the team | Accounts where you or your subordinates are on the account team.
My territory hierarchy | Accounts in your sales territories and all of their subordinate territories in the sales territory hierarchy.
I am on the team or territory | Accounts where you’re either on the account team or a member of the sales territory.
My subordinates are on the team or territory | Accounts where you or your subordinates are either on the account team or the sales territory.
All records I can see | Accounts that you can view based on your account team membership, sales territory assignments, your position in the organization, and security permissions.

Tip: To improve saved search performance, restrict your saved searches to smaller record sets. For example, rather than searching all the records you can see, search all the records in your territory hierarchy. Or restrict your searches to a smaller geographical area. For example, search all the accounts in one state instead of the whole country.

What accounts does selecting My Accounts display?
When you select the **My Accounts** list in the Accounts work area, the application displays a list of all of the accounts where you’re listed as the account owner. You’re automatically the account owner if you create the account or are designated as the owner by an application administrator.

What contact records do the different records sets permit you to search?
The different record sets provided in the Saved Searches window restrict your saved searches to different sets of contacts. For example, the default **My Contacts** saved search, searches the **Records I own** record set, listing all of the contacts you created or are assigned to as an owner.
Here’s a list of the record sets for contacts. Not all record sets are available to all users. For example, some record sets are available only if you sell to consumers. Record sets involving subordinates are available only to managers.

<table>
<thead>
<tr>
<th>Record Set Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Records I own</td>
<td>Contacts you own. You’re the contact owner if you created the contact or if ownership was assigned to you.</td>
</tr>
<tr>
<td>Record Set Name</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Records where I am on the team</td>
<td>Contacts where you’re on the contact team. You’re on the contact team if you’re the contact owner or were added as a member by another team member.</td>
</tr>
<tr>
<td>Records my subordinates own</td>
<td>Contacts owned by you and your subordinates.</td>
</tr>
<tr>
<td>Records where my subordinates are on the team</td>
<td>Contacts where you or your subordinates are on the contact team.</td>
</tr>
<tr>
<td>All records I can see</td>
<td>Contacts that you can view based on your contact team membership, sales territory assignments, your position in the organization, and security permissions.</td>
</tr>
<tr>
<td>Records in accounts I own</td>
<td>Contacts in the accounts you own. You’re the account owner if you created the account or ownership was assigned to you.</td>
</tr>
<tr>
<td>Records in accounts where I am on the account team or territory</td>
<td>Contacts in the accounts where you’re on the account team or sales territory.</td>
</tr>
<tr>
<td>Records in my territory</td>
<td>Contacts in your sales territories.</td>
</tr>
<tr>
<td>Records in my territory hierarchy</td>
<td>Contacts in your sales territories and all of their subordinate territories in the sales territory hierarchy.</td>
</tr>
<tr>
<td>Records where I am on the team or territory</td>
<td>Contacts where you’re either on the contact team or the sales territory.</td>
</tr>
<tr>
<td>Records where my subordinates are on the team or territory</td>
<td>Contacts where you or your subordinates are either on the contact team or the sales territory.</td>
</tr>
</tbody>
</table>

**What contacts get displayed when I select My Contacts, My Favorite Contacts, and My Business Contacts?**

Selecting the **My Contacts** list in the Contacts work area displays a list of all of the accounts where you are listed as the contact owner. You are automatically the contact owner if you create the contact or you can be designated as the owner by an application administrator.

Selecting the **My Favorite Contacts** list displays a list of contacts you designated as favorites.

Selecting **My Business Contacts** displays all contacts for accounts you own. You are the account owner if you created the account or if an administrator assigned ownership to you.
What household records do the different record sets permit you to search?

The different record sets provided in the **Records** field of the Saved Searches window restrict your saved searches to different sets of households. For example, the default **My Households** saved search, searches the **I own** record set, listing all of the households you created or were assigned to as an owner.

Here are the record sets for households. Not all record sets are available to all users. For example, the record sets involving subordinates are available only to managers.

<table>
<thead>
<tr>
<th>Record Set Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>I own</td>
<td>Households you own. You're the household owner if you created the household or if ownership was assigned to you.</td>
</tr>
<tr>
<td>I am on the team</td>
<td>Households where you're on the household team. You're on the household team if you're the household owner or were added as a member by another team member.</td>
</tr>
<tr>
<td>My territory</td>
<td>Households in your sales territories.</td>
</tr>
<tr>
<td>My subordinates own</td>
<td>Households owned by you and your subordinates.</td>
</tr>
<tr>
<td>My subordinates are on the team</td>
<td>Households where you or your subordinates are on the household team.</td>
</tr>
<tr>
<td>My territory hierarchy</td>
<td>Households in your sales territories and all of their subordinate territories in the sales territory hierarchy.</td>
</tr>
<tr>
<td>I am on the team or territory</td>
<td>Households where you're either on the household team or a member of the sales territory.</td>
</tr>
<tr>
<td>My subordinates are on the team or territory</td>
<td>Households where you or your subordinates are either on the household team or the sales territory.</td>
</tr>
<tr>
<td>All records I can see</td>
<td>Households that you can view based on your household team membership, sales territory assignments, your position in the organization, and security permissions.</td>
</tr>
</tbody>
</table>

What households does selecting My Households display?

When you select the **My Households** list in the Households work area, the application displays a list of all of the households where you’re listed as the household owner. You’re automatically the household owner if you created the household or you can be designated as the owner by an application administrator.
Record Integrity

Resolve Duplicate Accounts and Contacts

You can resolve duplicate records as you create accounts and contacts, if the administrator has enabled the functionality. Resolving duplicate records ensures that clean customer data is available as you create, maintain, and use customer records.

Since multiple salespeople can create and update the same accounts and contacts, the potential exists for duplicate records in the application. You can view and act upon duplicate accounts and contacts as you create new records, if the ability is enabled by your administrator.

When you create an account or a contact, the application searches for duplicate accounts or contacts based on one of these conditions:

- The data quality rules established for accounts and contacts
- An exact name match

If the application finds duplicate accounts or contacts, then the application displays the records in the duplicate notification page. You can either ignore the duplicate accounts and contacts and continue creating the record, or you can select the correct account or contact from the list that's displayed.

How can I make merge requests?

You can create a merge request when you have duplicate records pointing to the same customer, and you want to consolidate those records into one. An approved merge request results in one surviving record. The status of all other duplicate records changes to Merged. You can select to merge two or more customer records from the customer list on your Customer home page or in the customer search results.

Since the sales application Customer Data Hub processes all merge requests, you must implement Customer Data Hub and set the profile option Merge Request Enabled to YES to make this feature available.

Can I specify multiple accounts or contacts that I want to merge?

Yes. You can select and submit a request to merge multiple accounts or contacts into a single surviving record.
Use the landing page for accounts or contacts to submit a merge request.

Data Enrichment
Overview of Data Enrichment

A key requirement in the lifecycle of a customer record is keeping the data clean, accurate, relevant, and easily accessible.

You can use different options to enrich your accounts:

- Oracle DaaS for Sales to enrich your accounts and contacts.
- Oracle Address Verification lets salespeople verify that the address entered for an account or contact is a confirmed postal address.
- Oracle DataFox to enrich your account data and increase your sales.

Oracle DaaS

Oracle DaaS for Sales provides rich data and insights about common business entities, such as businesses, people, and products. This information comes from third-party data sources such as Dun & Bradstreet Corporation.

You can use DaaS for Sales to enrich account and contact data in sales applications, including:

- Individual accounts and contacts
- Lists of accounts and contacts
- New contacts for an account as you import them into the account

Oracle DataFox

Use Oracle DataFox to enrich your accounts and learn more about your customers. Information about your accounts come from third-party data and real-time signals from Oracle DataFox.

Enrich Accounts and Contacts with DaaS

You can enrich accounts using Oracle DaaS for Sales (also known as Social Data and Insight) or Oracle DataFox.

Enrich Single Accounts and Contacts

You can enrich a single account and the contacts associated with that account from within Sales. Use real-time duplicate identification and enrichment with the batch enrichment functionality. The Actions menu in the account or contact's profile page provides access to the enrichment capabilities.

When you enrich a single account or contact, the application displays a list of attributes available for that record with side-by-side values for both Sales and the DaaS for Sales.

Predefined attributes available for accounts include the following:

- Company Name (not Sales Account Name)
- Current Fiscal Year Potential Revenue
- Primary Street Address
- Duns Number
- Line of Business
- Public Private Ownership Mark
• Stock Symbol
• Year Established
• Location Type
• Primary Address 1
• Primary Address 2
• Primary City
• Primary County
• Primary State
• Primary Postal Code
• Primary Postal Plus-4 Code
• Mailing Address 1
• Mailing Address 2
• Mailing City
• Mailing State
• Mailing Postal Code
• Mailing Postal Plus-4 Code
• Phone
• Fax
• URL
• Trade Style Name
• Major Industry
• North American Cartographic Information Society (NACIS) Classification
• SIC Classification

Predefined attributes available for contacts include the following:

• Prefix
• First Name
• Middle Name
• Last Name
• Job Title
• Gender
• Suffix
• Work Street Address 1
• Work City
• Work State
• Work Postal Code
• Work Postal Plus-4 Code
• Work Country
• Contact Work Phone
• Contact Phone Extension
• Email Address
• Department

While viewing the data, you can accept all attribute values from DaaS or only specific values. The application updates the account or contact information with the information selected.

**Enrich Multiple Accounts or Contacts**

You can enrich multiple accounts and the contacts associated with the accounts, from within Sales. You use the Actions menu on the Accounts and Contacts landing (list) pages to gain access to the enrichment capabilities.

Instead of showing you a comparison of attribute values between Sales and DaaS, as in the single account enrichment, when you select multiple accounts or contacts for enrichment, you see an indicator showing enrichment progress.

As you enrich multiple accounts or contacts, you can’t select which attributes to enrich like you can when you enrich a single account or contact. Administrators can use the Manage Social Data and Insight Cloud Service Attribute Mapping and Preferences task to determine which attributes to enrich.

After completion, review the enrichment summary report for details about:

• Records Selected
• Records Enriched
• Record with Multiple Matches
• Records with No Match
• Records Failed

**Note:** Real-time bulk enrichment limit is set to 5 records. You can’t select more than 5 records for enrichment on the list page.

**Enrich an Account**

To enrich an account, do these steps:

1. From your Accounts list, select the account you want to enrich.
2. On the Overview page for the selected account, select Enrich Account from the Action menu.
3. On the Select Fields to Enrich dialog box, select DaaS values you want to add to the account, and click Enrich.

**Enrich a Contact**

To enrich your contact, do these steps:

1. From your Contacts list, select the contact you want to enrich.
2. On the Overview page for the selected contact, select Enrich Contact from the Action menu.
3. On the Select Fields to Enrich dialog box, select the data cloud values you want to add to the contact, and click Enrich.

You see a confirmation message stating that the enrichment was successful, and you return to the contact Overview page, which reflects the enriched information for the contact.

**Add Enriched Contacts to an Account**

You can add new contacts to a previously enriched account in the Sales application. You add these new contacts in the Contacts tab, by either clicking **Get Contacts** or selecting **Get Contacts** from the Actions menu.
When you start adding enriched contacts to an account, the application displays a list of contacts available for download from DaaS. You can choose to see these contacts grouped by job level or by location, and you can choose to add the contacts by job level, job location, or both.

**Enrich Accounts with DataFox**

You can profile and classify your customer base with account insights that you get from Oracle DataFox. Your accounts are enriched and refreshed daily with the latest data.

You can use your enriched accounts to:

- View up-to-date account data in the Accounts page so you can have complete information about the account.
- Act on high-scoring prioritized accounts and focus your efforts on prospecting top accounts.
- Expand your target market by identifying new companies to sell to.

**Synchronize and Enrich Your Accounts**

You can enrich each account in your sales application using DataFox. To enrich a new account, first create and save the account, and then edit the account to enrich it. The procedure lists how to enrich existing accounts.

Here's how you enrich existing accounts:

1. Sign in as a sales user.
2. Click Navigator > Sales > Accounts.
3. Click an account that you want to edit.
4. In the Edit Account page, click Actions > Enrich Account.
   A confirmation message appears stating that enrichment is in progress.
5. Open the Account Profile page and verify the enrichment status.

Contact Oracle Support to synchronize and enrich all your existing accounts with companies in DataFox. To synchronize and enrich individual companies within DataFox to your accounts, see the topic Sync and Enrich Your Account in the Using Oracle DataFox guide.

For information on integrating with DataFox and getting started, see the topic Overview in the Get Started chapter of the Using Oracle DataFox guide.

**Related Topics**

- Using Oracle DataFox

**Enrich Account Lists and Contact Lists**

You can use DaaS for Sales to enrich your account list and contact list with the latest information available from Dun & Bradstreet Corporation.

**Enrich Your Account List**

Here's how you can enrich your account list:

1. From your Accounts list, select the accounts you want to enrich.
2. From the Action menu, select Enrich Selected Accounts.
3. On the Select Fields to Enrich dialog box, select the DaaS values you want to add to the accounts, and click Enrich.

You see an Enrichment Results page listing the selected accounts and the enrichment status of each.

If the enrichment was successful, you return to your Accounts list page and the additional information now appears for the selected accounts.

Enrich Your Contact List

Here’s how you can enrich your contact list:

1. From your Contacts list, select the contacts you want to enrich.
2. From the Action menu, select Enrich Selected Contacts.
3. On the Select Fields to Enrich dialog box, select the DaaS values you want to add to the contacts, and click Enrich.

You see an Enrichment Results page listing the selected contacts and the enrichment status of each.

If the enrichment was successful, you return to your Contacts list page and the additional information now appears for the selected contacts.

Enrich Account and Contact Data in Real Time

You can enrich account and contact data in real time using DaaS for Sales partners with Dun and Bradstreet (D&B) to get the most up-to-date data for over 300 million companies and over 100 million contacts worldwide.

Enrich Account Data in Real Time

You enrich account data from the Accounts page.

To enrich account data:

1. Navigate to the Accounts page.
2. Select the Enrich option from the Actions menu. In the Create Account flow, the option is named Enrich Account.
3. Select the account (or multiselect the accounts) you want to enrich.

   If you select multiple accounts for enrichment, the application automatically enriches the accounts and displays the results. The result includes information about the accounts enriched and the status of each account.

   If you select one account for enrichment, the Select Fields to Enrich page is displayed. In the page, you can select which data values you would like to use in the enriched account record for each of the fields.

4. Select existing value or the DaaS value for each of the fields.
5. Optionally, click Hide Identical Values to hide the fields where the Sales data is the same as DaaS data.
6. Click Enrich.

Enrich Contact Data in Real Time

You enrich account contact data from the Contacts page.

To enrich account contact data:

1. Navigate to the Contacts page.
2. Select Enrich option from the Actions menu. In the Create Contact flow, the option is named Enrich Contact.
3. Select the contact (or multiselect the contacts) you want to enrich.
   If you select multiple account contacts for enrichment, the application automatically enriches the contacts and displays the results. The result includes information about the contacts enriched and the status of each contact.
   If you select one contact for enrichment, the **Select Fields to Enrich** page is displayed. In the page, you can select which data values you would like use in the enriched contact record for each of the fields.

   **Note:** You can enrich only those contacts who are associated with enriched accounts.

4. Select existing value or the DaaS value for each of the fields.
5. Optionally, click **Hide Identical Fields** to hide the fields where the Sales data is the same as DaaS data.
6. Click **Enrich**.

### Add Accounts from DaaS for Sales

When creating a new account in a sales application, you can search for the latest company information in DaaS. Use the filter criteria to search and add accounts. If you select an existing sales account to be added from DaaS, then those accounts are enriched.

Add the selected (one or more) accounts and their contacts as new accounts. You can create a maximum of five real-time accounts. You can use the advanced search for adding the account search filter criteria that are searchable in DaaS, for example:

- County
- Created By
- Creation Date
- Current Fiscal Year’s Potential Revenue
- D&B Credit Rating
- Data Confidence
- HQ Branch Indicator
- Global Ultimate D-U-N-S Number
- Domestic Ultimate D-U-N-S Number

For more information about DaaS enrichment, see the Oracle Engagement Cloud Using Customer Data Management guide.

To add accounts from Data Cloud:

1. Sign in as a sales representative.
2. Click **Navigator >Sales> Accounts**.
   The Accounts page appears.
3. From the Actions menu, click **Add Accounts from Data Cloud**.
   The Get Accounts from Data Cloud: Select Accounts page appears.
4. Click the **Show filter** icon.
   The Advanced Search pane appears.
5. Click the **Data Cloud Accounts** tab.
6. Add filters or attributes that are searchable in data cloud, such as Revenue, Industry Category. The accounts are created and you receive a message stating the results.

7. Click **View Results** on the Account Creation: Results page. A list of newly added, enriched, or failed to create or enrich accounts displays.

8. Click **Done**. The View Results page is closed and the Get Accounts from Data Cloud page displays.

9. Add contacts from Data Cloud to the newly created accounts.

10. Click **Add** to add more filter criteria by adding attributes to view DaaS searchable attributes. The Data Cloud Accounts filter is available on the Advanced Search pane.

11. Verify that the DaaS usage is tracked for successfully created accounts.

---

**Related Topics**
- Enriching Data Using Social Data and Insight Cloud Service

---

**Overview of Using Smart Data for Account and Address**

You can use "smart data" to create accounts, add or edit an account, and add or edit a contact address. Smart data is ready to use in the application without any additional setup. Smart data for accounts is available on the Create Account page. Smart data for addresses is available on create or edit pages for accounts and contacts. The highlights for smart data are:

- Use autosuggestion when searching and selecting verified companies using Oracle Account Enrichment Cloud Service. This feature automatically fills over 90 company attributes into appropriate fields.
- Minimize the use of clicks and keystrokes during account entry in the account creation flow in Engagement Cloud.
- Use autosuggestion when searching and selecting verified addresses using Oracle Address Verification Cloud Service.
- Add or edit addresses across Engagement Cloud for accounts and contacts.

Smart data for accounts requires a license for Oracle Account Enrichment Cloud Service, and smart data for addresses requires a license for Oracle Address Verification Cloud Service.

**Use Smart Data for Accounts**

Smart data lets you to search and select validated Dun and Bradstreet accounts using autosuggestion functionality. Smart data provides you with enriched, validated data without data entry issues.

Validated global accounts improve the completeness, accuracy, and integrity of data. For validated accounts, the account data gets automatically populated into the fields, allowing you to quickly create an account without typing in account details. This improves efficiency and user experience when creating accounts. Additional benefits of smart data are:

- Search in real time to predict and fill more than 90 company fields with accurate and validated data.
- Specify country or address details using autosuggestion.
- Save time searching and filling in data.
- Avoid errors when filling in data.
When you create an account, enter the name of the account. Automatically, possible accounts appear. You simply select the appropriate account and the application automatically fills in the details for you.

Use Smart Data for Addresses

Smart data for addresses provides you with addresses and automatically enters complete data for you.

The benefits of smart data for account and contact addresses are:

- You type in a partial address and the application automatically suggests addresses for you.
- When you type more characters, the application automatically narrows the results.
- Select the address to automatically populate validated data.

Select appropriate options and all the details are populated with the relevant data.

Related Topics

- DaaS for Address Verification
- DaaS for Sales

Business Plans

Overview of Business Plans
Sales representatives and sales managers perform account planning to achieve specific goals. Goals for business plans are represented through objectives.

Access to the business plans is determined by the team membership and resource reporting hierarchy. This means that managers have access to business plans of the sales representatives in their team. In an account business plan, salespeople collaborate to discuss the sales of a specific account and analyze the need of a plan. An account business plans focuses on a specific account, to increase the sales or revenue of that account. With a business plan you can:

- Analyze the strengths, weaknesses, opportunities, and threats of the business plan in the context of the account.
- Add business plan classes to define plans for partner, account, opportunities, and contacts.
- Collaborate with team members to discuss prospective plans.
- Enable or disable any of the embedded classes for account and partner business plans.
- Add team members to work on a business plan to share information, identify objectives, and increase sales per quarter.
- Create notes while working on a business plan and continue with discussions in the next meeting referring to the notes created.

Make sure that your administrator has enabled the account business plan using Application Composer.

Create Business Plans

You create a business plan by selecting a type of plan and then adding objectives to it. The type of a business plan helps you to differentiate between business plans. The types you can create are: partner and account.

The procedure to create a business plan is the same for both partner and account. These steps represent a flow for creating an account business plan:

1. Sign in to the sales application as a sales manager.
2. Click the Business Plan icon on the home page.
   
   A list of business plans appears.
3. Click Create Business Plan.
4. Enter the name of the plan.
5. Select an account from the Account drop-down list.
6. Define the period for the objectives that you want to achieve, in the Period field.
   
   By default, the current year is displayed. You can change the period to year, quarter, or period.
7. Select a type from the options Regional and Global.
   
   The current user is the owner, by default.
8. Select a status for the plan. Initially, the status is Draft.
9. Click Save and Continue.
   
   You automatically navigate to the Edit Business Plan page.
10. Modify your business plans if required, and click Save and Continue.
11. Click the SWOT Analysis subtab to analyze the strength and weakness of your business plan.
12. Click the Activities subtab to add tasks to your plans.
13. Click Save and Close.
Add Business Plans Objectives

Objectives are the key aspect of a business plan. Salespeople use business plans to achieve objectives to meet the target goals.

To create objectives for a business plan:

1. Click Create Objective on the Edit Business Plan page.
   
   The Create Objective page appears.

2. Enter a name for the business plan.

3. Select a type from the Type drop-down list.

   Note: You can add a type to the list of options. The type of a business plan determines the unit of measure and the field is automatically populated on selection of a type.

4. Define the period in which you want to achieve your goals for the business plan.

5. Enter your target to achieve your objective in the defined period.

6. Click Save and Close.
   
   The objective is displayed on the Edit Business Plan page.

7. If you click Save and Continue, then the Edit Objective page appears.

   You can view the newly created objective and you can add notes, activities, and attachments to the objective.

Split Objectives

You can split an objective to specify how to achieve the objective between partner and account. To split an objective:

1. Click Split Objective on the Edit Objective page.
   
   The Split Objective page appears.

2. Specify how you want to split your objective.

3. Click Save and Close.
   
   The split objective appears on the Edit Objective page.

4. Enter your plan to achieve your set target, in the specified period.

5. Select Attainment in the Show field.
   
   The Attainment column appears.

6. Enter the details for the targets you achieved.

7. Click Save and Close.

Use the Business Plans Overview Tab

You view the list of business plan objectives on the Edit Business Plan: Summary page, or on a separate subtab named Objectives. If an objective is listed in the Objectives subtab, you can search for objectives by name. For every objective you must specify the following fields:
### Share Business Plans

You can share and view shared business plans and discuss business plans with your team. You can focus your attention on a specific account, including viewing revenue for the account. You can also drill-down into the details and edit a business plan from a conversation.

To share your business plans, publish a business plan using the Social subtab on the Edit Business Plan page.

| Note: | You must have access to Oracle Social Network to publish a business plan. |

### Assets

#### Overview of Sales Assets

Assets are high-net-worth products owned by an organization. After the functionality is enabled by the administrator, you can create and manage assets.

You use assets in the following ways:

- Click **Sales > Assets** on the springboard to use a full set of create, edit, and manage assets capabilities.
• Manage assets within the context of accounts
• Associate assets with activities, such as tasks and appointments
• Create an organization-level view of calendars associated with assets
• Associate assets with opportunities and leads

What assets records can I search using saved searches?

You can view different records from the two saved searches provided on the Assets landing page. Here’s a list of the supplied saved search for assets.

<table>
<thead>
<tr>
<th>Record Set Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>My Customers’ Active Assets</td>
<td>All active assets associated with your customers</td>
</tr>
<tr>
<td>All My Customers’ Assets</td>
<td>All assets, purchased in the last six months, associated with your customers (although the time frame can be modified by the administrator)</td>
</tr>
</tbody>
</table>

How can I view assets?

You can view asset information for your accounts from the Assets or Accounts page. Here’s how to view assets from the Assets page.

1. Sign in to a sales application as a sales manager.
2. Click **Sales > Assets** on the home page.
3. On the Assets landing page, view the summary details.
4. Click an asset record to view and edit the asset details.

Here’s how to view assets from the Accounts page.

1. Sign in to a sales application as a sales manager.
2. Click **Sales > Accounts** on the home page.
   
   The Accounts landing page appears with a list of accounts.
3. Click an account.
   
   The Edit Account page appears.
4. Click the **Assets** subtab.

If enabled by the administrator, you can also view asset information in activities, such as appointments, tasks, and call reports.
How can I create assets?

You can create asset information for your accounts.

To create assets from the Assets page:

1. Sign in to a sales application as a sales manager.
2. Click Sales > Assets on the home page.
3. In the Assets landing page, click Create Asset.
4. Enter the details, such as the account, product, status, quantity, and purchase price.
5. Click Save and Close.

To create assets from the Accounts page:

1. Sign in to a sales application as a sales manager.
2. Click Sales > Accounts on the home page.
3. In the Accounts landing page, edit an account.
4. In the edit page, click the Assets tab.
5. Click Create Asset and enter the details.
6. Click Save and Close.

How can I edit assets?

You can edit asset information for your accounts from the Assets or accounts page.

To edit the assets from the Assets page:

1. Sign in to a sales application as a sales manager.
2. Click Sales > Assets on the home page.
3. In the Assets landing page, select an asset to edit.
4. In the Edit Asset page, you can edit the asset information, such as owner, as well as details like status, quantity, and purchase price.
5. Save your changes.

To edit the assets from the Accounts page:

1. Sign in to a sales application as a sales manager.
2. Click Sales > Accounts on the home page.
3. In the Accounts landing page, edit an account.
4. In the edit page, click the Assets tab.
5. Select an asset to edit and edit the details.
6. Save your changes.

How can I delete assets?

You can delete asset information for your accounts from the Accounts landing page or the Assets landing page.

To delete assets from the Assets landing page:

1. Navigate to Sales > Assets on the springboard.
2. In the Assets landing page, select an asset.
3. In the Edit Asset page, select **Delete Asset** from the Actions menu.
4. Respond to the confirmation message.

To delete assets from the Accounts landing page:

1. Navigate to **Sales > Accounts** on the springboard.
2. In the Accounts landing page, edit an account.
3. In the Edit page, click the **Assets** tab.
4. Select an asset to delete.
5. In the Edit Asset page, select **Delete Asset** from the Actions menu.
6. Respond to the confirmation message.

### Apply Mass Update to Assets

You can select multiple asset records and update all of them to the same value for a field or a set of fields using the mass update feature. Before you can use the mass update feature, your administrator must enable it.

The default attributes that are available for mass update on the UI are:

- Asset Owner
- Status
- Quantity
- Purchase Date

Some fields that you can update might contain a list of values (also known as a fixed choice list field). In some cases, a list of values field can have a parent. This means that the parent field’s selected value controls which values display in the child field at runtime. If this type of parent/child relationship exists and you’re updating the value of a child field, note that the value of its parent field must be the same across all records selected for mass update.

To apply mass updates to assets:

1. Navigate to the **Sales > Assets**.
   The Assets landing page appears.
2. Enter the search criteria for the assets that you want to update and click **Search**.
   The application returns a list of results based on your search criteria.
3. Select the assets that you want to update at the same time.
4. Click **Update** from the **Actions** menu.
   To select or deselect assets click a record in the list. Use the select all and deselect all links to select or deselect all assets.

   **Note:** By default, all the asset attribute fields on the Mass Update dialog box are read-only until you select to update them.

5. Select the records that you want to update such as competitor asset, asset tag, and click **Update**. Assign a value for each of the selected attributes.
   The number of records you can update at once is configurable by the administrator.
6. Click **Save and Close**.
7. Click **Submit**.
Export Assets

You can export a list of assets from the application. When you export assets, the application generates a spreadsheet file that you can save locally.

To export assets, from the Assets landing page, click **Export List** in the Actions menu.

Mass Update

Overview of Mass Update of Accounts and Contacts

You can select records in bulk and update the values for fields of selected records at once, using the mass update feature. You can update fields for multiple accounts, contacts, or assets at once. For example, you can update the status or add comments for multiple accounts, contacts, or assets at the same time. You can update several fields on multiple accounts, or contacts using the **Update** action. Before you can use the mass update feature, your administrator must enable it.

The following account fields are available for update.

- Name
- Account
- Owner
- Job Title
- Phone
- Email

Here's the list of fields that you can update for contacts:

- First Name
- Last Name
- Middle Name
- Job Title
- Academic Title
- Annual Income
- Cleanliness
- Comments
- Created By
- Creation By Application
- Creation Date
- Last Updated By
- Last Updated Date
- Prefix(Salutation)
- Affinity
Apply Mass Update to Accounts and Contacts

You can use the mass update feature to update product information or primary contact information for accounts and contacts. You can also update an attribute, including company-defined attributes, on multiple accounts and contacts. For example, you might want to change a predefined field, such as primary contact or owner on multiple records. Here are few fields that you can mass update by default for an account:

- Type
- Primary Contact
- Owner
- Industry
- Sales Profile Status

Here are few fields that you can mass update by default for a contact:

- Favorite Contact
- Job Title
- Prefix
- Account
- Owner

Some fields that you can update might contain a list of values (also known as a fixed choice list field). In some cases, a list of values field can have a parent. This means that the parent field's selected value controls which values display in the child field at runtime. If this type of parent/child relationship exists and you're updating the value of a child field, note that the value of its parent field must be the same across all records selected for mass update.

Before you can use the mass update feature, your administrator must enable the update action using Application Composer. You can update several fields on multiple accounts or contacts using the Update action.

Update Accounts and Contacts in Bulk

You can apply mass updates for accounts and contacts. For the purpose of example, account is used in the procedure.

To apply mass update to accounts and contacts:

1. Navigate to the Accounts landing page from Sales > Accounts.
2. Enter the search criteria for the accounts that you want to update, and click Search.
3. In the search results, select the accounts that you want to update at the same time.
4. Click Update from the Actions menu.

Note: By default, all the account attribute fields on the Mass Update dialog box are read-only until you select them.
5. Select the attributes that you want to update and assign a value for each of the selected attributes. For account attribute lists, their default value is displayed. Text fields are blank by default.
6. Click Save and Close.

Record Management

What happens when I delete an account?

When you delete an account, the entire record is removed from the sales application and can't be restored.

In general, when you delete an account:

- The account party status becomes inactive in the database.
- The deleted account doesn't appear in the accounts list, account search, account list of values, account data quality match, segmentation, and recent items.
- The deleted account's profile and children, such as attachments and notes, can no longer be viewed.
- The account's contact relationships, if any, are deleted. The contact can still be viewed, but deleted contact relationships aren't shown in the contact.
- Deleting an account doesn't delete account-related objects, such as opportunities, leads and tasks. You can still view related objects and the account name on these objects, but you can no longer access the deleted account's details.

What happens when I delete a contact?

When you delete a contact, the record is removed and can't be restored.

In general, when you delete a contact:

- The person record of the contact is removed, including all profile data, customer usages, and group memberships.
- Relationships with associated customers or sales accounts are deleted.
- Contact points or other child objects specific to the customer-contact relationship aren't shown.
- A deleted contact isn't shown or available in any other contact or customer lists. A deleted contact isn't visible to all contact types (standalone, single, or multiple) including a customer-contact, a consumer or prospect, or in cases where the contact is both a customer contact and a consumer or prospect.
- Even if you have the functional privilege to delete a contact, you can't delete contacts unless you have full or edit access to at least one of the accounts associated with the contact.

How can I view contracts?

You can view contracts associated to your account only if the privilege of viewing contracts is assigned to your role. You can download individual contracts in PDF format, if you have the required security. Click Preview Contract, to view the contract in a PDF document format.
8 Campaigns

Overview of Sales Campaigns

This topic provides an overview of sales campaigns. Sales representatives and sales managers can create sales campaigns for reaching out to contacts within their territories. Use the sales campaigns feature from Sales > Sales Campaigns to invite contacts to an event or inform them about a product launch.

Some of the features of sales campaigns include:

- The ability to target contacts from multiple sources including the contact repository and previous campaigns.
- An easy-to-use guided process
- Access to email templates
- A response gathering and monitoring capability
- The option to personalize email for individual contacts
- The ability to schedule a campaign to launch on a specific date
- Automated follow-up for specific response types

Sales campaigns make it easy for salespeople to keep their contacts informed, announce product launches, and invite them to events. You can configure HTML email templates to send modified emails using your sales application built-in email server. The application monitors responses and can create follow-up tasks or send emails to sales campaign owners.

Create a Sales Campaign

Watch video

This topic describes how to create a sales campaign in your sales application.

Note: You should sign in as a sales representative (or higher classification) in order to create a sales campaign.

Steps to Create a Sales Campaign

1. Sign in as the sales administrator and navigate to Sales > Sales Campaigns. The Sales Campaign page appears. At the top of the page are competed campaigns, if available.
2. Click Create Campaign. The Create Sales Campaign: Select Contacts page appears.
3. Click Add Contacts. The Add: Contacts page appears.
4. Enter your search criteria and click Search.
5. In the search results list, click the check box next to each contact you want to add to the campaign.
6. Click OK to save the changes and return to the Create Sales Campaign: Select Contacts page.
7. Click the right-arrow icon to advance the page to the next step in the process, the design email step. The Create Sales Campaign: Design E-Mail page appears.
8. From the Actions list choose **Change Template** to use a different template.
9. Click **Insert Elements** to add response forms and show the Merge Fields list.
10. Select the **Personalized Message** standard field and click **Insert**, then **Done**.
   Before you create a personal message, you must insert the merge field into the body of the email where the personal message will appear. If the merge field for personalized message is not inserted into the template, the text doesn't display anywhere in the email.
11. From the Action list select **Personalize Message**.
12. Click the pencil icon next to the contact who is to receive the personalized message.
13. Enter the contents of your personalized message.
14. Enter your message and click **Ok**. Then click **Done**.
15. Click the right-arrow icon to move to the wrap-up stage. The Create Sales Campaign: Wrap Up page appears.
16. Enter the name of the sales campaign and a short description.
17. Select Immediate as the launch date for your sales campaign and click **Submit**.
   From your completed campaigns list, you can view the recently sent message, see how many contacts you targeted, and check if you have received any responses to your campaign.

Sales Campaign Management

Add Contacts to Sales Campaigns

You can select a specific set of contacts to include in a sales campaign, or you can decide to include all contacts from a previously created sales campaign.

| Note: The number of contacts to include in your sales campaign should not exceed 500. |

From the **Contacts** subtab, you can search for contacts by **Record Set, Name** or **Account**. You can add additional search criteria fields by clicking the **Add** button. This action lets you further segment and target specific contacts to include search criteria such as City, Country, Creation Date, Buying Role, and so on to further refine your search.

By selecting the **Previous Campaigns** subtab, you can select the campaign you want from the **Campaign Name** list. You can then select and apply the contacts to your campaign.

Here's how to select contacts for your sales campaign from the **Contacts** subtab.

1. Sign in as a sales representative or a sales manager.
2. Navigate to **Sales > Sales Campaigns** to go to the Sales Campaigns work area.
3. Click **Create Campaign**.
4. Click **Add Contacts** to go to the **Add: Contacts** screen.
5. Click **Contacts** subtab and enter search criteria for contacts by **Record Set, Name** or **Account**, and click **Search**.
6. Click **Add** if you need to further refine your search for specific contacts.

| Note: Click **Create Contact** if you want to create a new contact to add to your sales campaign. |

7. Select the contacts you want from the search list and click **Apply** and then **OK**.
Insert Response Forms to Sales Campaigns

You can add forms to campaign content so that recipients can respond to your campaign. You can add customer response forms to an e-mail template, track responses, and convert them to leads.

For example, during the Design E-Mail step of the creating sales campaign process, you can insert the following response forms to your campaign:

- Forward To Friend
- Request Call Back
- Requested More Information

Here's how to insert a response form to your sales campaign:

1. Sign in as a sales representative or a sales manager.
2. Navigate to Sales > Sales Campaigns to go to the Sales Campaigns work area.
3. Click Create Campaign.
4. Click Add Contacts to add the contacts you want to target for your sales campaign.
5. Go to the Design E-Mail step and select the template you want to use.
6. Place your cursor in the area of the template where you want to insert a response form link.
7. Click Insert Elements and from the Show field, select Response Forms.
8. Select the response form you want and click Insert. Repeat this step if you want to include another response form, and click Done when finished.

Add Follow-up Tasks to Sales Campaigns

You can associate follow-up tasks with customer response forms on an email template when creating a sales campaign. For example, during the final Wrap Up step of the create sales campaign process, you can associate one of these tasks to the customer response forms you inserted from the Design Email step:

- Create call back task
- Receive e-mail notification

Here's how to add a follow-up task for your customer response form:

1. Sign in as a sales representative or a sales manager.
2. Click Sales > Sales Campaigns to go to the Sales Campaigns work area.
3. Click Create Campaign.
4. Click Add Contacts to add the contacts you want to target for your campaign.
5. Go to the Design E-Mail step and select a template to use.
6. Select the response form you want, and click Insert. Repeat this step if you want to include another response form, and click Done when finished.
7. From the Wrap Up step, go to the My Follow-Up Actions, Customer Responses area.
8. From the Actions list, select the follow-up action you want to associate with each of the customer response forms you previously inserted in your email template.
Sales Campaign Content

You can personalize your sales campaign by adding components such as images, merge fields and response forms.

To create the content of your sales campaign, you can add any combination of these components:

- Images
- Merge fields
- Response forms
- Standard and other URLs
- Conditional content

Images

Add graphic images to your email. You can provide a link to an image already on a server, or select a local file and upload it to the server. Specify the size and placement of the image. You can add a URL of a publicly hosted image using the `<img src>` tag.

Merge Fields

Personalize your email message body by adding placeholders from a list of merge fields, such as the recipient's first name. Merge fields are standard sets of attributes pertaining to an individual contact. You can insert them into your email content. When you launch the campaign, merge fields are dynamically populated directly from the database. With sales campaigns you can also compose a personalized text message for each recipient.

Response Forms

Insert response forms as active links in your email campaign content. When a contact clicks one of the links, a specific response is automatically generated. All such responses are gathered and monitored, to track contacts' actions. Available response forms for sales campaigns are:

- Forward to Friend
- Request Call Back
- Request More Information

Standard URLs

You can add any of the following types of URL:

- Standard URLs are predefined and commonly used across the enterprise.
- A URL can be created when you define your email content.

By default, all standard URLs are tracked automatically. You can optionally enable tracking for other URLs, or disable tracking for standard URLs. With tracking enabled, every time a contact clicks a link in a campaign email, the click is recorded as a specific response, together with details pertaining to the URL.

Conditional Content

Conditional content is inserted or omitted based on the results of a rule. There are two elements that you can use to generate conditional content within an email:

- If-Then-Else cases are used to determine if a block of text or HTML is removed from an outgoing email, by verifying if a merge field value is defined. The merge field is defined if it isn't an empty string or, for numeric
merge fields, if it isn’t a value of 0 (zero). If the merge field is defined, the block of text or HTML remains in the outgoing email. If the merge field isn’t defined, the block of text or HTML is removed from the outgoing email.

- Named Blocks are used to decide whether to insert a block of text or HTML into an outgoing email, by comparing one string to another. If the two strings are identical, the block is inserted.

Use Conditional Content to Personalize Sales Campaign Emails

Conditional content lets you present information that’s specific to individual email recipients without having to create multiple messages. There are two ways to generate conditional content within a sales campaign template:

- Block statement personalization
- If-Then-Else personalization

Conditional content and merge fields are available in both HTML and Text format emails.

Insert Text Using Block Statement Personalization

Blocks determine whether to insert a block of text or HTML into an outgoing email by comparing one string to another:

- If the two strings are identical, the block is inserted.
- If the two strings aren’t identical, the block isn’t inserted.

Note: The string comparison is case-sensitive.

Here are the components of the block personalization element.

<table>
<thead>
<tr>
<th>Personalization Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>$(DefineBlock &quot;MatchString&quot;)</td>
<td>Starts a block of text or HTML that’s inserted in place of an Insert Block component when MatchString is identical to the MatchString of the Insert Block component.</td>
</tr>
<tr>
<td>$(EndBlock)</td>
<td>Ends a block of text or HTML that was started with the Define Block component.</td>
</tr>
<tr>
<td>$(InsertBlock &quot;MatchString&quot;)</td>
<td>A block of text or HTML is inserted at the location of this component when MatchString is identical to the MatchString of a Define Block component.</td>
</tr>
</tbody>
</table>

Let’s look at an example of a block personalization element:

You live in $(InsertBlock "${Account Country}").
$(DefineBlock "USA") <B>the United States.</B>
$(EndBlock)
$(DefineBlock "India") <B>India</B>
$(EndBlock)

If you enter USA in the Country field of the Account record, then this displays:

You live in the United States.
If a given recipient has no associated value for a block variable listed in the `InsertBlock MatchString` component, then nothing is inserted into the message for that block.

**Insert Text Using a Block Statement**

Here’s how to insert a block statement:

1. Display the email template in the HTML editor.
2. Place the cursor in the location where you want the insert the block.
3. Create the Insert Block statement as follows:
   - In the editor toolbar, select **Insert Block** from the rule conditions drop-down list.
   - In the next drop-down list, select the record the field comes from: Contact, Account, or Campaign.
   - In the next drop-down list, select the field in the record.
   - Click **Insert**.
4. Here’s how to create a Define Block component:
   - In the drop-down list immediately within the email tag, select **Create Block**.
     - A `$ (DefineBlock "")` and `$ (EndBlock)` statement appear in the text.
     - Type a field value within the quotation marks of the `$ (DefineBlock "")` statement.
     - This is the value that drives the content displayed in the block.
     - Type the text that you want to insert into the email between the `$ (DefineBlock "")` and `$ (EndBlock)` tags.
5. Repeat Step 4 until you have added all the Define Block components that you need.

**Insert or Remove Text Using If-Then-Else Personalization**

You can insert or remove text in your email depending on the value of a merge field by using If-Then-Else personalization. The merge field is defined if it contains a value, or, for numeric merge fields, if the value isn’t 0 (zero).

- If the merge field is defined, the text remains in the outgoing email.
- If the merge field isn’t defined, the text is removed from the outgoing email.

Here are the components of the If-Then-Else personalization element.

<table>
<thead>
<tr>
<th>Personalization Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>$ (if {Record.FieldName})</td>
<td>Use the If component to start an If-Then-Else personalization element. It determines whether the merge field named [FieldName] has a value. If there’s a value for [FieldName], the text between this If-Then-Else component and the next If-Then-Else component isn’t removed from the email.</td>
</tr>
<tr>
<td>$ (elseif {Record.FieldName})</td>
<td>Ends a block of text or HTML that was started with the Define Block component.</td>
</tr>
<tr>
<td>$ (else)</td>
<td>Use the Else component after a $ (if) or $ (elseif) component. If the preceding $ (if) or $ (elseif) component removes the preceding block of text or HTML from the email, the $ (else) component’s block of text or HTML is included in the email. If the preceding $ (if) or $ (elseif) component doesn’t remove its block of text or HTML, the $ (else) component’s block of text or HTML isn’t included in the email.</td>
</tr>
</tbody>
</table>
Here's an example of an If-Then-Else personalization element:

```plaintext
$(if ${Contact.First Name})
Dear ${Contact.First Name}${Contact.Last Name},
$(else)
Dear Mr. or Ms. ${Contact.Last Name},
$(endif)
```

- If the Contact.First Name field is defined, the email begins with “Dear First Name Last Name”.
- If the Contact.First Name field isn’t defined, the email begins with “Dear Mr. or Ms. Last Name”.

You can use If-Then-Else statements similarly to block statements, by including operators such as Equal to, Starts with, Or Contains. You can select these operators from a drop-down list when you generate If or If-Else statements. Unlike blocks, this permits you to insert conditional content where the variable is true or not true.

For example, to modify the email with a condition for accounts in the state of California, you use the following statement:

```plaintext
$(if ${Account.Bill to State} == "CA") Join us all month long for special events and workshops held in each of our California locations.
$(else) Join us all month long for weekly online workshops and special offers at www.mycompany.com/events.
$(endif)
```

You can also nest If-Then-Else statements, placing one within another.

**Note:** The components of personalization elements must be placed in the correct locations in the text. Any incorrect placement causes an error.

### Insert an If-Then-Else Personalization Statement

Here's how to insert an If-Then-Else statement:

1. Display the email template in the HTML editor.
2. Place the cursor in the location where you want the If-Then-Else statement.
3. Create the If or ElseIf statement as follows:
   - In the editor Toolbar, from the drop-down list, select either If or ElseIf.
   - In the next drop-down list, select the record the field comes from: Contact, Account, or Campaign.
   - In the next drop-down list, select the field in the record.
   - In the next drop-down list, select the operator.
   - In the next text box, enter the value that the field is compared with.
   - Click Insert.
4. Following the If or ElseIf statement, enter the text that appears if the condition in the statement is satisfied.
5. At the end of the entire If-Then-Else statement, enter $(endif).
Example of Adding Personalized Text in a Sales Campaign

You are creating a sales campaign inviting contacts to an event that your company will host next month. You already have a template that provides most of the information.

In addition to standard merge fields that will automatically populate contact data, you want to add a more personal touch, for a selected few contacts, to the otherwise generic email content.

Add Personalized Text

1. Create a campaign, enter the details, select all the contacts for the campaign (not just the ones to whom you will send a personalized message) and, optionally, choose a template.
2. When you edit the email content, add the personalized text merge field where you want the personalized text to appear.
3. When you enter advanced options, locate the contact for whom you want to create a personal text in the list of contacts. Click the edit icon in the Personalize column to open a new HTML editor window where you can enter a message for the selected contact. You can apply styles just as in the common area of the email. You can preview and edit the personal message until you have what you want. You can repeat this step to create individual personal messages for as many contacts as you choose.

Response Follow-Up Actions for Sales Campaigns

When you create a sales campaign, you may want to be notified automatically when a targeted contact responds in a specific way. You can associate follow-up actions with specific responses, so that the follow-up action is triggered automatically when a contact responds to your campaign email.

Response Form

You can include response forms in the content of your campaign. These appear to recipients as links that they can click within the email. Every click is recorded, and used to track usage statistics. In addition, each response can also trigger an associated action to be performed automatically.

Follow-up Action

Follow-up actions are predefined actions that can be triggered by contacts' responses. The purpose of these actions is to inform you, the creator of the campaign, when a particular contact clicks a specific response. You can choose to either receive this information in an email notification, or by the creation of a task that appears in your user task list. In either case, the information you receive includes campaign details, contact details, the specific response that the contact submitted, and the date and time of the response submission.

FAQs for Sales Campaigns
What is the recommended limit of contacts to include in a sales campaign?

The number of contacts to include in your sales campaign should not exceed 500. Oracle recommends to create a new sales campaigns if you want to add more contacts beyond the recommended specification.

What campaign records do the different record sets permit you to search?

The different record sets provided in the Saved Searches window restrict your saved searches to different sets of sales campaigns.

The following table lists and describes the record sets for sales campaigns. Not all record sets are available to all users. For example, the record set involving subordinates is available only to managers.

<table>
<thead>
<tr>
<th>Record Set Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>I own</td>
<td>Sales campaigns that you created.</td>
</tr>
<tr>
<td>My subordinates own</td>
<td>Sales campaigns owned by your subordinates.</td>
</tr>
<tr>
<td>All records I can see</td>
<td>Sales campaigns that you can view based on your sales team membership, your position in the organization, and security permissions.</td>
</tr>
</tbody>
</table>

Tip: To improve saved search performance, restrict your saved searches to smaller record sets. For example, rather than searching all the records you can see, search all the records you and your subordinates own. Or restrict your searches to a smaller geographical area. For example, search all the sales campaigns in one state instead of the whole country.

How can I add optional text to the Forward to Friend response form?

Using the Design E-Mail step of the Sales Campaigns process, insert the `Forward to Friend` link from the Insert Elements > Response Forms list. Next, show the Merge Fields list, and insert the `Forwarder Message` standard merge field in the message content: `$(Standard.ForwarderMessage)`. The standard merge field is replaced with any optional text you might enter when you forward the e-mail campaign to your friend using the Forward to Friend link.
What sales campaigns display when I select the My Draft Campaigns and the My Completed Campaigns lists?

When you select the **My Draft Campaigns** list in the Sales Campaigns work area, the application displays a list of all of the campaigns you own that are pending activation. Selecting the **My Completed Campaigns** list displays all sales campaigns you own that have been completed within the last three months.

**Marketing Content**

**Treatment Components**

Use treatments to represent the combination of a marketing message for targeted audience members and delivery options for third-party suppliers. This topic provides a brief overview of the treatment components. A treatment defines the channel-specific marketing message for targeted audience members. For example, depending on the channel you select, the treatment can include options that control how marketing messages are sent to third-party suppliers. You can change the content and attach marketing collateral to personalize a treatment for a specific segment.

Treatments can contain these components:

- Products and promotions
- Distribution options
- Associated lists
- Confirmation e-mails
- Content and attachments

**Products and Promotions**

When you create treatment content, you can:

- Associate products and product groups with treatments.
- Use the available collateral for the products and product groups.
- Associate time-limited promotions and coupon codes to support the tracking of offers given to customers.

**Distribution Options**

Select the supplier and the supplier’s distribution profile if you use a supplier to fulfill your marketing campaign. The distribution profile provides instructions for creating and delivering campaign information to the supplier when the campaign is launched.

**Associated Lists**

In addition to your external recipients, you can associate a predefined list with your campaign. A predefined list is a static list of internal employees who receive the same campaign information as your external recipients. Sending your campaign content to a predefined list is a useful way to verify the quality of service that the supplier is providing to your contacts.
A subscription list associated with a treatment is the list of contacts that's updated when e-mail recipients select whether they want to subscribe or unsubscribe. You can associate a subscription list with multiple treatments. You can use a treatment-specific subscription list to have opt-in and opt-out responses associated with a particular list.

**Confirmation E-Mails**

If you're required to confirm or cancel a subscription, then you must have three treatments. To illustrate this requirement, consider the following example of three treatments that are referred to as Treatment One, Treatment Two, and Treatment Three.

Treatment One offers recipients the options to request a subscription or cancel a subscription. Those who respond receive a second e-mail to finalize their request. Although Treatment One is the first treatment to be sent, it's the last that you create because it refers to the other two treatments. The table shows the required attributes and values for Treatment One.

<table>
<thead>
<tr>
<th>Treatment Step</th>
<th>Attribute</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Treatment Details</td>
<td>Channel</td>
<td>E-mail</td>
</tr>
<tr>
<td>Channel Details, Confirmation E-Mails</td>
<td>Confirm-in Treatment</td>
<td>Click the <strong>Subscribe confirmation request</strong> link included in the e-mail content. For this example, select Treatment Two.</td>
</tr>
<tr>
<td>Channel Details, Confirmation E-Mails</td>
<td>Confirm-out Treatment</td>
<td>Click the <strong>Unsubscribe confirmation request</strong> link included in the e-mail content. For this example, select Treatment Three.</td>
</tr>
<tr>
<td>Content</td>
<td>Response Forms</td>
<td>Click <strong>Subscribe confirmation request</strong> or click <strong>Unsubscribe confirmation request</strong></td>
</tr>
</tbody>
</table>

Treatment Two provides the subscribe confirmation request to recipients who click the **Subscribe confirmation request** link included in the e-mail content of Treatment One. Recipients who respond to Treatment Two are added to the subscription list associated with this treatment. This table shows the required attributes and values for Treatment Two.

<table>
<thead>
<tr>
<th>Treatment Step</th>
<th>Attribute</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Treatment Details</td>
<td>Channel</td>
<td>E-mail confirmation in</td>
</tr>
<tr>
<td>Channel Details, Associated Lists</td>
<td>Subscription List</td>
<td>Select a list</td>
</tr>
<tr>
<td>Content</td>
<td>Response Forms</td>
<td>Subscribe to list</td>
</tr>
</tbody>
</table>
Treatment Three provides the unsubscribe confirmation request to recipients who click the **Unsubscribe confirmation request** link included in the e-mail content of Treatment One. Recipients who respond to this Treatment Three are removed from the subscription list associated with this treatment. This table shows the required attributes and values for Treatment Three.

<table>
<thead>
<tr>
<th>Treatment Step</th>
<th>Attribute</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Treatment Details</td>
<td>Channel</td>
<td>E-mail confirmation out</td>
</tr>
<tr>
<td>Channel Details, Associated Lists</td>
<td>Subscription List</td>
<td>Select a list</td>
</tr>
<tr>
<td>Content</td>
<td>Response Forms</td>
<td>Unsubscribe from list</td>
</tr>
</tbody>
</table>

**Content and Attachments**
To create your content, select a treatment template, or you can start with a blank page. You can either upload content from your desktop or switch the HTML editor to source mode and paste the HTML source code.

In the body of the e-mail, include text, merge fields, graphic links, and response forms. If you have both plain text and HTML versions of the treatment, the MIME standard ensures that the appropriate version is delivered to each recipient’s email client. You can attach a file, a URL, or a text block to the treatment. You can also select product specific content.

**Guidelines for Creating Global Sales Campaigns**
When you create campaigns that target multiple geographic regions, languages and currencies, consider what products to market, what languages to include, and how the campaigns will be fulfilled. Here’s some typical factors to consider:

- Product eligibility
- Contact Lists
- Treatments
- Campaigns

**Product Eligibility**
You must select products that apply to each geographic area that you target with your global campaign.

**Contact Lists**
You can create lists of contacts that are filtered by language or by geography. Name your lists so that you can identify them by language when you add your contacts to your sales campaign.

**Treatments**
If you have multiple language-specific contacts, then you must create a corresponding treatment for each language. Name your treatments so that you can identify them by language when you add them to your sales campaigns. When creating your marketing message and choosing supporting product collateral, consider the following:

- Marketing message text
- Text, images, and colors included in graphics
- Date and time formats
- Currency and local taxes
- Content of any collateral attached to the treatment
- Content of any web pages linked to the treatment

You must also verify that your third-party fulfillment supplier can manage your language requirements.

Campaigns
For campaigns, you can create separate treatment template for each language. For example, for Latin America, you could create a Spanish campaign applicable to multiple countries and a Brazilian Portuguese version for Brazil.

Marketing Source Codes
A marketing source code is a unique identifier that represents a sales campaign or marketing activity and is used to track marketing effectiveness.

Source Codes
Marketing source codes are automatically generated for every sales campaign and marketing activity. To view a listing of source codes and associated campaign components, navigate to the Review Marketing Source Codes task from Setup and Maintenance. Note that a source code can be listed more than once in this page to support querying on specific promotions and coupons.

Associate Source Codes to Responses and Leads
Source codes associated with responses and leads provide a reference to sales campaign activities for tracking campaign effectiveness.

You can provide a source code when creating, editing, or importing a response. A response generated as a result of an e-mail campaign trackable URL or an e-mail bounce inherits the source code derived from the originating e-mail sales campaign.

A source code can be associated with leads when designing a sales campaign, when manually creating or editing a lead, or when importing a lead. A lead created from a converted response inherits the source code from the response.

FAQs for Marketing Content
What happens to existing campaigns if I update the campaign template?
Existing campaigns that were created from the template are unaffected. Your changes will only affect campaigns created after the template is updated. Campaign templates provide models to use as a basis when planning and designing sales campaigns. When you use a template to create a sales campaign, the template values are copied to the new campaign and the template’s purpose then ends for that campaign.
What's the difference between a predefined list and a subscription list?

A predefined list is a static list of contacts.
A subscription list is another type of static list. When associated with a specific treatment that has subscription response forms included in the treatment content, it will reflect the responses of campaign recipients who choose to subscribe.

Marketing Campaigns

Overview of Campaign Management and Reporting

You can store marketing related data, such as campaigns and campaign members created and updated in Oracle Marketing Cloud, in your sales application. Campaign management and reporting is greatly improved by having campaign related data maintained and synchronized between Oracle Marketing Cloud and Oracle CX Sales.

You can view meaningful information about marketing campaigns and campaign members from the Campaigns user interface. The Campaigns UI provides visibility into the campaign effectiveness to support the sales processes. For example, you can view the campaigns and campaign members associated with a given lead and contact to gain key insights for closing a sale.

In addition, your administrator can also display a campaigns subtab and an Add to Campaign button on the Leads and Contacts user interface pages from where you can view data about the marketing campaigns and add the associated leads and contacts to the campaign. Add contacts or leads to marketing campaigns from these locations within your sales application:

- Campaigns subtab on the Edit Contact page
- Campaigns subtab on the Edit Lead page
- Campaign Members subtab on the View Campaign page

Use the campaign summary data to view associated leads, contacts, opportunities, and revenue amounts. The total number responding to a campaign represents the total count of campaign members who have responded to a marketing campaign. Campaign members include either leads or contacts that were sent or responded to a marketing campaign and have a status of Responded or Sent. Note that the response is only counted once even when a campaign member has responded multiple times to the same campaign.

Related Topics

- Enable the Campaigns Subtab and Add to Campaign Button in Leads
- Enable the Campaigns Subtab and Add to Campaign Button in Contacts
- Enable the Campaign Analytics Tab in Campaigns List Page
About Campaign Management Reports

You can view predefined campaign-related reports and charts to determine the effectiveness of your campaigns and evaluate how they're progressing and performing. You can also create your own specific Campaign reports and charts using the Campaign and Campaign Member subject areas to suit your business needs.

The following subject areas enable the creation of reports on the Marketing Cloud and your sales application data.

- Campaign Members
- Campaign Opportunities

For example, sales and marketing operations can run campaign related reports and perform analysis on marketing attribution and evaluate a campaign's return on investment (ROI). The Profile link on the View Campaign shows some details about the campaign such as name, type and current status of the campaign. It also shows the owner, and the dates when the campaign started and ended as well as a brief description and costs of the campaign. Your administrator can use Application Composer to expose or hide such details or change the layout of the fields as they appear in the Profile page.

The Campaign Analytics subtab on the View Campaign page shows the campaign member dashboard. Your administrator can use Application Composer to expose a Campaign ROI dashboard from the Campaign List page.

Access these reports by clicking the Campaign ROI Analytics link from the Campaign List page.

<table>
<thead>
<tr>
<th>Report</th>
<th>Access this report to...</th>
</tr>
</thead>
</table>
| Campaign ROI Analysis   | • Determine how each of your campaigns are performing.  
• Measure the effectiveness of the campaign by calculating the return on investment (ROI) and average costs for your campaigns.  
  The Actual ROI is represented as a percentage (total opportunity revenue minus the actual cost divided by the actual cost).  
  View the pipeline ROI calculated as a percentage (total revenue on open opportunities minus the actual cost divided by the actual cost).  
• Filter the report data by campaigns with start date in the last 180 days.  
  Other time filter criteria include last quarter, last two quarters, and last year. You can set your own time period to run this report. |
| Campaign Revenue        | • Measures the total revenue of successful campaigns that are tied to won opportunities.  
• Analyze which won opportunities have resulted from which campaigns.  
• Filter the report data by campaigns with the default start date in the last 180 days.  
  Other time filter criteria include last quarter, last two quarters, and last year. You can set your own time period for which to run this report. |
| Top Campaigns           | • Displays the top 20 campaigns having the highest ROI in the last six months.  
• View the total revenue won opportunities value for each of the campaigns. |
Add Leads and Contacts to Marketing Campaigns

You can include contacts and leads created from your sales application as campaign members to your marketing campaigns created and updated in Oracle Eloqua. After the added campaign members are synchronized to Oracle Eloqua, they get added to the specified marketing campaigns.

Add contacts or leads as campaign members to marketing campaigns from these locations within your sales application:

- Campaigns subtab on the Edit Lead page
- Campaigns subtab on the Edit Contact page
- Campaign Members subtab on the View Campaign page

**Note:** These subtabs are hidden by default but your administrator can make them available to you through Application Composer. See the related topics for more information.

Add a Lead or a Contact to Campaigns

From the **Campaigns** subtab in your Edit Lead and Edit Contact pages, you can add a lead or contact that you want to an existing marketing campaign as campaign members. Once you click **Add to Campaign** you select the specific campaigns to where your leads or contacts are added.

Here's an example of how to add a lead to a marketing campaign from the Edit Lead UI:

1. Sign in as a sales representative or a sales manager.
2. Navigate to **Sales > Leads** to go to the Leads work area.
3. Select a lead that you want to add as a campaign member to a marketing campaign.
4. From the Edit Lead page, click the **Campaigns** subtab.
5. Click **Add to Campaign** to go to the **Add: Campaigns** screen.
6. Search for and select the existing marketing campaigns that you want.
7. Click **Apply** and then click **OK**.

The selected lead is now included as a campaign member in your selected marketing campaigns.

To add a contact to a marketing campaign, go to the **Sales > Contacts** work area and follow similar steps. From the Edit Contact page, click **Add to Campaign** and select the specific campaigns to where you want your contact added as a campaign member.

Add Leads and Contacts to a Campaign

When you have added the marketing campaigns that you want, you can view and access them from the Campaign Members subtab on the Campaign Details page.

From here, you can add additional campaign members (leads and contacts) as follows:

1. Navigate to the **Campaigns** work area.
2. From the View Campaigns: Overview page, select and open a campaign that you want to add additional leads and contacts.
3. Click the **Campaign Members** subtab.
4. Click **Add Contacts** to go to the **Add: Contacts** screen.
5. Search for and select the contacts that you want to add to your existing marketing campaign as campaign members.
6. Click **Apply** and then click **OK**.

   ![Note: You can’t remove contacts from a campaign once the campaign is activated.](image)

The selected contacts are now included as campaign members to your selected marketing campaigns.

Similarly, if you want to add additional leads as campaign members to an existing marketing campaign, click **Add Leads** to go to the **Add: Leads** screen and follow similar steps.

### FAQs for Marketing Campaigns

**How can I view the amount of responses for a campaign?**

From the Campaigns List page, you can drill down into each campaign record to view campaign members that have responded to a given campaign, and view campaign member details. In addition, you can view campaign details including campaign name, start and end dates, status, and other standard or custom attributes.

The total number responding to a campaign represents the total count of campaign members with a status of **Responded**. Note that the response is only counted once even when a campaign member has responded multiple times to the same campaign.

**How many campaign members are associated with a campaign?**

From the Campaigns List page, you can drill down into each campaign record to view campaign members that have responded to a given campaign. You can also access the Campaign Members report that shows the amount of members in a campaign from the **Campaign Analytics** subtab on the **View Campaign** summary page. You can filter the report data by lead or contact name and response date range.

Your administrator can filter what user-defined or predefined campaign related reports to display to campaign users. For example, the default Campaign Analytics subtab search filter is **Record Set = All Members**. This search returns all campaign members with a status of **Responded and Sent**.
9 Leads

Overview of Lead Management

Leads provide a way for your sales organization to capture the potential interest in your products. After your organization qualifies the information and determines the lead is worth pursuing, you turn it into an opportunity and the sales process begins in earnest.

Use the Contact time zone field to capture the preferred time zone of a contact pursued on your lead. The contact time zone is based on the contact address and helps you know the preferred time to call or email a prospect or customer. You can also use the functional who columns to capture the record history of a lead. The columns let you accurately report on leads that are imported from other systems.

Other lead management features help to align marketing and sales objectives from lead generation to lead execution. Lead information is generated from a variety of sources and captured from:

- A company's existing contacts
- Sales campaigns

All leads then undergo the qualification and assessment process and are qualified either manually by a salesperson or automatically based on predefined rules. Finally, qualified leads are converted into opportunities.

Lead Processing

Overview of Lead Processing

Lead data is generated from a variety of sources and goes through further enrichment based on updates and follow-up activities. As a result, lead quality must be assessed periodically so that leads are distributed to the right salesperson to ensure timely lead follow up and closure.

This section contains information about how to import lead data from an external data source into your sales application using the Import Management feature.

How File-Based Data Import Works

The Define File Import group of tasks relies on integration with different architecture components, such as interface tables and application base tables. This topic provides an overview of these components to help you understand the import process and the different import activity statuses.

The following figure provides an overview of the major application components used when you import data from a file. These components include:

- Import object
- Import mapping
- Import activity
- File repository
- Application Composer
- Interface tables
- Base tables

You select the import object during setup. The import mapping is used in the import mapping step. The import file you upload is stored in a file repository. The additional attributes that you create in the Application Composer are stored in a separate extensions repository and are available for import and in the import mapping.

**Note:** If you change the NLS_LANG and the DATE_FORMAT environment variables, you must restart the Oracle Fusion applications.

**Import Objects, Import Mapping, and Import Activity**

When you create an import activity, the import objects you select are provided by Oracle. You manage these import objects using the Manage File Import Objects task.
Note: Avoid concurrent submission of File Import jobs for the same import object. Concurrent submission of multiple import jobs with same content results in creation of duplicate object records.

When you create an import activity, you must specify a mapping of the fields in your file to the attributes of the import object. You can create the mapping while creating an import activity or separately using the Manage File Import Mappings task. The mapping is stored and managed as a separate object.

File Repository
The text or XML data file that you upload during import is stored in a file repository. If you upload any attachments, they're also stored in the same repository.

Application Composer Extensions
When you create additional attributes for data import using the Application Composer, the extensions are stored in a separate repository and are available for import and export.

Interface Tables
The import activity populates the application interface tables with your data.

Base Tables
The import activity loads your data into the base tables to complete the import.

Related Topics
- File Import Activity Statuses
- Import Data from a File

Overview of Sales Lead Import
You can import sales lead data from an external data source into Oracle Engagement Cloud using the File-Based Data Import feature.

Consider the following questions when importing your data:

- How does your legacy or source system store and represent the sales lead information when compared to Oracle Engagement Cloud?
- Do you have to configure values in Oracle Engagement Cloud to map your existing data to the Sales Lead import object?
- Do you have to extend Oracle Engagement Cloud to add attributes?
- What import features are available to import your business data?
- How do I verify my imported data?

How Business Objects Are Structured
You must understand how your sales lead data corresponds with the data in Oracle Engagement Cloud to map your legacy data to the data in Oracle Engagement Cloud.

The Sales Lead object is hierarchical. Ensure that a sales lead exists before you can import its child objects, such as team members and activities. These child objects can in turn consist of other objects. You use this structure to support one-
to-many relationships between the objects that make up the sales lead. The image shows the sales lead object and its child objects.

The top-level sales lead object contains basic information about the account or prospect details, status, and deal size. For each sales lead, you can assign:

- Contacts
- Sales team members
- Products

You can also:

- Track activities and assign due dates
- Attach documents relevant to the sales lead
- Post notes for the sales lead

**Import Objects for the Lead**

To facilitate importing leads, Oracle Engagement Cloud incorporates the structure of the sales lead into import objects. The following table lists the import objects for the lead.

<table>
<thead>
<tr>
<th>Import Object</th>
<th>Structure</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lead</td>
<td>Contacts</td>
</tr>
<tr>
<td></td>
<td>Sales Team</td>
</tr>
<tr>
<td></td>
<td>Products</td>
</tr>
<tr>
<td></td>
<td>Attachments</td>
</tr>
<tr>
<td></td>
<td>You can create accounts and contacts, or associate existing accounts and contacts. You can optionally create campaign responses that are associated with the leads.</td>
</tr>
<tr>
<td>Note</td>
<td>Notes</td>
</tr>
<tr>
<td></td>
<td>Attachments</td>
</tr>
<tr>
<td>Activities</td>
<td>Activities</td>
</tr>
</tbody>
</table>
How Business Object Attributes are Structured

Every import object is a collection of attributes that help to map your data to the Oracle Applications Cloud data and to support one-to-many relationships between the structural components of a sales lead.

You must understand the attribute details of the import objects so that you can prepare your import data. You can use the import reference guide (File-Based Data Import for Engagement) files that contain:

- Attribute descriptions
- Values that populate attributes by default when you don’t provide values
- Validation information for each attribute

The validation information includes the navigation path to the task where you can define values in Oracle Application Cloud. For example, if you have values in your data that correlate to a choice list in Oracle Application Cloud, then the validation information provides the task name where you can define your values. For additional information, such as a list of reference guide file names and locations, see the topic How Sales Lead Import Objects Work Together. Listed in the table below are the import objects and the related import object topics.

<table>
<thead>
<tr>
<th>Import Object</th>
<th>Related Import Object Topic</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lead</td>
<td>Lead Import Object and Attributes: How They Work Together</td>
</tr>
<tr>
<td>Note</td>
<td>Note Import Object and Attributes: How They Work Together</td>
</tr>
</tbody>
</table>

You can explore related topics by entering the following keywords in the Help application search: importing leads

Configurable Attributes

Here is how you can configure the objects to import your legacy or source data:

- Use the Application Composer to design your object model extensions and to generate the required artifacts to register your extensions.
- Make the artifacts available for importing the object.

You can map these configurable attributes to your source file data. You can use the same source file to import both the configurable attributes and the standard import object attributes.

How You Import Sales Leads Using File-Based Data Import

You must first prepare a source data file to import sales leads. The source file can be either an XML file or a text file, such as a CSV files. You use the file import process to:

1. Read the data in your source file.
2. Populate the interface tables according to your mapping.
3. Import the data into the application destination tables.

The Define File Import Setup and Maintenance task list includes the tasks required to:

- Configure the import objects
- Create source file mappings
- Schedule the import activities

You can also access these tasks from the Data Import and Export functional area of the Sales offering. You submit file import activities for each import object. When you're creating a new sales lead, you use the Lead object to import your data. You must have one of these job roles to access and submit the import activities for sales leads.

- Corporate Marketing Manager
- Marketing Analyst
- Marketing Manager
- Marketing Operations Manager
- Marketing VP
- Sales Lead Qualifier
- Sales Representative

How You Verify Your Imported Data

You can use the File Import activity reports to verify imported data. Alternatively, you can also navigate to the Sales Lead work area to view the sales lead information that you have imported.

Related Topics

- About File-Based Import Documentation
- How Sales Lead Import Objects Work Together

Lead Follow Up

How Lead Components Work Together

The lead life cycle includes an automated process that captures leads and then prioritizes them for sales engagement through a scoring and ranking process. Leads are distributed to appropriate sales resources for further lead qualification, follow-up, and conversion. A sales lead cycle ends when salespeople convert a lead to an opportunity or when they retire a lead. A lead is retired if no possibility exists for converting the lead to an opportunity.

Leads Life Cycle

Leads are automatically monitored for sales representative acceptance. Unaccepted or rejected leads are reassigned as appropriate. The quality of the lead is continuously reviewed and adjusted by the lead owner at different stages of the lead life cycle. The lead owner can be a marketing resource or a sales resource, depending at what stage the lead is at in its life cycle. The lead life cycle is captured in the following sections:

- Lead Generation
- Lead Qualification
- Lead Distribution
- Lead Assessment
Lead Conversion

Lead Generation

Leads are generated and captured from many different sources such as:

- Campaign responses
- Third-party lead sources

Flexible lead import, customer and contact creation, and deduplication ensure that sales lead generation efforts are optimized. For example, the lead import process checks whether leads represent new or existing customers. For new customers, data must be created for the lead. If the lead is an existing customer, then part of the lead import process checks to ensure customer and lead information isn't duplicated.

Lead Qualification

Marketing departments help with the lead qualification process to ensure that only qualified leads are handed over to sales. Leads are typically ranked as Hot, Warm, or Cool. Leads are further qualified by the use of company-specific standard questions to score a lead. Lead scores are numeric values typically ranging from 1 to 100, in which a high score represents high quality.

It isn't good practice to let stale leads build up. Standardized criteria for lead qualification ensure that quality leads reach the sales representative and help maximize the conversion rate from leads to opportunities. For example, your organization has criteria and processes for ensuring that leads are either developed or retired within 30 days. When the lead age is greater than 30 days and the rank is Warm, Marketing reassigns the leads for follow-up by an internal telemarketing group. If leads can't be qualified or further developed to revenue opportunities, then rejected leads are reassigned or manually set to retired.

Lead Distribution

As the qualification of leads progresses into real potential prospects, assignment manager uses expression-based rules to associate one or more internal sales representatives with each lead. If the lead is associated with either a sales prospect or a sales account, then assignment manager uses territory definitions to associate (typically one) internal territory with each lead. The sales representative newly assigned to the lead can be related to the lead record directly through the lead team or indirectly through a territory associated with the lead. The sales representatives can view and update those leads assigned to them in the lead work area and can claim ownership of the lead by accepting the lead.

Other assigned resources can view and update the lead, but they can't make themselves the owners. If a sales prospect changes to a sales account by adding an address, assignment manager is automatically called during the next automated assignment cycle. Depending on the assignment logic, the lead can be reassigned to a different territory or sales resource. If the assigned sales representative takes no action on a lead for several days, then the lead can be manually reassigned to another sales representative.

Lead Assessment

Sales representatives must evaluate the quality of the information that they have received for the lead. They determine whether the details are sufficient to reach out to the customer and assess whether a lead is worth pursuing with the help of preconfigured assessment templates. Assessment templates help qualify the lead by:

- Reviewing the content shared with the customer during a campaign
- Framing the lead in the context of the campaign
- Ensuring the salesperson understands the information sent to the customer

You use the lead assessment feature to assess leads. Predefined questions help determine the likelihood of the lead being accepted by Sales. For example, you're a sales representative and you ask the customer a series of questions
created by Marketing and Sales to assess the quality of the lead. You record the answer of each question and the lead assessment tool automatically factors the answer into the assessment score of the lead. At the end of the call, you note that the assessment lead score is high, so you request that the lead is assigned to the direct sales team. If the lead score was low, then you might want to retire the lead. If the lead needs qualifying, then you can decide to leave it in your list of leads for follow-up. Finally, if the lead is good, but the potential revenue opportunity is less than a predetermined monetary amount, for example, twenty-five thousand dollars, then you can convert the lead to an opportunity to pursue as part of the sales cycle.

**Lead Conversion**

After establishing that the lead has potential, the sales representative can convert the lead to an opportunity. You can schedule meetings and presentations with your lead contact to move the opportunity along the sales pipeline. To track the progress of the lead, you can capture contact notes and associate them with the contact and opportunity. As the lead progresses through its life cycle, decisions to retire the lead are based on reasons such as:

- You can't verify the customer and lead details.
- The customer isn't interested in pursuing the lead any further.

**Differences Between Response, Lead, and Opportunity**

This table describes the main differences between a response, a lead, and an opportunity.

<table>
<thead>
<tr>
<th>Response</th>
<th>Lead</th>
<th>Opportunity</th>
</tr>
</thead>
<tbody>
<tr>
<td>A response is an interaction initiated by the customer in response to a</td>
<td>A lead is an inquiry, referral, or other information, obtained through</td>
<td>An opportunity is a pending sale of a product or</td>
</tr>
<tr>
<td>marketing stimulus. Every outbound sales activity is a sales stimulus.</td>
<td>a sales campaign, or other means that identifies:</td>
<td>service that can be forecasted and tracked using</td>
</tr>
<tr>
<td></td>
<td>- Potential contact or prospect</td>
<td>summary data such as:</td>
</tr>
<tr>
<td></td>
<td>- Specific purchase interest</td>
<td>- Potential revenue</td>
</tr>
<tr>
<td></td>
<td>You can create a lead if the specific purchase interest isn't known</td>
<td>- Sales stage</td>
</tr>
<tr>
<td></td>
<td>at the time. However, to qualify a lead you must record a primary</td>
<td>- Win probability</td>
</tr>
<tr>
<td></td>
<td>purchase interest.</td>
<td>- Expected close date</td>
</tr>
<tr>
<td>Responses are created from interest recorded in response to sales</td>
<td>Leads are mostly created by automated lead capture or lead import</td>
<td>Opportunities are created by sales administrators when they have identified a qualified lead with a potential revenue opportunity. Leads are converted to opportunities when significant sales investment is foreseen to close the deal.</td>
</tr>
<tr>
<td>activities. Responses include:</td>
<td>processes which periodically create qualified responses as sales</td>
<td>A salesperson can create opportunities from scratch, without previously having a response or lead created.</td>
</tr>
<tr>
<td></td>
<td>leads.</td>
<td></td>
</tr>
<tr>
<td>- Providing answers to phone survey questions</td>
<td>Leads are sometimes created from the response data of a contact or</td>
<td>Inclusion of opportunities in the sales forecast is at the discretion of the sales administrator. However, not all</td>
</tr>
<tr>
<td>- Subscribing to a list</td>
<td>prospect who has expressed a need or interest in a product or service</td>
<td></td>
</tr>
<tr>
<td>- Replying to an email response form request</td>
<td>offered by the business.</td>
<td></td>
</tr>
<tr>
<td>As interest for the product or service matures, responses are</td>
<td></td>
<td></td>
</tr>
<tr>
<td>elevated as leads.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Responses aren't included as part of the sales forecast.</td>
<td>Leads aren't included as part of the sales forecast.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

ORACLE
Lead Actions

Use lead actions to manage leads. This topic provides a brief description of the actions that you perform on a lead. Lead actions are generally grouped into these categories:

- Standard create, edit, delete, and update functions such as performing a mass update
- Ranking, scoring, and qualifying actions to assist in prioritizing leads
- Accepting, rejecting, reassigning, and retiring actions to ensure leads are in the right queue for pursuing
- Converting leads to opportunities to continue sales pursuits and include in sales forecasting

The ability to perform each action depends on:

- Privileges assigned to your role
- Access level as a lead sales team member
- Current status of the lead

Lead Actions

Here are some of the actions you perform to manage leads.

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mass Update</td>
<td>Performs a mass update of specific attributes and user-defined attributes from the Leads Overview work area when selecting multiple records.</td>
</tr>
<tr>
<td>Rank</td>
<td>Submits the Request Sales Lead Assignments process to automatically assign a lead rank based on predefined rules specified in the Assignment Rule for Ranking Leads profile option. A rank represents the priority of the lead, such as Hot, Medium, and Cool.</td>
</tr>
<tr>
<td>Score</td>
<td>Submits the Request Sales Lead Assignments process to automatically assign a lead score based on predefined rules specified in the Assignment Rule for Scoring Leads profile option. Lead assignment score is different from qualification and assessment scores. A lead score can be used as a source for predefined rules that automatically assign lead rank, qualification status, territories, and resources.</td>
</tr>
<tr>
<td>Qualify</td>
<td>Updates the lead status to Qualified, bypassing the automated sales lead classification process.</td>
</tr>
<tr>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Reassign</td>
<td>Provides choices for when the sales lead assignment process evaluates the lead to reassign sales team members and territories to the lead:&lt;br&gt;&lt;br&gt;<strong>Automatic assignment</strong>&lt;br&gt;Lead is selected for reassignment and is reassigned when the Request Sales Lead Assignments process next runs using the Reassign process selection criteria.&lt;br&gt;&lt;br&gt;<strong>Immediate automatic assignment</strong>&lt;br&gt;Immediately runs the Request Sales Lead Assignments process, reevaluating, and reassigning per the process.&lt;br&gt;&lt;br&gt;<strong>Manual assignment</strong>&lt;br&gt;You can select an owner to assign to the lead from a list of eligible resources.&lt;br&gt;&lt;br&gt;A lead must have a Qualified or Unqualified status to be reassigned.</td>
</tr>
<tr>
<td>Retire</td>
<td>Updates the lead status to a retired lead indicating the lead is no longer one that needs pursuing.</td>
</tr>
<tr>
<td>Reject</td>
<td>Removes you as the lead owner. The accepted indicator and assignment status are also updated to reflect that the lead is no longer accepted. The lead is eligible for reassignment when:&lt;br&gt;&lt;br&gt;<strong>The next scheduled Sales Lead Processing Activity submits the Request Sales Lead Assignments process</strong>&lt;br&gt;<strong>The lead meets the processing activity's selection criteria</strong>&lt;br&gt;<strong>The previous lead owner is excluded when assigning team resources</strong>&lt;br&gt;&lt;br&gt;The reject reason, and the number of times the lead is rejected, is available when searching leads. This information is displayed in the Overview page for analysis and to provide possible indicators that the lead should be retired.</td>
</tr>
<tr>
<td>Accept</td>
<td>Updates the lead with you as the owner. The Request Sales Lead Assignments process assigns sales team territories and resources based on predefined rules. The rules are specified in the Assignment Rule for Ranking Leads profile option.</td>
</tr>
<tr>
<td>Convert to Opportunity</td>
<td>Creates an opportunity based on lead information. The lead status is updated to converted.</td>
</tr>
<tr>
<td>Submit for Approval</td>
<td>Click Submit for Approval when you're ready to register the lead for the approval of a channel account manager.</td>
</tr>
</tbody>
</table>

**Lead Statuses**

The status of a lead is primarily determined by a user performing an action on a lead, or upon successful completion of the lead qualification activity. Once leads have been assigned to lead qualifiers or related sales roles, lead follow-up activities begin. As specific actions are performed on a lead, the status of the lead changes accordingly.
Lead Status

This table describes the statuses of leads.

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unqualified</td>
<td>A lead with a status of unqualified signifies that the lead requires additional information and qualification activities by the lead team. Unqualified is the default status assigned to all newly created leads.</td>
</tr>
<tr>
<td>Qualified</td>
<td>A qualified lead signifies that the lead is ready for sales attention. The status can be updated to qualified by either the user selecting the Qualify action or upon successful completion of the qualification processing activity. Leads can have a status of qualified based on many factors including the status of the budget and the time frame of the project.</td>
</tr>
<tr>
<td>Converted</td>
<td>When a lead is converted to an opportunity, then the status is set to Converted.</td>
</tr>
<tr>
<td>Retired</td>
<td>The status of a lead is updated to Retired when a user selects the Retire action. A lead is retired when:</td>
</tr>
<tr>
<td></td>
<td>• There's no likelihood of the lead being converted to an opportunity</td>
</tr>
<tr>
<td></td>
<td>• A lead is no longer followed up by Sales</td>
</tr>
<tr>
<td></td>
<td>• A lead isn't evaluated by Marketing over a certain period of time</td>
</tr>
<tr>
<td></td>
<td>A retired lead can't be converted to an opportunity. Marketing users can review retired leads and then delete them as required.</td>
</tr>
</tbody>
</table>

Lead Conversion

A lead's life cycle ends either when a lead is converted to a sales opportunity, or when the lead is retired. Conversion to an opportunity stage allows the sales representative to pursue the account in the sales cycle. After establishing that the lead has potential, the sales representative converts the lead to an opportunity. Contact is established and meetings and presentations are scheduled to move the opportunity along the sales pipeline.

To convert a lead to an opportunity depends on the privileges assigned to your role, your access level as a lead sales team member, and the current status of the lead. You can convert a lead to an opportunity from the Actions menu by selecting Convert. This action creates an opportunity based on lead information. When a lead is converted to an opportunity, the lead status is set to Converted.

Leads to Opportunities Conversion

You convert a lead to an opportunity when the lead is ready for further processing along the sales cycle. Once the conversion is successfully completed, you can review the newly created opportunity using the opportunities UI. During your review, you might want to retain only a select few lead product lines to pursue as opportunity revenue line items. Since the conversion process automatically creates revenue lines from all lead lines, you can remove unwanted revenue lines from the opportunities UI. You can, at a later stage, create another opportunity from the removed lead revenue lines by converting the lead to an opportunity again. You can then decide to keep only those revenue lines that you want on the newly created opportunity.
When you convert a lead to an opportunity, the following rules may apply depending on the setup criteria for your company:

- The person converting the lead becomes the primary sales team member for the opportunity.
- The customer reference on the original lead is maintained for the opportunity.
- The associated lead team members are copied with the same primary team member.
- The newly created opportunity is assigned to the appropriate sales territories.

You can view opportunities associated with leads in the leads UI. If you don't see the converted lead in your list of opportunities, this means that the opportunity is assigned to a different territory.

Create Leads with New Contact and Account for Sales Prospects

You can enter leads for new sales prospects without associating an existing contact or account with the lead. As part of the lead management ready to use functionality, this is achieved by typing the contact name and account name directly onto the lead.

Create Leads with New Contact and New Account

Here's how to create a lead for a new sales prospect without associating an existing contact and account:

1. Sign in as a salesperson and navigate to the Leads area.
2. Click Create Lead.
3. From the Create Lead page, enter the name of your contact in the Primary Contact field.
   As you enter the name, note that any existing matching contacts are automatically suggested which you can choose to ignore, as applicable.
4. Enter the name of the account in the Account field.
5. Enter other lead details as required, and when finished, click Save and Close.

When you successfully convert the lead, the Primary Contact and Account on the converted lead show links to the newly created contact and account.

Convert Leads with New Contact and New Account for Sales Prospects

You can convert leads for new sales prospects with a new contact and a new account. When a sales prospect lead is converted, a new contact and account are created along with a new opportunity.

Convert Leads for a New Sales Prospect with New Contact and New Account

Follow these steps:

1. Sign in as a salesperson and navigate to the Leads area.
2. Select the sales prospect lead that you want to convert.
3. From the Edit Lead page, enter other lead details as required and when finished, click Save.
4. From the Actions menu, select Convert.
5. From the Convert dialog, click Submit.

A new contact and a new account are created during the lead to opportunity conversion. The newly created contact and account are now associated with both the opportunity created during conversion and the converted lead. The Primary
Contact and Account fields on the converted lead contain links to the newly created contact and account. Prior to the conversion, they're both listed as a value in their respective drop-down lists.

Apply Mass Update to Leads

You can update attributes, including user-defined attributes, and apply changes to several fields on multiple leads at once using the Mass Update feature. Let's say you want to change a user-defined field, such as Expiration Date, on multiple leads. First, query leads using the Expiration Date field, and then select all the leads you want to update at once. You can also use the Mass Update feature to update product information or primary contact information for leads.

Before you can use mass update, your administrator must enable the update action using Application Composer. Optionally, your administrator can also set a profile option that controls how many lead records you can update at once.

You can update several fields on multiple leads using the Update action. Here are the fields that you can update.

- Account
- Budget Amount
- Budget Status
- Campaign
- Currency
- Customer Need
- Deal Size
- Decision Maker Identified
- Description
- Primary Contact
- Primary Product
- Rank
- Sales Channel
- Source
- Time Frame

User-defined fields, if created, are available for update as well.

Some fields that you can update might contain a list of values (also known as a fixed choice list field). In some cases, a list of values field can have a parent. This means that the parent field's selected value controls which values display in the child field at runtime. If this type of parent/child relationship exists and you're updating the value of a child field, note that the value of its parent field must be the same across all records selected for mass update.

Apply Lead Mass Update

Here's how to apply a mass update to leads.

1. From the Leads landing page, enter the search criteria for the leads that you want to update, and click Search.
2. Based on the leads returned from your search criteria, select the leads that you want to update at the same time.
3. From the Actions menu, click Update.
   You can select or deselect leads by a single click of the lead record in the list. Use the select all and deselect all links to select or deselect all leads.
Note: By default, all the lead attribute fields on the Mass Update dialog box are read-only until you select to update them.

4. Select the attributes that you want to update and assign a value for each of the selected attributes.
   For lead attribute lists, their default value is displayed. Text fields are blank by default.
5. Click Save and Close.

Related Topics
  • Enable Mass Update of Records

How Users Gain Access to Leads

This topic explains how the security reference implementation provided by Oracle determines who can access what lead information in your sales organization. Qualified leads are assigned to a sales team based on sales territories. Unqualified leads are assigned to individual lead qualifiers either manually or based on rules defined in the assignment manager application. Whether or not you can access a particular lead depends on your membership in the resource and territory hierarchies.

You can access a lead if the following conditions apply:

• You’re the lead owner.
• The lead owner or sales team member is your direct or indirect report in the resource hierarchy.
• You’re a member of the lead sales team.

Resources in the management hierarchy of a newly added lead sales team member have the same level of access to the sales leads as the team member.
• You’re the owner or you’re a member of the territory assigned to the lead.
• You’re the owner or member of an ancestor territory of the territory assigned to the lead.

The flowchart illustrates some of the different ways you can gain access to a lead:

• Named agents in the diagram (A, B, and C) can access the lead.
• Unnamed agents (highlighted in yellow) can’t access the lead.
• Sales managers can access the lead because a salesperson in their management chain has access.
Here’s an example flowchart that shows who in a sales hierarchy can access a sales lead. Access using accounts isn’t shown.

- Agent A can access the lead because agent A created it. When you create a lead, you’re the initial owner.
- Agent B can access the lead because agent B is on the sales team.
- Agent C can access the lead because agent C is the owner of the NW territory.
- Sales managers who are higher up in the management chain can also see the lead because access is provided through the resource hierarchy. The manager of agent C can access the lead information, but colleagues of agent C don’t have access to the lead.
Special Access

Not all access is affected by the management hierarchy and membership in sales teams or territories. For example, special access includes:

- Administrators: Administrators get access to leads and other objects. This access is based on their privileges, regardless of where the administrators are in the management hierarchy. Administrators don't have to be on the sales team or members of territories.
- Deal Registration: Salespeople assigned to a deal registration retain access even if they're moved to another deal registration.

Lead Ownership and Sales Team Resources

A market is typically organized into territories that include customers and prospects. Marketing is closely aligned with sales, and marketing activities are launched to generate leads and maintain the strength of the sales pipeline. This topic explains lead ownership and sales team resources.

When the lead doesn't have any owner, the sales representative can accept the lead which makes him or her the lead owner. All resources who are given access to leads get full access. Full access level allows the user to update the sales lead team by adding or removing individual resources. Hence, territory resources, sales team members and lead owner and resources in their hierarchy, all get full access. Territory team members inherit the access level of the territory.

All members of sales territories assigned to the lead have full access to the lead. Ancestor territory owners of all sales territories assigned to the lead also have full access to the lead. Resources who access leads have different roles such as:

- Operations
  Support an automated process to capture leads, prioritize leads for sales engagement, and distribute the leads to appropriate sales or territory team resources.
- Marketing and lead qualifiers
  Monitor leads, reassign leads, and continually review and adjust the lead quality.
- Sales and territory teams
  Enable lead qualification, perform follow-up lead activities, and convert leads to opportunities.

This topic includes these sections:

- Lead, Sales, and Territory Resources
- Assignment of Leads to Marketing and Sales Resources
- Sales Resource Role

Lead, Sales, and Territory Resources

Sales resources are organized into flexible teams and are associated with the sales territories. These sales territories are then assigned to customers, leads, and opportunities to carry out the sales process. The lead follow-up team can include a lead team made up of individual sales resources who are predominantly active during the lead qualification stage. All sales resources who are assigned to the territory team can view and follow up the lead.
Assignment of Leads to Marketing and Sales Resources

Qualified leads are assigned to a sales team based on sales territories. Unqualified leads are assigned to individual lead qualifiers either manually or based on rules defined in the assignment manager engine. Users can be assigned to a lead in one of several ways:

- Ownership through lead creation
- Territory-based lead assignment
- Rule-based sales team member assignment
- Manual selection of resources

Sales Resource Role

Here are some of the activities performed by sales resources.

- Review quality leads that are augmented with sales collateral, marketing content, customer contact interactions, and references.
- Qualify and assess the lead quality further with the help of user-defined or company-defined assessment templates.
- Use the resource drop-down list to manually select a resource to add to the team.

Include a description to indicate what role the resource has on the sales team. Many sales team members can access each lead, and each team member is identified as either an internal (sales force), or an external (channel partner sales force) resource. Each sales team member can be associated with a specific resource role to indicate what capacity the member has on the lead.

- Add additional contacts and products to the lead as the lead moves further down the sales cycle.

Examples of Sales Lead Team

A sales lead team is made up of assigned territories and individual team members. This topic provides examples to illustrate some of the features available for the sales lead team:

- Automate assignment of individual resources to sales lead team
- Add ad hoc members to sales lead team
- Update access rights based on the resource
- Change the lead owner

Automate Assignment of Individual Resources to Sales Lead Team

The sales lead team for your company wants to add a support person to the lead. Typically, support people aren’t part of any sales territory. Use the Manage Sales Lead Assignment Rules task to set up a rule set for the category, Sales Lead Resource Rule Category. For example, assign support team members as individual resources based on rules which match the lead product with specific support team members.
Add Ad Hoc Members to Sales Lead Team

Generally, sales team resources are automatically assigned to leads based on configured assignment rules. The following scenarios provide examples of when you may want to manually add additional team members to assist with the lead.

- The lead owner, who has full access to your company lead, wants to add one of his company’s contractual experts to his team to help pursue the lead. The lead owner manually accesses the resource drop-down list and selects the ad hoc resource that he wants to add to his team.
- When pursuing a lead for an insurance policy, the customer contact requests a unique and complex combination of policy components that require a review from an expert in the company. The lead owner adds the expert resource to the lead with full access. Now, the expert resource can update the lead with valid combinations of products and services, and, if required, add more team members to the team.
- A salesperson is pursuing a lead that requires the export of products outside the country. He wants to ensure there are no legal issues with exporting the products. The salesperson adds a member of their company’s legal team to the lead to review the details before contacting the customer again.

Update Access Rights Based on the Resource

When a resource is added to the sales lead team through rule-based assignment, a profile option determines the member’s default access level. Resources in the management hierarchy of a newly added team member have the same level of access to the sales leads as the team member.

All members of the sales territories assigned to the lead have full access to the lead. Owners of ancestor territories of all sales territories assigned to the lead also have full access to the lead.

Change the Lead Owner

Only the lead owner, or the resources in the management hierarchy of the lead owner, can change the ownership of the lead.

Qualification

Lead Qualification

The lead qualification process can either be performed by internal marketing or internal sales groups. This topic provides a brief overview of what constitutes a qualified lead. Qualifying leads is an important first step in bringing the sales lead to a conclusion. At the end of the lead qualification process, you can classify the lead as a qualified lead that’s ready for conversion to an opportunity. Or you can retire the lead if the purchase interest for the lead can’t be validated. What constitutes a qualified lead varies from company to company.

Basic Lead Qualification

In some companies, basic lead qualification data is gathered by lead qualifiers and contains data such as:

- Customer need
- Urgency or time frame for the project
- Budget considerations such as available amount and status

The scheduled process that determines lead qualification status also takes into consideration basic lead data.
Additional Lead Qualification

In other companies, the lead qualifier or salesperson uses a lead qualification questionnaire as part of the qualification process. Based on the answers received, he or she can decide to manually set the lead to a Qualified status using the lead actions menu. Your application administrator assigns the questionnaire to your Lead Qualification Template profile. The answers entered are assessed using a weighted scoring model with instant feedback available as a scoring status bar in the UI.

Related Topics
- Example of Defining a Sales Lead Qualification Template

Perform a Lead Qualification

Lead qualification helps you in the lead follow-up process. Assess the lead quality and lead conversion potential by using the preconfigured qualification templates.

Lead qualification is part of the lead follow-up activity where you further nurture the lead in order to qualify it. Your administrator must set the Advanced Lead Qualification Enabled profile option after the qualification templates are created. This action specifies the qualification template to display in the Edit Lead UI to assist with evaluating the lead.

You can conduct a lead qualification, view completed lead qualifications, and view the responses to the questions posed in the qualification template. Qualification templates enable you to analyze the lead and suggest the appropriate next steps based on the overall assessment score and feedback for the lead.

Edit a New Lead Qualification

1. From the Navigator, click Leads.
2. In the list of leads, click on a lead to edit it. The Edit Lead page appears.
3. Click the Qualification tab to open the default qualification template.
4. Fill out and complete the lead qualification template.

If there are multiple qualification templates associated with the lead, then you can choose to select a different qualification by clicking Replace Qualification.

Related Topics
- How to Create Assessment Templates
- How Assessment Template Score Range is Calculated
- Assessment Template Components

Overview of Lead Qualification Templates

When you create a lead, you can qualify the lead by leveraging the many templates provided by your sales organization. This means you can evaluate various aspects of the lead which can subsequently help you sell more by converting the leads in less time.

Qualification Templates

After you create the lead, go to the Qualifications tab to view and complete the recommended qualification template created for you by your organization. If there are multiple templates associated with the lead, select one by clicking
Replace Qualification. Any responses for the current qualification will be reset and can’t be restored. You can choose to cancel the operation and use the current qualification template, or you can choose to continue.

If you continue, the qualification UI is refreshed to display the questions from the template you selected. Start entering responses to the questions and track the updates from the Qualification status fields on the page. Statuses toggle between: Not Started, In Progress, and Completed. You can also include other status values such as the number of questions answered, last updated date, and name of the template. Track the total score by summing up the weighted answers and display a graphical circular format of the score.

Perform Multiple Lead Qualifications Using the Same Template

From time to time, you might want to requalify your sales lead information and perform multiple qualifications for leads using the same qualification template. To do this, your administrator must set the profile option Enable Multiple Assessments Per Qualification Template to Yes at the site level.

From the Edit Qualification page click Add Qualification and then select the template you want from the available templates for your sales lead. If you add an additional qualification using the same qualification template, the application automatically generates a qualification name using the qualification template name plus a counter suffix. For example, if you have an existing qualification for a lead named Lead Qualification V1, then if you add another qualification using the same template, the new qualification name is displayed as Lead Qualification V2. You can edit this name to suit your own requirements.

When all questions are answered, the qualification is set to Complete status and continues to be available for edit. You can view all ongoing or historical qualifications, scores, statuses, and qualification template names. Use the Delete and Submit features only if the buttons are enabled by your administrator using Page Composer. You can delete a qualification that’s no longer required or if it was created by mistake as long as it hasn’t been submitted. The Submit button, if enabled, becomes available only when you have entered responses for all questions. Submit isn’t available on the single lead qualification page. You can’t edit the lead qualification once the status is set to Submitted but you can continue to view it.

Perform Multiple Lead Qualification

Before you begin, ensure that your administrator has set the Enable Multiple Assessments Per Qualification Template (MOW_MULTIPLE_QUALIFICATIONS_ENABLED) profile option to Yes. You must also have Full or Edit access on a lead to perform multiple qualifications and update existing qualifications for leads using the same qualification template. With View Only access, you can view qualifications but not update them.

Here’s how to perform multiple lead qualifications using the same qualification template:

1. From the Navigator, click Leads.
2. In the list of leads, select a lead to edit it. The Edit Lead page appears.
3. Click the Qualification tab to open the Edit Qualification page.
   If existing qualifications are available for the selected lead, they’re listed here.
4. Click Add Qualification. The Add Qualification dialog appears.
5. From the Template drop-down list, select the qualification template previously chosen for the selected lead qualification.
6. Click Save and Continue.
7. Select the appropriate responses to all the questions.
8. Click Submit and then click Yes from the confirmation dialog box.
   Once the qualification has a status of Submitted, it can’t be revised.
Examples of Lead Qualification

This topic explains the lead qualification process and provides examples of the different methods used for qualifying leads.

Lead Qualification Process

Lead quality is assessed as soon as a lead is generated and is mainly based on:

- The characteristics of the customer contact on the lead
- The type of response which caused the lead to be generated
- The type of sales campaign that the lead may be associated with

Leads are enriched further, typically by means of prequalification telemarketing activities performed by internal marketing, internal sales groups, or external third-parties. Qualification data is added to the lead such as:

- Customer need
- Urgency or time frame for the project
- Budget considerations such as available amount and status

At the end of this process, the lead is either:

- Classified as a qualified lead which is ready for conversion to a sale
- Retired if purchase interest for the lead can’t be validated

The following scenarios illustrate some of the lead qualification processes.

Rule-Based Lead Qualification

The rule-based lead qualification process requires that the value of the Lead Status attribute be set to Qualified if qualification rules evaluate to a positive answer. For example, consider the sample rule:

\[
\text{IF budget status is approved} \\
\quad \text{AND time frame is 3 months} \\
\quad \text{AND decision maker has been identified} \\
\quad \text{AND response type is attended event} \\
\text{THEN rule is passed} \\
\text{ELSE rule is failed}
\]

If this rule evaluates to TRUE, the value of Lead Status is set to Qualified.
Internal Marketing Qualification

Internal lead qualifiers or inside salespeople conduct phone conversations to gather qualification data about leads. They can use qualification templates to define consistent and specific qualification criteria for similar leads. The qualification questions are tailored to a specific product, industry, and source of the lead.

Before updating the lead status to qualified, the lead must have a valid primary product associated with it. Users can select multiple leads and select Qualify from the Actions list. Leads meeting the requirements for lead qualification are processed.

As the qualification data is gathered using the leads management user interface, the lead qualifier or salesperson can decide to manually set the lead to Qualified status. In some companies, the lead qualification data gathered by lead qualifiers is considered in the scheduled automated lead process. For example, the assignment manager engine can calculate lead score or lead rank, as well as assign sales team territories. For such companies, a simple rule to move leads to a Qualified status when the lead score reaches a specific threshold is sufficient.

A lead can be qualified when the basic attributes of the lead indicate interest in the purchase of a product. For example, basic attributes might include:

- Contact attended a product event
- Budget is approved
- Purchase time frame is less than a year

The Additional Qualification tab displays the qualification template with questions where you can enter the answers on the same page. Most of the data required to qualify the lead is available from the Basic Qualification area of the Lead details page. Supporting data is included in the contextual area for easy reference.

Internal Sales Group Qualification

Leads are generated and captured from many different sources. Leads are created when customers are created. Leads are also generated from leads that already exist. After salespeople accept the generated leads, they can evaluate the quality of the information received for the lead. They determine if the details are sufficient to reach out to the customer and assess whether a lead is worth pursuing with the help of predefine assessment templates. If they can establish that the lead has potential and can be marked as qualified, they can then convert the lead to an opportunity. Contact is established and meetings and presentations are scheduled to move the opportunity along the sales pipeline.

External Third-Party Qualification

External third-party qualification involves using input from a third-party source to qualify leads. For example, your company has obtained a list of contacts that purchased a car in the last 90 days. You have hired a telemarketing company to call each contact to determine if there is interest in your company's auto security products. The third-party telemarketer provides weekly files of potential contacts who are interested in your products. Using the file-based data import feature and qualification rules configured using the assignment manager engine, the interactions resulting from the telemarketer’s activities are imported as leads. The marketing operations manager schedules the rule-based qualification process to occur as soon as the enriched lead data is imported to the lead management application. If the rules evaluation is successful, the result sets the lead status as Qualified.

Related Topics

- Lead Assessments
- Lead Ranking
FAQs for Leads

How can I quickly enter and search address details for leads?

Lead address fields such as Country, City, State, and Postal Code have type-ahead and autocomplete features based on the values you start to enter. For example, when you begin to enter one of these fields, the application either displays the matching filter names and makes it possible for you to select filter values or the associated values are automatically inserted for you in the appropriate fields.

Use letter keys on your keyboard to display values within the Country field. You can also filter by City, State, and Postal Code fields based on the selected country, and you can filter by City and Postal Codes, based on the state selected.

Related Topics
- Overview of Using Smart Data for Account and Address
- Enable Smart Data for Accounts and Addresses

How can I fix an invalid relationship error when converting leads?

If you try to convert a lead that contains an invalid contact relationship, you may receive an invalid relationship error during the conversion. For example, you create a lead with a valid active primary contact and account. An issue might arise when you go to convert the lead if an incorrect relationship exists for a second contact on the lead. In such a scenario, you must deactivate the relationship and after some time try to convert the lead again.

However if you want the association of the lead and contact to remain, you must add the contact back on the lead through the Contacts tab on the Edit Lead page. Here’s how to resolve the issue:

1. Navigate to the Edit Lead page.
2. In the Contacts tab, remove the second (nonprimary) contact.
3. Click Save.
4. Add the contact that you just removed back again to the lead.
5. Click Save.
6. Convert the lead.

What leads are displayed when I select My Open Leads?

Selecting the My Open Leads list in the Leads work area displays a list of all of the qualified and unqualified leads where you’re listed as the lead owner and that were created within the last 90 days, or another number of days specified by the administrator in a system profile. You are automatically the lead owner if you create the lead or you can be designated as the owner by an application administrator.

How can I check for duplicate leads?

As a sales representative you want to know if your leads for new contacts or accounts have any duplicates in the application. You can manually check for leads duplicates from the edit leads page. Select the lead that you want to
check and from the **Actions** menu, select **Duplicate Check**. Duplicate check can only be run on new (non-existing) contacts and accounts.

A message is displayed if no duplicates are found for new contacts or accounts. If potential duplicates exist, the Resolve Duplicates page is displayed for the contact or account where you can select the appropriate contact or account to resolve any duplicates.

**Why did the deal size change?**

The *deal size* is automatically determined by the products entered for the lead. When you add or remove products for a lead the deal size is recalculated. You can override the calculated amount after all products are entered. For example, if the lead is eligible for a discount, you can manually change the total of the deal size to apply the discount. However, the application overrides the deal size total if you add or remove a product from the lead after having manually adjusted the deal size. In this case, you have to reapply the manual change.

**What happens if I manually change a lead rank that was automatically assigned?**

Lead rank suggests a priority to help you select leads for follow up. When the lead is created, a *lead rank* is first calculated by the assignment manager engine based on ranking rules. You can select a different lead rank from the list in the UI. When the lead is further processed, a different rank may be assigned based on enriched lead data, or the rules may cause the lead to revert to its original rank.

**How can I add lead contacts to my sales campaign?**

From the Leads overview area, select the lead you want to be part of your sales campaign. From the Lead details page, click the **Contacts** tab. Select the contacts that you want to add to your *sales campaign*. From the **Actions** menu, select **Add to Sales Campaigns** to view and select a campaign from your saved campaigns. Your selected contacts are notified when you launch your sales campaign.

**What's the difference between lead qualification and lead assessment?**

Lead qualification determines whether a lead has a budget and project timeline defined, and indicates if someone with purchasing authority is identified. Company-specific standard questions and the associated scoring mechanism help to capture the additional data critical to qualifying leads. A lead is typically considered qualified when the need and purchase interest are confirmed.

Lead assessment helps in the lead follow-up process, where the salesperson continues to assess the lead quality and lead conversion potential through preconfigured assessment templates. From the Assessment tab, the salesperson can conduct a new assessment, view completed assessments, and view the responses to the questions. Assessment templates provide the mechanism for the salesperson to analyze the lead and suggest appropriate next steps based on the overall assessment score and feedback for the lead.
What are assessment templates?

You can use assessments to evaluate the health of a business object, such as an opportunity or a lead. Administrators set up assessment templates that consist of weighted questions and possible responses that get scored. After selecting the appropriate assessment type, you enter responses for all the questions in an assessment, and achieve a score once the assessment is submitted. This score is used to evaluate the health of the business object. For example, the score could help determine whether an opportunity is viable enough to offer the potential customer a discount.

Why was a customer reference displayed for my lead?

A customer reference is based on the customer industry and associated lead product or product group related to the specific lead. For example, a customer reference displays for your lead if a customer has purchased a similar product or service. You can leverage the reference details for effective lead follow-up.

The leads UI is designed to ensure that you're productive and can readily access related lead information with as few clicks as possible. Supporting data related to each lead is included in the contextual area for easy reference. It includes references to all open leads and open opportunities for the lead customer, as well as supporting collateral. This information is useful to the lead sales team to facilitate an effective lead follow-up.

What happens if I convert a lead to an opportunity?

You convert a lead to an opportunity when the lead is qualified and is ready for further processing along the sales cycle. Once the conversion is successfully completed, you can review the newly created opportunity using the opportunities UI. During your review, you might want to retain only a select few lead product lines to pursue as revenue on the opportunity. Since the conversion process automatically creates product lines (representing revenue) from all lead lines, you can remove unwanted product lines from the opportunities UI.

You can view opportunities associated with leads in the leads UI. When you convert a lead to an opportunity, the following rules may apply depending on the setup criteria for your company:

- The person converting the lead becomes the primary sales team member for the opportunity.
- The customer reference on the original lead is maintained for the opportunity.
- The associated lead team members are copied with the same primary team member.
- The newly created opportunity is assigned to the appropriate sales territories.
How can I copy notes, attachments, and activities during Lead to Opportunity conversion?

You can copy notes, attachments, and activities from a lead record to an opportunity record during the lead to opportunity conversion process. Your administrator must set the Reference Copy Lead to Opportunity Map profile option value to the Direct Lead to Opportunity Mapping profile option.

Related Topics

- Enable a User-Defined Copy Lead To Opportunity Map Value

Can I create more than one opportunity from a single lead?

Yes, you can convert the same lead into another opportunity and then delete unwanted product lines. For example, during your review of an opportunity, you decide you want to retain only a select few of the lead product lines to pursue as opportunity revenue. Since the conversion process automatically creates the product lines from all lead lines, you can remove unwanted product lines from the opportunity details page. You can, at a later stage, create another opportunity from the removed lead product lines by converting the lead to an opportunity again. You can then decide to keep only those product lines that you want on the newly created opportunity.

Why can't I see converted leads in my list of opportunities?

If you don't see the converted lead in your list of opportunities, this means that the opportunity is assigned to a different territory.

Who can view the record sets for leads for saved searches?

The different record sets provided in the Saved Searches window restrict your saved searches to different sets of leads. The following table lists and describes the record sets for leads. Not all record sets are available to all users. For example, the record sets involving subordinates are available only to managers.

<table>
<thead>
<tr>
<th>Record Set Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>I own</td>
<td>Leads you own, including those leads you created or where ownership is assigned to you.</td>
</tr>
<tr>
<td>I am on the team</td>
<td>Leads where you're on the lead team. You are on the lead team if you're the lead owner or were added as a member by another team member.</td>
</tr>
</tbody>
</table>

Tip: To improve saved search performance, restrict your saved searches to smaller record sets. For example, rather than searching all the records you can see, search all the records in your territory hierarchy. Or restrict your searches to a smaller geographical area. For example, search all the leads in one state instead of the whole country.
<table>
<thead>
<tr>
<th>Record Set Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>My territory</td>
<td>Leads in your sales territories.</td>
</tr>
<tr>
<td>My subordinates own</td>
<td>Leads where you or your subordinates are on the lead team.</td>
</tr>
<tr>
<td>My territory hierarchy</td>
<td>Leads in your sales territories and all of their subordinate territories in the sales territory hierarchy.</td>
</tr>
<tr>
<td>All records I can see</td>
<td>Leads that you can view based on your lead team membership, sales territory assignments, your position in the organization, and security permissions.</td>
</tr>
</tbody>
</table>

**Can I perform a mass update for leads of different business units?**

You can't perform a mass update of modified values for leads that apply to different business units. A dialog box is displayed if the selected leads belong to different business units which don't share the same reference data sets. You must remove the set-enabled attribute for the offending leads and perform the mass update only for leads with business units containing the same reference data sets. For more information on reference data sets, see the topic Business Units and Reference Data Sets: How they Work Together. Also, consult the online help, using keywords "reference data".
10 Responses

Overview of Response Management

When prospects or contacts respond to an offer through a channel, such as inbound email, internet, or call center, the details are captured by the response management feature. You can review response details and convert qualified responses to sales leads. You can then determine which responses to pursue as leads or which ones you can convert to opportunities.

Campaign channels can be different from response channels. Recipients of an internet campaign can respond through a call center. Recipients of a direct mail offer may respond by clicking a Web offer URL link. Responses are generated because of sales and marketing activities. Responses gathered from external call centers and suppliers are imported to your sales application.

Websites can capture response details, while phone calls or direct mail responses must be recorded manually. When these responses are recorded, you can import them. Inbound email replies aren't automatically captured as responses. You must configure your email response product to support inbound email processing. Each response type has several parameters that store details about a given response. You can modify an automatically captured response if you have permission. Responses are tracked for an offer and for a campaign.

Response Management Summary

Responses are captured either through the file import feature, or they're automatically captured by recording the various clicks when opening emails associated with the sales campaign. You can review imported and autogenerated responses and convert qualified responses to leads and opportunities.

Response Management Features

You can create responses provided by prospects and contacts, and you can convert responses to leads and opportunities. You can record campaign responses to:

- Calculate campaign response rates
- Target promotional material to those prospects and contacts who are more receptive to offers
- Build a profile of prospects and contacts who responded to run targeted campaigns
- Extract and source key data from the responses to generate quality leads
Differences Between Response, Lead, and Opportunity

This table describes the main differences between a response, a lead, and an opportunity.

<table>
<thead>
<tr>
<th>Response</th>
<th>Lead</th>
<th>Opportunity</th>
</tr>
</thead>
</table>
| A response is an interaction initiated by the customer in response to a marketing stimulus. Every outbound sales activity is a sales stimulus. | A lead is an inquiry, referral, or other information, obtained through a sales campaigns, or other means that identifies:  
- Potential contact or prospect  
- Specific purchase interest  
You can create a lead if the specific purchase interest isn't known at the time. However, to qualify a lead you must record a primary purchase interest. | An opportunity is a pending sale of a product or service that can be forecasted and tracked using summary data such as:  
- Potential revenue  
- Sales stage  
- Win probability  
- Expected close date |
| Responses are created from interest recorded in response to sales activities. Responses include:  
- Providing answers to phone survey questions  
- Subscribing to a list  
- Replying to an email response form request | Leads are mostly created by automated lead capture or lead import processes which periodically create qualified responses as sales leads.  
Leads are sometimes created from the response data of a contact or prospect who has expressed a need or interest in a product or service offered by the business. | Opportunities are created by sales administrators when they have identified a qualified lead with a potential revenue opportunity. Leads are converted to opportunities when significant sales investment is foreseen to close the deal.  
A salesperson can create opportunities from scratch, without previously having a response or lead created. |
| As interest for the product or service matures, responses are elevated as leads. |                      | Inclusion of opportunities in the sales forecast is at the discretion of the sales administrator. However, not all opportunities are included and the decision to include them may depend on your company's requirements. |
| Responses aren't included as part of the sales forecast. | Leads aren't included as part of the sales forecast. | |

What's the difference between a response and an interaction?

A response signifies a recorded reaction of a prospect or contact to a sales or marketing activity. An interaction is a record of communication between your company and the prospect or contact or customer.
The following table outlines the key points about responses and interactions:

<table>
<thead>
<tr>
<th>Responses</th>
<th>Interactions</th>
</tr>
</thead>
<tbody>
<tr>
<td>A response can be converted into a sales lead for further qualification or sales opportunity to be pursued and included in sales forecasting.</td>
<td>An interaction is recorded when a communication occurs with customer contacts by means of any communication channel such as e-mail, phone, direct mail, or web.</td>
</tr>
<tr>
<td>Responses received by phone, e-mail, or web are saved and positive responses can be converted to sales leads and opportunities.</td>
<td>An interaction is typically created for each outbound and inbound communication. An outbound communication is initiated by a company employee such as a salesperson by a phone call, or marketing manager by means of an e-mail campaign. An inbound communication is initiated by a prospect or contact by means of web activity or through a call center.</td>
</tr>
<tr>
<td>Responses are typically captured by automated processes or are imported in the application.</td>
<td>Interactions for a particular customer or contact can be viewed in Customer Center.</td>
</tr>
<tr>
<td>A response captures information specific to the sales or marketing activity such as source codes and specific destination URLs.</td>
<td>The channel details on a marketing treatment include the option to create interactions when a response is created.</td>
</tr>
</tbody>
</table>

What happens when I convert a response to a lead?

A lead is created and becomes available for follow up from the Leads work area. As the user who converted the response to the lead, you're listed as the lead owner.
11 Opportunities

Overview of Opportunities

Opportunities allow organizations to support the full sales process, from leads, to opportunities, to sales, to follow-up analytics. Within opportunities, sales organizations can capture a wide variety of information related to an opportunity, such as customer (account) and the products to be sold. They can use the supplied sales methods and sales stages to step the opportunity to its eventual conclusion.

In addition, account intelligence, sales actions, and historical sales analysis further enable salespeople to increase their win rates by offering data-driven pipeline management and recommendations for the next best sales action. For example, setting win probability variance thresholds and providing multiple recommendations per opportunity enables sales representatives to optimize their sales opportunities.

This table lists opportunity features.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Support the sales life cycle</td>
<td>Create, manage, and close opportunities, supporting the entire sales life cycle. By integrating with leads, you can convert leads to opportunities. Post-sale, take advantage of supplied business intelligence reports related to sales.</td>
</tr>
<tr>
<td>Maintain opportunity information</td>
<td>Here are just some of the data that sales teams can capture for an opportunity:</td>
</tr>
<tr>
<td></td>
<td>• Accounts: You can associate an account (for example, a customer or prospect) with the opportunity.</td>
</tr>
<tr>
<td></td>
<td>• Opportunity owner: The person who creates an opportunity is automatically assigned ownership. You can change owner if needed.</td>
</tr>
<tr>
<td></td>
<td>• Contacts: You can associate contacts with an opportunity. In addition, you can specify a contact’s role, affinity, and influence level on an opportunity. A single contact can be marked as primary.</td>
</tr>
<tr>
<td></td>
<td>• Currency: The application supports multiple currencies at both the opportunity header and revenue-line levels.</td>
</tr>
<tr>
<td></td>
<td>• Budget: A Budgeted indicator lets you display whether the opportunity revenue amount has been budgeted by the customer, as well as the date that the budget was made available.</td>
</tr>
<tr>
<td></td>
<td>• Competitors and partners: You can associate partners and competitors with opportunities, both at the opportunity and revenue line levels.</td>
</tr>
<tr>
<td></td>
<td>• Marketing data: The Source field allows the association of sales campaigns with an opportunity.</td>
</tr>
<tr>
<td></td>
<td>• Mass update opportunities: Allow sales personnel to update several opportunity attributes at once on multiple opportunities.</td>
</tr>
<tr>
<td>Employ sales methodology</td>
<td>Your company can employ its own sales methodology by using the supplied sales methods and stages. For each sales stage, administrators can create action items (process steps), task templates, recommended documents, assessment templates, and fields that are required for use in opportunities. In addition, administrators can specify a different default win probability percentage for each sales stage.</td>
</tr>
<tr>
<td>Feature</td>
<td>Details</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Use Sales Coach for guided selling</td>
<td>Sales Coach, part of sales methods, guides salespeople through each step of the sales cycle with an organization's own sales methodology and best practices. The action items (process steps), task templates, recommended documents, assessment templates, and mandatory fields set up by your administrator in each of the sales stages translate into guided notes and appropriate opportunity UI interactions.</td>
</tr>
<tr>
<td>Leverage the product revenue model</td>
<td>Opportunities support a product revenue model that features revenue-based forecasting, products and product groups, recurring revenue, and revenue data captured at the line level, such as win probability, close date, include in forecast, and status.</td>
</tr>
<tr>
<td>Support recommended actions</td>
<td>Prompts salespeople to respond to the next best set of recommended actions for customer engagement, drive pipeline and determine how often to reach out to customers post sales. Here are some of the benefits of the next best sales action feature:</td>
</tr>
<tr>
<td></td>
<td>• Support multiple recommendations per opportunity.</td>
</tr>
<tr>
<td></td>
<td>• Enables smarter sales experiences and optimizes the selling process.</td>
</tr>
<tr>
<td></td>
<td>• Provides a percentage win probability in comparison to other opportunities from your sales organization or a prediction about the close date of the opportunity. For example, based on historical data, the likelihood to close an opportunity is less than 40%.</td>
</tr>
<tr>
<td></td>
<td>• Supports user feedback per opportunity.</td>
</tr>
<tr>
<td></td>
<td>• Enables administrative and supervisory controls. For example, manage the win probability variance thresholds for opportunities and define user actions to suit the organization's requirements. As salespeople update the opportunity information, win likelihood and recommended actions are regenerated.</td>
</tr>
<tr>
<td>Assign sales team</td>
<td>Opportunities align with territories and the assignment engine for rule-based or territory-based autoassignment of salespeople to opportunities. In the team pages, you also can manually add sales team members to an opportunity.</td>
</tr>
<tr>
<td>Allocate sales credit</td>
<td>By allocating sales credit to salespeople on product lines, you can capture the amount of credit salespeople receive for the sale. You can track direct, channel, and overlay resources and their contributions using revenue and non-revenue credit splits.</td>
</tr>
<tr>
<td>Use forecast territories on product lines</td>
<td>By integrating with forecasting, you can use forecast criteria to automatically include product-line revenue in the forecast. You can leave the default forecast territory on the product lines or assign another forecast territory. The forecast is refreshed in real-time from revenue when an opportunity is created or updated.</td>
</tr>
<tr>
<td>Assess opportunities and their products, contacts, and competitors</td>
<td>You can use assessments to evaluate the health of an opportunity or an opportunity product, contact, or competitor. After setup by the administrator, assessments are available to salespeople in the Assessments tab.</td>
</tr>
<tr>
<td>View business intelligence reports</td>
<td>Several supplied business intelligence reports give you views into sales metrics, from lists of opportunities and accounts, to pipeline data, sales team performance, and other revenue metrics.</td>
</tr>
</tbody>
</table>
Related Topics

- Overview of Opportunity Products and Revenue
- Best Practices for Sales Credits
- Overview of Sales Methods, Sales Stages, and Sales Coach

Opportunity Management

What opportunities are displayed for My Open Opportunities and Open opportunities where I am on the team?

Selecting the My Open Opportunities list displays a list of all of the open opportunities expected to close within the current calendar or fiscal period where you're listed as the opportunity owner. You're automatically the opportunity owner if you created the opportunity. You also can be assigned as the owner by someone else.

Selecting the Open opportunities where I am on the team list displays a list of all of the open opportunities expected to close within the current calendar or fiscal period where you're on the opportunity team. You're on the opportunity team if you created the opportunity or you can be assigned to the team either by an automatic assignment process or by another team member.

What do the opportunity saved searches mean?

In the opportunities landing page, several different saved searches retrieve specific sets of records. The following table lists and describes the record sets for opportunities. Not all record sets are available to all users. For example, the record sets involving subordinates are available only to managers.

<table>
<thead>
<tr>
<th>Record Set Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>I own</td>
<td>Opportunities you own include those opportunities you created or where ownership is assigned to you.</td>
</tr>
<tr>
<td>I am on the team</td>
<td>Opportunities where you are on the opportunity team. You are on the opportunity team if you are the opportunity owner or if you were added as a member.</td>
</tr>
<tr>
<td>My territory</td>
<td>Opportunities in your sales territories.</td>
</tr>
<tr>
<td>My subordinates own</td>
<td>Opportunities owned by you and your subordinates.</td>
</tr>
<tr>
<td>My subordinates are on the team</td>
<td>Opportunities where you or your subordinates are on the opportunity team.</td>
</tr>
<tr>
<td>My territory hierarchy</td>
<td>Opportunities in your sales territories and all of their subordinate territories in the sales territory hierarchy.</td>
</tr>
</tbody>
</table>
Can I sort opportunity searches by the last update date?

Yes, you can sort the records returned from your opportunity search by last updated date in descending order. Request your administrator to change the Opportunity List Sort profile option from N to Y. You can then quickly review and action recently updated opportunities.

Why did some fields change when I changed the sales stage?

When you move an opportunity from one sales stage to the next, the opportunity-level win probability increases to reflect the progress of the opportunity. The win probabilities of all product lines that are in sync with the opportunity-level win probability also change to match the opportunity-level probability.

During setup, the administrator can specify the default win probability for each sales stage.

Which fields or data is initially set on an opportunity?

Several fields are initially set to default values when you create an opportunity, as described in this topic.

Following are the fields initially set to default values when you create an opportunity:

- Sales Channel: Set to Direct
- Currency: Determined by the settings in user preferences
- Win Probability: Set to percentage determined by sales method or profile option
- Close Date: Set to 90 days from creation date
- Status: Set to Open
- Sales Method: Set to default sales method
- Sales Stage: Set to first sales stage in default sales method
- Owner: Set to user creating opportunity
- Revenue: Set to zero
- Worst Case: Set to zero
- Best Case: Set to zero
- Opportunity Number: Unique, application-generated number
- Created By: Set to user creating opportunity
What information is required to create an opportunity?

Opportunity Name is the only field required to be filled out when creating an opportunity. Note, however, that the name and sales account combination must be unique. In other words, you can’t have two opportunities with exactly the same name and associated to the same sales account.

What happens if I change win probability?

If you change win probability at the opportunity level, the application updates the win probability of all opportunity product lines that are in sync. In addition, if you update win probability at the product level, the product lines included in the forecast may change, depending on whether the line matches forecast criteria or not.

How is the expected close date of an opportunity initially set?

When defining a sales method, administrators can insert the average close window of the sales method, in days. The value is then used to set the default close date of opportunities using that sales method.

What's a billing account on an opportunity?

A billing account on an opportunity is the customer's financial account to be used for the transaction.

How can I copy an opportunity?

While viewing the opportunity details, select **Copy Opportunity** from the Actions menu and enter a new, unique name for the opportunity.

What is copied when I copy an opportunity?

The application copies the following attributes when you copy an opportunity:

- Opportunity header attributes, including standard and user-defined fields
- Contacts
- Products:
  - Revenue information, such as quantity, unit price, revenue amount
  - Schedule information and the underlying scheduled transactions
  - Sales credits, including recipients, amounts, and percentages
User-defined attributes of revenue

- Sales team, including partner resources
- Source
- Partners
- References
- Competitors
- Leads
- User-defined child objects of the opportunity

The following aren’t copied:

- Notes
- Tasks
- Appointments
- Assessments
- Attachments
- Deal registrations

What happens to forecasted revenue when an opportunity is changed?

The current forecast is automatically updated to reflect the changes. Past forecasts remain unchanged. Scheduled processes synchronize changes to territories and update active forecasts.

Related Topics

- Forecast Synchronization

How do I delete an opportunity?

To delete an opportunity, open it for editing and click Delete Opportunity from the Actions menu.

After you delete an opportunity, it’s no longer available in the application.

Apply Mass Update to Opportunities

You can update fields on multiple opportunities at once. For example, you can update the status or add comments for multiple opportunities at once.

You can modify several fields for each update. Here’s a list of predefined fields available for mass update:

- Account
- Budgeted
These predefined fields can't have a blank value:

- Currency
- Close Date
- Sales Stage
- Include in Forecast

Some fields that you can update might contain a list of values (also known as a fixed choice list field). In some cases, a list of values field can have a parent. This means that the parent field's selected value controls which values display in the child field at runtime. If this type of parent/child relationship exists and you're updating the value of a child field, note that the value of its parent field must be the same across all records selected for mass update.

Mass Update Opportunities

Here's how to update multiple opportunities at once.

1. In the Opportunities overview (also called the landing page or list page), enter the search criteria for the opportunities that you want to update, and click Search.
   The application returns a list of results based on your search criteria.
2. From the Actions menu, click Update.
3. Click the opportunities you want to update.
4. After you have made your selections, click Update.
   The Update Opportunities page appears. The page title indicates how many opportunities you're updating.
5. In the Field column, select a field that you want to update.
   After you make your selection, the application activates the Value column for data entry or selection.
6. In the Value column, assign a value for the selected field.
7. Click Submit to commit the changes.
   A page appears, confirming that the changes were successfully applied.
8. Click Done in the confirmation page to return to the overview page.
Recommended Actions

Overview of Recommended Actions for Opportunities

Opportunities allow organizations to support the full sales process, from leads, to opportunities, to sales, to follow-up analytics. Within opportunities, sales organizations use the supplied sales methods and sales stages to step the opportunity to its eventual conclusion. Account intelligence, sales actions, and historical sales analysis further enable salespeople to increase their win rates by offering data-driven pipeline management and recommendations for the next best sales recommended actions. For example, setting win probability variance thresholds and providing multiple recommendations per opportunity help sales representatives optimize their sales opportunities.

Using the recommended actions feature lets sales representatives know which opportunities to focus on, which ones are at risk to close, and specifically, what's the next best recommended action to take to close opportunities.

Your administrator must enable the Enable Adaptive Intelligence profile option (ZCA_ENABLE_ADAPTIVE_INTELLIGENCE) and extend the opportunity detail page to display the Recommended Actions section and related steps in the opportunities UI.

This table lists some of the ways recommended actions can help close deals.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Details</th>
</tr>
</thead>
</table>
| **Smarter sales experiences and optimizes the selling process** | Helps you identify best opportunities to pursue based on:  
  - Current and past deal assessments  
  - Opportunities needing most attention  
  - Sales volatility |
| **Multiple recommendations per opportunity** | Prompts you to respond to the next best set of actions for customer engagement, for driving the sales pipeline, and for determining how often to reach out to customers post-sales. For example, provide the relevant data to:  
  - Perform competitive analysis through competitive data alert messages.  
  - Initiate a follow-up call with the customer.  
  - Focus on the top five deals, to reduce sales volatility.  
  - Determine the likelihood of closing an opportunity.  
  - Provide a percentage win probability in comparison to other opportunities from your sales organization or a prediction about the close date of the opportunity.  
  For example, based on historical data, the likelihood to close an opportunity is less than 40%. |
| **User feedback per opportunity** | Lets you provide feedback, such as to how helpful, or not, are the recommended next best actions provided for the opportunity. Salespeople can select the recommended action they completed or signify whether or not the suggested action was helpful. |
| **Administrative controls** | Enables sales administrators to manage the win probability variance thresholds for opportunities. As you update the opportunity information, the application regenerates win likelihood probability and recommended actions. |
You must complete the following configuration steps in Oracle CX Sales to ensure that recommendations are displayed on opportunities:

- Update relevant profile options.
- Add the Recommended Action column to the Opportunities page using Application Composer.

For more information, see the section Configure Oracle Engagement Cloud for Adaptive Intelligent Apps for CX in the Oracle Adaptive Intelligent Apps - Implementing Adaptive Intelligent Sales guide on Oracle Help Center (https://docs.oracle.com).

### Recommended Actions for Opportunities

Recommended actions in opportunities are prompts that provide you with suggestions about how to reduce the risk of opportunities being lost. The prompts, which leverage adaptive intelligence data, guides you by suggesting which actions can improve the likelihood of winning and closing deals. You can regenerate the win likelihood and recommended actions by providing feedback and updating information for the opportunity.

### Recommended Actions

Using adaptive intelligence, system learning, and other data science capabilities, optimized recommended actions and predicted win likelihood data is presented to you for opportunities. Recommended actions provide insights into the possible issues in the opportunity and suggest recommended actions to improve your chances of winning the opportunity. You engage with those opportunities requiring the most attention and move them to the next sales stage.

For example, suppose the role marked as the primary contact on an opportunity correlates with a low win rate in the past. The reason might be that this contact isn't the decision maker in the customer organization. Therefore, the adaptive intelligent algorithm recommends that you check that the primary contact is the decision maker. Other examples of recommended actions include:

- Schedule an appointment
- Focus on the top five deals to reduce sales volatility
- Perform competitive analysis
- Other opportunity-specific recommended actions prompted to move a deal to the next sales stage and closer to a win

### Feedback on Recommended Actions

When you select a recommended action for a specific opportunity, a dialog box appears which provides additional information about the recommended action. There's also a link to any additional recommended actions to take for the selected opportunity. After reading the explanation or after you perform the action, you can indicate if the suggestion was helpful or not. You can also indicate whether the recommended actions were helpful with moving the opportunity to the next stage.

You provide feedback by clicking either **Good Suggestion** or **Not Helpful**. As soon as you provide your feedback, the recommendation isn't visible anymore.
Create a Task from Recommended Actions

You can create a task for each recommended action by clicking the Task icon from the contextual Recommendations dialog box. You can also create a task from the edit opportunity's recommended region page by clicking Create Task to create a related task for yourself.

What's the difference between win probability and predicted win probability?

Win probability represents the likelihood (in percent form) of winning the opportunity. You manually set the win probability at the opportunity level for the sales stage. If you don't want your sales stages to control opportunity win probability, make sure that no value exists in the win probability field.

The predicted win probability displays the automated predicted win probability based on adaptive intelligence (AI), system learning, and other data science capabilities. It provides a percentage of the predicted win probability in comparison to other opportunities from your sales organization or a prediction about the close date of the opportunity. For example, the adaptive intelligent models might suggest a win probability for an opportunity that's significantly different to the salesperson's estimation. In that case, your sales application displays a warning icon on the Opportunities page.

You can hover over a warning indicator icon next to the Win Probability (%) field which is displayed only when the differences between the win probability percentage value and the predicted win probability percentage value is greater than the defined threshold. The text is read only and displays both win and AI predicted probability values as well as the Opportunity name.

Related Topics

- Edit the Opportunity Win Probability Risk Threshold Profile Option

Opportunity Team Members

Add Team Members to an Opportunity

You must have Full or Edit access control privileges to add or remove team members to or from an opportunity. From the opportunity team page, you can add team members to the opportunity team. You can also view assigned territories and the associated territory team members on the opportunity team by selecting Territories from the Show list of values. With View Only access, you can view team members but not update them.

Add a Member to an Opportunity

As owner of the opportunity, you're listed on the opportunity team page as the owner with Full access.

Here's how to add a member to an opportunity.

1. Sign in to the application as a user with access to opportunities, such as a salesperson or sales manager.
2. Navigate to Sales > Opportunities.
The opportunity landing page displays your opportunities.

3. Find an opportunity and edit it. Or, create an opportunity and save and edit it.

4. From the Edit Opportunity page, click the **Team** icon to open the Team page.

5. Click **Add Team Members**.

6. Search for the team member you want to add to your opportunity team.

7. Select the team member you want from the **Search Results**, then click **OK**.

8. Select the access level control for the team member’s privileges from the **Access** list of values.

9. Select the function for the team member from the **Function** list of values.

10. Click **Save** to add the team member to the opportunity team.

You can change the primary owner of the opportunity by selecting **Owner** from the team page.

**Note:** You can remove a team member from the opportunity team by clicking the delete icon represented by X next to the team member. However, you can't remove the owner from the opportunity team.

Related Topics

- Account Team Member Access Levels

---

**Sales Coach**

**Sales Coach Methodology Setup**

Watch video

Sales Coach is a mechanism to present best practice sales methodology and teaching aids to help improve your sales effectiveness. Administrators set up Sales Coach by associating action items and recommended documents with a sales stage. You can then view these items as you progress your opportunities. The coaching components or job aids are associated with a specific sales stage. Each sales stage potentially can have multiple action items and recommended documents associated with it.

Here are the areas that administrators can define for each sales stage:

- Action items (process steps)
- Recommended documents

**Action Items**

Action items are steps you should follow during a sales stage. For example, your company might recommend that you interview a potential customer, develop a product list, and schedule a presentation for a product launch.

**Recommended Documents**

Recommended documents are helpful documents and resources, such as customer letter templates, relevant websites, and training materials.

Related Topics

- Overview of Sales Methods, Sales Stages, and Sales Coach
Opportunity Access

How Sales Users Gain Access to Opportunities

The security reference implementation provided by Oracle determines who can access opportunity information in your sales organization.

Whether or not you can access a particular opportunity depends on your membership in the resource and territory hierarchies. You can access an opportunity if:

- You create the opportunity.
- You're on the opportunity sales team.
- The opportunity owner or sales team member is your direct or indirect report in the resource hierarchy.
- You’re the owner or are a member of the territory assigned to the opportunity.
- You're the owner or member of an ancestor territory of the territory assigned to the opportunity.
- You’re assigned to a territory for the account associated with the opportunity.
- You’re assigned to a territory that’s an ancestor of the territory for the account associated with the opportunity.

Salespeople can see all opportunities related to their accounts but access differs between territory members and opportunity members:

- An opportunity owner gets full access to the opportunity, which includes the ability to edit as well as add and remove team members.
- Owners and members of territories or of ancestor territories assigned to the account of the opportunity get read-only access to the opportunity and aren't added to the opportunity sales team.
- Owners and members of territories assigned to the opportunity product lines are added as a distinct list of territories to the opportunity sales team. Owners and members of these territories get full access to the opportunity. Depending on a profile option, either only the owner or all the members of the territory are added as resources to the opportunity sales team. Regardless of the access level for these members as a resource on the opportunity team, they always have full access.

Owners and members of ancestor territories of the territory assigned to the opportunity aren't added to the opportunity sales team but they always get full access.

The following diagram illustrates some of the different ways you can gain access to an opportunity:

- Named agents in the diagram (A, B, and C) can access the opportunity.
- Unnamed agents (highlighted in yellow) can't access the opportunity.
- Sales managers can access the opportunity because a salesperson in their management chain has access.
This diagram shows who in a sales hierarchy can access an opportunity.

- Agent A can access the opportunity because she created it. When you create an opportunity, you’re the initial owner.
- Agent B can access the opportunity because he’s on the sales team.
- Agent C can access the opportunity because he’s the owner of the NW territory.
- Sales managers who are higher up in the management chain can also see the opportunity because access is provided through the resource hierarchy. Agent C’s manager can access the opportunity information, but agent C’s colleagues can’t.
- Sales administrators can access the opportunity.
Special Access

Some access isn't affected by the management hierarchy and membership in sales teams or territories. This special access includes:

- Administrators: Users assigned the Sales Administrator job role get full access to opportunities and other objects. This access is based on their privileges, regardless of where the administrators are in the management hierarchy. Administrators don't have to be on the sales team or members of territories.
- Deal Protection: Salespeople assigned to an opportunity retain the sales credit on an opportunity even if they're moved to another opportunity.

Why can't I edit some fields for an opportunity?

Salespeople can see all opportunities related to their accounts. However, depending on how your opportunity access profile has been set up, your access may be different between territory members and opportunity members. If you're listed as the owner of the opportunity, you have full access to the opportunity, which includes the ability to edit as well as add and remove team members. If you're a territory or ancestor territory member assigned to the account of the opportunity, you can edit some fields in the opportunity record, but you can't make changes to the team or change the record ownership.

For example, the following fields in the edit opportunity page aren't editable for territory or ancestor territory members:

- Name
- Account
- Primary Contact
- Owner
- Status
- Currency
- Sales method
- Sales Stage
- Primary Source

Why can't I see the Partners tab and Primary Partner field when I edit an opportunity?

When editing an opportunity, you need the right privileges to see partner information. Contact your administrator for more details.

Sales Competitors
Overview of Sales Competitors

Want your team to get insight into the competition while working deals? It's easy -- simply set up your competitor records and then associate competitors with your opportunities. After you add information on the competition and associate competitors with opportunities, you and the rest of your sales team can access to important competitor data that can help you more effectively close deals.

Here's the type of details you can store on the competition:

- Company details, such as stock symbol, website, industry, and geography
- Perceived threat level, such as high, medium, or low
- Experts who have knowledge about the competitor
- Collateral about the competitor, such as data sheets and the like
- Opportunities where the competitor is associated
- Revenue at stake, which is potential revenue that could be lost
- Notes about the competitor

Link Competitors with Opportunities

When you're ready to enter competitor information on a deal, link competitors at the opportunity-level or at the product-line level. Once linked, the competitor and opportunity are associated in the competitor’s profile screens (available in the Competitor pages of Sales, outside of the opportunities UI). The revenue amount entered on an opportunity drives the revenue-at-stake metric, also available in the competitor profile screens. See the related topics for more information.

View Competitor Information Outside Opportunities

Sales administrators can store a many details about sales competitor companies. As a salesperson, you can associate competitors with opportunities to get insight into which competitors may have won a deal against your company. You can also use competitor details when you want specific information about a competitor during a sales deal.

Here's how to view competitor information:

1. Navigate to Sales > Competitors.
2. Select a competitor in the list and view the details.
3. Here’s a summary of information that gets stored about competitors in their profiles:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Organization Name</td>
<td>Name of the competitor.</td>
</tr>
<tr>
<td>Name Suffix</td>
<td>Value appended to the name of the Organization Name for the competitor.</td>
</tr>
<tr>
<td>Chief Executive Name</td>
<td>Name of the competitor company's chief executive officer or highest-level employee.</td>
</tr>
<tr>
<td>Line of Business</td>
<td>Line of business of the competitor company's products.</td>
</tr>
</tbody>
</table>
### Field
<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>D-U-N-S Number</td>
</tr>
<tr>
<td>Organization Size</td>
</tr>
<tr>
<td>Year Established</td>
</tr>
<tr>
<td>Threat Level</td>
</tr>
<tr>
<td>Year Incorporated</td>
</tr>
<tr>
<td>Stock Symbol</td>
</tr>
<tr>
<td>Fiscal Year End Month</td>
</tr>
<tr>
<td>Dun &amp; Bradstreet Corporation Credit Rating</td>
</tr>
<tr>
<td>Privately Owned</td>
</tr>
<tr>
<td>Minority Owned</td>
</tr>
<tr>
<td>Small Business</td>
</tr>
<tr>
<td>Status</td>
</tr>
</tbody>
</table>

This table shows the information available in the details tabs of the Edit Competitor page:

### Item
<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SWOT Analysis</td>
</tr>
<tr>
<td>Product groups</td>
</tr>
<tr>
<td>Opportunities</td>
</tr>
</tbody>
</table>
### Attachments

Attachments are files, free-form text, or URLs that can give you information that helps you position products or solutions against specific competitors.

### Internal Experts

Internal experts are people in your company who are experts on the competitor.

### Geographies

Geographies where the competitor company is present.

### Industries

Industries where the competitor competes with your company.

You can also view revenue at stake for the competitor. The Revenue at Stake area in the Edit Competitor page shows the revenue that potentially could be lost to the competitor. The data comes from product or product group revenue on the opportunities where the customer is present.

You may want to view notes associated with the competitor, if entered by the administrator. Notes are stored in the contextual area of the Edit Competitor page.

## Associate Competitors with Opportunities

Capture the competitive information for a deal when you associate competitors with an opportunity, either at the header-level or product-line level.

### Associate Competitors at the Opportunity Level

Here’s how you associate a competitor at the opportunity level:

1. Sign in as a sales user, such as a salesperson or sales manager.
2. From the Sales > Opportunities page, drill into an opportunity.
3. Depending on how the application is configured, you can access competitors on an opportunity by:
   - Use the Competitors subtab: If it's enabled, click the Competitors subtab and make your changes in the Competitors page.
   - Use the Primary Competitor or Competitors field: If they're enabled, these fields appear in the edit page.
4. In the competitor association pages, you can:
   - Search for and select a competitors to add to the opportunity.
   - Remove competitors from the opportunity.
5. Save your changes.

*Note:* To associate multiple competitors with an opportunity, more than one competitor must be set up in the application. Competitors are set up by the administrator.

### Associate Competitors at the Product-Line Level

Here’s how you associate a competitor at the product-line level on an opportunity:

#### Prerequisites:

- More than one competitor must be set up by the administrator.
• The administrator must have enabled the Competitor field in the Products table using Application Composer.
• To select a competitor in the Competitor list in the Products table, it must first have been associated with the opportunity at the opportunity level. Competitors won't show up in the list of values in the Products table unless they were first added to the opportunity at the header level.

1. From the Opportunities list, click the name of an opportunity to edit it.
2. In the Primary Competitor list, click Search.
3. Search for and select a competitor.
4. Click OK.
5. Save your changes.
6. Add a product line to the table.
7. In the Competitor list of values, select a competitor.
8. Save your changes.
9. Repeat this procedure to add more competitors.

FAQs for Sales Competitors

How can I see the opportunities that I lost to a competitor?

Look at the competitor record details. It includes a consolidated view of past and current opportunities where the competitor is at play. It gives you important details so that you can plan future sales strategies.

How can I see the win/loss distribution on competitors?

Use competitor analysis graphs to see why opportunities were won or lost. You can also analyze the reasons for losing or winning against specific competitors. As a sales manager, you can use this analysis to improve your overall deal success rates and revenues. For more information, see the Creating and Administering Analytics guide.

Related Topics
• Creating and Administering Analytics guide

How can I see win/loss trends against selected competitors?

Take a look at the Win Loss Trends report. It displays opportunity revenue won by your organization against competitors. The report shows the number of wins and losses and closed-won opportunity revenue by quarter and by competitor. The report can also show overall opportunity won revenue and number of wins and losses regardless of whether there was a competitor on the opportunity. For more information, see the Creating and Administering Analytics guide.

Related Topics
• Creating and Administering Analytics guide
How can I get more information about a competitor?

Take a look at the list of your colleagues on the Internal Experts tab. The list contains experts who know something about the competitor.

What's SWOT?

SWOT stands for: Strengths, Weaknesses, Opportunities, and Threats. The SWOT attribute in the Competitors feature of your sales application gives organizations a way to examine the strengths, weaknesses, opportunities, and threats of a competitor. SWOT analysis can provide insight into how a competitor’s resources are mapped against the environment in which it is pitted against the deploying organization. As part of the competitor profile, SWOT provides a mechanism to plan, strategize and compete against your competition.

Opportunity Assignment

How are territories assigned to opportunities?

You can’t explicitly add territories to an opportunity. Rather, the assignment engine automatically assigns territories to opportunity product lines by matching the dimensional attributes of product lines to territory dimensions, such as Customer Size or Industry.

When the assignment engine assigns territories to opportunity product lines, the territory owner is also copied to the opportunity team.

Profile options set by the administrator determine the following:

- Whether, when a territory is assigned to an opportunity product line, all territory team members are also copied to the opportunity team, in addition to the territory owner.
- Whether the assign opportunity action is available from within an opportunity for salespeople to run assignment.
- Whether the application runs assignment when salespeople save an opportunity.

Note: With partner integration, partner territories (territories whose sales channel dimension is equal to Partner) aren’t assigned to product lines. Partner organizations can only be associated with an opportunity manually, or they can be automatically associated through an approved lead registration.

Related Topics

- Sales Resources to Opportunity Assignment
- Overview of Territory Account Assignment
How do I assign team members automatically to an opportunity?

While editing an opportunity, from the Actions menu, select Save and Run Assignment.
You must have Full access to the opportunity to see the Save and Run Assignment action.

**Tip:** You can view assigned territories and the associated territory team members on the opportunity team in the opportunity Team pages.

Why can't I assign an opportunity?

You must have Full permission on an opportunity to see the Save and Run Assignment action.
Note that a profile option determines whether the assignment action is available in opportunities.

What’s lock assignment?

Lock assignment prevents a salesperson from being automatically removed from an opportunity through the assignment engine. Only users with Full access on the opportunity can check or deselect the Lock Assignment check box for sales team members.

What’s deal protection?

With the deal protection feature, all salespeople are automatically protected from being removed from a product line for which they’re receiving sales credit, or from the opportunity team, when territory realignment happens. Deal protection applies to sales resources that get automatically assigned to product lines as credit recipients or to the opportunity team using territory-based assignment.

A profile option set by the administrator specifies the default number of days for which salespeople are protected. An opportunity team member with Full access level can override the dates for which the protection is active.

Opportunity Closure

Considerations for Closing an Opportunity

You can close opportunities as needed, for example, when they’re won, lost, or no longer active.
When closing an opportunity, you may be required to enter a win/loss reason and a competitor, if enabled during setup.

There are two ways to close an opportunity:

- Use the edit opportunity UI: See the topic, Close an Opportunity Using Edit Opportunity UI, for more information.
• Use the update feature: See the topic, Close Multiple Opportunities, for more information.

Close an Opportunity Using the Edit Opportunity UI

You can use the Edit Opportunity page to close an opportunity by setting its status to one of the closed status categories and entering any required information.

Close an Opportunity

Here's how to close an opportunity from the Edit Opportunity page.

1. Sign in as a salesperson and navigate to Sales > Opportunities.

   The opportunity landing page displays the list of your opportunities.

2. Find an opportunity and edit it.

3. From the Status field, select a status that belongs to a Closed status category. For example, select Won.

   The Close Date field changes to the current date.

   The Win/Loss Reason field becomes active.

   Note: Depending how your administrator configured the closing action, the Win/Loss Reason and Competitor fields may or may not require your input.

4. Select a Win/Loss Reason, if required.

5. Select a Competitor.

This screenshot shows an example of the applicable fields when closing an opportunity in the Edit Opportunity page.

6. Click Save or Save and Close.

   Tip: You can find closed opportunities by searching for them using the search utility.
Close Multiple Opportunities

You can select several opportunities in the opportunity list and close them at once. You must have Full or Edit access to the opportunities to update them.

Close Multiple Opportunities at Once

Here's how to close multiple opportunities at once.

Note: If Competitor is a required field in the close opportunity flow, the opportunities you update must already have competitors associated with them before you attempt to update them.

1. Sign in as a salesperson and navigate to Sales > Opportunities.
2. In the Opportunities overview (also called the landing page or list page), enter the search criteria for the opportunities that you want to close, and click Search.
   The application returns a list of results based on your search criteria.
3. From the Actions menu, click Update.
4. Select the opportunities you want to close.
   To select multiple opportunities, hold the Ctrl key down as you select them. You can click the Select All link if you want to close all the opportunities up to a maximum of 25. Click Deselect All to undo your selection.
5. After you have made your selections, click the Update button.
   The Update Opportunities page appears. The page title indicates how many opportunities you're updating.
6. From the Field drop-down list, select Status.
   After you make your selection, the application activates the corresponding Value column for data entry or selection.
7. Select one of the values that belongs to a Closed status category. For example, select Won.
8. Enter a Win/Loss Reason, if enabled as required by your administrator.
9. If you want to enter a date to close your selected opportunities, enter Close Date in the Field drop-down list.
   Then enter a date to close the opportunities from the corresponding Value field.
10. Click Add if you want to add more fields to update for your closed opportunities.
11. Click Submit to commit the changes.
   A page appears, confirming that the changes were successfully applied.
12. Click Close in the confirmation page to return to the overview page.

Related Topics

- Opportunity and Product Line Attributes Synchronization

Examples of Using Opportunity Search Close Period and Close Date Range Fields

The opportunity search fields Close Period and Close Date Range can be used together or separately.

Use the Close Period field to set the calendar period for the opportunity close date. Predefined values are Current Quarter, Previous Quarter, Next Quarter, Previous and Current Quarter, Current and Next Quarter. When you set a value in this field, the Close Date Range field automatically changes to the dates for the calendar period.
To use the Close Date Range separately, enter your own Close Date Range values instead. The application clears the Close Period list so that it displays nothing.

Examples of Field Actions
Here's an example of the Close Date Range and Close Date fields working together:

- The CRM calendar is defined as:
  - Q1 2014 - January 1 to March 31
  - Q2 2014 - April 1 to June 30
- In January 2014, you select current quarter in the Close Period field.
  - The application sets the default Close Date range as 01/31/2013 to 3/31/2013.

Here's an example of using the Close Date field by itself:

- You want to review opportunities for a five-month range: March 1 through July 31, 2014.
- In the Close Date fields, you select 03/1/2014 to 7/31/2014.
- The application clears the Close Period field and retrieves opportunities whose close date falls within the date range.

Opportunity Assessments

Perform an Opportunity Assessment

Opportunity assessments contain a series of questions, responses and comments that help you evaluate the health of an opportunity. After you answer the questions and submit the assessment, you get a rating score. Such feedback enables you better pursue the opportunity and increase the chance of winning the deal.

For example, you complete an assessment intended to determine whether an opportunity is healthy enough to offer the customer a 15 percent discount. Based on the assessment score, you and your manager determine whether the opportunity qualifies for the discount. Giving a discount increases the chance of winning the deal.

Assessments Available for Sales Stages

Assessments are enabled for a specific opportunity sales stage within the sales method used on the opportunity. Assessments available in one sales stage may not be available in another sales stage.

Perform an Opportunity Assessment

You must have Full or Edit access on an opportunity to perform new assessments and update existing assessments. With View Only access, you can view assessments but can't update them.

Here's how to perform an opportunity assessment.

1. From the Navigator, click Opportunities.
2. In the list of opportunities, select an opportunity to edit it. The Edit Opportunity page appears.
3. Click the Assessments tab to open the Assessments page.
   - Note that if only one assessment is available, it displays in the Assessments page, ready for entry.
If multiple assessments are available, the most recently created (by the administrator) assessment displays. You can use the Show list of values to select other assessments. You can add assessments, if more are available, by clicking Add Assessment, and then selecting the assessment. The Add Assessment button displays only if multiple assessments are available.

After you submit an assessment, you can't revise it.

**Update an In-Progress Assessment**
Here's how to update an assessment that's in progress.

1. From the Navigator, click **Opportunities**.
2. In the list of opportunities, select an opportunity to edit it. The Edit Opportunity page appears.
3. Click the **Assessments** tab to open the Assessments page.
4. To retrieve the assessment you have in progress, click the **Show** list of values and select the assessment from the list. Note that the assessment that was worked on last is the one that appears by default in the Assessment tab.

**View and Edit Assessment Comments**
You can view all assessment responses, including free-form response text and comments. If the question has existing comments, then a two-line read-only Comments text box is displayed. If there's more than two lines' worth of text to display, then the text is truncated and ends with an ellipsis. You can click on the edit icon to view the entire text. You can also add a comment for questions that don't have existing comments to display.

**Delete Assessments**
Your administrator may have enabled the Delete Assessment button in the Assessments page. The delete action lets you delete an existing assessment. After you delete an assessment, it's available to rerun using the Add Assessment button. Note that you must have Full or Edit access on the opportunity to delete an assessment.

**Perform Multiple Opportunity Assessments Using the Same Template**
From time to time, you might want to reassess your opportunity information and perform several assessments for opportunities using the same assessment template. To perform multiple assessments per template, your administrator must set the profile option Enable Multiple Assessments Per Assessment Template to Yes at the site level.

You can add assessments, if more are available, by clicking Add Assessment, and then selecting the assessment template. When you add another assessment for your opportunity using the same assessment template, the application automatically generates an assessment name using the assessment template name plus a counter suffix. If you have an existing assessment for an opportunity named Discount Eligibility V1, then if you add another opportunity assessment using the same template, the new assessment name is displayed as Discount Eligibility V2. You can edit this name to suit your own requirements.

When all questions are answered, the status of the assessment is set to Complete and continues to be editable. You can view all ongoing or historical assessments, scores, statuses, and template names. You can use the Delete and Submit features only if the buttons are enabled by your administrator using Page Composer. You can delete an assessment that's no longer required or if it was created by mistake as long as it hasn't been submitted. The Submit button becomes available only when you have entered responses for all questions. You can't edit the assessment once the status is set to Submitted but you can continue to view it.
Perform Multiple Opportunity Assessments

Before you begin, ensure that your administrator has set the Enable Multiple Assessments Per Assessment Template (MOW_MULTIPLE_ASSESSMENTS_ENABLED) profile option to Yes. You must also have Full or Edit access on an opportunity to perform multiple assessments and update existing assessments using the same assessment template. With View Only access, you can view assessments but not update them.

Here's how to perform multiple opportunity assessments using the same assessment template.

1. From the Navigator, click Opportunities.
2. In the list of opportunities, select an opportunity to edit it. The Edit Opportunity page appears.
3. Click the Assessments tab to open the Edit Opportunity Assessments page.
   - If existing assessments are available for the selected opportunity, they're listed here.
4. Click Add Assessment. The Add Assessment dialog appears.
5. From the Template drop-down list, select the assessment template previously chosen for the selected opportunity assessment.
6. Click Save and Continue.
7. Select the appropriate responses to all the questions.
8. Click Submit and then click Yes from the confirmation dialog box.
   - The assessment status is changed to Submitted.

After you submit an assessment, you can't revise it.
Overview of Opportunity Products and Revenue

You typically add product groups or products to opportunities to record potential sales revenue while working the deal. After an opportunity is won and closed, the revenue from the products sold becomes actual revenue, for reporting purposes. Companies use opportunity revenue information for several reasons, such as analyzing sales pipelines and win/loss trends, monitoring the performance of salespeople, and generating revenue forecasts.

Here are some typical tasks that you can perform with opportunity products and revenue:

- Add products and product groups that the customer is interested in.
- Set product line revenue attributes, such as revenue amount, price, and quantity.
- Set other product line attributes, such as inclusion in the forecast, expected close date, win probability, and competitors.
- Enter and maintain recurring revenue schedules, such as those for subscription services or training plans.
- Allocate and manage sales credit amounts that opportunity team members receive.
- Run the assignment process to assign salespeople to the product lines.

Opportunity Products and Revenue Management

Manage Opportunity Products and Revenue

You can add products or product groups to opportunities and then update the product lines, including revenue attributes, if required.

Add Products or Product Groups

Here's how to add a product or product group to an opportunity.

1. Sign in to the application as a user with access to opportunities, such as a salesperson or sales manager.
2. Navigate to Sales > Opportunities. The opportunity landing page displays your opportunities.
3. Find an opportunity and edit it. Or, create an opportunity and save and edit it.
4. In the Products region, click Add to add a row to the table.
5. In the Type field, select Group if you're adding a product group. Select Product if you're adding a single product.
   
   **Note:** Depending on your implementation, you may have the option to browse the sales catalog. The catalog contains the same product groups and products as those accessible from the table.

6. Select the Name list, and then select the product group or product. If the product group or product isn't in the recently used items list, access the search page by clicking the Search link in the Name list.
7. In the Search page, the product groups or products you have access to may be automatically filtered to show only the products in your sales territories.

For type **Product**, you can search for the product you want by entering a keyword, name, or product number. For type **Group**, you can search by name and reference number, if known.

To search all products in the database without the territory filtering, deselect the **Filter by Territory** option.

8. Select the product group or product and click **OK** to return to the Products table, where you can set other attributes of the product line, such as quantity, price, and so forth.

9. Save your work.

This table explains the product line attributes.

<table>
<thead>
<tr>
<th>Product Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Select either product group or product.</td>
</tr>
<tr>
<td>Name</td>
<td>Use to select a product or product group. If individual products aren't implemented, then only product groups are available.</td>
</tr>
<tr>
<td>Quantity</td>
<td>Enter values in whole numbers. The application multiplies this field by Estimated Price to calculate the revenue amount.</td>
</tr>
<tr>
<td>Estimated Price</td>
<td>Enter estimated price per item. The application multiplies this field by Quantity to calculate the revenue amount.</td>
</tr>
<tr>
<td>Amount</td>
<td>Amount used in forecasting and for reporting. The application calculated this field from price multiplied by quantity, but you can override the value.</td>
</tr>
<tr>
<td>Currency</td>
<td>The initial value is based on the opportunity-level currency. If multiple currencies are implemented, you can pick a different currency.</td>
</tr>
<tr>
<td>Sales Credit</td>
<td>Use sales credits to specify who gets revenue and overlay sales credit for the sale.</td>
</tr>
</tbody>
</table>

Depending upon how your application is configured, you may have these additional product line attributes available.

<table>
<thead>
<tr>
<th>Product Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Close Date</td>
<td>Indicates the expected close date of the product line. The initial value is the opportunity-level close date, but each line can have its own close date.</td>
</tr>
<tr>
<td>Forecast</td>
<td>Displays a check mark if the product line matches the established forecast criteria.</td>
</tr>
<tr>
<td>UOM (Unit of Measure)</td>
<td>The initial value is based on the product or product group selected.</td>
</tr>
</tbody>
</table>
### Product Field Description

<table>
<thead>
<tr>
<th>Product Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status</td>
<td>Use to set the product line status, such as Open or Won.</td>
</tr>
<tr>
<td>Win Probability</td>
<td>The initial value is the opportunity-level win probability, but can be overridden.</td>
</tr>
<tr>
<td>Best Case</td>
<td>The initial value is the revenue amount for the item or group (providing Revenue is greater than Best Case).</td>
</tr>
<tr>
<td>Worst Case</td>
<td>Use to set a worst case revenue amount.</td>
</tr>
<tr>
<td>Include in Forecast</td>
<td>The application sets the initial value to <em>When matches forecast</em>, if forecasting criteria have been enabled. Can be overridden to <em>Yes</em> (meaning always include in forecast) or <em>No</em> (meaning never include in forecast), if forecasting criteria override has been enabled.</td>
</tr>
<tr>
<td>Territories</td>
<td>Displays the territories assigned to the product lines. You can drill down into the field to view all of the associated territories.</td>
</tr>
<tr>
<td>Competitor</td>
<td>You can set a competitor at product-line level. The choice list is limited to those associated at the opportunity level. Depending upon your implementation, you may be required to enter a competitor when setting an opportunity or product line to closed.</td>
</tr>
<tr>
<td>Win/Loss Reason</td>
<td>When a product line or the opportunity is closed, this field indicates why the product line was won or lost.</td>
</tr>
<tr>
<td>Actual Close Date</td>
<td>This is a read-only field set by the application automatically when you set a product line to a closed status.</td>
</tr>
</tbody>
</table>

For procedures on managing recurring opportunity products or product groups that are part of a subscription business model, see the topic, Create and Maintain Recurring Opportunity Products.

### Remove Product Lines

Here's how to remove any products you don't need from the Products table in opportunities.

1. Sign in to the application as a user with access to opportunities, such as a salesperson or sales manager.
2. Navigate to **Sales > Opportunities**.
3. Find an opportunity and edit it. Or, create an opportunity and save and edit it.
4. In the Products region, click the X icon located at the end of the applicable table row to remove a product line from your opportunity.
5. Save your work.
Can I update products on multiple opportunity lines at the same time?

Yes, if you have the mass update feature enabled at either the opportunity summary or product tab level, then you can update attributes and apply changes to fields at once on multiple opportunity product lines.

Mass update of attributes at the product line level works similar to the mass update of top-level objects such as opportunities and accounts. The main difference is that your opportunity revenue and product line changes are saved at the product line level. Mass update of changes at the opportunity object level are saved at the parent opportunity level.

Related Topics

- Apply Mass Update to Opportunities
- Enable Mass Update of Records

Recurring Opportunity Products

Overview of Recurring Opportunity Products

Recurring schedules in opportunities enables you to enter and track opportunity products or product groups that are part of a subscription business model.

The subscription business model applies to the sale of goods, software, or services where the customer is required to pay a subscription price for access to the goods, software, or services, with additional usage or pay-as-you go charges in some cases. Some examples are:

- Data and phone services
- Credit collection or payment processing services
- Software, platform, or data-as-a-service costs
- Magazine subscriptions
- Product life cycle costs
- Engineering and infrastructure services

The subscription model can encompass both business-to-business (B2B) and business-to-consumer (B2C) customers. For example, a telecommunications company may sell mobile phone services to individuals, and multiple phone lines to a business for their employees. The supplier of these services typically charges the customer a periodic rate applicable to the plan that they subscribed to.

After you define a schedule for a subscription product or service, the application creates the recurring transactions from the frequency and the number of transactions specified in the schedule. There are several time frequencies to choose from, such as weekly, monthly, quarterly, yearly, and so on. The multiple frequencies make it easy to set up a recurring schedule, like a monthly subscription for three years, or a biweekly annual subscription. You can review the schedule and quickly add a one-time registration or installation fee, and adjust the amount or date of any transaction.
Subscription changes are easy to manage. If there is a change in the terms or price of the subscription, you can quickly define a new schedule to replace the previous one. If the original subscription is extended, say, for another year, you can easily extend the existing schedule on the product for the period that you want.

Product amounts from recurring schedules are summed into the corresponding quarterly or yearly periods, and are readily available in pipeline reports and forecast rollups for you and sales managers.

Create and Maintain Recurring Opportunity Products

You use recurring transactions to enter and track opportunity products or product groups that are part of a subscription business model. Use the procedures in this topic to create and maintain recurring revenue schedules in opportunities.

Note: Recurring opportunities functionality is available only if your administrator has enabled it.

Create a Recurring Revenue Schedule

Here’s how to create a recurring revenue schedule for a product or product group in the opportunities UI.

1. Sign in as a sales user, such as a sales representative or sales manager.
2. Navigate to Sales > Opportunities.

The opportunity landing page displays your opportunities.

3. Edit an opportunity by clicking the name in the list. Or, create an opportunity and save and edit it.
4. In the Products table, click the Add button and enter the details about the product or product group.
5. In the Schedule column, click the add icon (plus sign). The Set Schedule page appears.

Enter data into the fields, using the guidance in this table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Guidance</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frequency</td>
<td>Select a frequency that the revenue should be generated for. Note that:</td>
</tr>
<tr>
<td></td>
<td>◦ Bi-Weekly is twice a month (every two weeks)</td>
</tr>
<tr>
<td></td>
<td>◦ Bi-Monthly is every other month</td>
</tr>
<tr>
<td>Start Date</td>
<td>◦ The default date is opportunity close date.</td>
</tr>
<tr>
<td></td>
<td>◦ You can update the field to any other value (equal to or later than current date).</td>
</tr>
<tr>
<td>End By</td>
<td>Enter the number of transactions or a calendar end date.</td>
</tr>
<tr>
<td></td>
<td>Note: The number of transactions to include in your recurring revenue schedule for a product or product group should not exceed 500.</td>
</tr>
<tr>
<td>Quantity</td>
<td>Enter quantity of the product or product group being sold, as a whole number.</td>
</tr>
</tbody>
</table>
**Field** | **Guidance**
---|---
Amount | Enter the amount of the product or product group being sold.

**6.** Click **Next**. The Manage Schedule page appears. Note the following actions:
- The appropriate number of transactions are created based on frequency, start date, and number of transactions or end date.
- The close date on each transaction is set to a value derived from the combination of frequency, start date, and end date.
- Quantity and amount are repeated for each transaction.
- Other values (like status, win probability, product, currency, and so on) are cascaded from the parent revenue line.
- Transactions are ordered by ascending close date by default.
- Total quantity and amount are displayed for the schedule. Total amount shows the applicable currency symbol of the product currency.

**7.** Review the transactions in the schedule and adjust if required.

You can add a schedule transaction row by clicking the **Add** button and entering the required information.

**8.** Click **OK** to save the schedule. The application returns to the edit opportunity page.

**9.** Click **Save** or **Save and Close** to save the changes.

---

**Manage Scheduled Transactions**

All other actions you can perform with an existing recurring schedule are done in the Manage Schedule page, available by editing the schedule.

You can:
- Edit the existing transactions in the schedule.
- Extend the schedule by entering new dates.
- Replace the schedule altogether.
- Delete the schedule.

Here’s how to manage existing scheduled transactions.

**1.** Sign in as a sales end user, such as a sales representative or sales manager.

**2.** Navigate to **Sales > Opportunities**.

The opportunity landing page displays your opportunities.

**3.** Edit an opportunity by clicking the name in the list.

**4.** In the Products table, click the edit icon in the Schedule column. The Manage Schedule page appears.

**5.** In the Manage Schedule page, perform, if required, the actions in this table.

<table>
<thead>
<tr>
<th>Action</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit schedule transactions</td>
<td>To add a row to the transactions table, click the <strong>Add</strong> button and enter the required information.</td>
</tr>
</tbody>
</table>
### Action | Details
--- | ---
To remove a row in the transactions table, click the X in the row.  
Replace a schedule | Click the Replace Schedule button.  
The Replace Schedule page behaves as if you’re creating a new schedule.  
Enter the new schedule details and save. The new schedule replaces the old schedule.
Extend a schedule | Click the Extend Schedule button to retrieve the Extend Schedule page.  
Edit the schedule details as needed.  
Note the following actions:  
• If the previous schedule had the number of occurrences stored, then that value is set as the default.  
• The recurring quantity and recurring amount are set by default, based on previous values. If you update these to any other values, the resulting transactions are generated based on the updated values.  
• If the start date of the new schedule is prior to the end of current schedule, then the process replaces all existing transactions with a close date later than the new schedule’s start date.
Delete a schedule | Click the Delete Schedule button.  
Respond with Yes to the warning message.  
All underlying scheduled transactions are deleted, and the schedule parameters on the parent line are removed.  
The product line is converted to a standard revenue line and the quantity and amount field are set to blank.

6. Click **Save** or **Save and Close** in the edit opportunity page to commit the changes made in the recurring schedules page

---

### Sales Credits

**Best Practices for Sales Credits**

Companies use sales credits to report on the performance and quota attainment of their sales personnel. They also use sales credits to aid in compensation calculation and to facilitate forecasting by territories. Sales credit recipients and revenue amounts roll up the resource hierarchy for pipeline reporting and quota attainment.

You assign sales credits to sales resources (salespeople or other sales users) while editing product lines in opportunities. When a product line is first added to an opportunity, the application sets the user who added it, as the sole sales credit recipient. This means that the sole recipient receives 100 percent of the sales credit.

Two types of sales credit exist for opportunities:

- **Revenue sales credit**: Typically allocated to salespeople working the deal.
- **Overlay sales credit**: Typically allocated to other resources helping out with the deal, such as a product or market specialist. Overlay sales credit is also known as nonrevenue sales credit.
Revenue Sales Credit

When assigning revenue sales credits, keep in mind:

- Only internal resources are eligible as revenue credit recipients.
- Revenue sales credits must add up to 100 percent.
- The Forecast Territory can be set to any territory assigned to the product line with Revenue Or Revenue and Nonrevenue Forecast Participation.

Overlay Sales Credit

When assigning overlay sales credits, keep in mind:

- Both internal and external (for example, partner) resources are eligible as nonrevenue credit recipients.
- Nonrevenue sales credits doesn’t have to add up to 100 percent.
- If the selected Allocation Style is Proportional to Revenue, the sales credit amounts adjust automatically and proportionally when the product line amount changes.
- If the selected Allocation Style is Ad Hoc Amounts the sales credit amounts don’t change with product line amount changes.
- The Forecast Territory can be set to any territory assigned to the product line with Revenue Or Revenue and Nonrevenue Forecast Participation.

Note: Territories with a Forecast Participation of Nonforecast aren’t eligible to be set as the forecast territory on either revenue or nonrevenue sales credits.

Configure Default Assignment

You can configure the revenue territory assignment default logic to meet your specific business needs for reporting and forecasting the product amounts on an opportunity. See the article, Configuring Credit Recipients and Forecast Territories Assignment (Doc. ID 2089301.1), available on My Oracle Support (support.oracle.com).

Manual Territory Assignment by Administrators

In the sales credits screens, sales administrators can manually assign a sales representative’s territory to a product line when the territory hasn’t been assigned automatically. Manual assignment allows sales personnel to forecast an opportunity immediately while the territory setup is being reviewed and updated.

Related Topics
- Sales Credit Recipient and Forecast Territory Predefined Logic
- Set Deal Protection on Opportunities

Allocate Sales Credits

Sales credit recipients and revenue amounts roll up the resource hierarchy for pipeline reporting and quota attainment. Your company can use sales credits to report on salesperson performance and quota attainment, to aid in compensation calculation, and to facilitate forecasting by territories.

When a product line is first added to an opportunity, the user who added it, is automatically set as the sole revenue sales credit recipient (receiving 100 percent of the sales credit). For each product line, you can assign a portion or all of the sales credit from the product revenue to individual salespeople.
Note: You must have Full access to an opportunity to assign sales credits.

Allocate Revenue Sales Credit
You typically allocate revenue sales credit to salespeople working the deal.

Here's how to allocate revenue sales credit to a user.

1. Sign in as a salesperson or sales manager and navigate to Sales > Opportunities.

   The opportunity landing page displays the list of your opportunities.

2. Find an opportunity and edit it. Or, create, save, and edit an opportunity and then add a product line to it.

3. In the Edit Opportunity page Products table, click the edit icon in the Sales Credit column for the line you're editing. The Edit Sales Credit window appears.

4. Click the Add Revenue Credit button to add another row to the sales credits table.

5. Select the drop-down list in the Name column for the new row. Select a name from the recently used list, or click Search to search for the salesperson.

   a. If searching, in the Select: Owner page, enter the search criteria for the user you want to allocate sales credit.
   b. In the search results, select the user and click OK.

6. In the table, enter the percent of sales credit for the user or an amount. With revenue sales credit, the total of all percentages entered must add up to 100 percent.

7. Optionally, in the Forecast Territory column, pick a territory to forecast the revenue in. The Forecast Territory can be set to any territory assigned to the product line with Revenue or Revenue and Nonrevenue Forecast Participation. The forecast territory is set automatically when the assignment process runs, so you can skip this step if you want.

8. When you're finished setting the sales credit, click OK.

9. In the Edit Opportunity page, save your changes.

Allocate Overlay Sales Credit
You typically allocate overlay sales credit, or nonrevenue credit, to other resources helping out with the deal, such as a product or market specialist.

Here's how to allocate overlay sales credit to a user.

1. Sign in as a salesperson and navigate to Sales > Opportunities.

   The opportunity landing page displays the list of your opportunities.

2. Find an opportunity and edit it. Or, create, save, and edit an opportunity and then add a product line to it.

3. In the Edit Opportunity page Products table, click the edit icon in the Sales Credit column for the line you're editing.

   The Edit Sales Credit window appears.

4. Decide which type of overlay credit you want to enter and then select that type from the Allocation Style list of values:

   o Proportional to Revenue: With this type, the sales credit amounts adjust automatically and proportionally when the revenue item amount changes.
   o Ad Hoc Amounts: With this type, the sales credit amounts don't change with revenue item amount changes.

5. Click the Add Overlay Credit button to add another row to the sales credits table.
6. Select the drop-down list in the Name column for the new row. Select a name from the recently used list, or click Search to search for the salesperson.
   a. If searching, in the Select: Owner page, enter the search criteria for the user you want to allocate sales credit.
   b. In the search results, select the user and click OK.
7. In the Edit Sales Credit window, in the Sales Credit column of the table, enter the percent of sales credit for the user. With overlay sales credit, the total of all percentages doesn't have to add up to 100 percent.
8. Optionally, in the Forecast Territory column, pick a territory to forecast the revenue in. The Forecast Territory can be set to any territory assigned to the product line with Revenue or Revenue and Nonrevenue Forecast Participation. The forecast territory is set automatically when the assignment process runs, so you can skip this step if you want to.
9. When you're finished setting the sales credit, click OK.
10. In the Edit Opportunity page, save your changes.

Related Topics
- What's deal protection

How can I lock in a sales credit recipient?

When assigning sales credits, you can lock the sales credit recipients of a revenue line by setting the corresponding Lock Credit Owner check box on the line. This setting prevents the recipient from automatic replacement when assignment is run.

Generally, you don't need to lock resources who are members of a forecast territory on the sales credit. However, you should consider locking ad hoc resources or non-territory-based recipients, such as partner resources, to prevent automatic assignment from removing them as credit recipients.

Related Topics
- Sales Credit Recipient and Forecast Territory Predefined Logic

Product Attribute Synchronization

Example of Product Line Synchronization with Win Probability

When you change the win probably percentage on an opportunity, the application automatically resynchronizes any product lines whose win probability percentages were previously in sync with the opportunity win probability.

Scenario
This example illustrates what happens when you change the opportunity win probability:

- Opportunity win probability is 50%.
- Product line 1 win probability is 50%.
- Product line 2 win probability is 50%.
- Product line 3 win probability is 40%.
You change the opportunity win probability to 60%. The application automatically changes the win probability for product lines 1 and 2 to 60% as well, because they were previously in sync with the opportunity-level win probability.

The win probability for product line 3 doesn't change, because it wasn't previously in sync with the opportunity-level win probability.

**Related Topics**
- What happens if I change win probability

**Opportunity and Product Line Attributes Synchronization**

Opportunities and their product lines share common attributes, for example, status or win probability percentage. For several attributes, under certain conditions, the application automatically synchronizes them so that they're the same. In addition, the application updates certain opportunity and product line attributes based on the values of other attributes.

The attributes that the application synchronizes or updates automatically are:
- Win probability
- Close date
- Include in forecast setting
- Status
- Win/loss reason
- Competitor

**Note:** An attribute is said to be synchronized if its opportunity and product line values are the same, and if the product line is in the same status category as its opportunity. If a product line and its opportunity both have undefined values, they're considered to have the same value.

**Synchronization of Opportunity and Product Line Attribute**

The application synchronizes certain product line attributes based on the opportunity-level attribute, under certain conditions.

Synchronization occurs for these attributes:
- Win probability
- Close date
- Include in forecast setting
- Status (not status category)

Here is an example of close date synchronization:
- An opportunity with an Open status category has a close date of July 14, 2018.
- Product lines 1, 2, and 3 have the same close date and they're in the same status category.
- Product line 4 has a different close date, but the same status category.
- The close date of the opportunity is changed to August 14, 2018. The application automatically sets the close dates of product lines 1, 2, and 3 to the same close date as that of the opportunity. The close date of product line 4 remains unchanged, because it has close date that wasn't already synchronized with the date of the opportunity.
Opportunity Status Updates
These scenarios explain what happens when the opportunity status is updated:

- Opportunity status is updated to a Won status:
  - The application updates the opportunity win probability to 100 percent. It also updates all synchronized product lines’ win probability to 100 percent.
- Opportunity status is updated to a Lost or No Sale status:
  - The application updates the opportunity close date to the current date. It doesn’t update the close date on synchronized product lines.
- Opportunity status is updated from an Open status to a Closed status:
  - The application enables the opportunity win/loss reason attribute.
  - If an opportunity primary competitor has been defined, the application updates the product line competitor to the opportunity primary competitor for all opportunity product lines, if they aren’t already defined. This action applies only to the close opportunity and mass update opportunities flows.
- Opportunity status is updated from a Closed status to an Open status:
  - The application disables the opportunity win/loss reason attribute.
  - The application sets the opportunity win/loss reason attribute to "undefined". It doesn’t update the win/loss reason on synchronized product lines.

Product Line Status Updates
These scenarios explain what happens when the product line status is updated:

- Product line status is updated to a Won status: The application sets the product line win probability to 100 percent.
- Product line status is updated to a Lost or No Sale status: The application sets the product line close date to the current date.
- Product line status is updated to a Closed status: The application enables the product line win/loss reason attribute.
- Product line status is updated to an Open status:
  - The application disables the product line win/loss reason attribute.
  - The application updates the product line win/loss reason attribute to "undefined".

Opportunity Win/Loss Reason Updates
When an opportunity is in an Open status, the opportunity win/loss reason attribute is disabled. Win/loss reason is activated when the opportunity is set to a Closed status. When the opportunity win/loss reason is updated, the application updates all opportunity product lines where the win/loss reason attribute is synchronized.

Note: If the opportunity line item status is set to inactive, then Reason field is editable in the List view so that you can include a reason why the line item isn’t active. However, the Reason field isn’t editable on the Form view of the Opportunity Line Item. This is expected behavior due to the difference in the page structure. The edit page from the List view has a table view for Revenues, while the Form page has a form view and is therefore not editable.
Opportunity and Product Line Competitor Updates

If a primary competitor has been defined at the opportunity level, when the opportunity status changes from an Open status to a Closed status, the application updates the product line competitor to the primary competitor for all lines that don't already have a competitor.

**Tip:** If a product line without a competitor is set to closed and the opportunity is saved, the application displays a dialog box that lets you copy the opportunity primary competitor to the product lines without competitors.

This action applies only to edit opportunity and close opportunity flows. It doesn't apply to the mass update flow.

*Related Topics*

- [Set Opportunity Revenue Forecast Criteria](#)
13 Forecasts

Overview of Forecasts

Your forecasts of future sales provide predictions of future revenue for specific time periods. Management uses sales forecast data to set production schedules and volumes, to determine resource requirements, and to report financial guidance to investors.

<table>
<thead>
<tr>
<th>What You Can Do</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Submit forecasts</td>
<td>You can view, manage, and submit your forecasts in the office and using the mobile application. You can:</td>
</tr>
<tr>
<td></td>
<td>• Review your forecasted product items and submit the forecast.</td>
</tr>
<tr>
<td></td>
<td>• View your pipeline that isn’t forecasted.</td>
</tr>
<tr>
<td></td>
<td>• Use embedded analytics to improve forecast accuracy.</td>
</tr>
<tr>
<td>View automatically generated forecasts</td>
<td>Your forecast for a period is automatically generated from eligible opportunity product items scheduled to close within the period. Forecasts are refreshed from the pipeline revenue in real time. Opportunities and forecast items continue to synchronize until you submit forecast items for final approval.</td>
</tr>
<tr>
<td></td>
<td>The sales administrator sets the criteria that determine whether a product item is eligible to be automatically included in a forecast. The administrator also provides the option for you to override the established criteria and manually include or exclude a product item from the forecast.</td>
</tr>
<tr>
<td></td>
<td>Forecasting reflects any edits you make to an opportunity, or any adjustments at the deal level in real time.</td>
</tr>
<tr>
<td>Forecast by territory</td>
<td>You forecast sales by territory. The forecasts roll up following the territory hierarchy. Changes to the active territory hierarchy are periodically synchronized with the forecast hierarchy up until a freeze date. After the territory freeze date, you can make changes to your forecasts.</td>
</tr>
<tr>
<td>Compare forecasts</td>
<td>You can view current, future, and past forecasts. The current forecast is open for editing at certain times and then frozen. Your manager can view the latest forecasting data and compare it to key metrics such as pipeline and won revenue.</td>
</tr>
<tr>
<td>Adjust forecasts</td>
<td>Sales managers can review and adjust forecasts anywhere.</td>
</tr>
<tr>
<td>Manage subordinates’ forecasts</td>
<td>You can quickly see which salespeople have submitted their forecasts, what has changed since the previous forecast, and the opportunities that comprise the forecast. You can also drill into your subordinates’ forecasts to view a forecast the same way that the salesperson sees it. This provides sales managers with the opportunity for more effective coaching and greater forecast accuracy.</td>
</tr>
<tr>
<td></td>
<td>You can add, remove, or adjust individual lines in a salesperson’s forecast, segment the totals by time period, and override forecast totals for each salesperson. Any adjustments are</td>
</tr>
</tbody>
</table>
### What You Can Do

<table>
<thead>
<tr>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clearly identified throughout the forecast hierarchy, allowing management to quickly view the changes made by sales managers who are on their team.</td>
</tr>
</tbody>
</table>

#### Record overlay forecasts

You can record overlay forecasts on opportunity revenue transactions in addition to the revenue sales credit split. Overlay forecasts allow nonprimary salespeople to forecast sales expectations for all overlay sales credits.

#### Forecast by product

If enabled, you can forecast by product, forecasting amount, and quantity.

---

How can I add forecast items to a forecast?

Watch video

To add forecast items to a forecast, navigate to Forecasts and click **Review**. Search for opportunity items on the Unforecasted Pipeline tab and add them to the forecast. For any forecast item with a warning icon, you must change any attributes that don’t meet the forecast criteria. When all attributes fall within the forecast criteria, the product item becomes part of your forecast.

You can also use a forecast override if the administrator enabled it for your territory. You can set the Forecast Option to Always to override the lack of matching forecast criteria. An icon warns you when a product item doesn’t match the forecast criteria and requires the forecast override.

If you’re unable to edit the forecast item you’re adding, then the item is added with the forecast amount set to zero. But, the item now has a positive adjustment amount to match the original product item revenue amount. For example, if the revenue amount is 3,000, then the forecast is 0, the forecast adjustment is 3,000, and the adjusted forecast is 3,000.

You can further refine the adjusted forecast item amount, or remove the forecast item if you no longer want the item included in the forecast.

---

### About Forecasting by Territory, Product, or Unit

You can forecast sales by territory and amount, by product and amount, or by product and quantity of units. A forecast covers a specified time period, such as quarter or month. A territory owner submits the current forecast to the owner of the parent territory, who’s likely the owner’s manager.

The application generates the forecast by capturing information from opportunity lines as follows:

- Opportunity items are placed in time periods according to the planned or actual close date.
- Only opportunities that meet the forecast criteria are included in a forecast.
- Opportunities assigned to a territory are added to the forecast for that territory.
Forecast Amounts by Territory
The territory owner forecasts the amount of sales for the territory by time period. The sum of the amounts for all included opportunity items is the forecast amount. Use the Edit Forecast page Territories tab and Forecast Items tab to forecast amounts by territory.

You can:
- Manually add opportunity items to your forecasts or remove them.
- Change the amounts for individual forecast items.
- Make adjustments by changing the total forecast amount for individual time periods for a subordinate’s territory forecast.
- Make adjustments to the amounts for a subordinate’s forecast items.

Forecast Amounts by Product
Within the territory, the territory owner forecasts the amount of sales for each product by time period. The forecast amount for each product is the sum of the amounts from opportunity items for that product. Use the Edit Forecast page Products tab and Forecast Items tab to forecast amounts by product.

You can:
- Manually add opportunity items to your forecasts or remove them.
- Change the amounts for individual forecast items.
- Make adjustments to the individual product amounts by time period.
- Make adjustments to the amounts for a subordinate’s forecast items.
- Make adjustments to the product amounts for a subordinate’s territory forecast.

Forecast Unit Quantities by Product
Within the territory, the territory owner forecasts the quantities of each product by time period. The forecast quantity for each product is the sum of the quantities from opportunity items for that product. Use the Edit Forecast page Products tab and Forecast Items tab to forecast unit quantities by product. In the Products tab, select to show Quantity or All Totals.

You can then, for your territory:
- Manually add opportunity items to your forecasts or remove them.
- Change the quantities for individual forecast items.
- Make adjustments to the individual product quantities by time period.
- Make adjustments to the quantities for a subordinate’s forecast items.

Manage Your Forecast

Watch video
Sales managers review and adjust the forecasts of their sales teams. You can add or remove items from your or a subordinate’s forecast. When you make adjustments, you can adjust quantities and amounts directly for an opportunity item. You can also make adjustments for a territory and add amounts that don’t come from existing opportunities.

Review Your Forecast

To review your forecast:

1. During an open forecast time period, navigate to Sales > Forecasts.
2. Review the graph to compare your group’s forecast with won revenue and the pipeline.
3. The second chart shows your group’s percentage of quota attained. Roll over the target quota amount to review quota and won revenue amounts.
4. Click the breadcrumbs to switch to your next forecast for review and back to your current forecast.
5. Click Review to see the details of your forecast.
6. Click Edit to make your changes.

Any subordinate forecasts that weren’t submitted by their owners will now be submitted for them

Edit the Forecast

The Territories tab shows your team’s forecasts, won revenues, open pipelines, and quotas. To edit your forecast:

1. Roll over the icons in the first column to see which territory owners submitted their forecasts.
2. Hover over the Forecast Change arrow to see what’s changed since you last submitted your forecast.
3. Click the Products tab.
4. Click Show and choose All Totals.
5. You can view and change the totals for current, best case, and worst case forecasts as well as the quantity for each product.

Adjust Opportunity Items in the Forecast

You can adjust the forecast for accuracy in two ways. Edit the totals by product or adjust the opportunities that sum to the totals. To adjust your forecast:

1. Click the Forecast Items tab.
   The tab lists the opportunity items currently in your forecast. The items meet the forecast criteria.
2. In the Show list, select one subordinate’s territory.
3. Select the opportunity item you want to change, and enter new values for quantity or forecast, or both.
4. Click the icon to remove an opportunity item.
5. Click Add Forecast Items to find and add a missing opportunity item.
6. Click Save.
   The opportunity items you edited show the new values, and the forecast totals are recalculated.
7. Hover over a blue dot next to one of your changed opportunity items.
   You see the adjustment you made, as well as the un-adjusted forecast submitted to you by the salesperson.
   The salesperson can’t see any of the changes you made.

Adjust and Submit the Forecast

You can adjust the forecast by product and submit the forecast to your manager. To complete your forecast:

1. Click the Products tab.
You can see the changes you made to the opportunities reflected in the respective product totals.

2. Deselect **Exclude All Rows with All Zero Values**.

You can now see and adjust all products.

3. Make your changes to quantities and forecast amounts to any products, including those with zero values.

4. **Save** your forecast.

5. **Submit** your forecast to your manager.

You can make no further changes after submitting your forecast.

**Sales Forecast Adjustments**

Changes you make to the original forecast up or down are adjustments. If your forecast is by product, then you can adjust quantities as well as the amounts for individual forecast items.

Depending on your configuration, you can adjust the following:

- The amounts for individual forecast items
- The total amounts for each territory owned by your subordinates and by time
- The total amounts by product and also by time period for your territory
- The quantities for individual forecast items
- The total quantities by product and also by time period for your territory

**Remove Adjustments**

To remove all of your adjustments, go to the Actions menu and select Remove My Adjustments.

**Copy Forecasts**

If you copy the prior forecast, then your copy takes the total forecast numbers from the previous forecast, including adjustments, and pastes them into your current forecast. These numbers overwrite any calculated totals from rolled up opportunity or adjustment data.

**Adjusted Best Case and Worst Case Forecasts**

The adjusted best case forecast is the sum of:

- The best case for all forecasted items
- Item-level adjustments for the best case
- Any summary level adjustment to best case

The adjusted worst case forecast is the sum of:

- The worst case values for all forecasted items
- Item-level adjustments for worst case
- Any summary level adjustment to worst case
Forecast Adjustment Notes
If enabled, you can add a note to each forecast item you adjust and add one consolidated note for all summary adjustments. Each note includes who created the note and when you created it. You can edit the notes that you created. Managers and senior management can view notes within their territory hierarchy. You can create notes for the following:

- **Forecast Items**
  A sales manager can add a note to each item included in subordinates’ forecasts provided the item is not in won status. Use the Note column in the Items tab to add, edit, or delete an adjustment note for an item. A VP sees item adjustment notes added by subordinates. When the VP drills down into the manager territory forecast, he can add notes to items.

- **Territory Summary**
  This is a single consolidated note for all the territory summary adjustments that the user can make in the territories tab. A VP sees summary adjustment notes added by subordinates in the territory row of the Territories tab. When the VP drills into the manager territory forecast, he sees the summary adjustment note added by the subordinate in the Territories tab.

- **Product Summary**
  This is a single consolidated note for the product summary adjustment you create in the products tab. A VP sees summary adjustment notes added by subordinates in the territory row of the Territories tab. When the VP drills into the manager territory forecast, she sees the summary adjustment note added by the subordinate in the Products tab.

Copy the Prior Forecast
Use the Copy Prior Forecast action to ignore the rolled up opportunity data and copy the numbers from the previously submitted forecast to the current forecast. Your copy takes the total forecast numbers, including adjustments, and pastes them to your current forecast. These numbers overwrite any calculated totals from rolled up opportunity or adjustment data.

Forecast Actions and Results
The actions you take with your forecast produce different results depending on the timing and the actions of others. Most forecast actions take place during the submission window. After the end of the submission window, everyone’s current forecast is frozen regardless of submission status. The next forecast is then available to view. At the start of the next submission window, a completely new forecast snapshot is available, and everyone’s forecast is ready to be submitted and adjusted again. Here are the most common actions you can do:

<table>
<thead>
<tr>
<th>Action</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Make changes to opportunities</td>
<td>The forecast is updated to reflect changes.</td>
</tr>
<tr>
<td>Add or remove forecast items</td>
<td></td>
</tr>
</tbody>
</table>
Oracle CX Sales
Using Sales

Chapter 13
Forecasts

<table>
<thead>
<tr>
<th>Action</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Submit your forecast</td>
<td>The forecast is frozen. You can’t make changes.</td>
</tr>
<tr>
<td>Withdraw your forecast after submission, but before your manager submits or adjusts his forecast</td>
<td>You can again make changes to the forecast and resubmit. Forecast numbers update from the pipeline.</td>
</tr>
</tbody>
</table>

If you have subordinates, then you can also do these actions.

<table>
<thead>
<tr>
<th>Action</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adjust numbers for forecast items</td>
<td>If previously unsubmitted, all subordinates’ forecasts are submitted and frozen when you edit your forecast. The subordinate’s forecast is frozen and can’t be changed by the subordinate. All direct and indirect subordinates can’t make changes unless you remove your adjustments and reject each subordinate’s forecast. Forecast numbers no longer update from the pipeline. The adjustment becomes the current forecast and ignores the rollup values from current forecast items.</td>
</tr>
<tr>
<td>Adjust totals, including copy previous forecast totals to the current forecast</td>
<td></td>
</tr>
<tr>
<td>Edit a subordinate’s unsubmitted or rejected forecast</td>
<td>You can act as your subordinate, so all edits and adjustments can be seen by your subordinate. You can adjust the forecast only if your subordinate can adjust his own forecast.</td>
</tr>
<tr>
<td>Submit a subordinate’s unsubmitted forecast</td>
<td>Your subordinate’s forecast is frozen and can’t be changed by her. All direct and indirect subordinates can’t make changes to the forecast unless you remove your adjustments and reject each subordinate’s forecast. Forecast numbers no longer update from the pipeline.</td>
</tr>
<tr>
<td>Remove your adjustments</td>
<td>Adjustments are removed. Opportunity changes are ignored for as long as your subordinate’s forecast remains submitted.</td>
</tr>
<tr>
<td>Reject a subordinate’s forecast</td>
<td>The application will clear all your adjustments of your subordinate’s forecast. Your subordinate can again make changes to the forecast and resubmit. If the subordinate is a sales representative, then the forecast numbers update again from the pipeline.</td>
</tr>
</tbody>
</table>

Available Forecast Metrics

Metrics provide calculated measures based on historical or current transactional data. You can refer to metrics when making forecasting decisions.

This table shows the available metrics and how they’re calculated:
<table>
<thead>
<tr>
<th>Metric</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Best Case Forecast</td>
<td>The sum of all best case revenue values for all forecast items in the forecast period.</td>
</tr>
<tr>
<td>Closed Revenue</td>
<td>Actual revenue that was closed during the forecast period.</td>
</tr>
<tr>
<td>Estimated Adjustment</td>
<td>The sum of the difference between estimated revenue and revenue for all transactions in the forecast period. Statistical analysis provides the estimated revenue amounts based on historical sales for the product.</td>
</tr>
<tr>
<td>Expected Forecast</td>
<td>The sum of all weighted revenue values for all forecast items in the forecast period. Weighted revenue is the revenue amount multiplied by the probability of the deal closing.</td>
</tr>
<tr>
<td>Likelihood to Buy Product</td>
<td>The percentage of confidence that a deal will close with the specified revenue on the specified close date. Statistical analysis provides the likelihood to buy product based on historical sales for the product.</td>
</tr>
<tr>
<td>Pipeline</td>
<td>The total revenue amount of all product lines where the Status category is Open, the primary territory is the target territory, and the close date lies in the forecast period.</td>
</tr>
<tr>
<td>Quota</td>
<td>The quota metric is the revenue target associated with the expected performance of a salesperson’s territory for a given forecast period.</td>
</tr>
<tr>
<td>Worst Case Forecast</td>
<td>The sum of all worst case revenue values for all forecast items in the forecast period.</td>
</tr>
</tbody>
</table>

**FAQs for Forecasts**

**How can I remove forecast items from a forecast?**

You can click the item in the Forecast Items tab to open the opportunity and make changes. For any product item with a warning icon, you must change any attributes so that the product item doesn’t meet the forecast criteria or so that the forecast item no longer closes within the forecasting period.

A sales manager can drop the item by selecting Remove from the Action menu for the item in the Forecast Items tab. To see your deleted items, choose Dropped Forecast Items from the Show list. You can then add any dropped items back to your forecast by clicking the Add icon for the item.

You can also use a forecast override if the administrator enabled it for your territory. You can set the Forecast Option to Never to override the matching forecast criteria. An icon warns you when a product item matches the forecast criteria and requires the forecast override.

If you’re unable to either change the forecast criteria for the item or use the override, the item disappears from your forecast items list, but the forecast amounts remain the same. But, the item now has negative adjustment amounts to match the forecast amounts. For example, if the forecast amount is 3,000, then the forecast adjustment is negative.
3,000 and the adjusted forecast is 0. With the removed forecast item selected, you can add it back in if you want to include the item back in the forecast.

**When does my forecast appear in my currency?**

Your forecast appears in your preferred currency. You can select a different currency from the Currency list. Your selected currency also applies to your view of subordinate forecasts. However, the currency selection doesn't apply to any graphs or reports that were added to the forecasting screens.

**When do I submit my forecast?**

You can make changes to your forecast and submit it during the submission window. You can submit your child territory forecasts on behalf of your subordinates and then make adjustments to your forecast before submitting.

**What happens if I submit my forecast?**

You can't make adjustments or update your forecast after you submit it. Your manager can make adjustments to your forecast only after your submission. If your manager rejects your forecast, then you can make further changes to the rejected forecast and then resubmit it.

**What happens if I select Forecast not visible to territory owner?**

The owner of a parent territory sets this option to perform all forecasting actions and hide forecasts from the child territory owners. The owner of the parent territory can submit the forecast for the child territory. If the child territory owner also owns the parent territory, then the territory owner can edit forecast items, add and remove forecast items as adjustments, and adjust the territory forecast.
14 Territories

Overview of Territories

Your territories contain rules for automatically assigning salespeople and other resources to accounts, contacts, households, partners, leads, and opportunity items.

Salesperson

As a salesperson viewing an account, partner, lead, or opportunity, you can see the assigned territories when you view the sales team information. You also forecast your sales by territory. Sales quotas can be assigned to you by territory.

Sales Managers

As a sales manager, you can modify the territories in the hierarchies below your assigned territories. Your sales administrator must create the top territory first. If you see no Parent field and no existing territories, then the top territory doesn’t exist. Here are examples of changes you can make to territories:

- Add a new child territory.
- Change the owner of an existing territory.
- Add team members to a territory.
- Remove an existing territory.
- Add specific accounts, contacts, and households to the coverage of a territory.
- Exclude specific accounts, contacts, and households from the coverage of a territory.
- Define or change the definition of a territory coverage.

You can change an active territory directly without using a territory proposal. You can:

- View a list of territories.
- Look at the details for a territory.
- Use the Summary tab to change attributes of the territory.
- Use the Dimensions tab to modify the boundaries of the territory.
- Use the Inclusions tab to add specific accounts, contacts, and households to the territory.
- Use the Exclusions tab to exclude specific accounts, contacts, and households from the territory.
- Use the Team Members tab to change team members or the territory owner.
- Use the Child Territories tab to navigate the territory hierarchy and to add a new child territory.

Modify Your Territories
This example describes each tab in the Territories work area and the typical tasks you perform as a sales manager. Let's explore the following tabs in the work area:

- Summary tab
- Dimensions tab
- Team Members tab
- Child Territories tab

View the Summary and Dimension Tabs

1. Click Navigator > Territories.
2. In the list of your team's territories, click the Ireland territory name. The summary tab displays commonly used territory attributes. You can use Application Composer to add other attributes to this tab.
3. Click the Actions menu. From this menu you can delete this territory including all of its children. You can also delete this territory coverage or add coverage if it has none.
4. Click the Dimensions tab. The dimensions tab displays the defined boundaries of the territory. You can add or change the values that define the territory coverage.
5. Click Edit. The coverage dimensions include a set of attributes and their corresponding values. An account that matches these attributes will be assigned to this territory.
6. Select the Industry dimension.
7. To add an industry to the coverage, select it in the Available region and use the arrow to move it to the Selected region.
8. Select the Geography dimension.
9. Click Edit. Choose to add the values you select to the existing values for geography and click OK.
10. Enter values separated by commas, or a range of values. Enter a range of postal codes, 85001-85030. You can use a range of values only for the Geography or Address dimensions.
11. Click Cancel until you return to the Edit Coverage Dimensions page.
12. Click Remove All. Select the Remove All selection will remove all coverage for this territory.
13. You can add individual customers to this territory in the Inclusions tab.

View the Team Members Tab

1. Click the Team Members tab. This tab displays the territory team members. You can add or remove team members and change the territory owner.
2. The Owner column contains a check mark to indicate Paddy Joyce is the owner of this territory. Click his name. The Resource Details dialog shows information about Paddy Joyce. You can send an e-mail to Paddy by clicking the e-mail address on this dialog or in the Team Members page.
3. In the **Function** field for Paddy, change his *function* to **Sales Representative**. This is the function Paddy has in this territory team.

**View the Territory Hierarchy**

1. Click the **Summary** tab.
2. Click the name of the parent territory to open the Edit Territory page for the parent.
3. Click the **Child Territories** tab to see all child territories of the open territory.
4. Click the **Ireland** territory.
5. Click the **Child Territories** tab.
6. Click **Create Territory**.
   Notice that the parent territory is Ireland.
7. Click **Cancel**.
   When you click Save, or Save and Close, your changes immediately become the active definition for this territory.

**Territory Proposals, Coverage and Dimensions**

**Create a Territory Proposal**

You can update active territories directly, or use a territory proposal as a sandbox where you make your proposed changes to your territory hierarchy before activating the changes.

⚠️ **Tip:** Use proposals for territory realignments or changes to be activated at a future date.

1. Click **Navigator > Territories**.
2. Click **More Details**.
3. In the Active Territories page, click the **Manage Proposals** button.
4. In the Current Territory Proposals region, click **Create**.
5. In the Create Territory Proposal window, enter a name for your proposal.
6. You can enter an **Activation Date** or accept the default which is immediate activation.
7. Click **Save and View**.

Your territory proposal opens and displays your current territory hierarchy. You can start making your changes.

**Add Child Territories to Your Territory Hierarchy**

You can add child territories to your own territory or to another territory in your hierarchy.

**Change Active Territories**

You can make immediate changes to your active territories. If you see no territories and no parent territory field, then your sales administrator must first create the top territory for the hierarchy.

1. Select from your territories list the territory that will be the parent to your new territory.
2. Go to the Hierarchy tab.
3. Click **Create Territory**.
4. Enter the territory name.
5. Select the owner for the territory.
6. If Territory Precedence is enabled, then you can select a territory function. Assignment compares all territories with the same function and gives precedence to the territories containing included accounts.
7. Click Save and Continue.
8. Go to the Dimensions tab.
9. To change dimension definitions, click Edit.
10. Select a dimension and move the values you want to the Selected column.
11. Optionally, click Edit and enter several members or ranges of members separated by commas and click OK.
12. Click OK.
13. To add an account, select the Inclusions tab.
14. Click Add Customers and select Accounts.
15. Use the Exclusions tab to select customers to be excluded from the territory. (Use Application Composer to enable the Exclusions tab.)
16. Use the Team Members tab to add members to the territory team.
17. When you complete making all changes, click Save and Close. Your new territory is now active.

Use Territory Proposals

Add territories using a territory proposal you created.

1. In the Manage Territory Proposals page, select the name of your proposal.
2. In the Edit Territory Proposal page, select the parent territory.
3. From the Actions menu, select Create and Update > Create Child.
4. Enter the territory name.
5. Select the owner for the territory.
6. If Territory Precedence is enabled, then you can select a territory function. Assignment compares all territories with the same function and gives precedence to the territories with included accounts.
7. Click Save and Close.
8. Click Edit Coverage.
9. The coverage for the child territory is the same as the parent’s coverage. Select the members for each dimension that you want to change.
10. Click Save and Close.

How can I move a territory in the hierarchy?

When you edit an active territory, you can change the parent territory on the Summary tab. Click the X to delete the current parent and use the choice list or the search to select a new parent territory.

In a proposal, select the territory you want to move. In the Actions menu, select Create and Update > Move. Select the new parent on the Move Territory page and click Save and Close. The territory appears in the new position in your proposal hierarchy.

Change Territory Coverage in a Proposal

A new child territory has the same coverage as the parent. Change dimension selections and included or excluded accounts, contacts, and households to refine the coverage. Your changes aren’t active until you activate the proposal.

1. In the Manage Territory Proposals page, select the name of your proposal.
2. In the Territories table, select the territory you want to change.
3. If the territory isn't already added to the proposal, then click **Add to Proposal**.
4. Click **Edit Coverage**.
5. In the Edit Coverage window, do this for every dimension you want to change:
   a. Select the dimension from the **Dimensions** list. (For the Address dimension, enter values in the correct address column.)
   b. Add or remove dimension members from the Selected Dimension Members box.
   c. Optionally, click **Add Members in Bulk** and enter several members or ranges of members separated by commas and click **OK**.
   d. Click **Save and Close**.
6. In the Included Customers region, select and add specific accounts, contacts, and households to include in the territory.
7. In the Excluded Customers region, select and add specific accounts, contacts, and households to exclude from the territory.
8. Click **Done**.

### Activate a Territory Proposal

When you finish making changes to your territories, use this procedure to activate your territory proposal and start using the new territories for assignment.

1. Click **Navigator > Territories**.
2. Click **More Details**.
3. In the Active Territories page, click the **Manage Proposals** button.
4. If the proposal you want to activate doesn't appear in the Current Territory Proposals table, select **All Proposals** from the Proposals list.
5. Select the proposal and click **Activate**.
   
   You can see the activation process status in the Details region of your proposal.
6. Click **Done** to return to Manage Proposals.
7. Click **Done** to return to the Overview page. Your territory changes now appear in the list of active territories.

### How Dimensions Define Territories

Dimensions define territory boundaries. A territory captures business objects, such as customers, that fall within the defined boundaries of the territory. If your territory boundary covers Spain, then an account in Spain is your customer.

#### Dimensions to Assign Customers or Partners

You can define a territory either for partners or for customers, but not for both. You select either Customer or Partner for the **coverage model**. When creating a territory, you can include individual customers or partners by selecting them for the **territory coverage**. Dimensions to define customer or partner territories are:

- Geography or Address, but not both
- Account type

   The account type designates the customer designated as a named account or not named. This dimension is only available for customer territories.
• Customer size
• Industry
• Organization type

Your administrator can also use classification categories to define up to three additional dimensions.

Dimensions to Assign Leads and Opportunities

Your territory is assigned to leads and opportunities using the attributes of the customer or partner on the transaction. These additional dimensions can match attributes of the lead or opportunity to assign your territory:

• Business unit
• Product

  Groups of products form a hierarchy in the sales catalog.
• Sales channel

  The available sales channels are Direct, Indirect, and Partner.

For example, your company is launching a new product line in all countries. One sales manager with a small sales team specializes in selling only the new product line. You define the sales manager’s territory only by the new product line and define geography as Any.

Related Topics

• Territory Coverage
15 Quotes

Overview of Using Quotes

Create quotes and orders from an opportunity as part of a deal or directly from an account using the automated opportunity-to-quote-to-order process. The quotes and orders feature lets you:

- Create professional proposal documents.
- Share quotes and collaborate with customers to close the deal.
- View quote summary information and drill down into quotes to view details.
- Create valid product configurations in the integrated quoting application.
- Perform automated pricing calculations.
- Specify pricing and discounts.
- Streamline approval processes.

Create Quotes in Sales

While working on an opportunity or account, you can create, update, duplicate, and version quotes. You can add and remove products and change pricing. When you’re satisfied with a quote, you can save it and then mark that quote as active. When you create, edit, or version a quote, you navigate to the integrating quoting service, Oracle Configure, Price and Quote (CPQ) Cloud. The application carries the opportunity ID and account ID into CPQ, and when you save the quote, CPQ creates the new quote. When you return to the sales application, the newly created quote reflects there, associated with the opportunity or account it relates to.

The Quotes and Orders page displays only opportunity-related quotes.

Access Quotes

In the sales work area, you access quotes by:

- Searching for quotes using the global search
- Navigating to the Quotes and Orders landing page within the Sales work area
- Viewing and updating quotes from within an opportunity or an account

For the quotes you have access to, the details include quote number, quote amount, status, and proposal document.

You can find quotes on these UIs in the Engagement Cloud:

- In an opportunity, on the Quotes and Orders tab that displays only opportunity-based quotes.
- In an account, on the Quotes and Orders tab that displays only account-based quotes.
- At the top level on the Quotes and Orders page, that displays only opportunity-based quotes.

Synchronizing Opportunity Products and Status

The application automatically synchronizes opportunity products and associated revenue in the quote lines. Marking a quote as active enables the automatic synchronization of the quote lines with the opportunity revenue lines that
were the source of that quote. When you update an opportunity, the application saves the first three rows with the information.

For more information on using Oracle CPQ see the Oracle CPQ Help Center, linked in this topic.

Related Topics

• Oracle CPQ Cloud Help Center

Overview of Quotes and Orders

Watch video

Using the Oracle Engagement Cloud quotes and orders feature, you can create quotes from an opportunity as part of a deal cycle or directly from an account. You can view basic quote information such as quote number, quote amount, status, and proposal document for all quotes to which you have access and then drill down into the quote to view details.

Get quick access to the quotes you need using the global search. Search on External Quote Number, Order Total, Status, Expiration Date, Opportunity Name, Opportunity Number and Account Name.

In addition to listing all quotes as well as quotes that you own, you can create your own personal list. For example, you want quick access to a listing of quotes for which an order has been submitted or quotes with amounts greater than $1 million.

You can modify the quote details for an opportunity or account by drilling down on the quote links from the Quotes and Orders landing page. This action takes you to the Oracle Configure, Price and Quote (CPQ) Cloud service screen, where you can modify the quote details. For example, you can update the quantity of servers that a customer wants to purchased, and the sales figures are immediately updated. Click Update Opportunity to sync your changes back to your sales application and when done, return to your sales application.

When you drill down on an opportunity and click the Quotes and Orders tab, then from the resulting page, you can edit the quote, create a new version, or duplicate the quote. You can also create a new quote or navigate to the quote record.

Create and Update a Quote for an Opportunity

You can create, view, and share quotes information from the opportunities UI through integration with the Oracle Configure, Price, and Quote (Oracle CPQ Cloud) quotes feature.

With quotes, you can:

• Create professional proposal documents including current product and pricing information within an existing opportunity.
• Create multiple quotes and orders for an opportunity, including multiple versions for the same quote.

Note: Only one quote or sales order version can be active for an opportunity.
When you create or update a quote or sales order in the Oracle CPQ Cloud quoting application, the associated opportunity, if active, must be updated in your sales application with the same changes. Updates include additions, deletions, and updates to product (revenue) lines on the opportunity.

Note:

Other updates such as issuing the quote to a customer and submitting it as a sales order are performed only within Oracle CPQ Cloud application.

Create a Quote from an Opportunity

When you create a quote from an opportunity in your sales application, Oracle CPQ Cloud automatically starts. The opportunity ID and account ID is copied to CPQ, and when you save the quote, CPQ creates the new quote. When you return to the sales application, the newly created quote is available for you and is associated with the opportunity or account it relates to.

Here's how to create a quote from an opportunity:

1. From the springboard or Navigator, click **Sales > Quotes and Orders**.
2. From the Quotes and Orders landing page, edit an opportunity.
3. From the Edit Opportunity page, click the **Quotes and Orders** tab.
4. Click **Create Quote** and the application automatically signs you in to CPQ.
5. In CPQ, start creating the quote by clicking **Add Line Item**.
6. Enter the remaining quote information.
7. When done, click the **Update Opportunity** tab to synchronize your changes back to your sales application.
8. Click **Return to Engagement Cloud**.

Update Opportunity Products and Status

You can automatically synchronize opportunity products and associated revenue with quote lines. If you’re satisfied with a quote, save it, and then mark that quote as active. Setting a quote as active enables the synchronization of the quote line items with the opportunity revenue lines. When you update an opportunity, the first three rows that contain the revenue information is saved.

Here's how to update a quote from an opportunity:

1. From the springboard or Navigator, click **Sales > Quotes and Orders**.
2. From the Quotes and Orders List page, click the Opportunity link for which you want to update a quote.
3. From the Edit Opportunity page, click the **Quotes and Orders** tab.
4. Locate the quote you want and click **Edit** from the Actions menu. You’re signed in to CPQ.
5. In CPQ, update the quote.
6. Click the **Update Opportunity** tab to synchronize your changes back to your sales application.
7. Click **Return to Engagement Cloud**.

For more information about using Oracle CPQ, see the Oracle CPQ Help Center, linked in this topic.

**Related Topics**

- Oracle CPQ Cloud Help Center
Create and Update a Quote for an Account

While working on an account you can create, update, duplicate, and version associated quotes to reflect the product and pricing configuration.

Here’s how to create a quote from an account:

1. From the springboard or Navigator, click **Sales > Accounts > Quotes and Orders**.
2. From the Quotes and Orders landing page, edit an account.
3. From the Edit Accounts page, click the **Quotes and Orders** tab.
4. Click **Create Quote** and the application automatically signs you into CPQ.
5. In Oracle Configure, Price and Quote (CPQ Cloud), click **Add Line Item** and start creating the quote.
6. Enter the remaining quote information.

   See the Help Center for CPQ Cloud for information about adding line items for your quote.

7. When done, click the **Update Account** tab to synchronize your changes back to your sales application.
8. Click **Return to Engagement Cloud**.

Related Topics

- Oracle CPQ Cloud Help Center
16 Quotas

Overview of Sales Quotas

You set annual quotas for your sales organization from the top down. Effective top-down planning with bottom-up assessments ensures that quotas relate to corporate goals. After the sales plan is deployed for the year, sales executives can then monitor and track sales performance by comparing forecasts with sales and with quotas.

Features

Here are some key features:

- Assign territory quotas to territories and resource quotas to people.
- Create sales goals such as number of sales calls.
- Review quotas assigned to you by your senior manager and allocate quotas to your salespeople.
- Compare quota to revenue, pipeline, forecast, and other metrics using business intelligence.
- Use formulas to calculate territory quotas using measurements of historical data and future potential.
- Add adjustments to your quota to cushion against attainment risk.
- Track current quota achievement compared with quota targets.
- Manage seasonal variations in sales by distributing the revenue quota among several calendar periods using seasonality guidance.
- Send notification to Incentive Compensation with new and changed individual quota assignments for all sales goals.
- Use a round trip export, update, import of quotas to add bulk quotas from spreadsheets.

How You Allocate, Publish, and Revise Quotas

When you complete assigning quotas to your directs, you publish the quotas to the owners and resources of your child territories. Child territory owners can then view their quotas for the territories they own. Publishing your quotas also sends notifications containing resource quota information to an incentive compensation analyst. The territory owner and your manager receive notifications that the quotas are published.

Allocate Quotas

You can allocate quotas in the Manage Sales Quotas page. Sales administrators can enter and edit territory and owner quotas for any territory quotas that aren’t published. Sales managers can enter and edit child quotas that aren’t published. For territory quotas that aren’t published, you can also:

- Enter or edit a quota for each period
- Apply seasonality factors
Select a parent territory and click Details to use the Edit Sales Quotas page to enter or edit quotas. You can enter annual quotas, period quotas, and apply seasonality to any quotas not published.

Publish Quotas
When you finish allocating your quota, you publish the quotas to make them available to your directs. After publishing, you can't make changes to the quotas.

You can select one or more territories to publish. If you click Publish Child Territories, then the selected territories and their children are published. A sales administrator can publish a hierarchy of territories from the Actions menu. When you publish a territory, you publish the following, and the data becomes available for Business Intelligence:

- Territory quota
- Resource quotas for all sales goals for the selected territory
- Quotas assigned to finer time periods

If you didn't apply seasonality to quotas, then the publishing process applies the seasonality factor that was defined in the sales quota plan for the territory. If there are no seasonality factor groups defined, then seasonality factors aren't applied and there is no granular time period quota. Excluded territories can't be published. Publishing fails if the selected territory or any territory resource has no quota.

Tip: Save time entering period quotas. Seasonality gets applied automatically when you publish if you haven't manually entered period quotas.

Copy Territory Quotas to Resource Quotas
By setting two profile options, the administrator enables the automatic copying of quotas during publishing. Publishing does the following:

- Copies the territory owner's annual quota for the sales revenue goal to the owner's resource quota.
- If the owner's annual resource quota is zero, then publishing copies the territory period quotas to resource period quotas. It overwrites any existing resource period quotas.

Revise Quotas
Before you can revise published quotas, you must change the quota status to Pending Revision. The Revise action changes the status for your selected territory and its children. You can then revise territory quotas, and add, revise, or end date resource quotas. When you complete your revisions you can again publish the quotas and send notifications. The territory quotas change to the Published status and resource quotas change to the Submitted status.

When you revise quotas, the revised values aren't available in Business Intelligence until you republish the revised quotas.

Related Topics
- Copy Territory Quota to Resource Quota Options

FAQs for Quotas
What's seasonality?

You distribute annual quotas to shorter time periods, factoring in seasonal expectations in sales. This expectation is represented as a percentage factor, which reflects the share of quota for the season, or time period.

For example, your sales are typically higher the last quarter of the year and at their lowest the first quarter of the year for several of your product lines. You create a seasonality group named Retail to automatically distribute your annual quota and factor in the seasons.

- 10 percent for the first quarter
- 25 percent for the second quarter
- 25 percent for the third quarter
- 40 percent for the fourth quarter

When you assign quota to territories that include these product lines, you apply the Retail seasonality group to correctly distribute the annual quota amounts.

What's an adjustment?

An adjustment is the amount that territory owners, or sales managers who have child territories, add to the territory quota assigned to the territory they own. The territory owner can then allocate the adjusted territory quota to child territories.

What's a variance?

The variance is the difference between the adjusted quota amount for the parent territory and the rolled up total amount from the child territory quotas. The variance can be spread, meaning it gets added to the child territories.
Chapter 17
Analytics

Overview of Sales Analytics Pages

Oracle provides a broad set of analytics and analytic pages to give you quick access to key insights and metrics for all aspects of your sales organization. This table shows the various options for using analytics for sales organizations.

<table>
<thead>
<tr>
<th>Sales Analytics</th>
<th>What's Available</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prebuilt or Build-Your-Own Analytics</td>
<td>Your application comes with over 150 prebuilt analytics. There are role-based analytics as well as analytics for the organization in general. Administrators create and edit analytics, as well as add them to the user interfaces. If you want to build your own, there is an easy drag-and-drop editor for creating analytics.</td>
</tr>
<tr>
<td>Sales Infolet Page / Sales Pages</td>
<td>You get to the Sales Pages by navigating from the Home page using the white navigation dots. The Sales Infolet page comes enabled, and prebuilt with infolets specific to many of the roles in your organization. The five Sales Pages are enabled and configured by your administrator.</td>
</tr>
<tr>
<td>Analytics Tabs</td>
<td>Many of your work areas such as Opportunities, Contacts, Accounts, and the Analytics page, provide additional Analytics tabs with detail in context to the information you're viewing. These tabs appear along the side of the page. Typically, administrators and some manager roles add analytics tabs to work areas for users.</td>
</tr>
<tr>
<td>Analytics Page</td>
<td>From the Home page click Sales and then click Analytics. Users search and make analytic favorites which persist on this page as long as they remain favorites. This page also shows analytics recently viewed by the signed-in user.</td>
</tr>
</tbody>
</table>

Sales Analytics Interfaces

Oracle Sales provides many options for getting key analytic data for sales users.

Sales Analytics Pages

With Oracle Sales analytics you have analytics interfaces right at your fingertips. You can make favorite analytics on your Analytics page, and your administrator can add analytics to your Sales Pages.
Interfaces where you view analytics:

- **The Sales Pages**: The Sales Infolet page comes enabled and prebuilt with analytics specific to many of the sales roles. The Sales Pages are enabled and configured by your administrator.
- **The Analytics Page**: You personalize this page by adding favorite analytics. It also shows recently viewed analytics.

  **Note**: Depending on your implementation and software version, some page icons, menu links, and navigator options may not be available.

### Exploring the Sales Infolet Pages

The sales Infolet pages contain analytics that can be viewed on mobile, tablet, or laptop. Clicking an infolet drills down to more detail on an analysis. Your administrator can change the content that you see on these pages. The Sales Infolet page comes prebuilt with analytics that show data specific to the many sales roles in your organization.

### Exploring the Analytics Page

From the Home page you get to your Analytics page by clicking **Sales** and then **Analytics**. You configure which analytics you see on this page by searching for analytics, and marking them as your favorites. Favorites remain on your Analytics page to view at any time.

This figure shows the Analytics page with the Search for analytics option and the favorites marked with the gold star.
18 Office 365

Overview of Office 365 for Sales

Use Oracle add-in Office 365 to maximize productivity by accessing your sales application data, such as mails and appointments, from within Office 365.

Here’s what you can do in the application.

<table>
<thead>
<tr>
<th>Features</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Access your sales application information within Office 365.</td>
<td>Manage sales records and activities from within Microsoft Office 365.</td>
</tr>
<tr>
<td>Share Office 365 mails with your sales application.</td>
<td>Save your Office 365 mails in your cloud service application as activities and associate them with accounts, leads, or opportunities.</td>
</tr>
<tr>
<td>View the top contact connections in the side panel.</td>
<td>Use your organization’s resources that interact the most with a contact to gain better insight into the contact.</td>
</tr>
<tr>
<td>Synchronize data between your sales application and Office 365.</td>
<td>Synchronize contacts, appointments, and tasks between your sales application and Office 365 to have a continuously updated and accurate 360 degree view.</td>
</tr>
</tbody>
</table>

Prerequisites

If you use Internet Explorer for online Office 365, do these two things before you connect to the Oracle Office 365 add-in.

1. Turn off the compatibility setting: Display intranet sites in Compatibility View.
2. Add sites as Trusted sites.

<table>
<thead>
<tr>
<th>Prerequisite 1 for Internet Explorer: Turn off the compatibility setting</th>
<th>Prerequisite 2 for Internet Explorer: Add Few Sites as Trusted Sites</th>
</tr>
</thead>
<tbody>
<tr>
<td>Turn off the setting, <strong>Display intranet sites in Compatibility View</strong> for the Oracle add-in to appear well in the side panel. Here’s how you can turn off:</td>
<td>For the Oracle add-in to open in the side panel, add these sites as the Trusted Sites in your IE browser. Navigate to Settings &gt; Internet Options &gt; Security &gt; Trusted Sites &gt; Sites and add these sites as Trusted sites:</td>
</tr>
<tr>
<td>1. Open Settings in Internet Explorer.</td>
<td>1. https://*.office.com</td>
</tr>
<tr>
<td>2. Go to the Compatibility View Settings.</td>
<td>2. https://*.office365.com</td>
</tr>
<tr>
<td></td>
<td>3. Add the host of the pod. Ex: <a href="https://something.oraclecloud.com">https://something.oraclecloud.com</a></td>
</tr>
</tbody>
</table>
First Time Sign In

The first time you sign in, open the Oracle add-in in your Office 365 application. The add-in opens in a side panel, showing the **Connect** button and a check box ‘This is a trusted device’. Only if you’re using your own computer, select this check box.

Click **Connect** to connect the Office 365 application with Oracle. Provide your Oracle credentials. During your first sign-in, as a one time activity, you must authorize the relationship between your Oracle account and your Office 365 account. This ensures that only your Oracle account can access the side panel from your Office 365 account.

Side Panel Components

Integrate your sales application and Office 365 to access your cloud data, such as contacts and appointments, through the side panel. You can also manage synchronization settings for contacts and activities using the side panel.

You see the side panel when you open an email. The side panel displays relevant information about all the known and unknown contacts associated with the email.

Here are the three main regions of the side panel:

- **Records**
- **Connections**
- **Activities**

**Records**

View the accounts, open opportunities, and open leads associated with the contact in the Records tab. Associate an email as an activity with any of the accounts, opportunities, and leads. Resources on the email are automatically added to the activity.

*Note:* If the contact you’re viewing isn’t the primary contact of a lead, the lead isn’t displayed as a related record.

**Connections**

View a list of resources from your company who have interacted most with the contact. These connections are listed in the order of resources with most interactions to resources with least interactions. Interactions are a set of emails, appointments, and calls with the contact.
You can view interactions from the current month, back to the first email, appointment, or call logged against the contact. You can also select a specific month or year to view activity history for that point in time.

Activities

View the history of a contact’s activities in the Activities tab. You can also create, edit, and delete activities, such as appointments and tasks using the side panel.

The activities created, edited, or deleted in the side panel are automatically updated in your sales application. However, if you import an activity to your sales application and synchronize it with Office 365, the activity exists in Office 365, even after you delete in your sales application. You must delete the activity in Office 365 as well.

Search Using the Side Panel

You can select predefined saved searches from the side panel or create your own saved search in the sales application. When you select a saved search, the corresponding records matching the saved search are synchronized with Office 365 when the next synchronization runs.

These are the predefined saved searches options for contacts and activities such as appointments and tasks:

<table>
<thead>
<tr>
<th>Saved Search</th>
<th>What Gets Searched</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Contacts</td>
<td>All contacts in your sales application.</td>
</tr>
<tr>
<td>My Business Contacts</td>
<td>All contacts belonging to all the accounts you own.</td>
</tr>
<tr>
<td>My Contacts</td>
<td>All contacts, of the type account, that you’re an owner of.</td>
</tr>
<tr>
<td>My Favorite Contacts</td>
<td>All your favorite contacts.</td>
</tr>
<tr>
<td>My Open Activities</td>
<td>All appointments that are open and you’re a resource for in your sales application.</td>
</tr>
</tbody>
</table>

Create Contacts from the Side Panel

Add contacts to your sales application from your Office 365 account and maintain a consolidated list of contacts to work more effectively. Use the side panel to identify which of your contacts, from an email, exist in your sales application and those that you need.
Add Contacts to Your Sales Application

You must have an email open on Office 365 to add a contact to your sales application. If your contact already exists in your sales application, the side panel displays the name of the contact. If the contact doesn’t exist in your sales application, the side panel displays the person icon and the email ID.

Here's how you can add a contact to your sales application.

1. Open an email in Office 365.
2. Click **Create Contact**.
3. Enter relevant information to create your contact.

   **Note:** The email is automatically populated with the email ID that the opened email displays. You can’t edit the email ID.

4. Click **Save**.

The full name of the contact you just added now appears in the side panel, indicating that the contact is added to your sales application.

To edit or open the contact in your sales application, click the ellipsis icon on the home page and select the option you want.

Create Contacts Automatically

Your application can automatically create contacts who are part of a shared email sent to you or your sales team.

You have the option whereby the application automatically creates the contacts or the application sends a notification and you choose to create the contact in the sales application. If your application has Oracle Data as a Service (Oracle DaaS) configured, then additional information from Oracle DaaS is used to augment the contact data.

Set Communication Preference of a Contact

Among your contacts, few people may not prefer to be called on phone, emailed, or get mails to their home or office address. You can indicate the communication preference as 'Do Not Call', 'Do Not Email', or 'Do Not Mail' from the Oracle add-in. If you have set do-not-contact preferences in sales application, the add-in indicates them in the Contacts list view.

Here are the steps to turn on these communication preferences from add-in:

1. Open Contacts from the Menu.
2. For an existing contact, open their details in the Edit mode. For a new contact, set the preference while you are creating the contact.
   - **Do Not Call** is available on the contact number fields. Once you set this, the indicator reflects for all the contact numbers.
   - **Do Not Email** is available on the Email fields. Once you set this, the indicator reflects for all the email IDs of the contact.
   - **Do Not Mail** is available on the Address fields. Once you set this, the indicator reflects for all the addresses of the contact.
3. Save the contact.
Share Contacts

As part of sync process, contacts from Office 365 are shared to and from your sales application, mediated by the Oracle add-in. When contacts are synced from Outlook, the add-in uses the company name of the contact to determine the Sales Cloud account for that contact. If a unique account can be determined, the contact will be associated to that account.

Example of Familiarizing with Contacts Using Top Connections

If you're a new salesperson who just took over a sales account and want to learn more about that account from your colleagues, look at the Top Connections tab. Here, you can see the salespeople from your company who interacted the most with the contacts on your customer side. You can connect with such colleagues and learn more about that sales account and people on that account. Take a look at this example where Robin prepares himself before he starts communicating with his new customer, Smith.

Scenario

Robin Marlow is a salesperson in Penny Pack LLP. He spends a significant amount of time working on Outlook. Recently, he took over Service Sales in the North America region and is introduced to several new accounts that he's not familiar with.

Robin receives an email from Smith Wilson of First Software.

- He looks through the top connections to see if anyone from his company has worked with Smith in the past and decides that Daniel Grayson is the ideal resource to contact.
- He views Smith's upcoming activities through the side panel and finds that Smith has an appointment scheduled with Daniel.
- He creates a task to call Daniel later in the day to learn more about Smith and the appointment scheduled for next week.

Robin's call with Daniel gives him details about Smith's interests and activities and Robin is now better informed about the contact before he interacts with him.

Add Objectives to Your Appointment, Call Report, or Tasks

From the Oracle add-in, you can add goals or objectives you want to achieve or have achieved from an appointment, call report, or task. With objectives laid out, you can stay focused on what you want to target and gain from these meetings or tasks.
Here’s how you can add objectives to your appointments, call reports, or tasks:

1. In the add-in, open an Appointment, Call Report, or Task for which you want to add objectives. Go to the Edit mode.
2. In the Activity Objective section, use the + icon to add the objectives. The add-in shows default objectives. You can create custom objectives as well. To create custom objectives, enter your objective’s name in the text field that has the watermark ‘Create custom objective’ and press the Create button.
3. Next, opt the objectives and add them to the appointment, call report, or task.
4. If an objective is already met, mark it as Complete.
5. Save the appointment, call report, or task.

Example of Sharing Emails and Appointments with the Sales Application

Share emails and appointments that you send or receive from your Office 365 account with your sales application. You can share emails and appointments related to a specific account, opportunity, or lead with your team in your sales application to provide them with any relevant information or history related to the customer. Sharing emails and appointments associates the email or appointment as an activity with the relevant account, opportunity, or lead. You can also search for other accounts, opportunities, and leads that you have access to. Related known contacts or resources are added to the activity in your sales application.

Share Email

Let’s say you’re a sales person handling the North America region for laptop sales. You’re in conversations with a customer on their requirement for your new range of laptops.

You have just received an email reply from the customer with some questions on pricing. You would like to associate this email with an existing opportunity in your sales application so that you can share it with your manager and other salespeople on your team.

Open the email to view the side panel. Click Share Email on the Related Records tab. On the Share Email page, search for and select the relevant opportunity, and click Save. You have now saved your email in your sales application as a task for the selected opportunity, making it available for your team to review. When salespeople open the opportunity, they can now view this email as an activity associated with the opportunity.

Share Appointments

To further discuss the customer’s requirement, you decide to include them in an existing appointment that you have with your manager.

Open the appointment to view the side panel. Click Share Appointment on the Related Records tab. On the Share Appointment page, you search for and select the customer, and click Save. You have now saved your appointment in your sales application and shared the activity with the customer.
Share the Appointment Received from an Email ID Held by Multiple Contacts

Assume you received a new appointment from a contact. You find that more than one existing contacts in your Sales Cloud uses the same Email ID from which you received the appointment. You can share that appointment with one or more of the contacts that share the same Email ID. Let’s see the steps to share such an appointment with your contacts:

1. Select the appointment you want to share with the Sales Cloud. You will find in the Oracle add-in home page that the contact from whom you got the appointment request, shows a number on top of the contact photo. The number corresponds to the number of contacts sharing the same Email ID from which you received the appointment.
2. You can edit the contact’s Email ID if they are different. This way, you can get rid of email duplication.
3. Click Share Item to share the appointment to the Sales Cloud. In the Share page, you will find the list of contacts sharing the same Email ID. By default, you will find that all the contacts marked. You can deselect the contacts not relevant with the Email ID.
4. Click Share. The add-in shares the appointment successfully with the Sales Cloud, updating all the contacts associated with the Email ID. You will find that the appointment is now labelled as 'Shared with Oracle'. Note that in the Oracle add-in, you can see the shared appointment under the Primary Contact only, though the appointment is shared with all the contacts that share the Email ID.

Example of Creating Activities in the Side Panel

Create activities, such as appointments and tasks, in the Office 365 side panel.

Here is the key decision for this scenario:

<table>
<thead>
<tr>
<th>Decisions to Consider</th>
<th>In this Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Should I create my sales application</td>
<td>Yes, use the Office 365 side panel to create an appointment that’s automatically</td>
</tr>
<tr>
<td>activity in Office 365?</td>
<td>synchronized with your sales application.</td>
</tr>
</tbody>
</table>

Create an Appointment

1. Open an email from the contact you want to schedule an appointment with.
2. Click the Activities tab on the Office 365 side panel.
3. Click Create and select Appointment.
4. On the Create Appointment page, enter all the details. Invite contacts and resources for the appointment.
5. Select attachments that you want to include in the appointment.
   The attachment size for the file types .jpg, .png, .m4a, .mp3, .gif, .pict, .aac, .wav, and .tiff must not exceed 2 MB whereas the attachment size for the file types .ppt, .doc, .xls, .mov, .mp4, and .avi must not exceed 25 MB. The attachment size for any other file type must not exceed 10 MB.
6. Click Submit.
The appointment you just created appears on the Activities tab in the side panel and also in your sales application. When you change the owner of the activity and save your updates, then the application does not remove your sign-in information from the invited resources. The new owner must sign in to the application to remove you as the original owner from invited resources.

**View Service Requests**

Use the service request functionality to review and update service requests in the side panel, without explicitly going into your sales application. You can also link service requests to emails to send to or receive from your customers.

Service requests are available here:
- Related records in the side panel
- Related items in the Accounts and Contacts tabs.

Click on an applicable service request to see its details.

**Sync Records with the Sales Application**

Save time by using the synchronization feature. Sync your Office 365 and sales application data by running the sync engine.

The sync engine comprises these regions:
- Enable sync
- Contact sync settings
- Activities sync settings
- Sync summary and errors

**Enable Sync**

You can enable or disable the sync engine. If you enable the sync engine, then the application runs the synchronization process at scheduled intervals. If you disable the sync engine, then the records aren’t automatically synced between Office 365 and your sales application.

**Contacts Sync Settings**

Use this region to set the parameters for syncing contacts. You can select the list of contacts that are synced. Additionally, you can select the conflict resolution rule.

<table>
<thead>
<tr>
<th>Resolution Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cloud version wins</td>
<td>The contacts in your sales application overwrite the contacts in your Office 365 account.</td>
</tr>
<tr>
<td>Outlook version wins</td>
<td>The contacts in your Office 365 account overwrite the contacts in your sales application.</td>
</tr>
</tbody>
</table>
Resolution Option | Description
--- | ---
You decide | You select the way you want to resolve the conflict if there's a conflict.

### Activities Sync Settings

Use this region to set the parameters for syncing appointments and tasks. You can select the list of appointments and tasks that are synced. Additionally, you can select the conflict resolution rule.

<table>
<thead>
<tr>
<th>Resolution Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cloud version wins</td>
<td>The appointments and tasks in your sales application overwrite the appointments and tasks in your Office 365 account.</td>
</tr>
<tr>
<td>Outlook version wins</td>
<td>The appointments and tasks in your Office 365 account overwrite the appointments and tasks in your sales application.</td>
</tr>
<tr>
<td>You decide</td>
<td>You select the way you want to resolve the conflict if there's a conflict.</td>
</tr>
</tbody>
</table>

### Summary of Sync Errors

Here you can see the sync summary and list of errors when sync fails.

The summary is segregated into three regions:

- **Last sync**: This region displays information of the latest sync.
- **Outlook**: This region displays the number of appointments, tasks, and contacts synced to your Outlook account.
- **Oracle Engagement Cloud**: This region displays the appointments, tasks, and contacts synced to your Oracle Engagement Cloud account.

**Note**: The synced records can either be new records added to your account or existing records updated with new information.

The error region displays the appointments, tasks and contacts that weren't synced, along with the nature of the error. From here you can go to the individual records and fix the errors. You also have the option to display only the resolvable errors. You can't update those records whose errors you can't resolve.

### Fix Resolvable Sync Errors

When contacts, appointments, and tasks from Office 365 are synced to the sales application, you may get errors due to invalid or missing information in them. Most of the errors due to deficient information are resolvable just by correcting or updating that information.
Here's how you can fix such errors:

1. Go to Synchronization.

   **Note:** The Resolve Errors button only appears on the Synchronization page if the errors are resolvable.

2. Click Resolve Errors. In the Errors list page, you can see the resolvable errors with an Edit icon.
3. Click the Edit icon to go to the respective Contacts, Appointments, or Tasks page that has the errors.
4. Fix the errors and click Save. After save, the Oracle add-in directly saves the records to the sales application, and takes you back to the Errors list page to resolve pending errors.

### Sync Emails with the Sales Application

To make your work more efficient, use the Office 365 add-in that automatically syncs emails originating from a sales application contact.

Here are the options:

- Select a group of contacts for auto-sharing. All emails that you send to this group or receive from this group are automatically synced.
- Select individual contact for auto-sharing. All emails sent to these contacts or received from these contacts are automatically synced.
- Select individual to exclude from auto-sharing. All emails sent to these contacts or received from these contacts aren't synced. Even if these contacts are part of a group that are tagged for sync, they aren't synced.

### See Opportunity Quotes and Download the Proposal

From the Oracle add-in, you can see quotes for your opportunities. If a proposal was generated for a quote in the sales application, you can download it from the add-in. Here are the steps to view quotes and download the proposal associated with a quote:

1. Open an opportunity and go to the Quotes and Orders tab.
2. You can see the details, such as Quote name, status, active or inactive, amount, and version.
3. If a quote has a proposal generated in your sales application, you can find the link to the proposal. Click the link to download the proposal. Proposal is downloaded as a PDF file.
4. To view the corresponding record of this quote in your sales application, select the 'Open in Oracle Engagement Cloud' option from the menu (ellipsis icon ...).

### FAQs for Office 365
Can I open sales application records from add-in?

Yes. From the add-in, you can open sales application records of contacts, appointments, tasks, call reports, and custom pages. To do so, open the menu (ellipsis icon ...) from their detail page and use the 'Open in Oracle Engagement Cloud' option. The corresponding record shared with your sales application opens in your default browser page.

What happens when I share an Office 365 email with my sales application?

The shared email is associated as a task with the relevant account, opportunity, or lead. Related known contacts or resources are added to the task on your sales application.

How can I share an email with my sales application?

Use the Share Item feature to share your email with the sales application.

1. Click **Share Item** on the Records tab.
2. Select the appropriate accounts, contacts, and sales leads.
3. Click **Share**.

The application shares your email with the selected parties. Notice that Office 365 has categorized your email as Shared with Oracle. All information in the email is saved as an activity of the type email. Go to the Activities tab and select this activity to see the details. You can download the email body from the attachments section.

You can similarly share appointments that you compose in Office 365.

How can I send a call report as an email?

Open a call report in its detail view. Within the menu (ellipsis icon ...) use the option **Send as Email**. Outlook opens a draft email that has link to the call report, some default content, reference to the meeting, and attendees of the meeting. The To field shows email IDs of contacts and assignees of the call report. You can change the content, add more people as recipients, or copy people to the email. Send out the email when ready.

Can I share my Office 365 email attachments with my sales application?

Yes, you can. Click **Share email** in the Related Records tab. From the list of contacts, accounts, and attachments associated with the email, select the attachments you want to share, and click **Save**. Attachments must not exceed 25 MB.
Why doesn't the category of my email show the sales application after I share it?

The category is added to your email only after Outlook updates the inbox. To categorize instantly, click **Send/Receive** on the Office 365 ribbon. Click **Update Folder** and select the email.

What happens if I create or update records in the side panel?

When you create contacts, tasks, or appointments using the side panel, the records are automatically synced with the sales application, and the application creates the corresponding records both in the Office 365 add-in and in the sales application. This action isn't dependent on the sync settings.

When you or another user updates a contact in the side panel, the application automatically updates it in Office 365 as well. Similar is the case when you update appointments and tasks. But, when another user, not the owner, updates an appointment or task, then the sync engine deleted the linked appointment or task in Office 365.

Note that when you delete any of these records, the corresponding records aren't automatically deleted in the sales application. The sync engine deletes the records when the next sync process runs.

Why can't I open the sales application records from the Office 365 side panel?

You can't open the records because the profile option FND_CLASSIC_INTERFACE is enabled. Disable this profile option to view your sales application records from the Office 365 side panel.

Why aren't my sales application user preferences visible in the Office 365 side panel?

Any change that you make to user preferences in your sales application is reflected in the side panel only after you sign out of the add-in, restart Outlook, and sign in again.

Why didn't the invitees within my organization get notification when I updated a meeting I created?

While creating a meeting, ensure that you select the category as 'MS allows invitee record update'. So that, whenever you update the meeting after it's shared with the sales application, your invitees will receive notifications about the update.
Will my internal and external invitees be notified when I update a meeting shared with my sales application?

Yes. If you have shared your appointment with the sales application, your internal and external invitees will receive notification when you make updates.

Can I share a meeting I received from an external contact with the sales application?

Yes. If you're a resource in the sales application and an active user of the Office 365 add-in, the appointment created by an external contact showing up in your Outlook is shared with the sales application. If the external contact updates the meeting, the updates are also shared automatically with the sales application.

Why can't I share a meeting created by an internal contact with the sales application?

Meetings created by a resource who's not an active user of the Office 365 add-in can't be shared by invitees with the sales application.
IBM Notes

Overview of Oracle Sales Cloud for IBM Notes

The Oracle Sales Cloud for IBM Notes application helps maximize sales productivity by providing your sales application capabilities directly within IBM Notes. It enables sales professionals access to essential your cloud service data.

Summary of Features

Here are some of the key features:

- Sales capabilities within IBM Notes: Using Oracle Sales Cloud for IBM Notes, all emails, calendar events, and tasks can be linked to the respective contact, customer, lead, or opportunity within your sales application. Sales professionals can access customer and sales information within IBM Notes.

- Single-click sharing between IBM Notes and your sales application: When sending a meeting invite or an email, or when setting up a task, a single click captures the action and updates of your sales application in the background.

- Synchronization of data between your sales application and IBM Notes: Two-way data synchronization allows sales professionals to have a continuously updated and accurate 360-degree view of your sales application data changes.

- Synchronization Control Panel: Oracle Sales Cloud for IBM Notes provides synchronization filtering capabilities, enabling sales professionals to synchronize only the most critical data from your sales application.

- Offline access: The transition between online and offline modes of operation enables sales professionals in the field to use the full functionality of the product in an offline mode, and then synchronize the sales data in the next synchronization cycle.

Note: You can't create user-defined configurations for Oracle Sales Cloud for IBM Notes.

Considerations for IBM Database Configurations

The Oracle Sales Cloud for IBM Notes configuration is deployed on top of the email database, which in most cases is located on the IBM Domino Server or on the Personal Address Book database, which is located on the client. These databases are both created and updated using IBM's user-specific templates.
As a part of your cloud service configuration process, the installer modifies some of the existing original design elements in the Personal Address Book and IBM Notes email databases. To protect those changes in the design elements from unexpected external updates, the **Prohibit design refresh or replace to modify** check box is selected for such modified elements. Therefore, the user-defined elements won’t be updated with any design refresh or be replaced, after the user-defined template is released. As a result, the IBM Notes email database's design elements may become incompatible and cause errors.
Apply a New User-Defined Template on Top of the IBM Notes Email Database

To avoid errors, you must follow these steps.

1. Perform full synchronization with your cloud service server to synchronize all your local unsaved data.
2. Remove your sales application user-defined configuration from IBM Notes.
3. Deploy your template on the IBM Notes email database.
4. Install the user-defined configuration again.

Oracle recommends that you test how your user-defined configurations work with your cloud service configurations using a test deployment, before rolling out your user-defined template.
Overview of Oracle Sales for Gmail

Oracle Sales for Gmail helps increase sales productivity by providing your sales application capabilities within Gmail. Sales professionals can easily access the cloud service data such as contacts, appointments, and emails from their Gmail accounts.

Summary of Features

These are the key features of Oracle Sales for Gmail:

- Synchronize contacts and appointments from your sales application with Gmail and have a consolidated view in Gmail.
- Selectively choose which emails, contacts, and appointments in Gmail are tracked in your sales application.
- Link your sales application accounts, contacts, leads, opportunities, and resources with emails, contacts and appointments in Gmail.
- Administrative filters to determine which contacts and appointments synchronize to Gmail to limit the cloud service data in users’ Gmail accounts.

Note: Oracle Sales for Gmail doesn't support the concept of a joint email inbox.

Install and Configure Gmail for Sales

Integrate your sales application with your Gmail account and access your contacts, appointments, and emails from your Gmail account.

To install the Gmail extension:

1. View the MOS note at https://support.oracle.com/epmos/faces/DocumentDisplay?id=2188288.1 for details on where to find the Gmail Extension on the Chrome Web Store.
2. Click Add to Chrome.
3. On the confirmation dialog box, click Add.

The Chrome extension for your sales application is now added to your Chrome browser.

The Oracle Sales for Gmail extension appears as a side panel on your Gmail when you open an appointment or an email.

Note: If you installed the extension after signing in to your Gmail, you must refresh the page for the Oracle Sales for Gmail side panel to appear.

To uninstall the Gmail extension:

1. Navigate to Chrome Settings.
2. Click Extensions.
3. Find the Oracle Sales for Gmail extension and click the Remove from Chrome icon.
Sign in to Gmail
Once you sign in to Gmail, you must open an appointment or an email for the Gmail side panel to appear.

To configure and sign in to Gmail:

1. Click the Settings icon on the side panel.
2. On your sales application connection page, enter the host name.
   
   To obtain the host name, sign in and navigate to Accounts, and copy the server portion of the URL, for example, https://slc11kez.oracle.com. Here you see a sample URL with the portion you should copy highlighted.

3. Sign in using the salesperson user name and password that you use to sign in to your sales application.

Upgrade to New Versions
Gmail for sales detects when a new version of the extension is available and automatically upgrades you to the latest version. If your Chrome browser is open, the upgrade happens only when you restart the browser.

Create Contacts from the Oracle Sales for Gmail Side Panel
Maintain a consolidated list of your contacts within Gmail to work more effectively. You can add contacts to your sales application from your Gmail account.

Oracle Sales Cloud for Gmail identifies which of your contacts from an email or appointment exist in your sales application and highlights those that have to be added. The Gmail configuration also highlights Google contacts that don't exist on your cloud service server when you open a specific contact.

Add Contacts to Your Sales Application
You must have an email, an appointment or a new or an existing contact on Google Contacts open to add a contact to your sales application.
If your contact already exists in your sales application, the side panel displays the initials of the contact. For contacts that don’t exist in your sales application, the side panel displays the person icon.

To add a contact to your sales application from Gmail:

1. Click the person icon for the contact on the side panel of Oracle Sales Cloud for Gmail.
   
   A message appears on the top of the Oracle Sales Cloud for Gmail panel notifying that the contact does not match an existing contact in your sales application.

2. Click the link on the message to add your contact.

3. On the Create page, enter the fields to create your contact.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>First Name</td>
<td>Enter the name of the contact.</td>
</tr>
<tr>
<td>Last Name</td>
<td></td>
</tr>
<tr>
<td>Job Title</td>
<td>Optionally, enter the job title of the contact.</td>
</tr>
<tr>
<td>Account</td>
<td>Optionally, search for and select the account that the contact belongs to.</td>
</tr>
<tr>
<td>Email</td>
<td>The email is automatically populated with the email ID that the opened email displays. You can't edit the email ID.</td>
</tr>
<tr>
<td>Address</td>
<td>Enter the complete address of the contact.</td>
</tr>
<tr>
<td></td>
<td>You must enter the state and country codes in the State and Country fields respectively.</td>
</tr>
<tr>
<td>Favorite</td>
<td>To save this contact as a favorite, highlight the star.</td>
</tr>
</tbody>
</table>

4. Click Save.

Your contact is now added to your sales application. Close the email and open it again. The contact you just added now appears as initials in the side panel indicating that the contact is now added to your sales application.

Examples of Creating Contacts

Create contacts on your sales application using Oracle Sales Cloud for Gmail in several ways. Let’s see few examples that illustrate these options.
Create Contacts from Email

You just received an email on Gmail from your customer Devon Smith from Seven Corporation. You open the email and the Oracle Sales Cloud for Gmail side panel appears. The side panel shows that your contact Devon Smith isn’t added as a contact on your sales application.

You would like to add Devon Smith to your sales application. You click the person icon and create your contact.

Create Contacts from Appointments

You want to set up a meeting with Anne Balmer, a new contact that you’re interacting with from Seven Corporation. You navigate to Google Calendar and create a new appointment. When you add Anne Balmer as a guest to the appointment, the Oracle Sales Cloud for Gmail side panel appears with the person icon to indicate that your contact isn’t added on your sales application. You click the person icon and create your contact on your sales application.

Create Contacts from Google Contacts

You’re viewing your list of contacts on Google contacts to verify if you have already added your customer Fen Lee as a contact on Google. You don’t see the contact, and you want to create the contact and also add it to your sales application. You click **New Contact** on Google Contacts and enter the name of the contact, Fen Lee. The Oracle Sales Cloud for Gmail side panel appears and shows that your contact isn’t added as a contact on your sales application.

You click the person icon and create the contact Fen Lee on your sales application.

**Note:** If you add a note to the contact on Google Contacts, the note isn't synchronized with your cloud service server.

Example of Sharing Your Email with Sales Application Users

Share email that you receive or send from your Gmail account with your sales application. You can share email related to a specific account, opportunity, or lead with your team on your sales application thereby providing them with any relevant information or history related to the customer. Sharing email not only associates your email as an activity with the relevant account, opportunity or lead, but also adds related known contacts or resources to the Activity on your sales application.

Share Email with Your Sales Application

You’re a sales representative handling the North America region for laptop sales. You’re in conversation with a customer on their requirement for your new range of laptops. You just received an email reply from the customer with
some questions on pricing. You want to associate this email with an existing opportunity on your sales application so that you can share it with your manager and other salespeople on your team.

You click the Email icon on the side panel of Oracle Sales Cloud for Gmail.

On the Share Email page, you search for and select the relevant opportunity and click Save. You saved your email on your sales application as an activity task for the selected opportunity, making it available for your team to review. When salespeople open the opportunity, they can now view this email as an activity associated with the opportunity.

- **Note:** If the email that you’re sharing contains attachments, all attachments that are 10 MB or less are associated with the corresponding task in your sales application.

### Sync Settings

You can sync your contacts and appointments between your sales application and Gmail.

Synchronization of contacts and appointments between Gmail and your sales application is triggered automatically according to the defined synchronization frequency. All Google contacts and appointments aren't automatically saved in your cloud service server. You must choose contacts and appointments that you want saved in your sales application in the Oracle Sales for Gmail side panel.

### Sync Settings

Use two settings to select saved searches and determine what you want to sync between your sales application and Gmail:

- Contact Synchronization
- Activity Synchronization

You can select the setting you want from the drop-down list of the Oracle Sales for Gmail side panel. You can select a saved search option to set up synchronization between your sales application and Gmail.

- **Note:** After contacts and appointments are synced between your sales application and Gmail, any updates to the contacts and activities either on your cloud service server or on Gmail are synced during the next synchronization depending on the frequency that your administrator has defined.

### Saved Search

You can use the predefined saved searches that are available in the drop-down list on Oracle Sales for Gmail or create your own saved search for your sales application. By default, the saved search for contact is set to **My Favorite Contacts** and for appointment it’s set to **All Open Activities**.

Apart from the predefined saved searches, if you want to define your saved search, you can create it on your sales application. These are the predefined saved search options for contact and activity, along with descriptions.

<table>
<thead>
<tr>
<th>Saved Search</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Contacts</td>
<td>All contacts in your sales application.</td>
</tr>
<tr>
<td>My Business Contacts</td>
<td>All contacts belonging to all the accounts you own.</td>
</tr>
</tbody>
</table>
When you select a saved search, the corresponding records matching the saved search are synchronized with Gmail when the next synchronization runs. If you then select another saved search, a new set of records are synchronized with Gmail. However, the old set of records synchronized with Gmail earlier continue to remain on Gmail. You must manually delete these records on Gmail. If you update a record from the old set of records on Gmail, your changes will be synchronized with your sales application. However, if you update a record from the old set of records in your sales application, your changes aren't synchronized with Gmail.

### Related Topics
- Schedule the Gmail Synchronization Job
- Manage Contact Saved Search Lists

### About Sales and Gmail Sync
Sync your contacts and appointments between your sales application and Gmail so that the two versions are the same.

### New Records
During sync, the application adds contacts and appointments that you create in your sales application to Gmail. The sync is based on the saved search criteria that you define. However, contacts and appointments that you create in Gmail aren't synchronized with your cloud service server. You can sync contacts and appointments with your sales application only through the Gmail side panel.

*Note:* If you mark a new contact as favorite in your sales application, the contact doesn't appear as a favorite in Gmail.

### Update Records
Update contacts and appointments that are already shared with your sales application directly in Gmail or in the side panel.

- Updates in the side panel: If you update your record in the side panel, the record is updated in your sales application as soon as you save your record.
- Updates in Gmail: If you update the record in Gmail, the application updates the record in the sales application during the next sync. Also, any updated records in the sales application are updated in Gmail during the next sync.
Delete Records
You can delete records only in the sales application. If you delete a shared contact or appointment in Gmail, the record is shared with Gmail again from your sales application during the next sync.

Simultaneous Updates to Records
If contacts or appointments are updated simultaneously in your sales application and Gmail, the updates in your cloud service server are retained and synchronized with Gmail. Between sync cycles, even if a record is updated first in your sales application and then in Gmail, the updates made in your sales application are retained and synchronized with Gmail.

For example, your sync duration is set to run once every hour starting at 12.00 a.m. During the sync cycle between 2.00 p.m. and 3.00 p.m., a salesperson updates the mobile number of a contact in your sales application at 2.10 p.m. You update the mobile number of the same contact on Gmail at 2.45 p.m. When the sync engine runs at 3.00 p.m., your changes on the contact will be lost and the mobile number update on your sales application will be brought down to Gmail although you made your change later in the sync cycle.

Related Topics
- Schedule the Gmail Synchronization Job
21 Mobile Applications

Using Mobile Applications

Oracle Applications Cloud offers the following mobile applications that integrate with Oracle Sales Cloud: Oracle CX Cloud Mobile and Oracle Sales Cloud Mobile. This chapter outlines the capabilities of these applications, provides installation information, and answers general use questions.

Oracle CX Cloud Mobile

Overview of Oracle CX Cloud Mobile

The Oracle CX Cloud Mobile (CX Cloud Mobile) application enables you to manage your day effectively and develop customer relationships using a smartphone. With a task-based user interface and built-in analytics, the CX Cloud Mobile application guides daily sales activities and enables the following activities:

- Manage Sales Activities
  - Manage daily activities on your calendar.
  - View and update opportunities.
  - Create follow up tasks, to help you manage all your activities, including your leads, opportunities, and deals.
  - View and update call reports, to help you prepare for future meetings and log meeting attendees, objectives, and minutes.
  - Review quote proposal documents and email them to customers. Share proposals with relevant team members and get feedback before finalizing the proposal.
  - View leads, opportunities, accounts, and partners in your vicinity using the map.

- Use Offline
  - View and edit Oracle Engagement Cloud data in areas with no network connection.
  - Sync automatically when a connection is re-established.

- Navigate Using Your Voice
  - Find any sales record with a simple command from anywhere in the application. For example, say, "Open Account Pinnacle Technologies"

- View Customer Service Requests
  - View, create, and edit service requests
  - Access related information such as team, message, and attachments
CX Cloud Mobile Installation

Which phones and operating systems are supported?
See the System Requirements for Oracle Applications Cloud at: http://www.oracle.com/us/products/system-requirements/overview/index.html

Install the iPhone Application
Here’s how you install the Oracle CX Cloud Mobile application on to your iPhone:
1. Open the App Store, search for Oracle CX Cloud Mobile application, and then tap Install.
2. Open the application. If you have received an application URL from your administrator, you can tap on the URL link to open the application. Alternatively, you can scan the QR code to launch the application.
3. Accept the Legal Terms.
4. If you have opened the application using the application URL or the QR code, the host name, port number, and SSL details will be populated automatically.
   If you opened the application after downloading it from the App Store, you must enter the host name your administrator has provided (or refer to the Finding Your Company’s Host URL: Worked Example topic).
5. Enter your sales application user name and password. You can tap Save Password to save this password.
6. Tap Sign In.

Install the Android Application
Here’s how to install the Oracle CX Cloud Mobile application on to your Android device.
1. Open the Google Play Store on your Android device.
2. Search for the Oracle CX Cloud Mobile application and tap Install.
3. Open the application. If you have got the application URL from your administrator, you can tap on the URL link to open the application. Alternatively, you can scan the QR code to launch the application.
4. Accept the Legal Terms.
5. If you have launched the application using the application URL, or the QR code, the host name will be populated automatically.
   If you have opened the application after downloading it from the Google Play Store you must enter the host name provided by your administrator (or refer to the Finding Your Company’s Host URL: Worked Example topic). Tap Settings to enter the host name.
6. Enter your sales application user name and password. You can tap Save Password to save this password.

Set Up Calendar and Contact Synchronization on Your iPhone
Here’s how you set up the synchronization of your Oracle Engagement Cloud calendar and contacts with the native calendar and contacts on your iPhone.

Note: You can synchronize your Oracle Engagement Cloud favorite contacts using the contact synchronization. However, the calendar synchronization doesn't synchronize invitees.
Install the Calendar Synchronization Profile

1. Sign in to Oracle CX Cloud Mobile (CX Cloud Mobile) using your user name and password.
2. Tap the menu icon to open the shuttle menu.
3. Tap Settings and tap Setup Calendar Sync.
4. The Safari browser opens automatically with the Oracle Engagement Cloud sign in page displayed. Sign in using your CX Cloud Mobile name and password and install the synchronization profile onto your phone. Installing the profile adds a new calendar to your iPhone that you can view beside your other calendars.
5. Enter the password for the CalDav server. This is the same password that you use to sign in to Oracle Engagement Cloud.
6. Tap Next.
7. When you have finished tap Done.

Install the Contacts Synchronization Profile

1. Sign into CX Cloud Mobile using your user name and password.
2. Tap the menu icon to open the shuttle menu.
3. Tap Settings and tap Setup Contact Sync.
4. Repeat steps 5 to 7 above and you're done.

General Use

How do I navigate around Oracle CX Cloud Mobile?

On both the iPhone and Android mobile devices, just tap the menu icon on the top left-hand side to show the list of features. Then tap the feature to retrieve a list of items - for example, tap Opportunities to get a list of your open opportunities. To view the item details, tap any item in the list view. In the list view, swipe right on an item to access frequent tasks.

To e-mail, call, text, or locate a contact quickly, tap their initials to display a contact wheel, and then tap the relevant icon. Your smartphone’s native e-mail, phone, or text application opens, or - if you have tapped the pin icon - a map opens within Oracle CX Cloud Mobile.

You can also quickly access actions that you can carry out, such as logging a call or creating a task, by just tapping the more icon (three horizontal dots).

How can I remove a contact from an opportunity, account, or lead?

From the opportunity, account, or lead detail page, tap the Contacts tab and swipe right on the contact you want to remove. Tap the more icon and tap Remove.

How can I add an objective when I am creating a call report?

There are two different kinds of objectives that you can add when you create a call report: A predefined objective and a user-defined objective.

Here’s how you create a predefined objective:

1. Tap the plus icon in the Objectives section
2. Select the predefined objective
3. Tap Add

Here’s how you create a user-defined objective:

1. Tap the plus icon in the Objectives section
2. Type the name of the objective at the top of the page
3. Tap Add

How can I view an interaction that I have logged?
Open the navigator menu and tap Call Reports. Then tap the list of options at the top of the page and select My Call Reports.
Alternatively, you can view the Leads, Contacts, or Accounts details pages and tap the Activities tab.

Why can't I view more records on the map?
The map shows you the closest 25 records (such as contacts and opportunities) to your current vicinity. If there are more records available, then you will see a message saying that there are more records in the vicinity. Tap the message and you will see the next 25 records (as well as the ones you can already view). If there are even more records to display, then tap the message again and you will see another 25 records on top of the 50 records that you can already view.

Can I limit the records I see in the map to a specified radius?
Yes, you can set a radius in the map feature, so that the map only shows sales records (such as accounts, leads, and contacts) within a set boundary. Open the main menu, tap Settings, and scroll down to Map Settings. Change the radius to either 1, 5, 10, 20, 50, or 100 miles. The radius will apply to all map views.

How can I change my primary contact in an opportunity, account, or lead?
Tap the edit icon on the opportunity, account, or lead, and tap the cross icon that appears next to the primary contact name. Select a new primary contact from the contact list and tap Save.

Navigate Around the App Using Voice Commands
You can use these voice commands to navigate around the application:

- **Note:** Voice commands are available in English only at this time.

<table>
<thead>
<tr>
<th>To do this</th>
<th>Say this</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open a page</td>
<td>Open &lt;page name&gt;</td>
<td>“Open Calendar”</td>
</tr>
<tr>
<td></td>
<td>Take me to &lt;page name&gt;</td>
<td>“Take me to Deal Registrations”</td>
</tr>
<tr>
<td></td>
<td>Pull up &lt;page name&gt;</td>
<td>“Pull up Opportunities”</td>
</tr>
<tr>
<td></td>
<td>Go to &lt;page name&gt;</td>
<td>“Go to Tasks”</td>
</tr>
<tr>
<td></td>
<td>Show &lt;page name&gt;</td>
<td>“Show Contacts”</td>
</tr>
<tr>
<td>Open a list</td>
<td>Open/open my &lt;list name&gt;</td>
<td>“Open my Account list”</td>
</tr>
<tr>
<td></td>
<td>Take me to my/take me to the &lt;list name&gt;</td>
<td>“Take me to the Contact list”</td>
</tr>
<tr>
<td></td>
<td>Pull up/pull up my/pull up the &lt;list name&gt;</td>
<td>“Pull up Lead list”</td>
</tr>
<tr>
<td></td>
<td>Go to/go to my/go to the &lt;list name&gt;</td>
<td>“Go to my Opportunity list”</td>
</tr>
<tr>
<td></td>
<td>Show/show my/show the &lt;list name&gt;</td>
<td>“Show the Deal Registration list”</td>
</tr>
<tr>
<td>To do this</td>
<td>Say this</td>
<td>Example</td>
</tr>
<tr>
<td>-------------------------</td>
<td>--------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Open a record</td>
<td>Open &lt;record type&gt; &lt;record name&gt;</td>
<td>“Open Deal Registration 'Elite Server’”</td>
</tr>
<tr>
<td></td>
<td>Take me to &lt;record type&gt; &lt;record name&gt;</td>
<td>“Take me to Call Report 'Key Account Call’”</td>
</tr>
<tr>
<td></td>
<td>Pull up &lt;record type&gt; &lt;record name&gt;</td>
<td>“Pull up task ‘Executive Demo Prep’”</td>
</tr>
<tr>
<td></td>
<td>Go to &lt;record type&gt; &lt;record name&gt;</td>
<td>“Go to Accounts ‘Pinnacle Technologies’”</td>
</tr>
<tr>
<td>Search for a record</td>
<td>Search for &lt;record type&gt;&lt;record name&gt;</td>
<td>“Search for task ‘Email Quote’”</td>
</tr>
<tr>
<td></td>
<td>Find &lt;record type&gt; &lt;record name&gt;</td>
<td>Find contact ‘Cole Mitchell’</td>
</tr>
<tr>
<td></td>
<td>Look for &lt;record type&gt; &lt;record name&gt;</td>
<td>Look for opportunity ‘Data Center Upgrade’</td>
</tr>
<tr>
<td>Open an embedded application</td>
<td>Search for &lt;application name&gt;</td>
<td>“Search for ‘Incentive Compensation’”</td>
</tr>
<tr>
<td></td>
<td>Go to &lt;application name&gt; application</td>
<td>“Go to ‘Social’ application”</td>
</tr>
<tr>
<td>Open the settings page</td>
<td>Open/Take me to/Pull up/Go to the Settings page</td>
<td>“Take me to the Settings page”</td>
</tr>
<tr>
<td>Open the home page</td>
<td>Open/Take me to/Pull up/Go to the home page</td>
<td>“Pull up the home page”</td>
</tr>
</tbody>
</table>

There are also specific sentences that you can say to open your task list and calendar, and to turn off the voice feature:

<table>
<thead>
<tr>
<th>To do this</th>
<th>Say this sentence</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open the task list</td>
<td>“What's on my task list?”</td>
</tr>
<tr>
<td></td>
<td>or</td>
</tr>
<tr>
<td></td>
<td>&quot;What should I do next?&quot;</td>
</tr>
<tr>
<td>Open the calendar</td>
<td>“What's on my calendar?”</td>
</tr>
<tr>
<td></td>
<td>or</td>
</tr>
<tr>
<td></td>
<td>&quot;What's next on my calendar?”</td>
</tr>
<tr>
<td></td>
<td>or</td>
</tr>
<tr>
<td></td>
<td>&quot;What's coming up next?”</td>
</tr>
<tr>
<td>Turn off voice commands</td>
<td>“Close voice”</td>
</tr>
<tr>
<td></td>
<td>or</td>
</tr>
<tr>
<td></td>
<td>&quot;Cancel&quot;</td>
</tr>
</tbody>
</table>
Offline Usage

Can I use CX Cloud Mobile when I am not connected to Wi-Fi and I haven’t got a cell phone signal?
Yes, you can view, create, and edit records in the app even when you’re offline. When you lose your network connection, a banner is displayed to indicate that you’re working offline. When the network connection is restored, the application automatically syncs the updates you have made on your phone to Oracle Engagement Cloud. Alternatively, you can manually sync the records by tapping Pending Sync in the main menu.

Why can’t I view updates to my data?
When the application is in offline mode, you can’t view any updates that were made to the sales data since the application changed to offline mode, because the application needs a cellular or Wi-Fi connection to update the data. You can view data updates when you access the record again after regaining access to a network connection.

Can I create new records offline?
Yes, you can create, edit, and delete records throughout the application in the offline mode and then sync them once you have a cellular or Wi-Fi connection. You will see a banner telling you that you’re in the offline mode when the application detects that the network connection is lost.

What Data Can I See and How Much Data Can I Store in the Offline Mode?
Here’s some details about the data that’s available in the offline mode and also how to specify how much data you want to store on your phone when you’re in the offline mode.

Data Availability
All of the data that you view in the application when you’re online will be available when you’re offline. Also, all of the sales objects that your administrator has specified for offline use, such as opportunities and contacts, are available in the offline mode. The data can be synchronized when the application detects a network connection and switches to the online mode, or alternatively you can sync the records manually.

Note: Any features that require access to online data, or a network connection, aren’t available offline. These include reports, analytics, maps, voice navigation, and Oracle Social Network.

Data Capacity
Up to 50 MB of offline data can be downloaded to your device by default. This is usually sufficient for typical usage, however if you find that this isn’t enough then you can increase the storage in increments of 100 MB, up to a maximum of 500 MB. To change the storage amount, open the main menu in the application, tap Settings and then select the storage limit in Offline Storage Limit.

Your administrator can specify how long the downloaded data is stored. After this time the data will be erased and more recent data is downloaded when you next use the application online.
Features That Are Available When You're Offline
You can view, create, and edit all records in the application even when you don't have a cell phone signal, or a Wi-Fi network.

Features that require access to up-to-date data, however, aren't available offline - such as reports and analytics. Also, features that need to interact with online data, or interact with other applications, aren't available offline. These include maps, voice navigation, and Oracle Social Network.

How can I synchronize my offline data?
Depending on the settings that your administrator has specified, your data either synchronizes automatically when the device detects a network connection and goes online, or you can synchronize your data manually. To sync your records manually, tap **Pending Sync** in the main menu.

What happens if there's an issue when you synchronize your offline updates?
You can find a list of records that have synchronization issues in the **Pending Sync** shuttle menu item. You can sync the records manually once the issues have been resolved.

Note: If Oracle CX Cloud Mobile detects a data conflict, then the updates you have made in CX Cloud Mobile override the updates made in the Oracle Engagement Cloud application.

How can I stop the offline banner notification from appearing?
Tap **Settings** on the main menu and in the Offline Mode section use the **Offline Notification** toggle to disable the notification.

Sales Cloud Mobile

Overview of Oracle Sales Cloud Mobile
Use the Oracle Sales Cloud Mobile application to do the following tasks:

- Track and update sales information on your smartphone or tablet
- Keep up to date with sales activities in your enterprise while on the move

Tasks That You Can Do
The key features of Oracle Sales Cloud Mobile include the following:

- Application Home Page: From the application home page, you can access critical information when you're in the field.
- Sales Account Management: You can access reference information, as well as current events about the customer while on the road.
- Opportunity Management: From the mobile opportunity management page, you can access current and critical information about your opportunities and share opportunity updates with your sales team.
- Lead Management: With access to open leads while on the road, you can act upon leads and reduce the sales cycle time.
- Calendar and Tasks: With these features, you can manage appointments and tasks on the road.
• Contacts: You can call or e-mail contacts from the Actions menu. The application displays a list of your key contacts by default, and you can search for all other contacts. E-mail Contact and Call Contact features are disabled for contacts who don’t want to be phoned or e-mailed.

• Sales Analytics: You can access business intelligence reports from the home page. Analytics also are embedded contextually for each account that you view. The contextual reports include data on sales account revenue trends, sales account win/loss trends, and sales account win/loss reasons.

• Alerts: You receive alerts when new leads are assigned or opportunities of interest become available.

Prerequisites
Before implementing Sales Cloud Mobile, you must:
• You must set up Oracle Engagement Cloud before you can use Sales Mobile.
• Determine if your mobile device meets Sales Mobile system requirements. See the System Requirements for Oracle Applications Cloud here: http://www.oracle.com/us/products/system-requirements/overview/index.html

Sales Cloud Mobile Installation

What are the supported operating systems?
See the System Requirements for Oracle Applications Cloud at: http://www.oracle.com/us/products/system-requirements/overview/index.html

Install the Oracle Sales Cloud Mobile iPhone Application
This procedure shows you how to install Oracle Sales Cloud Mobile on your iPhone.

How to Install the iPhone App
1. Use your iPhone to sign in to iTunes and access the App Store.
2. Search for Oracle Sales Cloud Mobile and then tap Install.
3. Enter the host URL that your administrator has provided.
4. Enter your user name and password.
5. Sign in to the Oracle Sales Cloud Mobile application.

Related Topics
• Finding Your Company’s Host URL for Oracle Sales Cloud Mobile: Worked Example

Install the Oracle Sales Cloud Mobile Android Application
This example shows you how to install the Oracle Sales Cloud Mobile application on an Android device.

How to Install the Android App
1. Use your Android device to sign in to Google Play, then browse the Apps.
2. Search for Oracle Sales Cloud Mobile and then tap Install.
3. Enter the host details that your administrator provided.
4. Open the Oracle Sales Cloud Mobile application, and enter your user name and password.
5. Sign in to the Oracle Sales Cloud Mobile application.
Example of Installing the Oracle Sales Cloud Mobile BlackBerry Application
This topic shows you how to install the Oracle Sales Cloud Mobile application on a BlackBerry device.

How to Install the Oracle Sales Cloud Mobile Application on a BlackBerry Device
1. Check that the BlackBerry's Wi-Fi is switched on.
2. Obtain the host URL from your administrator, then enter the host URL in the BlackBerry browser.
3. Enter the authentication credentials to sign in.
4. Click Start Download to start the download and installation.

How can I update the Oracle Sales Cloud Mobile application on my BlackBerry device?
Enter the following URL in the BlackBerry browser: http(s)://host:port/sales/faces/MobileInstallerMain (replace the word "host" with the location of the latest version of Oracle Engagement Cloud). Enter the authentication credentials to sign in, and click Start Download to start the download and installation of the latest version of Oracle Sales Cloud Mobile. Your existing Oracle Sales Cloud Mobile installation will be overwritten.

Note that Oracle Sales Cloud Mobile application is not available on BlackBerry App World.

General Use

How can I navigate within the Oracle Sales Cloud Mobile client?
On both the Apple iPhone and Blackberry mobile devices, tap any icon on the home page to show a list of items. For example, tap Opportunities to retrieve a list of your open opportunities. To view details, tap any item in the list view. Scroll upward in list view to access a search box. To access contextual actions, tap and hold any list item to reveal available contextual actions.

On the Apple iPhone, tap the Title bar to return to the application springboard. Select Action to reveal a contextual action sheet. Select Action again to close the action sheet.

On the Blackberry, both Short and Full menus are enabled. You can also use the Back button to return to the previous screen.

Why can't I access the application?
You must have the Sales Representative duty role to access the application. The delivered application has this role granted in the Sales Representative, Sales Manager, and Sales VP job roles.

How can I remove contacts, assignees, and resources from appointments, tasks, and interactions?
Navigate to the appointment, task, or interaction, and tap Edit to turn on the edit mode. Tap and hold on the contact, assignee, or resource you want to remove for two or three seconds. Then tap Remove, and tap Done to save your update.

Note that the owner of the appointment, task, or interaction can't be removed.
How can I manage my activities in the application?
While viewing an opportunity, lead, customer or contact, open Activities. By default, your current activities are shown. This list includes the activity subject, due date and an icon that denotes the type of activity.

When is data quality checked in Oracle Sales Cloud Mobile?
If your company has licensed and set up Oracle Engagement Cloud Data Quality features, when you enter a new contact address, upon clicking Done, you are presented with a list of similar addresses. You can choose the closest match, merge the new information with the existing contact, or save the new contact you just entered.

How can I change my Primary Contact in an opportunity, account, or lead in the application?
While viewing the contact list in the opportunity, account or lead, tap the Action list and choose Change Primary Contact. Tap and hold the contact name that you want, then choose Make Primary.

Why is the contact’s account information missing?
If you create a contact record from the contact search results page, when you're creating or editing an appointment, the contact’s account information won’t be transferred to the appointment. You will need to manually select the account associated with the contact record and add it to the appointment.

How can I remove a contact from an opportunity, account, or lead?
While viewing the contact list in the opportunity, account or lead, tap the Action list and choose Remove Contact Association. Tap and hold the desired contact name, then choose Remove Contact.

How can I work with reports and graphs?
You can swipe to navigate between reports, or tap to view a list of available reports. When you're viewing a report, you can tap and hold a slice of graph to see the aggregate values, for example, on a bar of a bar graph, to see values for the bar. You can also double tap to drill down into the area of the graph or see the report view, or pinch and zoom to zoom in or out of a graph.

Why can't I convert a lead to an opportunity?
You can convert a lead to an opportunity only when the prospect or customer associated to the lead is a sales account.

How can I create a search criterion that can be saved for use in the Oracle Sales Cloud Mobile application?
You can create saved search criteria for Apple and Android devices. Use either Oracle Page Composer or the Oracle Engagement Cloud web interface to create the saved search. Select Run Automatically to ensure that the search can be executed in the Oracle Sales Cloud Mobile application. Tap the search name in Oracle Sales Cloud Mobile to execute the saved search.

How can I view saved search criteria?
Tap the magnifying glass icon in the list view to view a list of available saved searches. Execute the search by tapping an individual saved search. Tap the search box to see additional fields where you can make changes to the search criteria.
Why can't I view the Around Me results on a map?
Android devices display the Around Me results in a list view, but not on a map.

Can I delete the custom fields I have created for the Around Me feature?
Yes. If you created custom fields for the Around Me feature for earlier releases, then you don't have to maintain the fields with geocodes because the application no longer uses them.

Offline Usage

Why can't I view updates to my data?
When the application is in offline mode, due to the absence of a network connection, you cannot view any updates that were made to the sales data since the application changed to offline mode. You can view data updates when you access the record again after regaining access to a network connection.

Why can't I create, edit, or delete any data in the application?
Verify that you have network coverage. Data cannot be created, edited or deleted in offline mode.

What data is available in the offline mode?
The application saves up to 50 MB of recently viewed data on the mobile device. After 50 MB is reached, the application removes the oldest entries to make room for newer data. Data stored includes:

- A list of opportunities
- Specific opportunity details
- A list of contacts
- Customer details

When you are using the offline mode, you can view saved data. You can also save specific account records and their related objects for offline use by tapping the action menu when viewing the record, and saving the customer detail.

When the application can connect to a network and you can get back online, data is not automatically synchronized with the data updates that other people have made when you were offline. To view updated data, you must access the records again in online mode.

Note that custom objects are not available in offline mode.

Integration with Oracle Social Networks

Can I use Oracle Social Network within Oracle Sales Cloud Mobile?
Yes, you can call the Oracle Social Network application for the customer, opportunity, or contact that you're viewing. Navigate to the detail view of the customer, opportunity, or contact, tap the Actions menu, then start the Oracle Social Network application by tapping Conversations.
How can I use Sales Cloud Mobile to collaborate through Oracle Social Networking?
You can manually share and view information about opportunities, leads, and contacts in two ways. When you create an object, upon saving, you can share the object, or, while viewing an object's details, you can tap Conversations in the Action sheet to see recent conversations.

You can also share information automatically. Automatic sharing means that a social object is created automatically in Oracle Social Network when an object - such as an opportunity, lead, or contact - is created in Oracle Sales Cloud Mobile. For more information about sharing information automatically, see the Oracle Sales Cloud Social Network Administration: Overview help topic.

What types of attachments can I use?
You can create image (for example, GIF or JPG) and audio files as attachments. You can view, but not save or create, PDF and Microsoft Office documents including Word, PowerPoint, and Excel attachments.

How can I view attachments offline?
To view an attachment offline, you must explicitly download it to your mobile device. In the attachment list view, tap the Actions menu to go into edit mode. Then, select one or more attachments to save locally and tap Done. When you tap Done, the attachment is saved locally for offline access.

How can I share attachments with my Oracle Social Network contacts from Oracle Sales Cloud Mobile?
In the attachment list view, tap on the action Post on OSN, then select one or more attachments, and tap Done.
Sales Assistant

Overview of Sales Assistant

Oracle Sales Assistant is one of several available skills supported by Oracle Digital Assistant. Skills are individual chatbots that are designed to interact with you when you're accessing information and performing tasks. Chatbots use artificial intelligence to create human-like written interactions when people communicate through internet chat. For example, a chatbot might be employed as a part of a customer service site to interact with and answer customer questions through a chat session as a part of the site. Using a mobile device you can send questions or commands to the sales assistant and it retrieves the information or act on your requests.

Before You Start

Here are some things to note before you start using Oracle Sales Assistant:

- Availability: If you're interested in using Oracle Sales Assistant, apply for access on the Oracle Sales Assistant forum on Oracle Cloud Customer Connect.
- Supported Channels: SMS, Microsoft Teams
- Supported Language: English
- Security: Functional privilege checks are done before you start to enter conversations. You must sign in to the sales assistant to access data. When you first converse with sales assistant using SMS, it responds with a URL where you sign in. To prevent SMS spoofing, when updating records by SMS (for example, updating an opportunity), the sales assistant sends a one-time personal identification number (PIN). You must enter the correct PIN to process the update.

If you're a user of the Microsoft Teams channel, then you receive a notification containing a sign in button that you must click to access the sales assistant.

For more information about Oracle Digital Assistant and skills, see https://docs.oracle.com/en/cloud/paas/digital-assistant/index.html

Features of Sales Assistant

Here are some things to note about using the Oracle Sales Assistant:

- Actions and Buttons: During your SMS interactions, the sales assistant responds with a list of supported actions for the message in context. You can act on the message by sending the index number associated with the action you want to do. For interactions with Microsoft Teams, sales assistant responds with a series of clickable buttons.
- List of Records: When you ask the sales assistant a question, for example, to find opportunities in the open pipeline, it responds with a list of records. From the list, you can select a record to drill in to, view, and act on the record. To select the record by SMS, send the index number associated with the record. For Microsoft teams, you click a Select button available from each record card.
- Context: The sales assistant recalls the context of records within a conversation between you and the sales assistant. For example, you're viewing the details of an appointment and you then navigate to view the associated opportunity's details. The sales assistant remembers the appointment that you viewed previously, so that if you request more details about the appointment, the sales assistant recalls the details.
Maybe you want to add a note to the account associated with the appointment? Once again, the sales assistant knows the account you want without having to prompt you based on the context of records within the previous conversation.

**Note:** If you request a sales briefing, the context of the conversation is cleared. The sales assistant also clears the context of all previous records if you haven’t interacted with the bot within the previous 24 hours.

- **WebView:** A WebView browser is launched to update or close an opportunity. The form provides a specialized user interface to capture data for updates and is only applicable for the SMS channel. When you select the action to update an opportunity or close an opportunity, the sales assistant sends a link to WebView. Click the link to open WebView in the default mobile browser. After you complete your updates, return to the SMS application to continue the conversation with the Assistant.

- **Deep Links:** The sales assistant uses the Oracle CX Mobile app to display deep links for the SMS channel. Deep links are links that let you drill directly down into a record, such as an opportunity record. Keep in mind that deep links are available only for certain *intents*.

  SMS channel, deep links are always to CX Mobile app. Deep links aren't available from Android devices for SMS only channel. If Microsoft Teams are using either the web or a desktop client, then the deep links are to the CX Sales web app.

  For Microsoft Teams Mobile app users, then the deep link is to CX Sales mobile app. If you switch from using the mobile app to the web or desktop app, then the deep links initially sent with the mobile app record card are maintained for that specific record. Any other cards you receive conversing on the desktop client will be to the CX Sales web app.

---

### Get Started with the Sales Assistant

To get started, greet the assistant or ask for help. Here are some sample phrases you can use:

- Hi
- Hello
- Hey
- Get started
- Start
- What can you do for me?
- What can you do?
- What can I do?

**Things to note:**

- Oracle Digital Assistant handles the initial greeting as well as any requests for help. If there are multiple *skills* (including the sales assistant) added to your Oracle Digital Assistant, the digital assistant returns suggestions for what you can do with each of the skills.

- For the Sales Assistant skill, you can start with any of the functionality covered in this document:
  - Get your sales briefing
- Create task
- Get your open tasks and create tasks
- Get your open pipeline
- Get opportunity details and actions
- Get account details and actions
- Get contact details and actions
- Get current or next appointment
- Follow up on appointment

**Tip:** Remember: The first time you send a message on the SMS channel to the digital assistant for one of the supported sales actions, the sales assistant responds with a URL for you to sign in to your sales application. For Microsoft teams, you click a sign in button available from your adaptive card. After you sign in, the assistant continues the conversation with you.

**Tip:** Remember: You can either type or use the speech-to-text feature on your mobile device to communicate with the sales assistant.

### Use Sales Briefing

Obtain a snapshot of your day and review specific actions to see the open pipeline, any tasks due today, and your next sales appointment details.

**Intended user:** Sales representative

**Sample phrases you can use:**
- Hey, how's my day today?
- How's my day today?
- Sales briefing

**Sample synonym words:** None

**Things to consider:** None
Here’s a sample conversation using the SMS channel. The conversation shows the phrase “Sales briefing”, with the bot returning, “You have 11 open opportunities and 1 task due today.”, following by “Actions”, underneath which is an ordered list: “1 - Pipeline, 2 - Tasks, 3 - Next Appointment”.

![SMS Conversation]

Here’s a sample sales briefing from an adaptive card used for the Microsoft Teams channel. The card shows the phrase “DAILY BRIEFING”, with the bot returning, "22 Opportunities closing this quarter", followed by "0 Appointments today" and "1 Task due today". Underneath are three buttons : "Pipeline", "Next Appointment" and "Tasks".

**DAILY BRIEFING**

22 Opportunities closing this quarter

0 Appointments today

1 Task due today

[Button Links: Pipeline, Next Appointment, Tasks]
Use Create Tasks

You can request Oracle Sales Assistant to create a task for you. Just provide the subject and due date details, and if needed, an associated account or opportunity. The sales assistant prompts for more details, and then creates the task with you as the owner.

Intended users: Sales representative, sales manager

Sample phrases you can use:

- Create task
- Create task to setup call with Grace for this Friday
- Create task due May 5 to review quotes for opportunity Server Upgrade
- Create a task, create presentation, due September 10 for account Pinnacle

Sample synonym words: tasks, task, to do

Things to consider: If the sales assistant can’t determine the due date or subject of the task, you’re prompted for these details. However, you won’t be asked for associated account or opportunity details if you didn’t include them as part of the initial phrase.

Use Get Tasks

Get any tasks due today, overdue tasks, or tasks due on a certain day. You can also see details for each of the tasks and can mark tasks as complete.

Actions supported for a specific task include:

- Mark a task as complete
- View account if there is an associated account
- View opportunity if there is an associated opportunity
- View contact if there is an associated primary contact

Intended users: Sales representative, sales manager

Sample phrases you can use:

- Get my overdue tasks
- Get my tasks due today
- Get my tasks due tomorrow
- Get my tasks due next week
- Get my tasks due on December 10
- Get my tasks due this week
- Get my tasks due in the next two weeks

Sample synonym words: tasks, to-dos, to dos
Things to consider: None

Here's a sample conversation for the SMS channel. The conversation shows the phrase "You have 294 overdue tasks." The phrase is followed by a series of sample tasks. The details of the tasks include things like account name, task name, and task due date.

Here's a sample task from an adaptive card used for the Microsoft Teams channel. The card shows the Task due today and the "Mark Complete" button.
Use Get Open Pipeline

View the open opportunities in the pipeline for a specific close period, sorted by sales stage. You can also view the open opportunities in the pipeline based on revenue or close date if you have Adaptive Search configured. The sort order depends on how you ask for opportunities. For example:

<table>
<thead>
<tr>
<th>If you're asking for...</th>
<th>Then this is opportunity view sort order...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Opportunity by name and multiple matches</td>
<td>• account name</td>
</tr>
<tr>
<td></td>
<td>• revenue (highest)</td>
</tr>
<tr>
<td></td>
<td>• close date (closest first)</td>
</tr>
<tr>
<td>Pipeline for closed period</td>
<td>• sales stage</td>
</tr>
<tr>
<td></td>
<td>• close date (closest first)</td>
</tr>
<tr>
<td></td>
<td>• win prob (highest)</td>
</tr>
<tr>
<td></td>
<td>• revenue (highest)</td>
</tr>
<tr>
<td>Opportunities for an account</td>
<td>• revenue (highest)</td>
</tr>
<tr>
<td></td>
<td>• close date (closest first)</td>
</tr>
<tr>
<td>Opportunities based on revenue</td>
<td>• revenue (highest)</td>
</tr>
<tr>
<td></td>
<td>• win prob (highest)</td>
</tr>
<tr>
<td>Opportunities based on close date</td>
<td>• close date (closest first)</td>
</tr>
<tr>
<td></td>
<td>• revenue (highest)</td>
</tr>
<tr>
<td>opportunities based on revenue and close date</td>
<td>• close date (closest first)</td>
</tr>
<tr>
<td></td>
<td>• revenue (highest)</td>
</tr>
</tbody>
</table>

Supported operations includes:

- Greater than
- Greater than and equal to
- Equal to/in
- Less than
- Less than and equal to
- Between
- Not equal to

Intended user: Sales representative

Sample phrases you can use:

- Get opportunities with revenue greater than $100K
- Get opportunities closing October 1, 2019
• Pipeline
• Get my open opportunities
• Get my pipeline
• Get my pipeline for the <close period>, for example "Get my pipeline for the next fiscal quarter"

Sample synonym words: None

Things to consider: If you don't specify a close period in the phrase, Sales Assistant gets the open opportunities in the pipeline for the current fiscal quarter.

To view open opportunities by revenue or close date, you must enable Adaptive Search on your instance.

To search by revenue, the phrase must contain the word revenue or amount and a numeric value. Your search returns all opportunities matching the criteria irrespective of the currency code. So if you ask for greater than 100K, search returns all open opportunities greater than 100K USD, and 100K Euro, and other available currency types greater than 100K.

Here's a sample conversation from the SMS channel. The conversation shows the phrase "You have 11 open opportunities." The phrase is followed by a list of the open opportunities. The details about the opportunities include things like opportunity name, revenue amount, sales stage and close date.

Here's a sample pipeline from an adaptive card used for the Microsoft Teams channel. The card shows one of the 6 open opportunities and the "More Details" button opens the opportunity card for this opportunity.
Use Get Opportunity Details and Actions

Retrieve the details of an opportunity and act on the opportunity when you ask for the pipeline or for a specific opportunity. Opportunity details include the account of the opportunity, the opportunity's sales stage, the close date, the primary contact, and associated products. Details also include notes on the opportunity from the past seven days.

Actions supported on an opportunity include:

- Add a note to an opportunity
- Update an opportunity
  - Lets you update an opportunity's sales stage, close date, and competitors using the update opportunity WebView for the SMS channel. Click the link provided to open WebView from where you can save the changes or cancel the changes. For the Microsoft team channel, update opportunity is a card and supports updating sales stage, close date, and win probability.
- Close an opportunity
  - SMS channel users can close an opportunity using the close opportunity WebView. Click the link provided to open WebView. The browser sets the default status to Won, the close date to today's date and the sales stage to Won. You can change the values as required for these fields and choose a Win/Loss Reason. Sales assistant provides a deep link for users of the Microsoft team channel to go to CX Sales web or CX Sales mobile apps to close the opportunity.
- See recommendations
  - Returns an opportunity's main Oracle Adaptive Intelligence recommended actions, if any. If there are no next best actions, returns any Sales Coach actions.
- Get active quote
  - Returns the opportunity's active quote, if any.
- View account
  - Returns the associated account details. See the Get Account Details and Actions section for more information.
- View contact for the opportunity if there is a primary contact on the opportunity.

These actions are available when viewing the details of an opportunity. You can also take direct action on an opportunity without first having to view the detail of the opportunity. Send phrases such as "Add note to opportunity..."
"<name>" and "View recommendations for opportunity <name>". If the opportunity name isn’t provided, such as "Add note", the Assistant prompts you for the opportunity’s name.

Intended users: Sales representative, sales manager

Sample phrases you can use:

- Get opportunity <opportunity name>
- Get details for opportunity <opportunity name>
- View opportunity <opportunity name>
- Add note to opportunity <opportunity name>
- Update opportunity <opportunity name>
- Close opportunity <opportunity name>
- View recommendations for opportunity <opportunity name>
- Get active quote for opportunity <opportunity name>
- View account for opportunity <opportunity name>

**Note:** Precede the opportunity name with the word "opportunity" or its synonyms.

Sample synonym words: opportunity, oppty, opty

Things to consider: When adding a note, you can’t send multiple messages. The first message sent is the note added to the opportunity.
Here are two parts of a sample conversation from the SMS channel. The first part shows the details of an opportunity, such as name, sales stage, revenue, and close date. It shows the product list, and also includes a link to view the opportunity in the cloud application.

This portion of the conversation from the SMS channel shows the actions you can take on the opportunity, such as adding a note, updating the opportunity, closing the opportunity, viewing recommendations, getting an active quote, and viewing the account on the opportunity.
1. Add note
2. Update opportunity
3. Close opportunity
4. See recommendations
5. Get active quote
6. View account

What note would you like to add?

Currently reviewing agreement and will let us know next week
Here’s a sample adaptive card from the Microsoft Teams channel. It shows the actions you can take on the opportunity, such as adding a note, updating the opportunity, closing the opportunity, viewing all notes, viewing an active quote, and viewing the account on the opportunity.

**OPPORTUNITY**

Pinnacle Technologies

**AutoOpty8bf31484204**
(20.51K USD)
Stage: 01 - Qualification, Closing: Nov 12th, Win: 75%

**Primary Contact**
Matt Liu
sendmail-test-discard@oracle.com - +1 925-694-8120

**Products**
- Servers (10000 USD)
- Elite Pro DG 455 Green Rack Server (5010 USD)
- Sentinel Power 7501RT Server (5000 USD)
- Electronics (500 USD)

**Recent Notes** (2)
*Today*
Demo products and provide quotes

View all notes

[Add a Note] [View Account]

[Update Opportunity] [Close Opportunity]

[View Active Quote]

---

### Use Get Account Details and Actions

View the details of an account by checking for the next appointment or by viewing a specific opportunity or asking for a specific account. The sales assistant responds with the details of the account including the account's primary contact, the number of open opportunities, and any notes on the account from the past 7 days.

You can also request the open service requests for an account. The sales assistant responds with service request details, such as title, description, milestone, time remaining, and so on. You can view the latest message on the service request as well as add an internal note to the service request.

Actions supported on an account include:

- Get service requests

- Add a note on an account
  - Returns the details of the associated open service requests.

- View opportunities
Returns the list of open opportunities for an account. You can drill into each opportunity to see details. See the Get Opportunity Details and Actions section of this document for more information.

- View contact for the account if there is a primary contact on the account.

These actions are available when viewing the details of an account. They can also be directly used to take action on an account without first having to view the detail of the account. Send phrases such as "Add note to account" <name> and "View opportunities for account" <name>. If account name isn't provided, such as "Add note", the Assistant will prompt you for the account's name.

Intended users: Sales representative, sales manager, service manager, service representative

Sample phrases you can use:

- Get account <account name>
- Get details for account <account name>
- View account <account name>
- Add note to account <account name>
- View opportunities for account <account name>
- Get service requests for account <account name>
- What are the service requests for account <account name>

**Note:** Precede the account name with the word "account" or its synonyms.

Sample synonym words: account, acct

Things to consider: When adding a note, multiple messages aren't accepted. The first message sent is the note added to the account.
Here’s a sample SMS channel conversation. The conversation shows the account name followed by the number of open opportunities, and the contact name and details. It also lets you select from related actions, such as adding a note and viewing the opportunities.

Here’s a sample adaptive card used for the Microsoft Teams channel. The card shows the account details and the "Add a Note" and "View Opportunity" buttons.
Use Get Contact Details and Actions

View the details of a contact by asking for a specific contact. Sales Assistant responds with the details of the contact such as job title, affinity, buying role, primary phone number, and any notes on the contact from the past 7 days.

Actions supported on a contact include:

- Add a note on a contact
- View account
  Returns the associated account details. See the Get Opportunity Details and Actions section for more information.
- View opportunities
  Returns the list of open opportunities that the contact is associated with. You can drill into each opportunity to see details. See the Get Opportunity Details and Actions section for more information.

Intended users: Sales representative, sales manager

Sample phrases you can use:

- Get contact <contact name>
- Get details for contact <contact name>
- View contact <contact name>

Note: Precede the account name with the word "contact" or its synonyms.

Sample synonym words: None
Things to consider: When adding a note, multiple messages aren't accepted. The first message sent will be the note added to the contact.

Here's a sample SMS channel conversation. The conversation shows the contact name and details. It also lets you select from related actions, such as adding a note and viewing the opportunities.

Here's a sample adaptive card used for the Microsoft Teams channel. The card shows the contact details and the "Add a Note", "View Account", and "View Opportunities" buttons.
Use Get Current, Next Appointment, and Reschedule Appointment

You can check the details of your current appointment, such as the appointment's location and objectives. You can also get appointment details for your next appointment by sending the date, such as "get appointments on June 2" or "get appointments for tomorrow". You can also reschedule an appointment, for example, by sending "reschedule appointment at 3pm to tomorrow at 5pm". If you send the word "Appointments" without including a date, all appointments scheduled in the next 24 hours are returned. You can request to show the briefing for the appointment currently in progress, with the option to view the briefing of your next appointment. For example, during an appointment, you can request a briefing to receive a quick re-cap of the objectives of your next appointment.

Actions supported include:

- **More Details**
  
  Lets you see more details about the appointment including description and objectives.

- **View Account**
  
  Returns the details of the associated account. See the Get Account Details and Actions section for more information.

- **View Opportunity**
  
  Returns the details of the associated opportunity. See the Get Opportunity Details and Actions section for more information.

- **View Contact** if there is an associated primary contact on the appointment.

- **Reschedule an appointment**
When you request to reschedule an appointment, the sales assistant attempts to extract which date and time to reschedule to. If it can't extract the details, you are prompted for the date and time to reschedule the appointment. Other updates can't be done on the appointment.

Intended users: Sales representative, sales manager

Sample phrases you can use:

- Next meeting
- Get appointments on June 2
- Current meeting
- Next appointment
- Show me a briefing of my next appointment
- Current appointment
- Show me a briefing of my current appointment

Sample synonym words: appointment, meeting, appt

Things to consider:

When asking for the next appointment and if an appointment has started and is in progress, but, is less than half completed, the assistant:

- Responds with the details of the appointment in progress and
- Provides an action to view the next future appointment
- Sales assistant doesn't currently support all-day appointments.
- You can't reschedule all day appointments
Here’s a SMS sample conversation of an upcoming appointment which shows the customer name, the date and time, and the meeting subject. It also shows the meeting status, location, and objectives for the meeting as well as what actions you can select on the meeting.

Next appointment: 01:00pm
PDT (Starting in 2 hrs 28 mins)
Meeting
Demo Server Upgrade
Pinnacle Technologies: Green Server Upgrade
Location: Pinnacle's Office
Actions:
1. Brief me
2. View account
3. View opportunity

Today's Agenda:
Demo Servers
Q&A
Wrap up
Objectives:
• Gather Feedbacks
• Demo product
Actions:
1. View account
2. View opportunity
Here's a sample SMS conversation of a current appointment which shows the date and time, and the meeting subject. It also shows the meeting status and location, as well as what actions you can select on the meeting.

![Sample SMS Conversation]

Here's a sample adaptive card used for the Microsoft Teams channel. The card shows a sample of a next appointment and the "View Opportunity", "View Account", "Current Appointment", and "Update Opportunity" buttons.

![Sample Adaptive Card]
Use Follow Up on Appointment

Locate the appointment that last ended and get a list of follow-up actions that you can do. Send a date to locate another appointment to follow up on.

Actions supported on the follow-up on appointment include:

- **Call report outcome**
  
  Lets you create a call report and add meeting minutes to the call report for the appointment.

- **Schedule next appointment**
  
  Lets you schedule a follow-up appointment based on the information from the original appointment, as well as select the date for the follow-up appointment.

- **Add a task**
  
  Lets you create a follow-up task based on the information from the original appointment.

- **View opportunity, update opportunity, and close opportunity**
  
  If an opportunity is associated with the appointment, lets you access the opportunity details, update the opportunity's sales stage and close date, or close the opportunity directly. See the Get Opportunity Details and Actions section for more information.

Intended users: Sales representative, sales manager

Sample phrase you can use: Follow up

Sample synonym words: meeting, appointments, appt

Things to consider:

- When you send "follow up" to the Sales Assistant, it looks for appointments ended within the previous 100 days from the current date. If no appointments exist, the sales assistant responds "You have no appointments scheduled". To follow up on an appointment older than 100 days, include a date older than 100 day, for example, send "Follow up July 30".

- You can directly create a call report outcome, schedule the next appointment or add a follow-up task for an appointment by using phrases such as "create call report," "schedule next appointment," or "create follow-up task." Direct requests bypass the Sales Assistant follow-up query and retrieve the appointment that last ended.

- If your last interaction with sales assistant is following up on a specific appointment, then you're prompted with the following choices before you request the sales assistant to follow up, create call report, schedule next appointment, or create follow-up task:
  
  o There's another appointment just ending so do you want to follow up on that newly ended appointment
  
  o Continue with the existing appointment you were following up

- In-progress appointments aren't returned as the default appointment for follow-up actions.

- If multiple appointments end at the same time, the Sales Assistant returns a list of the conflicting appointments for you to select.

Here's a sample SMS channel conversation. The image shows the phrase "Follow up", followed by the response from the bot, which is like "Ok, last appointment was yesterday at 5:00 p.m. PDT". The details include the customer's name.
The image also shows a series of actions you can do, such as entering the call report outcome, scheduling the next appointment, adding a task, and viewing, updating, and closing the opportunities.

Here's a sample card where you can choose what you want to do to follow-up on an appointment. It is displayed when you type "follow up".

Here's a sample follow-up task from an adaptive card used for the Microsoft Teams channel. Click the Create button to create an appointment.
**FOLLOW-UP TASK**

For the meeting (Yesterday at 8:30am PST)

Devon Networks

**Subject**

Meeting with Devon

**Description**

Meeting to discuss next steps

**Due by**

Dec 3, 2019

[Create](javascript:;)

---

![Oracle Logo](https://oracle.com/logo)
Overview of Social Networking

Oracle Social Network is a secure, private social network that integrates with your sales application and connects you with all your colleagues. With Oracle Social Network, you and your teams have the tools to collaborate, capitalize on collective experience, and make informed business decisions.

You can use Oracle Social Network for:

- Discussing projects, plans, and issues in public forums, membership groups, or one-on-one.
- Reviewing and publishing files.
- Following the daily activities of the people you choose.

The real power of Oracle Social Network is how it integrates with common sales objects. For example, you can bring an opportunity into a Conversation where you can discuss it, plan around it, and share it. You can take the opportunity from possibility to realization without losing any of the casual and formal information that flows from all of this activity.

Note: You can create custom reports for Lightbox. For more information see the Creating and Administering Analytics guide.

Overview of Adding Oracle Social Network

After the administrator has enabled Oracle Social Network in your environment, you can add Oracle Social Network to your sales application.

Objects Enabled for Oracle Social Network

You can share object records to Oracle Social Network as Social Objects.

To share object records:

1. Click the Social tab from within the specific opportunity to open Oracle Social Network.
2. Click the Social link on a specific object record.
3. Click Share if the opportunity hasn't already been shared.
4. Click Join to join the opportunity.

Share Information Using Oracle Social Network

Oracle Social Network helps you collaborate with colleagues who can share their knowledge or information about a particular business object. Sharing knowledge and collaborating helps you to be prepared with the latest data. Using Oracle Social Network conversations, you can associate collaborative discussions with a particular Oracle Applications Cloud object. You can include participants in the conversation even if they don't have access to Oracle Applications...
You can also join an object, add members to the wall, post messages, and share the object if the object hasn't been shared.

Objects you can tie conversations to include:

- Accounts
- Activities
- Contacts
- Households
- Leads
- Opportunities
- Partner accounts

The following example shows how to use Oracle Social Network to share information. The example is common to all object types, though the specifics might vary slightly by object. For example, suppose you're a sales representative who needs more information about the way regulations work in a particular territory, so you want to seek additional information from colleagues with knowledge of that territory. To share information:

1. Click the Social tab from within the specific object to open Oracle Social Network.
2. Click Share if the object hasn't already been shared, or Join to join the object. You can also add members to the wall and post messages to the wall associated with the object.
3. Click Create New Conversation, from the More Options menu, to create a new conversation about the object.
4. Add your knowledgeable colleagues to the conversation.
5. Post your questions to the conversation, and mark them for follow-up to let your colleagues know you're waiting for their responses.
6. When your colleagues respond (perhaps with Word documents or other useful files), you can annotate these files with additional questions and comments if necessary. Mark the additional questions for follow-up to alert your colleagues that you have updated them.
7. Continue the collaboration in the conversation as long as you require further details. If you want additional information, you can add more colleagues.

If you see the Social link in an Oracle Engagement Cloud object, that's your cue that social networking features are available for that particular object.

Note: Oracle Social Network integration is only available with Oracle Cloud deployments.

Collaborating to Drive Sales Activity

If you're a sales manager, you can encourage collaboration among your team and any other people at your company who can provide information. To do this:

1. Review your team's conversations, and identify any issues that they might need help with.
2. Add colleagues, both in your group and in other areas, who have knowledge about these issues.
3. If necessary, add documents to the conversation to update your newly added colleagues about the issue.

You can facilitate collaboration when you notice that one of your team's sales accounts hasn't had any activity for two months. You can collaborate with the customer about a new product that fits their requirement. To facilitate collaboration:

1. Start a private conversation with a member of the product team to discuss the product and how well it meets the customer's needs.
2. Schedule a meeting between you, the product team member, and the salesperson.
3. You and the other participants can post files, such as a slide deck, to the conversation for review prior to the meeting.
4. Participants can annotate the files with additional or updated information both before and after the meeting.

Note: Oracle Social Network is currently available in Cloud implementations only.
24 LinkedIn Sales Navigator

Overview of LinkedIn Sales Navigator

LinkedIn Sales Navigator helps sales teams acquire new business, expand existing customer relationships, and maximize sales productivity. Use the LinkedIn Sales Navigator to:

- Get introduced to buyers through your company's network with TeamLink.
- Spot new buyers that appear at your target accounts with saved search.
- Get immediate alerts when a lead engages with your marketing campaigns.
- Proactively track champions through real-time alerts including role changes.
- Find distributed buyers at the account with lead search.
- Connect with warm outreach with a personalized InMail.

To learn more about LinkedIn Sales Navigator, visit sales.linkedin.com.

Use the LinkedIn Sales Navigator

Watch video

Use your LinkedIn credentials to view the LinkedIn profile details. Before you can use LinkedIn Sales Navigator, your administrator must enable it and you must have Team or Enterprise licenses.

You can access the information in LinkedIn Sales Navigator region from these pages:

- Edit Contact: Profile page for a contact
- Edit Lead: Summary page for a lead

Here are the tasks you can do with the LinkedIn Sales Navigator:

<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>View Profile</td>
<td>View the complete LinkedIn profile details of a contact or lead.</td>
</tr>
<tr>
<td>Connect</td>
<td>Request to connect on LinkedIn by sending an invite.</td>
</tr>
<tr>
<td>Send Message or Send InMail</td>
<td>Send messages to first-level connections. Alternatively, use an InMail to connect with contacts or leads at other levels.</td>
</tr>
<tr>
<td>Icebreakers</td>
<td>Explore common interests and conversation starters with the selected contact or lead.</td>
</tr>
<tr>
<td>Get Introduced</td>
<td>Request an introduction through a mutual connection.</td>
</tr>
</tbody>
</table>
### Task | Description
--- | ---
Match Profile | Associate an accurate profile when LinkedIn suggests multiple profiles that match with a contact or lead. Once associated, you can see the matched LinkedIn profile in your contact or lead records.
Not this person | Use this option if LinkedIn displays profiles that don't belong to the selected contact or lead.

**Note:** You must add LinkedIn to your list of trusted sites, if you use Internet Explorer as your browser.

### Associate a LinkedIn Record with Contacts or Leads

You can use LinkedIn Sales Navigator to build and nurture sales relationships that increase sales performance. Use LinkedIn Sales Navigator to associate a LinkedIn record with contacts or leads. The association helps to connect with the relevant people.

To receive information about a new contact or lead, search in LinkedIn with a few basic details such as name or job title. With LinkedIn Sales Navigator, you get a detailed overview of your contact or lead. Your administrator has to enable the LinkedIn Sales Navigator for you on the contact and lead pages. The steps given here use contacts as an example. Use similar steps to associate a lead with a LinkedIn record.

Here’s how to associate a contact with a LinkedIn record.

1. On your Sales application home page, click Sales > Contacts.
2. Click Create Contact.
3. Enter the first name, last name, and job title.
4. Click Save and Close.
5. Click to open the newly created contact and expand the LinkedIn region of the Lead and Contact detail page.
6. Click LinkedIn Sales Navigator. LinkedIn suggests potential matching profiles.
7. Select the relevant person.
8. Click Match. You receive a notification saying that the contact is matched to the contact.
9. Click Save in Sales Navigator to save the association.

### How can I add LinkedIn to my list of trusted sites in Internet Explorer?

Here’s how you can add LinkedIn to your list of trusted sites.

1. Open Internet Explorer.
2. Press the **Alt** key to view the Tools menu.
3. In the menu, click **Tools**.
4. Click **Internet Options**.
5. Click the **Security** tab.
6. Select **Trusted Sites**.
7. Click **Sites**.
8. Enter https://*.linkedin.com
9. Click **Add** to add the site.
10. Close Trusted Sites and Internet Options.
25 Service Requests

Overview of Service Request Management

Service request management functionality lets you manage and deliver a streamlined service in response to service requests. Delivering consistent answers to customer questions helps ensure that service requests are resolved efficiently and effectively.

Service request management lets you:

• Create service requests
• Enter summary information into service requests
• Add products and product groups to service requests
• Organize service requests into queues
• Compose and send messages from service requests
• Add contacts to service requests
• Add team members to service requests
• Automatically or manually assign service requests to other users
• Create activities for service requests
• Share service request information using a social network
• Associate and view items in the knowledge base
• Integrate with the partners application to capture and resolve issues reported by your partner accounts

See the Using B2B Service guide for more information about sales user tasks for service requests.

Overview of Service Request User Tasks

You can create and manage service requests once your sales administrator enables the service request offering. To create a service request (SR), select the Service Requests menu from the Navigator page, and on the Service Requests list page, click Create Service Request.

Here are some of the high-level user tasks that you can perform for service request management:

• Capture service requests
  You can capture new service requests through user data entry, APIs, or file import.
• Organize and assign service requests
  You can organize and assign service requests to queues either manually or using the Assignment Manager feature. You can also assign service requests to team members through the Assign To field in the service requests UI.
• Manage the lifecycle of a service request
A service request typically moves through the statuses: New, Waiting, In Progress, Resolved, and Closed. You can modify the statuses per your requirements if you have sufficient privileges.

See the Oracle CX Service Using B2B Service guide for more information about sales user tasks for service requests.

See the Oracle CX Service Implementing B2B Service guide for more information about service requests setup tasks.
Overview of Sales Lightbox

With the Sales Lightbox content library, you can store, access, and share files, such as slide decks, web-based content, and .pdfs. The following is a high-level summary of the content library features:

- **Upload and access stored content:** Upload content from your computer to the library for later access and sharing. Supported file types include .pptx, .html (in the form of microsite .zip files), and .pdf. The image file types .jpg and .png are supported as separate file types as well.

- **Find content:** Browse and search for library content. Search includes file name, owner, and keywords.

- **Share content:** Share content with other users, with sales accounts, and with sales opportunities. Joint ownership also is supported.

- **Create new presentations on the fly:** For .pptx files only, assemble new slide decks using slides from the library.

- **Add to cart:** For .pptx files only, add slides to your cart.

The topic, Available Lightbox Actions for Different Content Types, has full details of the available actions for each file type.

Library Views

When you open the library, you see these views:

- **My Content:** Displays all content that you own. This includes content that you have uploaded and all the content that was shared with you by other users. Documents can be shared with or without joint ownership.

- **Shared Content:** Displays all content that you own, and all the content that's shared with you by other users.

If you're an administrator, you also see the All Content view: This view displays all content uploaded by all users, including all content that belongs to the administrator. For more administrator information, see the Implementing Sales guide.

For more information about user tasks in the content library, see the online help and the Using Sales guide.

Available Actions for Different Content Types

In the Sales Lightbox content library, different file types carry different available actions. For example, slides presentations can be added to the cart, but microsite and .pdf files can't.

Here's a list of actions that you can perform with different Lightbox file types.

<table>
<thead>
<tr>
<th>Action</th>
<th>PowerPoints</th>
<th>PDFs</th>
<th>Microsites</th>
<th>Images</th>
</tr>
</thead>
<tbody>
<tr>
<td>Upload</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>
Here's a list of actions with different Lightbox file types and the information that you must consider while performing them.

<table>
<thead>
<tr>
<th>Action</th>
<th>PowerPoints</th>
<th>PDFs</th>
<th>Microsites</th>
<th>Images</th>
</tr>
</thead>
<tbody>
<tr>
<td>Download</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Update</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Open</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>New Pages</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Share</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Add to cart</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Delete</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Search</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>View properties</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

**Upload**
- Slides must be .pptx files.
- Microsites must be .zip files. See the topics, Using Microsites in the Lightbox Content Library and Creating and Uploading a Microsite .Zip File: Procedure: Procedure, for more information.
- Image files must be .jpg or .png format.

**Share**
Sharing is possible with other users, accounts, and opportunities, including joint ownership.

**Delete**
The file owner can delete files that she owns. Administrators can delete any content.

**Search**
- Slides: Can use file name, owner, or keyword in the document.
- PDFs: Can use file name, owner, or keyword in the document.
- Microsites: Can use file name or owner. If keyword search is enabled within the microsite, can search by keyword. If keyword search isn't enabled, then the main .html file is scrubbed of HTML tags and stored as searchable content.
### About Bursting and Assembling Content

The terms burst and assemble have specific definitions in the context of the Lightbox content library.

- **Burst**: Users burst content when they open a file in Lightbox. The act of "bursting" refers to the application displaying the individual pages of a file as it's opened. During this process, after splitting a file into individual pages, the application analyzes the pages, saves them, and creates records for them in the database.

- **Assemble**: Users assemble content when they save individual pages to a cart and download them. Assembling means content with pages from one or more different files (of the same content type) is saved to the cart, potentially rearranged, and then downloaded. During assembly, in the background, the application compiles the files into a single file set.

For more information about using the content library, see the online help and the Using Sales guide.

### Content Creation

#### Overview of Creating Content

To be able to upload presentations to the Sales Lightbox content library, you first create them and then save them to your hard drive. Lightbox supports the following file types:

- **Microsoft PowerPoint**: The presentation library supports the Open XML file format (.pptx 2007). If you install the Microsoft Office Compatibility Pack, and save a presentation in the Open XML format (.pptx 2007), then those presentations are fully compatible with Sales Lightbox.

- **PDF**: You can upload .pdf files and share them with other users. However, you can't open .pdf files in Lightbox or add them to the cart.

- **Microsites**: These are collections of html and supporting files, saved in a .zip compressed file type. For more information about this content type, see the topics, Using Microsites in the Lightbox Content Library and Creating and Uploading a Microsite .Zip File: Procedure.

- **Image files**: The image file types .jpg and .png are supported for upload and sharing as distinct pieces of content. The topic, Available Lightbox Actions for Different Content Types, has full details of the available user actions for each file type.
Use Microsites in the Lightbox Content Library

You can use the Sales Lightbox content library to store and share microsite content. The content library supports multiple-page and single-page microsite content. You construct your microsite content in .zip file format. The .zip file contains the required .html and supporting files, such as images and cascading style sheets.

For a procedure about creating and uploading the microsite files, see the topic, Creating and Uploading a Microsite .Zip File: Procedure.

About the .Zip File

You create the microsite file structure on your hard drive and then you use a .zip compression utility to compress the files for upload. Only .zip compression format is allowed. The microsite's main landing page can have its own domain name or subdomain name. Your .zip file structure determines whether Lightbox considers the microsite a single-page microsite or a multiple-page microsite.

- Single-page microsite: The .zip file contains no embedded .zip files and contains one .html (or .htm) file in the directory structure. The page also contains additional supporting image files, cascading style sheet (.css) files, or JavaScript (.js) files in a separate folder.
- Multiple-page microsite: The .zip file contains embedded .zip files that contain one .html (or .htm) file in the directory structure. The page also contains additional supporting image files, cascading style sheet (.css) files, or JavaScript (.js) files in a separate folder.

This topic contains examples of the supported folder construction for microsite .zip files.

The following rules apply to the .html files:

- For a single-page microsite, the .zip file must contain only one .html (or .htm) file at the top location in the folder. For multiple-page microsites, the embedded .zip files serve as independent microsite pages. That is, each embedded .zip file must contain all of the elements that a single-page microsite contains, including the .html file.
- The .html file must be named identically to the .zip file. For example, visionservers.zip must contain a file named visionservers.html (or .htm) at the top location in the folder.
- If a properly-named, full-sized thumbnail image is provided in the .zip file, the application uses it as the thumbnail. See the rules on image files following this text for more information.

The following rules apply to the image files:

- Supported image file types are .png and .jpg.
- To designate a thumbnail image in the microsite, include the image file at the same location as the .html file and append -full to the file name. For example, in the visionservers.zip file, include an image file named visionservers-full.jpg.
- If no image is designated as the thumbnail, then Lightbox displays its default thumbnail image.

You can enable keyword search for microsites by including a text file with the keywords. See the section on enabling keyword search for microsites later in this topic.

Name and Structure Microsite Files

For microsites to be accepted for upload into the content library, you must follow some rules for naming and structuring the files. Each page must contain a folder of the same name, and that folder must contain an .html file
of the same name. Thus, `visionservers.zip` must contain a folder, `visionservers`. In that folder there must be a file, `visionservers.html`. It can contain any number of other files and folders, but it must at least contain that file.

For a single-page microsite, you supply the `.zip` file that contains an `.html` file named the same as the `.zip` file. Optionally, you also supply a thumbnail image, a text file for keyword search, and supporting files, such as a cascading style sheet and JavaScript files.

The following figure shows an example of a well-constructed single-page microsite folder structure called `visionservers`.

```
/visionservers.zip
  /visionservers/
    visionservers.html
    visionservers-full.jpg
    visionservers-Searchdata.txt
  /css
  /fonts
  /img
  /js
```

For multiple-page microsites, you construct the `.zip` file as multiple `.zip` files within a parent `.zip` file.
The following figure shows an example of a well-constructed multiple-page microsite folder structure called `visionservers`.

```
visionservers.zip
/visionservers1.zip
  /visionservers1/
    visionservers1.html
    visionservers1-full.jpg
    visionservers1-Searchdata.txt
  /css
  /fonts
  /img
  /js
/visionservers2.zip
  /visionservers2/
    visionservers2.html
    visionservers2-full.jpg
    visionservers2-Searchdata.txt
  /css
  /fonts
  /img
  /js
/visionservers3.zip
  /visionservers3/
    visionservers3.html
    visionservers3-Searchdata.txt
  /css
  /fonts
  /img
  /js
```

Enable Keyword Search for Microsites

You can add the ability for users to search for microsite files by keywords. Add a text file with the keywords to the microsite .zip file and name the file appropriately. If keyword search isn't enabled, then the main .html file is scrubbed of HTML tags and stored as searchable content. Use the following guidance when creating the text file:

- Use a text editor application, such as Microsoft Notepad, to create the text file.
- Name the text file with the same name as the .zip and .html files and append it with `-Searchdata` (note the file name is case-sensitive). For example, name it `visionservers-Searchdata.txt`.
- Include the text (.txt) file in the same location as its corresponding .html file.
- Enter the keywords with only spaces between them.
- Don’t use punctuation marks, such as commas or periods, in the text file.
Create and Upload a Microsite .Zip File

After you have created your files and file structure for the microsite, you then must create a .zip file containing the folders and files in the correct structure.

Here are the high-level steps to create and upload microsite .zip files to the content library. For more details about how to structure the folders for the .zip file, see the topic, Use Microsites in the Lightbox Content Library.

1. Create and store the .html and supporting files in a location on your computer. When creating the folder structure, you can use the examples in the topic, Using Microsites in the Lightbox Content Library.
2. Use a file compression application to add the files to a .zip file.
3. Sign in to the applications and navigate to Sales > Lightbox.

   The Lightbox page appears, showing content that's available to you.

4. In the My Content view, click Upload.

   The Upload Content dialog window appears.
5. Browse for the .zip file on your computer.
6. Click Open.
7. Click Upload in the Upload Content dialog window.

   A confirmation message lets you know of a successful upload.

Content Upload

Use the Cart

The cart enables you to assemble content and download them. You can view the details of the content while they’re in the cart. Select the content and remove it using the drop-down button on the content, or clear the cart and remove all the content.

You can add only one type of content at a time to the cart. If you try to add different types of content to the cart, you receive an error stating that the content type is different. For example, if you have uploaded a .pptx presentation and then try to add a PDF file, an error message appears. Clear out the cart and then add your other item type. To add content to a cart:

1. Click Sales > Lightbox.

   The Lightbox overview page appears.
2. Click the plus symbol on the content on the Lightbox overview page to add the content to the cart.
3. Click Cart to view the content.

   The Lightbox: Cart page appears.
4. Click the drop-down button on the content to remove or move the content.
5. Click Clear Cart to remove all the content from the cart.
About Uploading Content

In the Sales Lightbox content library, you can upload content that you want to view later or share with other users. For a procedure detailing how to upload content, see the topic, Uploading Lightbox Content: Procedure.

When you upload content, the application performs in the following way:

- If the content uploads successfully, then a thumbnail image appears on the My Content view after you refresh your view. After an initial upload, a placeholder thumbnail appears and postupload processing continues. You can continue to work during this time.
- An error message appears if uploaded file isn’t a supported file type.
- After the initial file upload, postupload processing extracts thumbnails, performs a virus check on the uploaded file, and so on. A confirmation message appears if the content has successfully uploaded. When the upload is complete, refresh your view to see the content thumbnail image and to access the content.
- If postupload processing fails, and if a preferred notification method has been configured for you, then you receive a message explaining that an error occurred. If this error occurs, contact your administrator. Any content that fails the postupload process is removed from the My Content view.
- If you sign out during an upload, then postupload processing continues.

Note: The maximum file size of a content that can be uploaded is 100 MB.

Upload Content

In the Sales Lightbox content library, you can upload content that you want to share with other users. You also can share content with a potential sales opportunity or with an account.

Here’s how you can upload new content.

1. Navigate to Sales > Lightbox.
   
   The Lightbox page appears, showing content that is available to you. Each item is represented by a thumbnail image. The image has icons on it that allow access to actions and information.
2. In the My Content view, click Upload.
   
   The Upload Content dialog window appears.
3. Click Browse. Browse for and select the content you want to upload from a location on your computer.
4. Click Open or double-click the file.
5. Click Upload in the Upload Content dialog window.
6. A confirmation message lets you know of a successful upload.
7. After the upload is complete, refresh your view to see the new thumbnail images for the content, and to access the content.

Content Update
About Updating Content

In the Sales Lightbox content library, you can replace or overwrite existing content that you own. For example, you might have already shared content with other users, but you want to replace the original content with a version containing newer data.

For a procedure detailing how to update an existing content, see the topic, Update Content

When you update content, the application performs in this ways:

- During post-upload processing, the placeholder thumbnail images change, but the file name remains the same for the newer content. You can continue to work during this time.
- If you're updating content while another user wants to use the content, for example, to add the content to the cart or to share the content, the other user can do so safely, and the current version of the content is used.
- When you're updating content, any search results for that content display the previous version of the content.
- If you attempt to update content while another user is already updating or deleting the content as a joint owner, then you will receive a message that an update is in progress, and to try again later.
- While the update is in progress, the content properties panel is available and a dynamic circle image is overlaid on the thumbnail, providing visual feedback that a new upload is processing.
- While the update is in progress, other users can open the previous version of the content.
- If you decide to update content with content that has a different name than the original content, then the name of the original content is kept, and only the content slides are updated.

After you update content, the application performs in the following way:

- If the content is successfully updated, then the content displays as the first document in the list.
- If the content fails to update, then the existing version remains in place and you receive an e-mail notification confirming that the update failed.
- The cover thumbnail image for the new content is determined by the previously selected cover thumbnail image. For example, if slide number 5 was the previous cover thumbnail, then slide number 5 is also selected for the new content. If the slides are re-ordered, then a different cover thumbnail is displayed.
- If the number of slides in content is reduced, then the thumbnail for the first slide is the cover thumbnail. For example, if slide number 20 was selected as the cover thumbnail for the previous content, but the new content only contains 10 slides, then the thumbnail for the first slide is the cover thumbnail for the content.
- When the content is fully updated, the Version and Uploaded properties are updated accordingly.
- The contents remain shared and the ownership remains shared with other users.
- Each time you update a specific content, the content is listed at the start of the content list in the My Content view.

Update Content

In the Sales Lightbox content library, you can replace or overwrite existing content that you own. For example, you might have already shared content with other users, but you want to replace the original content with a version containing newer data.

Here's how you can update content.

1. Navigate to Sales > Lightbox.
The Lightbox page appears, showing content that is available to you. Each item is represented by a thumbnail image. The image has icons on it that allow access to actions and information.

2. In the My Content view, locate the content you want to replace and update.
3. From the Actions menu, click Update.

The Upload new version of Content dialog window appears.

4. Click Browse. Browse for and select the updated content from a location on your computer.
5. Click Open or double-click the file.
6. Click Upload.

A confirmation message lets you know of a successful upload.

7. After the update is complete, refresh your view to see the new thumbnail images for the content, and to access the content.

Content Search

Overview of Searching for Content

You can search for content by file name, owner, or keyword, in the sales Lightbox content library. The search finds content that you own or that's shared with you by other users. As soon as a file is uploaded and processed, it's available in the search results.

To know how to search Lightbox content, see the topic, Search for Content.

When searching, remember:

- Searches aren't case-sensitive. For example, searching for America returns the same results as searching for aMERICA.
- The search returns partial word matches. For example, if you search for mas, the application finds files containing the words Masterson, Master, and Mask.
- You can use the percent sign (%) as a wildcard at the beginning of a string. For example, if you perform a search for %ore, the application returns all content containing core, sore, and so on.
- You can search for file names that contain special and accented characters such as ampersands.
- The order of keywords within the search string is irrelevant. All keywords must match, to match the search string text in file names and content. The Boolean AND operator is implicit. That's you don't enter the Boolean AND operator in your search string. The application automatically inserts it between each keyword (or between keywords and phrases) in the search string.
- From the search results, you can perform the allowed activities with the content. See the topic, Available Lightbox Actions for Different Content Types, for more information about the allowed actions.

Search for Content

You can search for content by file name, owner, or keyword, in the sales Lightbox content library. The search finds content that you own or that's shared with you by other users. As soon as a file is uploaded and processed, it's available in the search results.
For more information about the Lightbox search actions and tips, see the topic, Overview of Searching for Content.

Here's how to search for content containing a specific word or text.

1. Navigate to Sales > Lightbox.
   The Lightbox page appears, showing content available to you.
2. In My Content or Shared Content views, click the magnifying glass icon.
3. Enter the text that you want to find in the search field, and press Enter or click the search icon.
4. Use the Actions menu to download the content or add it to your cart (if applicable). To open the content (if allowed), click the content name.

See the topic, Available Lightbox Actions for Different Content Types, for more information about the allowed actions.

Search results remain available until you perform a new search in your current session.

## Content Download and Open

### Download Content

Using the Sales Lightbox content library, you can download content that's shared with you. You also can download .pptx slides that you added to your cart.

You can download content from these locations in Sales Lightbox:

- The Shared Content view
- The My Content view
- The cart

**Note:** Only .pptx slides can be added to the cart; therefore, this is the only content type you can download from the cart.

Here's how you can download content from the Lightbox page. To filter the view of the content, you use the Shared Content and My Content view filters.

1. Navigate to Sales > Lightbox.
   The Lightbox page appears, showing content that's available to you. Each item is represented by a thumbnail image. The image has icons on it that allow access to actions and information.
2. In the My Content or Shared Content views, click the Actions menu on a content item and select Download.
3. Do one of these actions:
   - In the open file window, click Save to save the content to your computer's local drive.
   - In the open file window, click Open to open the content and then save the content to your computer's local drive.

### Download Slides from the Cart

This procedure applies only to .pptx slides. Other content types can't be added to or downloaded from the cart. Use this procedure to assemble all slides in your cart into a single slide deck and download them to your computer's local drive.

**Note:** Slides must first be added to the cart in order for you to be able to download them from the cart. See the topic, Overview of Managing Your Cart, for more information.
1. Navigate to Sales > Lightbox.
   The Lightbox page appears, showing content that's available to you. Each item is represented by a thumbnail image. The image has icons on it that allow access to actions and information.

2. Click Cart to open the cart.
3. Click the Download button.
4. Do one of these actions:
   - In the open file window, click **Save** to save the content to your computer's local drive.
   - In the open file window, click **Open** to open the content in Microsoft PowerPoint and then save the content to your computer's local drive.

After you save the content, the download property for each slide is updated. The slides remain in the cart until you remove them.

## Open Content

In the Sales Lightbox content library, you can open your own content and content that has been shared with you.

Opening content lets you:

- View the thumbnail images of PowerPoint slides (if available) in a dialog box.
- View thumbnail images of multiple-page microsites (if images have been provided) in a dialog box.
- Set a particular slide as the content's cover thumbnail image (for slide presentations and microsites).
- Add individual slides from slide presentations to your cart.
- View content properties, such as the number of times the content was downloaded or shared.

**Note:** Note that you can't open .pdf files from the library. When you click on the link for a .pdf file, you see thumbnails of each page.

Here's how you can open content.

1. Navigate to Sales > Lightbox.
   The Lightbox page appears, showing content that is available to you.

2. In the **My Content** or **Shared Content** views, find the content you want to open.
   You can also locate content by performing a search. Files are listed in the chronological order in which they were uploaded.

3. To open content, do one of the following:
   - Click the **Actions** menu and select **Open**.
   - Click the file name link under each thumbnail.
   - From search results, click the content name.

## Overview of Managing Your Cart

You can use the cart in the Sales Lightbox content library to add and assemble Microsoft PowerPoint (.pptx) slides that are available to you. Other content types, including .pdfs, microsites, and image files, can't be added to the cart.
The following are the tasks for the Lightbox cart:

- Adding a presentation to the cart
- Adding a slide to the cart
- Removing slides from the cart
- Emptying the cart
- Downloading slides from the cart
- Arranging the slide order in the cart

**Tip:** The current number of slides you have in your cart is always indicated on the Cart button. And the number of slides in a presentation is shown next to the Add to Cart action.

### Add All Slides in a Presentation to the Cart

To add all the slides of a presentation to the cart, do the following:

1. Navigate to Sales > Lightbox. The Lightbox page appears, showing content that is available to you. Each item is represented by a thumbnail image. The image has icons on it that allow access to actions and information.
2. In the My Content or Shared Content views, locate the presentation you want to add to the cart.
3. Do one of the following:
   - Click the plus sign (+) icon located at the top center of the thumbnail to add the presentation to the cart.
   - Click the Actions menu and select Add to Cart.

A confirmation message notifies you of a successful addition to the cart.

### Add a Single Slide to the Cart

To add a single slide to the cart, do the following:

1. Navigate to Sales > Lightbox. The Lightbox page appears, showing content that is available to you. Each item is represented by a thumbnail image. The image has icons on it that allow access to actions and information.
2. In the My Content or Shared Content views, open the presentation that contains the slide you want to add to the cart. Open the presentation by clicking the Actions icon and then clicking Open.
3. To add a single slide of the presentation to the cart, do one of the following:
   - Click the plus sign (+) icon located at the top center of the slide that you want to add to the cart.
   - Click the Actions menu and select Add to Cart.

A confirmation message notifies you of a successful addition to the cart.

4. Click Done to return to the My Content or Shared Content views.

**Note:** If a slide in your cart has its corresponding presentation deleted, then the slide remains in the cart, but the slide properties are unavailable.

### Remove Slides from the Cart

To remove a slide from the cart, do the following:

1. Navigate to Sales > Lightbox.
The Lightbox page appears, showing content that is available to you. Each item is represented by a thumbnail image. The image has icons on it that allow access to actions and information.

2. Click Cart and find the slide you want to remove.
3. Do one of the following:
   - Click the minus sign (-) icon located at the top center of the slide that you want to remove from the cart.
   - Click the Actions menu and select Remove.
4. Click Yes on the confirmation message.
5. Click Done to return to the My Content or Shared Content views.

Empty the Cart
To empty the cart:

1. Navigate to Sales > Lightbox.
   The Lightbox page appears, showing content that is available to you. Each item is represented by a thumbnail image. The image has icons on it that allow access to actions and information.
2. Click Cart to view your cart.
3. Click Clear Cart.

Download from the Cart
To download all slides from the cart into a single presentation and save them to your computer's local drive, do the following:

1. Navigate to Sales > Lightbox.
   The Lightbox page appears, showing content that is available to you. Each item is represented by a thumbnail image. The image has icons on it that allow access to actions and information.
2. Click Cart to open the cart.
3. Click Download.
4. Do one of the following:
   - In the open file window, click Save to save the presentation to your computer's local drive.
   - In the open file window, click Open to open the presentation in Microsoft PowerPoint and then save the presentation to your computer's local drive.
   After you save the presentation, the application updates the properties information for the slide. The slides remain in the cart until you remove them.
5. Click Done to return to the My Content or Shared Content views.

Arrange the Slide Order in the Cart
To change the order in which slides appear in the cart, do the following:

1. Navigate to Sales > Lightbox.
   The Lightbox page appears, showing content that is available to you. Each item is represented by a thumbnail image. The image has icons on it that allow access to actions and information.
2. Click Cart to open the cart.
3. In the cart, find the slide you want to move.
4. Do one of the following:
   - Move the slides to where you want them.
Click the **Actions** menu and select **Move Left** or **Move Right**.

- Click the left or right arrow located at the top center of the thumbnail.

**5.** Click **Done** to return to the **My Content** or **Shared Content** views.

## Content Share

### Overview of Sharing Content

In the Sales Lightbox content library, you can share content with:

- Opportunities
- Accounts
- Users

You can also select a user to be the joint owner of a content item along with you.

### Share Content with Opportunities and Accounts

You can share your content with accounts and opportunities. When you share content with an opportunity or an account, you’re essentially attaching a copy of the content to the opportunity or account you select. Note the following:

- You can only share content with an account or an opportunity if you have access to Sales accounts or opportunities applications.
- If you make any changes to the content after you share it with an opportunity, the shared document isn’t affected.

### Share Content with Other Users

You can share content with another user without granting joint ownership. The following table indicates which actions the other user can perform after the content is shared. All content that’s shared without joint ownership is available in the user’s **Shared Content** view.

<table>
<thead>
<tr>
<th>Actions</th>
<th>User Permission?</th>
</tr>
</thead>
<tbody>
<tr>
<td>View content</td>
<td>Yes</td>
</tr>
<tr>
<td>Download content</td>
<td>Yes</td>
</tr>
<tr>
<td>Share content without joint ownership</td>
<td>Yes</td>
</tr>
<tr>
<td>Update content</td>
<td>No</td>
</tr>
<tr>
<td>Share content with joint ownership</td>
<td>No</td>
</tr>
<tr>
<td>Delete content</td>
<td>No</td>
</tr>
</tbody>
</table>
Share Content with a User as the Joint Owner

If you own a content item, you can share it with a user and grant joint ownership to that user. The following table indicates which actions the other user can perform when the content is shared with joint ownership. All content that’s shared with joint ownership is available in the user’s My Content view.

<table>
<thead>
<tr>
<th>Actions</th>
<th>User Permission?</th>
</tr>
</thead>
<tbody>
<tr>
<td>View content</td>
<td>Yes</td>
</tr>
<tr>
<td>Download content</td>
<td>Yes</td>
</tr>
<tr>
<td>Update content</td>
<td>Yes</td>
</tr>
<tr>
<td>Share content with ownership</td>
<td>Yes</td>
</tr>
<tr>
<td>Share content without ownership</td>
<td>Yes</td>
</tr>
<tr>
<td>Delete content</td>
<td>Yes</td>
</tr>
</tbody>
</table>

For procedures details sharing activities, see the additional topics on sharing content.

Share Content with an Opportunity

In the Sales Lightbox content library, you can attach a copy of a content to an opportunity. If you make any changes to the content after you share it with an opportunity, the shared document isn’t affected. You can only share content with an opportunity if you have permission to access the opportunities application.

Here’s how to share content with an opportunity.

1. Navigate to Sales > Lightbox.
   
   The Lightbox page appears, showing content that is available to you.

2. In the My Content or Shared Content views, click the Actions menu and select Share Content with Opportunity.
   
   The search and select page for opportunities appears.

3. Search for and select the opportunity.

4. Click OK.
   
   A confirmation message lets you know that the content was successfully shared.
Share Content with a User

In the Sales Lightbox content library, you can share your content with others using sales applications. After you share content with another user, the content appears in the user's Shared Content view. If you make any changes to the content after you share it with a user, these changes are visible to all users with whom the document has been shared. You can only share content with a user who has access to Sales Lightbox, and if the content owner has granted you joint ownership.

Here's how to share content with a user.

1. Navigate to Sales > Lightbox.
   
   The Lightbox page appears, showing content that is available to you.
2. In the My Content or Shared Content views, click the Actions menu and select Share Content with User.
   
   The search and select page for users appears.
3. Search for and select the user.
4. Click OK.
   
   A confirmation message lets you know the content was successfully shared.

Share Content as Joint Owner

In the Sales Lightbox content library, you can share your content with other sales application users and make them joint owners of the content. If you make any changes to the content after you share it with a user, these changes are visible to all owners with whom the document has been shared. When you share a document with a user with joint ownership, that user is allowed to update and delete that document. You can only share a content with a user as joint owner if the user has access to Sales Lightbox, and if the content owner has also granted you joint ownership.

Here's how to share content with a user as joint owner.

1. Navigate to Sales > Lightbox.
   
   The Lightbox page appears, showing content that is available to you.
2. In the My Content or Shared Content views, click the Actions menu and select Share Content with User as Joint Owner.
   
   The search and select page for users appears.
3. Search for and select the user.
4. Click OK.
   
   A confirmation message lets you know the content was successfully shared.

Share Content with an Account

In the Sales Lightbox content library, you can attach a copy of a content item to an account. If you make any changes to the content after you share it with an account, the shared document isn't affected. You can only share content with an account if you have permission to access the sales accounts application.
Here’s how to share content with an account.

1. Navigate to Sales > Lightbox.
   The Lightbox page appears, showing content that is available to you.
2. In the My Content or Shared Content views, click the Actions menu and select Share Content with Customer.
   The search and select page for accounts opens.
3. Search for and select the account.
4. Click OK.
   A confirmation message lets you know that the content was successfully shared.

Content with Thumbnail Images

About Setting a Slide as a Cover Thumbnail

When using .pptx slide decks as content in the Oracle Sales Lightbox content library, you can set one slide in the slide presentation as the cover thumbnail image. These images help users identify the contents of items in the library.

For details on how to set a cover thumbnail image, see the topic, Set a Slide as a Cover Thumbnail.

Before you set a slide as a cover thumbnail image, consider the following:

- If you don’t set a cover thumbnail, then a default cover thumbnail is assigned. The default cover thumbnail is either the last slide used as a cover thumbnail or the first slide in the presentation.
- If you explicitly set a cover thumbnail for a presentation once, then the cover thumbnail remains the same unless you explicitly change it again.
- If you’re the owner of the document and set the cover thumbnail, then the cover you set becomes the cover thumbnail for you and for all other users with whom this document is shared, who haven’t explicitly set their own cover thumbnail.
- If you own a document jointly with other users, and you and a second user have changed the cover thumbnail from the default cover, then all other document owners who haven’t set a new cover will see the most recently set thumbnail as the new cover.

Set a Slide as a Cover Thumbnail

When using .pptx slide decks as content in the Oracle Sales Lightbox content library, you can set one slide in the slide presentation as the cover thumbnail image. These images help users identify the contents of items in the library.

Here’s how you can set a slide that you want to display as the cover thumbnail image for a presentation.

1. Navigate to Sales > Lightbox.
   The Lightbox page appears, showing presentations that are available to you.
2. In the My Content view, open the presentation.
3. Click the star icon on the target slide to set the slide as the cover thumbnail.
   When a slide is set as the cover thumbnail, the star icon on it changes to a filled gray star.
Content Deletion

Overview of Deleting Content

In the Sales Lightbox content library, you can delete content that you own. When you delete content, it's no longer available to you or to others.

For a procedure detailing how to delete content, see the topic, Delete Content

If, before deleting a content item, you shared the content item with other users who are currently working with the content you deleted, one of the following scenarios might occur:

- If you're browsing through content library that includes deleted content, the deleted content isn't available when the page is refreshed.
- If you're browsing through content that has been deleted since you started browsing, when you scroll to the next set of content, a warning message indicates that the content has been deleted. You're then returned to the view prior to opening the content, for example, the Shared Content view.
- If you’re browsing through a content that has been deleted since you started browsing, and if you click Show Content Properties or another menu option, then a warning message indicates that the content has been deleted. You're then returned to the view that was active prior to opening the file, for example, the Shared Content view.
- In the case of slide decks, if you have already added slides from a deleted content to the cart, the thumbnail images of the slides remain visible and available for you to view and to download from the cart until they’re manually removed from the cart, or until the cart is cleared. However, the slide properties are unavailable for the deleted slides.
- If you try to directly download a deleted content from the Actions menu or from one of the views, a warning message indicates that the content has been deleted and the content isn’t downloaded.
- If a deleted content item is displayed in search results and you attempt to select or open that content, then a warning message indicates that the content has been deleted. You can’t interact further with the search result item.

Note: If you’re a sales administrator or a setup user, you can delete any content from the All Content view. This view is available only to sales administrators and setup users.

Delete Content

In the Sales Lightbox content library, you can delete content that you own. When you delete content, it’s no longer available to you or to others.

Here’s how you can delete content

1. Navigate to Sales > Lightbox.
   - The Lightbox page appears, showing contents that are available to you.
2. In the My Content view, locate the content you want to delete.
3. Click the Actions menu and select Delete from the menu.
4. Click Yes to confirm the deletion.
27 In-Context Audit

Overview of In-Context Audit

The In-Context Audit feature lets you view the change history on a record, such as an opportunity, while you're viewing the record. You can view the history for the object without checking the fundamental audit reports separately. You can view who made the changes, what were the changes, and when the changes were made in the change history subtab. This feature helps to:

- Reduce time to resolve an issue
- Understand the audit history
- Improve compliance
- Track the change history of a particular object record.

Use the Change History Subtab

The In-Context Audit feature provides a granular level of security where every object has a separate privilege for viewing its change history subtab. The subtab is visible only if your administrator has given the necessary privileges to you or to your role. Here's how you can use the Change History subtab.

View History

Click the Change History subtab on the object's details page, as shown in callout 1. By default, you can see the records of the last 30 days for that record. You can view all the changes in one transaction per object grouped together, as shown in callout 2.
Search Fields in the Change History Subtab

Use the fields within Search in the Change History page and define your search.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date</td>
<td>Specify the audit history date range.</td>
</tr>
<tr>
<td>User</td>
<td>Filter the records based on a particular user.</td>
</tr>
<tr>
<td>Action</td>
<td>Filter the records based on the action done, for example: Add, Update, Delete.</td>
</tr>
<tr>
<td>Modified Object</td>
<td>Specify whether you want to see the records for the parent object, related or child objects or both.</td>
</tr>
<tr>
<td>Name</td>
<td>Specify the name of the object that you want to search.</td>
</tr>
<tr>
<td>Field</td>
<td>Select one or more fields on the object and filter the records to see the changes made only for those fields.</td>
</tr>
<tr>
<td>Old Value/New Values</td>
<td>Search with the old or new value of a field.</td>
</tr>
</tbody>
</table>

For example, you search only the header opportunity object and within that, you want to view only the changes on Win Probability. Then do these actions as shown in the image.

- Select Opportunity in Modified Object, as shown in callout 1.
- Select Win Probability in Field as shown in callout 2.
- Search. The filtered records display, as shown in callout 3.
Glossary

**action**
The kind of access, such as view or edit, named in a security policy.

**adjusted forecast**
Total forecast for all product items that meet forecast criteria plus a salesperson's adjustment amount, which can be a positive or negative number.

**adjusted territory quota**
The quota amount assigned to the user plus the adjustment amount entered.

**assemble**
Refers to when, in the Sales Lightbox content library, content with pages from one or more different files is saved to the cart, potentially rearranged, and then downloaded. The content must be of the same file types. During assembly, in the background, the application compiles the files into a single file set.

**B2B**
Acronym for business-to-business. Indicates the type of customer relationship with a business, where the customer is a business rather than an individual consumer.

**B2C**
Acronym for business-to-consumer. Indicates the type of customer relationship with a business, where the customer is an individual consumer rather than a business.

**burst**
Refers to when, in the Sales Lightbox content library, the application displays the individual pages of a file as it's opened. During this process, the application doesn't just open the individual pages. Instead, after splitting a file into individual pages, the application analyzes the pages, saves the pages into the content management system, and creates records for the pages in the database.
business object
A resource in an enterprise database, such as an invoice or purchase order.

competitor
A company that competes with your company for sales.

deal size
Total monetary amount the customer is expected to spend.

global header
The uppermost region in the user interface that remains the same no matter which page you're on.

industry codes
Industry codes gives you the flexibility to assign the most accurate industry to your account that defines your account better. You can add or remove industries from your account as long as you have edit access to your account.

infolet
A small, interactive widget on the home page that provides key information and actions for a specific area, for example social networking or your personal profile. Each infolet can have multiple views.

intents
An intent provides a mapping between a user expression and the response displayed by the sales assistant. An intent consists of one or more questions which represent the intention or meaning underlying a possible user statement or query. The match engine maps a user expression to an intent using the questions defined in the intent. Your sales assistant’s response to user expressions is based on the intents you create.

interface table
Database table that stores data during data transfer between applications or between databases that reside inside and outside of an Oracle Fusion application.

internal expert
Experts within your company who have previous experience with a specific competitor.

lead rank
A configurable set of values such as hot, warm, or cool used to prioritize leads for lead qualification and sales engagement.

line of business
A particular kind of commercial enterprise. For example, a broad grouping of salable products such as hardware or training.
marketing activity
An instance of the execution of a campaign stage, such as delivering a specific treatment to a specific audience.

microsite
Individual web page or a small cluster of pages meant to function as a discrete entity within an existing website or to complement an offline activity.

nonrevenue quota
A type of quota typically assigned to a sales resource with overlay sales roles, such as sales consultants or telemarketing representatives, to measure their performance. It is for the Sales Revenue goal.

organization hierarchy
A tree structure that determines the relationship between organizations.

organization types
You can maintain multiple organization types for your account that can help you define your account better. You can add or remove organizations from your account as long as you have edit access to your account.

privilege
A grant of access to functions and data; a single, real world action on a single business object.

prospect
A prospect can be account, contact, or household you haven't sold to yet. A prospect is a potential customer, who you hope to convert into a selling relationship.

qualified lead
A qualified lead is one where the lead qualification status has been updated to qualified. Generally, a lead is considered qualified and ready for conversion to a sale when the need, purchase interest, and budget are confirmed.

quota
A revenue or other target, tied to expected performance.

request call back
A marketing response form that can be inserted into an e-mail. E-mail recipients can click the link to request a call back.

resource
People designated as able to be assigned to work objects, for example, service agents, sales managers, or partner contacts. A sales manager and partner contact can be assigned to work on a lead or opportunity. A service agent can be assigned to a service request.
resource organization
An organization whose members are resources. Resource organizations are used to implement sales organizations, partner organizations, and so on.

resource quota
The target associated with a territory resource. Resource quota can be either revenue resource quota or nonrevenue resource quota.

sales campaign
A sales campaign enables a salesperson to target customer contacts by email in a personalized campaign, using marketing generated collateral.

sales goal
A business or sales objective represented as a measurable goal. A sales goal is defined by how it's measured (amount or quantity), and whether or not the goal has a focus such as on specific product groups.

sales quota plan
Plan that contains all quota activities for the fiscal year, created by the administrator. Actual sales and pipeline are tracked against only one quota plan for the year.

skills
Skills are individual chatbots that are designed to interact with users and fulfill specific types of tasks, such as getting sales details, creating appointments, and changing contact information. Each skill helps complete a task through a combination of text messages and simple UI elements like select lists.

springboard
The grid of icons on the home page that you can use to open pages.

SWOT
Abbreviation for strengths, weaknesses, opportunities, and threats. SWOT analyses score the strengths, weaknesses, opportunities, and threats of a sales competitor, as compared to the selling company.

territory coverage
A territory coverage is a set of boundaries that define what's included or excluded in the territory and what can be sold. For example, sell all products in North America. Customers or partners can be selected to be included or excluded from the territory.

territory coverage model
The coverage model selection identifies whether the territory jurisdiction covers customers or partners. A Customer model means that the territory covers all customers within the territory definition, as well as leads and opportunities for those customers. Partner territories are typically defined for channel sales managers, where the channel sales manager is responsible for a set of partners, and for those partners' deals.
**territory quota**
The revenue target associated with the expected performance of a territory.

**territory team member function**
The function the resource has on the territory team.

**WebView**
A browser that's embedded in a mobile application, producing what's called a hybrid app.